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SYNOPSYS

Silicon to Software

CHAPTER 1

Overview of the Synthesis Commands

This document is part of a set that includes reference and procedural
information for the Synopsys® FPGA tool. This document describes the
commands available for the synthesis tool, which usually includes a
graphical user interface (GUI) as well as command line access. Commands
may vary with the capabilities of the synthesis tool.

The following sections provide an overview of the commands in the tool:
e About Tcl Commands, on page 12
e About the GUI Commands, on page 14

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Overview of the Synthesis Commands About Tcl Commands

About Tcl Commands

Tcl (Tool Command Language) is a popular scripting language for controlling
software applications. Synopsys has extended the Tcl command set with
additional commands that you can use to run the Synopsys FPGA programs.
These commands are not intended for use in controlling interactive debug-
ging, but you can use them to run synthesis multiple times with alternate
options to try different technologies, timing goals, or constraints on a design.

Tcl scripts are text files that have a .tcl file extension and contain a set of Tcl
commands designed to complete a task or set of tasks. You can also run Tcl
scripts through the Tcl window (see Tcl Script Window, on page 38).

The Synopsys FPGA Tcl commands are described here. For information on
the standard Tcl commands, syntax, language, and conventions, refer to the
Tcl online help (Help->TCL).

Tcl Conventions

Here is a list of conventions to respect when entering Tcl commands and/or
creating Tcl scripts.

¢ Tclis case sensitive.
¢ Comments begin with a hash mark or pound sign #).
* Enclose all path names and filenames in double quotes (").

e Use a forward slash (/) as the separator between directory and path
names (even on the Microsoft® Windows® operating system). For
example:

desi gns/ bi g_design/test.v

Tcl Commands

You can enter the Tcl (Tool Command Language) commands directly in the
Tcl window, or include them in Tcl scripts that you can run in batch mode.
For more information about Tcl commands, see Tcl Synthesis Commands, on
page 19.

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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About Tcl Commands Overview of the Synthesis Commands

Tcl Scripts and Batch Mode

For procedures for creating Tcl scripts and using batch mode, see Working
with Tcl Scripts and Commands, on page 506 in the User Guide:

Running Batch Mode on a Project File, on page 500

Running Batch Mode with a Tcl Script, on page 501

Generating a Job Script, on page 507

Creating a Tcl Synthesis Script, on page 508

Using Tcl Variables to Try Different Clock Frequencies, on page 510
Running Bottom-up Synthesis with a Script, on page 513

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Overview of the Synthesis Commands About the GUI Commands

About the GUlI Commands

The GUI commands are accessed from the software graphical interface. Most
commands open dialog boxes where you can specify parameters for the
command.

The GUI provides a few ways to access commands:
¢ Menus, on page 14
¢ Context-sensitive Popup Menus, on page 15
¢ Toolbars, on page 15
* Keyboard Shortcuts, on page 15
¢ Buttons and Options, on page 15

¢ Tcl Commands, on page 12

Most commands have GUI and command line versions, so you can use either
method to specify commands.

Menus

The set of commands on the pull-down menus in the menu bar varies
depending on the view, design status, task to perform, and selected object(s).
For example, the File menu commands in the Project view differ slightly from
those in the RTL view. Menu commands that are not available for the current
context are dimmed out. The menu bar in the Project view is shown below:

File Edit Yiew Project Import Bun Apalysis HDL-Analyst Options Window Tech-Support Wepb Help
The individual menus, their commands, and the associated dialog boxes are
described in the following sections:

¢ File Menu, on page 304

e Edit Menu, on page 309

e View Menu, on page 323

¢ Project Menu, on page 331

¢ Run Menu, on page 374

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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About the GUI Commands Overview of the Synthesis Commands

* Analysis Menu, on page 393

e HDL Analyst Menu, on page 405
* Options Panel, on page 347

e Web Menu, on page 443

* Help Menu, on page 444

Context-sensitive Popup Menus

Popup menus, available by right-clicking, offer access to commonly used
commands that are specific to the current context. See Popup Menus, on
page 452, Project View Popup Menus, on page 458, and RTL and Technology
Views Popup Menus, on page 475 for information on individual popup
menus.

Toolbars

Toolbars contain icons associated with commonly used commands. For more
information about toolbars, see Toolbars, on page 56.

Keyboard Shortcuts

Keyboard shortcuts are available for commonly used commands. The
shortcut appears next to the command in the menu. See Keyboard Shortcuts,
on page 63 for details.

Buttons and Options

The Project view has buttons for quick access to commonly used commands
and options. See Buttons and Options, on page 71 for details.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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About the GUI Commands
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CHAPTER 2

SYNOPSYS

Silicon to Software

Tcl Synthesis Commands

This chapter describes supported Tcl synthesis commands. The commands

are listed in alphabetical order.

add_file

analyst
command_history
create_fdc_template
design

encryptIP

get_env
get_option
hdl_define

history

job

log_report
open_design
partdata
program_version

project_data

Synplify Pro for Microsemi Edition Command Reference
January 2020

add_folder
check_fdc_query
constraint_file
define link
dump_metrics
encryptP1735
get_env

help

hdl_param

impl

log filter
message_override
open_file
program_terminate
project

project_file

© 2020 Synopsys, Inc.
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Tcl Synthesis Commands

project_folder

query_metric

recording
report_external_tool_versions
report_message_summary
run_tcl

select

status_report

syn_connect

synplify_pro

See also:

query_available_metrics
query_metric_details
report_clocks
report_messages
run_tcl

sdc2fdc

set_option

sub_impl

syn_create_err_net

* For specific categories of synthesis commands (for example, log file
commands), see Tcl Command Categories, on page 147.

* For a description of the find, expand, and collection commands, see Tcl
Find, Expand, and Collection Commands, on page 149.

* For the TCL timing and design constraints syntax and their descriptions
in SCOPE, see Constraint Commands, on page 213.

© 2020 Synopsys, Inc.
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Tcl Synthesis Commands

add_file

The add_file command adds one or more files to a project.

Syntax

add_file [-filetype] fileName [ fileName [ ...] ]

add_file -verilog [-lib fileName [ fileName [ ...] ]] [-folder folderName]

add_file -vhdl [-lib libName][ libName] ] fileName [ fileName [ ...] ] [-folder folderName]
add_file -include fileName [ fileName [ ...] ]

add_file [-filetype] -job_owner par | simulation [ fileName [ ...] ]

add_file -structver [fleName [ ...]]

add_file -tooltag tooltagName -toolargs [toolArguments] fileName

add_file -vlog_std standard fileName [ fileName [ ...] ]

-filetype Specifies the type of file being added to the project (files are
placed in folders according to their file types; including
this argument overrides automatic filename-extension
placement). See Filename Extensions, on page 23 for a
list of the recognized file types.

fileName Specifies the name of the file being added to the project.
Files are added to the individual project folders according
to their filename extensions (View Project Files in Folders must
be set in the Project View Options dialog box). You can add
multiple files by separating individual filenames with a
space, and you can specify different file types (extensions)
within the same command.

-verilog or -vhdl Adds HDL files with non-standard extensions to the Verilog
or VHDL directory, so that they can be compiled with the
project. For example, the following command adds the file
alu.v.new to the project’s verilog directory:

% add_file -veril og /designs/nmegachi p/al u.v. new

If you do not specify -verilog, the file is added to the Other
directory (new is not a recognized Verilog extension), and
the file would not be compiled with the files in the Verilog
directory.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Tcl Synthesis Commands

[Hib libName]

[-folder folderName]

-include

-job_owner

-structver fileName

© 2020 Synopsys, Inc.
22

Specifies the library associated with Verilog or VHDL files.
The default library is work. The -lib option sets the VHDL
library to libName.

Note: You can also specify multiple libraries for Verilog or
VHDL files.

Verilog Example:

add file -verilog -lib top -vlog_std sysv "top. v"
VHDL Example:

add file -vhdl -lib {nylib,work} "ff.vhd"

Both the logical and physical libraries must be specified in
the Project file (if you only specify the logical library
associated with the Verilog or VHDL files, the compiler
treats the module as a black box).

Creates logical folders with custom files in various
hierarchy groupings within your Project view. For example:

add file -verilog -fol der nenory "ram1.v"

add_file -verilog -fol der nenory
"C /exanpl es/veril og/ common_rtl/nenory/ram1. v"

Indicates that the specified file is to be added to the project
as an include file (include files are added to the Include
directory regardless of their extension). Include files are
not passed to the compiler, but are assumed to be
referenced from within the HDL source code. Adding an
include file to a project, although not required, allows it to
be accessed in the user interface where it can be viewed,
edited, or cross-probed.

Allows you to determine how files are used; you can
specify these options from the File Options dialog box. For
example, you can automatically decide to pass files to the
back-end place-and-route tool (Use for Place and Route) or
use them for test benches containing HDL constructs for
simulation (Use for Simulation only).

Adds structural Verilog files as input for your design
project. The software performs fast compilation of the
structural Verilog files, providing runtime improvements
for the design. For example:

add_file -structver fileName.vm

For more information, see Using the Structural Verilog
Flow , on page 52.

Synplify Pro for Microsemi Edition Command Reference
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Tcl Synthesis Commands

-tooltag tooltagName Creates a tool tag name for the application tool you want
to invoke from within the Synopsys FPGA synthesis tool.
For example:

add file -tooltag {ldentify} "ramv"

-toolargs tool Specifies any argument options to use with the application
tool you want to invoke from within the Synopsys FPGA
synthesis tool. For example:

add file -tooltag {EDK} -tool args {$SynCode}
"ramv"

-vlog_std standard Overrides the global Verilog standard for an individual file.
The accepted values for standard are v95 (Verilog 95),
v2001 (Verilog 2001), and sysv (SystemVerilog). The file
(fileName) is added to the Verilog folder in the project; the
specified standard is listed after the filename in the project
view and is enclosed in angle brackets (for example,
commchip.v <sysv>). Note that when you add a
SystemVerilog file (a file with an SV extension) to a project,
the add_file entry in the project file includes the -vlog_std
standard string.

The default standard for new projects is SystemVerilog.
For Verilog 2005 extensions, use sysv (SystemVerilog).

Filename Extensions

Files with the following extensions are automatically added to their corre-
sponding project directories; files with any other extension are added to the
Other directory. The -filetype argument overrides automatic filename extension

placement.
Extension -Filetype Project Folder
.adc -analysis_constraint Analysis Design Constraint
. edf, . edn -edif EDIF
. fde -fpga_constraint/-constraint Logic Constraints (FDC)
. sdc -constraint Logic Constraints (SDC)
.svl -verilog Verilog
. tel -tcl Tcl Script
.V -verilog Verilog
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Tcl Synthesis Commands

Extension -Filetype Project Folder

. vhd, . vhdl -vhdl VHDL

.vm, .vgqm -structver Structural Verilog File
any -include Include

1. Use the sv format for SystemVerilog keyword support. Both Verilog and SystemVerilog formats
are added to the Verilog folder.

Example: Add Files

Add a series of VHDL files to the VHDL directory and add an include file to the
project:

% add_file /designs/sequencer/top.vhd

% add_file /designs/sequencer/al u. vhdl

% add _file -vhdl /designs/sequencer/reg.vhd. fast
% add_file -include /designs/std/ decode. vhd

The corresponding directory structure in the Project view is shown in the
following figure:

&} ﬂ Z: fbonlsftemp)sequencer pri
El [,(/ YHDL
----- [ top.whd [work]
b [ aluvhdl [wiark]
[ req.vhd.fast
El [,{/ Include
----- [ decode.vhd

I#revl

Example: File Options Designation

Designate some IP core wrappers as well as their associated instantiated
component files that must be passed on to the place-and-route tool, since
they are not written to the final netlist:

add_file -verilog -job_owner par "ny_ip_core.v"
add file -verilog -job_owner par "ny_ip_core_enc.v"

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
24 Synopsys Confidential Information January 2020



Tcl Synthesis Commands

add_folder

The add_folder command adds a custom folder to a project.

Syntax

add_folder folderName

Creates logical folders with files in various custom hierarchy groupings
within your Project view. These custom folders can be specified with any
name or hierarchy level.

add_fol der veril og
add_fol der veril og/ common_rtl
add_fol der veril og/common_rtl/prep

For more information about custom folders, see Managing Project File
Hierarchy, on page 65 in the User Guide.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Tcl Synthesis Commands

analyst

Changes and manipulates the schematic views of the netlist. Note that the
following HDL Analyst commands can be used without the analyst prefix as

well.

analyst clone_view analyst critical_path analyst dissolve
analyst filter analyst flatten analyst get_selected
analyst group analyst pop analyst push
analyst select analyst unfilter analyst view

analyst clone_view
Opens a copy of the current view.

analyst clone_view designIiD

designID
The design ID to clone. If not specified, clones the current view.

analyst critical_path

Filters the view to show the instances that are part of the critical path, if
available.

analyst critical_path

analyst dissolve

Removes targeted hierarchies from the design. Contents of the hierarchy are
put into the level that originally contained the hierarchy.

analyst dissolve collection

collection
Collection of instances to dissolve.

analyst filter
Filters the view by selected instances and ports.

analyst filter

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
26 Synopsys Confidential Information January 2020



Tcl Synthesis Commands

analyst flatten
Flattens the current view.

analyst flatten

analyst get_selected
Returns the names of currently selected objects.
analyst get_selected [-inst] [-net] [-port] [-pin]

-inst
Returns the names of selected instances. If no -type option is set, the
names of all selected objects are returned.

-net
Returns the names of selected nets. If no -type option is set, the names
of all selected objects are returned.

-port
Returns the names of selected ports. If no -type option is set, the names
of all selected objects are returned.

-pin
Returns the names of selected pins. If no -type option is set, the names
of all selected objects are returned.

analyst group
Creates a graphical group of instances.

analyst group [collection] [-name groupName]

collection
Instances to group. All instances must be on the same level of the
hierarchy.

-name groupName
The name of the graphical group to be created.

analyst pop
Pops up the hierarchy.
analyst pop
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analyst push
Pushes down the hierarchy.

analyst push hierarchyName

hierarchyName
The name of the group or instance to push the hierarchy down into.

analyst select
Selects specified objects.

analyst select [collection] [-append] [-clear] [-instances] [-primitives]

collection
The ID of the collection to select.

-append
Appends objects to the selection list.

-clear
Clears the selection list.

-instances
Selects all instances in the current view.

-primitives

Selects all primitives (leaf) instances in the current view.
analyst unfilter
Unfilters the view.

analyst unfilter

analyst view
Opens a schematic view.

analyst view designID

designiD
The design ID to view.
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check_fdc_query

Runs the constraint checker for constraints using the get * and/or all_* query
commands specified in the timing constraint file for the project.

Syntax
check_fdc_query [-full_check]

Arguments and Options

-full_check
Runs the full constraint checker before checking the query commands.
The default is to run the check_fdc_query command without this option.

When the -full_check option is not specified, the command only runs the
constraint syntax checker, which reduces runtime significantly, since most
objects being searched are found in pre-mapping and do not require full
mapping to be run. However, this option does not find bit-blasted registers
and objects using the advanced -filter @property =~ commands, where the
property is created or applied during mapping because it requires optimiza-
tions such as register replication.

For example, if a 4-bit RAM output is targeted with the get_cell command, the
differences in the results are shown below:

Command Run Stage Results
Default (without -full_check) Pre-mapping ram_out [3:0]
With -full_check Mapping ram_out [3]
ram_out [2]
ram_out [1]
ram_out [0]
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Description

The check _fdc_query command reads the .fdc constraint file of the current
project file. It runs the constraint checker for the following object query
commands that are used with FDC constraints:

all_* Commands get_* Commands
all_clocks get_cells

all_fanin get_clocks
all_fanout get_nets

all_inputs get_pins

all_outputs get_ports
all_registers

The report provides feedback on how these query commands are applied and
ensures that the commands are used properly with constraints in the
constraint file.

Collections created with define_scope_collection, find, and expand are not covered
by this Tcl command. You can check these SCOPE collections in the HDL
Analyst and the SCOPE interface. The report does not cover the define_io_stan-
dard constraint either.

Example

Invoke check_fdc_query from the Tcl command line for the project. You can also
invoke it from a shell window.

The command writes out the results of the object query commands to the
projectName_cck_fdc.rpt file that opens in the GUI. You may need to run the
constraint checker (Run->Constraint Check) to find additional issues with
constraints.
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The following example shows the results of running the constraint checker in
the projectName_cck_fdc.rpt file.

FDC query commands results
kkhkkhkkkhkkhkkhkkhkhkhkhkhkhkhkhkhhkhkrkhkhkrkhhk*k
BHAGH R R
# 1019 : set multicycle path 2 -from[get _cells -hier {*[4]}]
#1line 175 in :
C /check _fdc_query/all _clocks/testl basic/top translated.fdc
Results of query command: get_cells -hier {*[4]}
(none)
BHHH R
# 1027 : set_multicycle path 3 -to [all _cl ocks]
#1line 196 in :
C /check _fdc_query/all _clocks/testl basic/top translated.fdc
Results of query command: all _cl ocks
cl ka
cl kb
dcmj CLKO_BUF _cl ock_CLKI N1
demj cl kO_i _cl ock_CLKI N1
demj CLKO_BUF 1 cl ock_CLKI NL

The syntax checker reports the object query commands and any issues it
found and writes them to the projectName_scck.rpt file.

# Synopsys Constrai nt Checker (syntax only), version map610dev,
Bui | d 1085R

# Copyright (C 1994-2016, Synopsys, Inc.

# Witten on Tue Apr 30 15:39:07 2013

###H## DESI GN | NFO

HHAHH A HH R R R R R R R R R

Top Vi ew "t op"

Constraint File(s):

"C\check _fdc_query\all _clocks\testl basic\top_translated.fdc"

"C \ bui I ds\ syn201309_063R\Ii b\ fdc_query. f dc"

# Run constraint checker to find nore i ssues with constraints.
HHHARHHH AR R R R R
HHH#HH

No issues found in constraint syntax.
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d ock Summary
Start
Request ed Request ed d ock d ock

d ock Frequency Period Type G oup
cl ka 100. 0 MHz 10. 000 decl are default_cl kgroup
cl kb 50.0 MHz 20.000 decl ared default_cl kgroup
denj CLKO_BUF _cl ock_CLKI NL
200.0 MHz 5.000 derived (fromclka) default _clkgroup
denmj CLKO_ BUF 1 cl ock _CLKINL
50.0 MHz 20.000 derived (fromclka) default_cl kgroup

See Also
* Constraint Checking, on page 138
* Constraint Checking Report, on page 171
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command_history

Displays a list of the Tcl commands executed during the current session.

Syntax

command_history [-save filename]

Arguments and Options

-save
Writes the list of Tcl commands to the specified filename.

Description

The command_history command displays a list of the Tcl commands executed
during the current session. Including the -save option, saves the commands
to the specified file to create Tcl scripts.

Examples
command_hi story -save C /Designsl|/tut/proto/ nyTcl Script.tcl

See Also

* recording, on page 102
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constraint_file

The constraint_file command manipulates the constraint files used by the active
implementation.

Syntax

constraint_file
-enable constraintFileName
-disable constraintFileName
-list
-all
-clear

The following table describes the command arguments.

Option Description

-enable Selects the specified constraint file to use for the active
implementation.

-disable Excludes the specified constraint file from being used for the active
implementation

-list Lists the constraint files used by the active implementation

-all Selects (includes) all the project constraint files for the active
implementation.

-clear Clears (excludes) all the constraint files for the active implementation

Examples

List all constraint files added to a project, then disable one of these files for
the next synthesis run.

%constraint_file -1ist
attributes.fdc cl ocksl.fdc cl ocks2.fdc eight_bit_uc.fdc
% constraint_file -disable eight_bit_uc.fdc

Disable all constraint files previously enabled for the project, then enable only
one of them for the next synthesis run.

% constraint _file -clear
% constraint_file -enable cl ocks2. fdc
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create_fdc_template

Lets you create an initial constraint file (.fdc) for your specific design.

Syntax

create_fdc_template [-period float] [-in_delay float] [-out_delay float]

The following table describes the create_fdc_template command options.

Option Description

-period float Specifies the default values for port clocks.

-in_delay float Specifies the default values for the input delay ports.
-out_delay float Specifies the default values for the output delay ports.
Examples

Each port clock includes a set_clock_groups header with details shown below,
which can help you determine whether clocks have been optimized away or if
there are any derived clocks.

HHHHH AR HH AR R R R
### 1 ndi vi dual "set_cl ock_groups” commands for all "clka" derived cl ocks
### appear at the end of this file. Enabling a given coomand wi |l nake the
### gi ven cl ock asynchronous to all other clocks. If a given clock (bel ow
### does not appear in the final Performance Summary (in the *.srr

### file after synthesis),the clock may have been optinized away due to
### Cat ed/ Generated O ock Conversi on.

### See the "CLOCK CPTIM ZATION REPCRT" in the *.srr file.

### Below is a list of any clocks derived from"clka":

### cl ka DER VED CLOCKS:

Hit# dcnj CLKO_BUF_1_derived_cl ock_CLKIN O ock Object: {t:dcm.inst.CLK BUF1. O
Hit# dcm CLKO_BUF_deri ved_cl ock_CLKI N1 Cl ock Object: {t:dcm.inst.CLK BUFO. G
HHHHH AR R R R

set _cl ock_groups -di sabl e -asynchronous -nane {cl ka_group}
-group {clka} -conmment {Source clock cl ka group}

set _cl ock_groups -di sabl e -asynchronous
-nane {dcn CLKO_BUF_1_deri ved_cl ock_CLKI NL_gr oup}
-group [get_cl ocks
-of _objects [get_pins {t:dcminst.CLK BUFl. G]]
-comrent {Derived clock dcnj CLKO_BUF_1 deri ved_cl ock_CLKI N1
fromsource cl ock cl ka}
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© 2020 Synopsys, Inc.
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set _cl ock_groups -di sabl e -asynchronous
-name {dcnj CLKO_BUF_deri ved_cl ock_CLKI N1_gr oup}
-group [get_cl ocks
-of _objects [get_pins {t:dcm.inst. CLK BUF0. G]]
-comment {Derived cl ock dcm CLKO_BUF _deri ved_cl ock_CLKI NL
from source cl ock cl ka}

set _cl ock_groups -di sabl e -asynchronous -name {cl kb_gr oup}
-group {cl kb} -coment {Source clock cl kb group}
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define_link

Use the define_link command to add or remove an instance or design block
to/from the subproject mapping.

Syntax

define_link [{i |v}: {instanceName | designBlockName}]
[-name linkSubProjectName] [-run_type value] [-remove] [-list] [-parameter]

The following table describes the define_link command options.

Option

i: instanceName
or
v: designBlockNeme

-name

-run_type value

-remove

-list

-parameter

Examples

Description

Specifies the name of the instance or design block to be
linked for the subproject.

Specifies the name of the subproject implementation that
contains the design block.

Defines how the subproject is run. You can specify:
* top-down - Runs the top-down flow from HDL or SRS.
* bottom-up - Runs the bottom-up flow from EDIF.

Removes the link to an instance or design block from the
subproject database. When the -remove option is not used, the
instance or design block is removed from the top-level project
and added as a subproject for that project.

Lists all existing links for the project.

Maps the subproject base on the parameterized design block.

Links the instance or design block to the subproject implementation that
contains the block definition. For example:

"define link "i:instl" -nane projl 1|rev_1"

or

"define_link "v:designbl ockA" -nane proj2|rev_3"
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design

Returns netlist data representing information about the design. Commands
are available in both batch and GUI mode. Note that the following HDL
Analyst find commands can be used without the design prefix as well.

design c_diff design c_filter design c_info
design c_intersect design c_list design c_print
design c_symdiff design c_union design close
design expand design find design get_prop
design get design list design open
design set design top_level

design c_diff

Returns a new find collection containing the differences between two existing
find collections.

Syntax

design c_diff collectionl collection2

collection1
The first collection to compare.

collecton2
The second collection to compare.

design c_filter

Filters a find collection based on set properties.

Syntax
design c_filter collection pattern [-inst] [-net] [-port] [-pin] [-view]

collection
The collection ID to filter.

pattern
Statement used to filter.
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-inst
Returns matching instances. If no -type option (-inst, -net, -port, or -pin) is
set, all types will be returned.

-net
Returns matching nets. If no -type option (-inst, -net, -port, or -pin) is set,
all types will be returned.

-port
Returns matching ports. If no -type option (-inst, -net, -port, or -pin) is set,
all types will be returned.

-pin
Returns matching pins. If no -type option (-inst, -net, -port, or -pin) is set,
all types will be returned.

-view

Returns matching views. If no -type option (-inst, -net, -port, or -pin) is set,
all types will be returned.

design c_info
Returns information about the contents of a find collection.

Syntax

design c_info [collection] [-array value]

collection
Find collection information to display.

-array value
Specify an array to store collection information in.

design c_intersect

Defines common objects that are included in each of the collections being
compared.

Syntax
design c_intersect collectionList

collectionList
List of collections separated by spaces.
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design c_list

Converts a collection to a Tcl list of objects.

Syntax

design c_list collection

collection
Collection to convert.

design c_print

Displays collections or properties in column format.

Syntax
design c_print collection [-prop propertyName] [-file filename] [-append]

collection
The collection to print as a table.

-prop
Writes a column in the table for properties of type propname.

-file
Writes the collection to filename.

-append
Appends to the file specified in -file rather than overwriting it.
design c_symdiff

Returns a new find collection containing the difference between two existing
find collections.

Syntax
design c¢_symdiff collectionl collection2

collectionl The first collection.

collection2 The second collection.
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design c_union

Combines multiple collections into a single collection.

Syntax

design c_union collectionList

collectionList
Space-separated list of collections.

design close

Closes the specified design ID. If no design ID is provided, this command
closes the current active design.

Syntax
design close designID

designID
The design ID to close.

design expand

The design expand command identifies objects based on their connectivity, by
expanding forward from a given starting point. Returns a collection.

Syntax
design expand [-objectType] [-from object] [-thru object] [-to object] [-level integer]
[-hier] [-leaf] [-seq] [-print]

-objectType
Optionally specifies the type of object to be returned by the expansion. If
you do not specify objectType, all objects are returned. The object type is
one of the following:

-inst — returns all instances between the expansion points. This is the
default.

-pin — returns all instance pins between the expansion points.

-net — returns all nets between the expansion points.
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-port — returns all top-level ports between the expansion points.

-from object
Specifies a list or collection of ports, instances, pins, or nets for expan-
sion forward from all listed pins. Instances and input pins are automati-
cally expanded to all output pins of the instances. Nets are expanded to
all output pins connected to the net. If you do not specify this argument,
backward propagation stops at a sequential element.

-thru object
Specifies a list or collection of instances, pins, or nets for expansion
forward or backward from all listed output pins and input pins respec-
tively. Instances are automatically expanded to all input/output pins of
the instances. Nets are expanded to all input/output pins connected to
the net. You can have multiple -thru lists for product of sum (POS) opera-
tions.

-to object
Specifies a list or collection of ports, instances, pins, or nets for expan-
sion backward from all the pins listed. Instances and output pins are
automatically expanded to all input pins of the instances. Nets are
expanded to all input pins connected to the net. If you do not specify
this argument, forward propagation stops at a sequential element.

-level integer
Limits the expansion to N logic levels of propagation. You cannot specify
more than one -from, -thru, or -to point when using this option.

-hier
Modifies the range of any expansion to any level below the current view.
The default for the current view is the top level and is defined with the
define_current_design command as in the compile-point flow.

-leaf
Returns only non-hierarchical instances.

-seq
Modifies the range of any expansion to include only sequential elements.
By default, the expand command returns all object types. If you want
just sequential instances, make sure to define the object_type with the
-inst argument, so that you limit the command to just instances.

-print
Evaluates the expand function and prints the first 20 results. If you use
this command from HDL Analyst, results are printed to the Tcl window;
for constraint-file commands, the results are printed to the log file at the
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start of the Mapper section. For a full list of objects found, you must use
c_print or c_list. Reported object names have prefixes that identify the
object type. There are curly braces around each name to allow for spaces
in the names. For example:

{i:regl}
{i:reg2}
{i:\weird_nane[foo$]}
{i:reg3}
<<found 233 objects. D splaying first 20 objects. Use
c_print or c_list for all. >>
design find

Identifies design objects based on specified criteria.

Syntax

design find
[-objectType] pattern
[-seq]
[-inst instance]
[-net net]
[-port port]
[-pin pin]
[-view view]
[-depth viewNumber]
[-flat]
[-print]
[-filter expression]
-in value
-below value
-nocase

-objectType pattern
Specifies the type of object to be found. Object types are view, inst, port,
pin, or net. The pattern argument is required and specifies the search
pattern to be matched. The pattern can include the * and ? wildcard
characters (see Wildcards and Special Characters, on page 155).

-seq
Finds sequential (clocked) instances (the -inst object type is not required).
This argument is equivalent to -filter @is_sequential.
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-hier
Extends the search downward through each level of the local hierarchy,
instead of limiting the search to the current view. The default hierarchy
separator for the search is the period (.).

-inst instance
Finds instances. If no -type option is set, find defaults to finding
instances, nets, and ports.

-net net
Finds nets. If no -type option is set, find defaults to finding instances,
nets, and ports.

-port port
Finds ports. If no -type option is set, find defaults to finding instances,
nets, and ports.

-pin pin
Finds pins. If no -type option is set, find defaults to finding instances,
nets, and ports.

-view view
Finds views. If no -type option is set, find defaults to finding instances,
nets, and ports.

-depth depth
Sets the start depth for the search. depth may be a single hierarchy depth
or a range. Using -depth with a range will cause -hier and -flat arguments
to be ignored. Setting -depth to 0 will start the search at the top level.

-flat
Extends the search to all levels, but with -flat, the * wildcard character
matches hierarchy separators as well as characters. This means that the
following example finds instance al_fft at the current level as well as the
hierarchical instance a1.fft:

find -seq -flat a1*fft

-print
Prints the first 20 search results. For a full list of objects found, use
c_print or c_list. If you use find from the shell, the results are printed to the
Tcl window; if you find in the constraint file, the results are printed to the
log file at the beginning of the Mapper section. Reported object names
have prefixes that identify the object type and curly braces around each
name to allow for spaces in the names as shown below:
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{i:regl}
{i:\weird_nane[foo%]}

{i:reg2}
<<found 233 objects. D splaying first 20 objects. Use c_print
or c list for all. >>

-filter expression
Further refines the results of find by filtering the results using the speci-
fied object property. For syntax details, refer to find -filter, on page 159.

-in value
Searchs a collection to find a subset of the collection.

-below value
Sets the start point of the search to the specified instance path. Only
search for objects below that point.

-nocase
Ignores the case when matching object names.

design get_prop

Returns a list of property values for an object or collection.

Syntax
design get_prop [objectName | collection] [-prop value] [-all] [-array value]

objectName | collection
The object or collection to use.

-prop
The property value to return.

-all
Prints all available properties.
-array
Specifies array where properties are stored. Only use with -all and the
find collection must be limited to one object.
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design get

Returns the design ID for the current active design.

Syntax
design get

design list

Returns a list of available design IDs.

Syntax
design list

design open

View schematic of the design in its current state.

Syntax
design open [netlist]

netlist
The netlist to view.

design set

Sets specified design ID as the active design.

Syntax
design set designiD

designiD

The design ID to set as active.
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design top_level

Returns a Tcl list of top-level information in the following order:
lib topModule topView.

Syntax

design top_level
For example:

desi gn top_| evel
work eight bit _uc veril og
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dump_metrics

Shows metrics and values available for the current implementation of a
design. By default, only primary metrics are shown.

Syntax

dump_metrics [-show_queries] [-all]

-all

Shows detailed metrics as well as primary metrics for the design.

-show_queries

Shows available metrics in the form of a Tcl command that can be used
to retrieve each metric.

The default output format is

table.[object|global]: metric = value [units] from job [// description]

Examples

% dunp_netrics -all

*cl ock_conversion. global : icg_renoved = 0 from premap
/I Nunber of 1GG |atches renoved
*cl ock_conversion.global: icg_retained = 0 from prenap

/I Nunber of |GG latches not renoved
*cl ock_conversion. global : clean_clock _trees = 1 from fpga_napper
/1 Nunber of non-gat ed/ non-generated clock trees
*cl ock_conversi on. gl obal : cl ean_cl ock_pins = 270 from f pga_napper
/1 Nunber of cl ock pins driven by non-gated/ non-generated clock trees
*cl ock_conversion. gl obal : gated _clock_trees = 0 from fpga_napper
/1 Nunber of gated/generated clock trees
*cl ock_conversi on. gl obal : gated_cl ock_pins = 0 from fpga_nmapper
[/ Nunber of clock pins driven by gated/ generated clock trees

*cl ock_conversion. gl obal : instances_converted = 0 from fpga_napper
/1 Nunber of sequential instances converted
*cl ock_conversi on. gl obal : instances_not converted = 0 from fpga_napper

[/ Nunber of sequential instances |eft unconverted
*hdl _conpile.global: rmodified files =28 fromconpiler
[/ Total nunber of HDL input files conpiled
*hdl _conpil e. gl obal : nodified_modul es = 11 from conpil er
[/ Total nunber of nodul es conpil ed
*hdl _conpile.global: total _nodules = 11 from conpil er
/I Total nunber of nodul es
*hdl _conpile.global: total _files = 28 fromconpiler
[/ Total nunber of HDL input files
*msc.global: Part = xc7vx485tffgll57-1 from fpga_mapper
*runtine.global: realtime = 3.154000 seconds from conpi | er
*runtine.global: cputime = 1.809612 seconds from conpil er
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*runtime.global: realtime = 1.452000 seconds from premap
*runtinme. global: cputinme = 1.622410 seconds from prenap
*runtime.global: realtime = 9.881000 seconds from f pga_mapper
*runtine. global: cputime = 9.828063 seconds from f pga_mapper
*timng.global: "Wrst Slack" = -0.445800 ns from f pga_mapper
utilization.global: LUl = 31 from fpga_nmapper
utilization.global: LU2 = 64 from fpga_mapper
utilization.global: LUT3 = 45 from fpga_napper
utilization.global: LU4 = 84 from fpga_mapper
utilization.global: LUS5 = 57 from fpga_nmapper
utilization.global: LUT6 = 160 from fpga_mapper
utilization.global: IBUF =1 fromfpga napper
utilization.global: IBUFG =1 from fpga_mapper
utilization.global: I1BU =24 fromfpga nmapper
*utilization.global: "I/Oprimtives" = 26 fromfpga_mapper

utilization.
*utilization
*utilization

gl obal : BUFG =
. gl obal :

.global: "Total

1

"1/O Register bits" =0
Luts”

from f pga_napper
from f pga_mapper

= 411 from fpga_napper

Note:

The * denotes a primary metric.

% dunp_rmetrics -show queries

query_nmnetric
query_rmetric
query_nmnetric
query_rmetric
query_nmnetric
query_rmetric
query_nmnetric
query_rmetric

cl ock_conversi
cl ock_conversi
cl ock_conversi
cl ock_conversi
cl ock_conversi
cl ock_conversi
cl ock_conversi
cl ock_conversi

on.
on.
on.
on.
on.
on.
on.
on.

i cg_renoved -jobnare premap

i cg_retai ned -jobnare premap

clean_cl ock_trees -jobnane fpga_napper

cl ean_cl ock_pi ns -j obnane fpga_napper
gated_cl ock_trees -jobnane fpga_napper

gat ed_cl ock_pi ns -j obnane fpga_napper

i nst ances_converted -jobnane fpga_napper

i nst ances_not converted -j obnane f pga_napper

query_nmnetric
query_rmetric
query_nmnetric
query_rmetric
query_nmnetric
query_rmetric
query_nmnetric
query_rmetric
query_nmnetric

hdl _conpile.nodified files -jobnane conpiler

hdl _conpi | e. modi fi ed_nodul es -j obnane conpil er
hdl _conpi |l e. total _nodul es -j obnanme conpil er

hdl _conpile.total _files -jobnane conpil er

m sc. Part -j obnane fpga_mapper

runtime.real time -jobnane conpil er

runtime. cputime -j obnane conpil er
runtime.real ti me -jobnane prenap

runtime. cputime -j obnane prenap

query_rmetric runtime.real time -jobnane fpga_napper
query_netric runtime.cputi me -jobnane fpga_napper

query_rmetric {tinm ng. Wrst Sl ack} -jobname fpga_napper

query _netric {utilization.l/Oprimtives} -jobnane fpga_napper
query _metric {utilization.l/O Register bits} -jobnane fpga_mapper
query _netric {utilization. Total Luts} -jobnane fpga_napper
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Naming Conventions for Metrics
The naming convention used for metrics consists of the following:

¢ Table — Represents a group of related metrics, such as, timing, runtime,
or clock conversion.

* Metric Name — Descriptive string used to query metrics. This name
usually consists of lower case letters with underscores between words.

* Units — Values associated with the metric, such as ns or percent are only
shown if details are specified.

* Object — Some metrics are associated with an object, while others are
global. Objects can be a clock net name, view name, or an instance path.

* Description — Brief description of the metric.

For example, clock conversion metrics can be specified as follows:

Table Metric Name Description

clock_conversion clean_clock_trees Number of non-gated /non-generated clock
trees

clock_conversion clean_clock_pins Number of clock pins driven by
non-gated/non-generated clock trees

clock _conversion instances_converted Number of sequential instances converted

clock_conversion instances_notconvert Number of sequential instances left

ed unconverted
See Also

To query metrics for a design, see the following commands:
* query_available _metrics, on page 95
* query_metric, on page 98

* query_metric_details, on page 100
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encryptiP

The encryptIP script lets you encrypt data with the OpenIP scheme.
Download the script from the Synopsys website and run it directly from Perl.
The Perl command line syntax for running the script is as follows:

Perl encryptIP Script Syntax

encryptIP
-in | input inputFile
-out | output outputFileName
-c | cipher "{des-cbc | 3des-cbc |aes128-cbc}"
-k | key symmetricEncryptionKeyInTextFormat
-kx | keyx symmetricEncryptionKeylnHexadecimalFormat
-bd | build_date ddmmmyyyy
-om | outputmethod "{plaintext | blackbox | persistent_key}"
-incv | includevendor vendorKeyBlock
-dkn | datakeyname sessionKeyName
-dko | datakeyowner sessionKeyOwner
-a | author dataAuthor
-v | verbose

You must specify all required parameters.

-in | input Names the input HDL file to be encrypted.
-out | output Names the output file generated after encryption.
-c | cipher Specifies the symmetric encryption cipher. The key length must

match the algorithm being used, with each character using 8 bits.

* des-cbc specifies the Data Encryption Standard (DES); uses a
64-bit key.

» 3des-cbc specifies the Triple Data Encryption Standard (Triple
DES); uses a 192-bit key.

* aes128-cbc specifies the Advanced Encryption Standard (AES
Rijndael); uses a 128-bit key.

See Encryption and Decryption, on page 471 in the FPGA
Synthesis User Guide for an overview.

-k | key Specifies the symmetric data decryption key used to encode your
HDL data block. The key is in text format, and can be any string
(e.g. ABCDEFG).The exact length of the key depends on the data
method you use.
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-kx | keyx* Optional parameter. Specifies the symmetric encryption key in
hexadecimal format.

-bd | build_date  Specifies a date (ddmmmyyyy). The IP only works in Synopsys
software released after the specified date. This option lets you
force users to use newer Synopsys FPGA releases that contain
more security features. Contact Synopsys if you need help in
deciding what build date to use.

-om | Determines how the IP is treated in the output after synthesis:
outputmethod * plaintext specifies that the IP is unencrypted in the synthesis
netlist.

* blackbox specifies that the IP is treated as a black box, and only
interface information is in the output.

See Specifying the Script Output Method for OpenlIP Encryption,

on page 488 for more information.

-incv | Optional parameter that specifies a key block for an EDA vendor,
includevendor so that IP can be read by the vendor tools. C

-dkn | Specifies a string that denotes your session key, that was used to
datakeyname encrypt your IP.

-dko | Optional parameter that names the owner of the session key. The

datakeyowner value can be any string.

-a | author Optional parameter that names the author of the session key. The
value can be any string.
-v | verbose Specifies that the script run in verbose mode.
© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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Example of encryptIP (OpenlP) Script Output

The following is an example of the script output:

Fey block with session key Key block header
with key information
%%% protect protected file 1.0
<optional wuencrypted HD

%%% protect begin protected

$%% protect key keyowner=S8Synopsys

$%% protect key:keyname=SYN 05 00l

%%% protect key block

92 A3KwWE 7RWEBESZ 70+ 7 00t KEshgQgTnbEUdR=T Sek TTDfon/

<other key blocks>
%%% protect data method=aeslZ8-chc

%%% protect data klock

UWhcm3CPnGz2 7IHANQZF 8 ry 7hSsvIme {1 PS OHY ZHT £ oMIM/
4

%%% protect end protected

<optional unencrypted HI)L>

Ciata block Diata block header with
encryption method

For brief descriptions of the pragmas used in the output of the encryptlP
script, see Pragmas Used by Encryption Scripts, on page 56.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 53



Tcl Synthesis Commands

encryptP1735

Run the encryptP1735 script directly from Perl.

The script supports different models for encrypting HDL files and accessing
the encrypted information (see IEEE 1735 Encryption Use Models, on

page 57). The use model is determined by how blocks are marked for encryp-
tion in the HDL, combined with the information in the public keys file, which
is described in Public Keys File, on page 55.

Perl encryptP1735 Script Syntax

encryptP1735
-1 | list listofFiles
[-pk | public_keys keyFileName]
[-sk | showkey]
[-verbose]
[-verilog]
[-vhdl]
[-log logFileName]
[-h | -help]

The following table describes the command-line arguments.

-l | list Specifies a list of the files to be encrypted; listofFiles is a list of
the non-encrypted HDL input files with each filename entry on
a separate line.

-pk | public_keys  Specifies the public keys repository file. This file contains
public keys for various tools. If the encryption envelope
contains a key block with a particular keyowner and keyname,
the script searches the public keys file to find a corresponding
public key to use during key-block generation. See Public Keys
File, on page 55 for information about this file.

-sk | showkey When used, the encryption script displays the session key in
use. This is useful when random keys are used and you want
to know which key is being used.

-verbose Prints more detailed messages to the screen or log file.
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-verilog Specifies Verilog HDL file format when filename does not
include a .v or .sv extension.

-vhdl Specifies VHDL HDL file format when filename does not include
a .vhd or .vhdl extension.

-log Prints messages to the specified log file.

Public Keys File

The encryptP1735.pl encryption script requires public key information, which is
specified in a designated file (-public_keys or -pk) option). This file includes
public keys for each of the tools that are allowed access to the envelope with
the encrypted data. The default keys file is called keys.ixt and is located with
the encryption script in the lib directory of the tool installation.

/!l Use verilog pragna syntax in this file

“pragna protect version=1
“pragna protect author="default"
“pragna protect author_info="default"

“pragna protect key keyowner="Synopsys", key keynane="SYNP15 1",
key net hod="rsa"

“pragma protect key_public_key

<publ i c_key_ bl ock>

// Add additional public keys belowthis |ine
// Add additional public keys above this |ine

“pragna protect data keyowner="default-ip-author"
“pragna protect data keynane="defaul t-i p-key"
“pragna protect data_net hod="aes128-cbc"

/1l End of file

For the partial file with all pragmas use model, the following pragma attribute
values must match the corresponding values in the key-block section of the
encryption envelope:

“pragna protect key_keyowner="Synopsys", key_ keyname="SYNP15 1",
key et hod="rsa"

For information on the pragmas supported, see Pragmas Used by Encryption
Scripts, on page 56.
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Pragmas Used by Encryption Scripts

Both the encryptlP1735 and encryptlP (OpenlP) schemes use the pragmas
described in the following tables. Note the following:

* The %%% protect directive must be placed at the exact beginning of a line.

* Exactly one white-space character must separate the %%% sequence
from the command that follows.

The following table lists the pragmas used. In Verilog, the pragma must be
preceded by the word pragma; this is not required in VHDL.

General Pragmas

%%% protect protected_file 1.0 Line 1 of file with encrypted data

%% % protect begin_protected Marks the beginning of data to be encrypted
%%% protect end_protected Marks the end of data to be encrypted

%%% protect comment comment Single-line plain-text comment

%%% protect begin_comment Marks the beginning of plain-text comment block
%%% protect end_comment Marks the end of plain-text comment block

Data Block Pragmas (IP Author Data Encryption Information)

%%% protect author=string Lists name of IP author

%%% protect version=1 Specifies encryption version; required only for IEEE
1735 Partial File with Standard Pragmas encryption
use model

%%% protect Specifies the DES encryption method used:

ld:ézTngeit:bocd—des-cbcl 3des-cbc , jes che: Data Encryption Standard (DES)

¢ 3des-cbc: Triple DES
* aes128-cbc: Advanced Encryption Standard (AES)

%%% protect data_block Immediately precedes the encrypted data block
Key Block Pragmas (IP Consumer Public Key Information)

%%% protect Lists the owner of the key
key_keyowner=string
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%%% protect Name recognized by the Synopsys software to select
key_keyname=string the key block

%%% protect key_method=string Encryption algorithm (RSA currently supported)

W %%% protect key_block Immediately precedes encrypted key block

IEEE 1735 Encryption Use Models

Encryption models determine the scope of what gets encrypted and who can
access the files. The encryptP1735 script lets you use these use models to
encrypt HDL files:

Encryption Model Details
Full file Full-File Use Model, on page 57
Partial file with minimal pragmas Partial File with Minimal Pragmas Use

Model, on page 58

Partial file with standard pragmas  Partial File with Standard Pragmas Use

(Recommended) Model, on page 59
Partial file with IEEE pragmas Partial File with IEEE Pragmas Use Model,
on page 61

Full-File Use Model

Use this model to encrypt the entire file. The entire HDL file is included in the
decryption envelope. This model uses the keys.txt file to define which
consumers have access to the encrypted data.

HDL ¢ Contains no encryption pragmas (entire file is encrypted)

keys.txt ¢ Contains public key information for multiple downstream tools
e Owners of all public keys listed have access to the entire file

This Verilog example encrypts the whole file (tb_encrypt.v), including the
module named secret that it contains.

nmodul e secret (a, b, clk);
i nput a, clk;

out put b;

reg b=0;
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al ways @posedge cl k) begin
b = g

end

endnodul e

Run the script to encrypt the file:
perl encryptP1735.pl -list nylist -1og encryptP1735.1 0og

This command runs the script on a file (mylist), which lists the single Verilog
file tb_encrypt.v. The command uses the default keys.ixt file from the lib direc-
tory, and creates the decryption envelope file tb_encrypt.vp. Messages from the
run are written to the encryptP1735.log file.

Partial File with Minimal Pragmas Use Model

With this encryption model, pragma protect begin and pragma protect end pragmas
are used to indicate the start and end points of encryption regions. This
model is best suited for cases where every encryption region must be
encrypted for every key in the key file. When using this model, you must
encrypt the entire module. The encryptP1735.pl script checks all the begin and
end pragmas and generates the decryption envelope for each tool specified in
the keys file.

HDL ¢ Contains individual blocks marked for encryption (partial file)
¢ Contains no public key information

keys.txt ~ * Contains public key information for multiple downstream tools
* Owners of all public keys listed have access to all encrypted HDL blocks

To illustrate this use model, consider a single, Verilog file (tb_encrypt.v) to be
encrypted with only begin and end pragmas. This file contains a single
module named secret.

“pragna protect begin
nmodul e secret (a, b, clk);
input a, clk;

out put b;

reg b=0;

al ways @ posedge cl k) begin
b = g

end

endnodul e

“pragma protect end
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When you run the script with the following command, it uses the begin and
end pragmas specified in the HDL file to encrypt the file:

perl encryptP1735.pl -list nylist -pk keys.txt

Here, the list file (mylist) names the Verilog file tb_encrypt.v. The command
encrypts the data between the begin and end pragmas and creates the
decryption envelope file tb_encrypt.vp for all tools listed in the key file. No log
file (Hlog option) is specified, so messages are not written to a log file.

Partial File with Standard Pragmas Use Model

This is the recommended encryption use model. It is the most flexible
because you can choose to encrypt individual blocks instead of the entire file
and specify which tools can access each encrypted block on a per-block
basis. When using this model, you must encrypt the entire module. This
model requires a side file (keys.txt) that contains public key information for IP
consumers.

HDL ¢ Marks individual blocks for encryption (partial file)

¢ Includes public key encryption pragmas for each tool that is allowed
access to an encrypted block, except the key itself (key_public_key)

¢ Key information must match the information in the keys.txt file
* Can allow different keys access to different blocks

keys.txt ¢ Contains public key information for multiple downstream tools
¢ Must include all public key encryption pragmas, as well as the public
key itself

¢ Only those owners of public keys listed in the HDL before the encrypted
block have access to that block; all public keys listed in keys.txt need not
be used in the HDL

If there are conflicting pragmas defined in the HDL and the keys.txt file, the
HDL pragma takes precedence over the corresponding pragma in the keys.txt
file. For example, if data_method in the HDL is defined as des-cbc but the same
pragma in the keys.txt file defines it as aes128-cbc, the HDL definition is used
and copied to the decryption envelope:

dat a_net hod="des- cbc"

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 59



Tcl Synthesis Commands

Verilog Example

This example encrypts a single Verilog file (tb_encrypt.v). The file contains a
module named secret and includes all the encryption-related pragmas in the
HDL, with the exception of key_public_key.

“pragma protect version=1

“pragna protect encodi ng=(enctype="base64")

“pragna protect author="author-a", author info="author-a-details"
“pragna protect encrypt _agent="encrypt P1735. pl "

encrypt _agent _i nfo="Synplify encryption scripts"

“pragma protect key_keyowner ="Synopsys", key_keyname="SYNP15 1",
key_net hod="rsa", key_bl ock

" pragna protect

dat a_keyowner ="i p-vendor - a", dat a_keynane="f pga-i p"

dat a_net hod="des- chc"

“pragna protect begin

nodul e secret (a, b, clk);

i nput a, clk;

out put b;

reg b=0;

al ways @ posedge cl k) begin
b = g

end

endnodul e

“pragma protect end

The script is then run with the following command, where the list file (mylist)
names a single file, tb_encrypt.v. The command uses the default keys.ixt file
from the installLocation/lib directory as the public keys file to create the decryp-
tion envelope file tb_encrypt.vp. No log file is specified, so messages from the
run are not sent to a log file.

perl encrypt P1735.pl -list nylist -pk keys.txt

VHDL Example

This example partially encrypts a VHDL file (tb_encrypt.vhd) where all encryp-
tion pragmas are specified in the file, except for key_public_key. The file
contains a single entity/architecture pair named secret. For VHDL pragmas,
just use the keyword protect.

l'ibrary | EEE;
use | EEE std |l ogic_1164.all;
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entity secret is
port (clk : in std_|logic;
a: in std_|logic;
b : out std logic);
end entity;

“protect version=1

“protect author="author-a", author_info="author-a-details"
“protect encrypt_agent ="encrypt P1735. pl ",

encrypt _agent _info="Synplify encryption scripts”

“protect encodi ng=(enctype="base64")

“protect key keyowner="Synopsys", key_ keyname="SYNP15 1",
key_met hod="rsa", key_bl ock

“protect data_keyowner="i p-vendor-a", data_keynane="fpga-ip",
dat a_net hod="des- cbc"

“protect begin

architecture rtl of secret is
signal b _reg: std_logic;

begi n
process (clk) is
begi n
if rising_edge(clk) then
b reg <= g;
end if;
end process;
b <= b _reg;

end architecture;
“protect end

Encrypt the file with the following command, where the list file (mylist) names
a single VHDL file, tb_encrypt.vhd. The command uses the default keys.txt file
from the directory installLocation/lib as the public keys file to create the decryp-
tion envelope file tb_encrypt.vhdp. Messages are not captured in a log file.

perl encryptP1735.pl -list nylist -pk keys.txt

Partial File with IEEE Pragmas Use Model

Like the partial file with standard pragmas model, this use model is flexible,
but it does not require a side file with the key block information. This makes
it the most portable model, because all the information, including the key
block information for each IP consumer, is included in the source code. When
using this model, you must encrypt the entire module.
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HDL

keys.ixt

Marks individual blocks for encryption (partial file)

Includes public key encryption pragmas for each tool that is allowed
access to an encrypted block, including the key itself (key_public_key)

Can allow different keys access to different blocks

Not required

nodule top (ga, gb, a, b, clk);
input a, b, clk;

out put ga, gb;

enc_and iand (qa, a, b, clk);
enc_or ior (gb, a, b, clk);
endnodul e

“pragma protect version=1

“pragna protect author="author-a",

aut hor _i nf o="aut hor - a-det ai | s"

“pragna protect key keyowner="Synplicity", key keynane="SYNP15 1",
key et hod="rsa"

“pragna protect key public_key
<publ i c_key_bl ock>

“pragma protect key keyowner = "XYZ'
“pragna protect key method = "rsa"
“pragna protect key keynane = "XYZ8 001"

“pragna protect key public_key
<publ i c_key_ bl ock>

“pragma protect data net hod="aes128-chc

“pragna protect begin

nmodul e enc_and (q, a, b, clk);
input a, b, clk;

out put g;

reg gq=0;

al ways @ posedge cl k) begin

qg=aé&b;
end

endnodul e

“pragma protect end
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pragma protect version=1

“pragna protect author="author-a", author_info="author-a-details"
“pragna protect key keyowner="Synplicity", key keynane="SYNP15 1",

key net hod="rsa"
“pragnma protect key_public_key
<publ i c_key_ bl ock>

“pragna protect key keyowner = "XYZ'
“pragna protect key nethod = "rsa"
“pragna protect key keyname = "XYZ8 001"
“pragnma protect key_public_key

<publ i c_key_ bl ock>

“pragma protect data_met hod="aes128-cbc"
“pragna protect begin

nmodul e enc_or (g, a, b, clk);
i nput a, b, clk;

out put q;

reg g=0;

al ways @posedge cl k) begin
q=al b;

end

endrodul e

“pragna protect end

Synplify Pro for Microsemi Edition Command Reference
January 2020 Synopsys Confidential Information

© 2020 Synopsys, Inc.
63



Tcl Synthesis Commands

get_env

The get_env command reports the value of a predefined system variable.

Syntax
get_env systemVariable

Use this command to view system variable values. The following example
shows you how to use the get env command to see the value of the previously
created MY_PROJECT environment variable. The MY_PROJECT variable
contains the path to an HDL file directory, so get_env reports this path.

get _env MY_PRQJECT
d:\project\hdl files

In the project file or a Tcl script, you can define a Tcl variable that contains
the environment variable. In this example, my_project dir contains the
MY_PROJECT variable, which points to an HDL file directory.

set ny_project_dir [get_env MY_PRQIECT]

Then, use the $systemVariable syntax to access the variable value. This is
useful for specifying paths in your scripts, as in the following example which
adds the file myfile1.v to the project.

add_file $ny_project_dir/nyfilel.v

get_option

The get_option command reports the settings of predefined project and device
options. The options are the same as those for set option. See set_option, on
page 112 for details.

Syntax

get_option -optionName

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
64 Synopsys Confidential Information January 2020



Tcl Synthesis Commands

hdl_define

For Verilog designs, this command specifies values for Verilog text macros.

You can specify text macro values that you would normally enter using the
Verilog "define statement in a Verilog file included at the top of the synthesis
project. The parameter value is valid for the current implementation only.

This command is equivalent to the set_option -hdl_define command.

Syntax

hdl_define
-set "directive=value [directive=value ...]"
-clear
-list

Examples
hdl _defi ne -set "SI ZE=32"

This statement specifies the value 32 for the SIZE directive; the following
statement is written to the project file:

set_option -hdl _define -set "SI ZE=32"

To define multiple directive values using hdl_define, enclose the directives in
quotes and use a space delimiter. For example:

hdl _define -set "SI ZE=32 W DTH=8"
The software writes the following statement to the prj file:

set_option -hdl _define -set "size=32 w dt h=8"

See Also

Compiler Directives and Design Parameters, on page 363 for information on
specifying compiler directives in the GUI.
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hdl_param

The hdl_param command shows or sets HDL parameter overrides. For the GUI
equivalent of this command, select Project->Implementation Options->Verilog/VHDL.

Syntax

hdl_param
-add {paramName}
-list | -set paramName {paramValue}
-clear
-overrides

The following table describes the command arguments.

Option Description
-add Adds a parameter override to the project.
-list Shows parameters for the top-level module only and lists

values for parameters if there is a parameter override.

-set Sets a parameter override and its value for the active
implementation. Only the parameter value is enclosed within
curly braces.

-clear Clears all parameter overrides of the active implementation.
-overrides Lists all the parameter override values used in this project.
Examples

In batch mode, to set generic values using the set_option command in a
project file, specify the hdl_param generic with quotes and enclose it within {}.
For example:

set _option -hdl _param-set ramfile {"init. menl}
set_option -hdl _param-set sinulation {"fal se"}
Suppose the following parameter is set for the top-level module.

set_option -hdl _param-set {"w dt h=8"}
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Add a parameter override and its value, then list the parameter override.

hdl _param -add {"si ze=32"}
hdl _param-1list "size=32"

You can specify hdl_param generics with different types, such as, an integer,
std_logic_vector, or string value for VHDL. Here are some examples that show
how to define these generics:

* With an integer value

set _option -hdl _param -set DATA WDTH 4
* With a std_logic_vector value

set_option -hdl _param-set MY_SLV {"0011"}
* Using a string value

set_option -hdl _param-set initialization file {"table2"}
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help

The help command displays the usage syntax and description for the specified
command in the Tcl window.

Syntax

help commandName | wildcardTerm

Examples
hel p set_opti on

usage: set_option -<opti onName> <optionVal ue> -- set option
on active inpl enentation

get _option -<optionNanme> -- return option value on
active inplenentation

help c_*

c diff

c filter
c_info
C_intersect
c_list
c_nenber
c_print
c_symdi ff
c_union
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history
Returns a numbered list of executed Tcl commands.

Syntax

history [event number | clear | info [number] | keep [number] | nextid | redo [number]]

event number
Returns command number from the history list.

clear
Clears the history list.

info [number]

Returns the last number of commands. If no number is included, returns
all.

keep [number]
Sets the number of commands to save in history. Also returns the
current setting.

nextid
Returns the index number that the next command will be assigned to in
the history list.

redo [number]
Executes the number command. If no number is given, executes the latest
command.

Examples
hi story event 12

hi story redo 4
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impl

The impl command adds, removes, or modifies an implementation.

Syntax

impl

-add [impIName] [model]
-name impIName
-remove impIName
-active [impIName]

-list

-type implType
-result_file

-dir

The following table describes the command arguments.

Option
-add

-name
-remove

-active

-list

-type

Description

Adds a new device implementation. If:

e implName is not specified, creates a unique implementation
name by incrementing the name of the active
implementation.

* you want to add a new implementation copied from
implementation model.

Changes the name of the active implementation.
Removes the specified implementation.

Reports the active implementation. If you specify an
implementation name, changes the specified name to the
active implementation.

Lists all the implementations used in this project.

Specifies the type of implementation to add. For example, the:

* -type fpga option creates an FPGA implementation.
* -type identify option creates an Identify implementation.

-result_file Displays the implementation results file.

-dir

Displays the implementation directory.

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Comma

70

Synopsys Confidential Information

nd Reference
January 2020



Tcl Synthesis Commands

Examples

The following command sequence lists all implementations, reports the active
implementation, and then activates a different implementation.

% inpl -list
desi gn_wor st desi gn_typi cal

%inpl -active
desi gn_best

% npl -active design_typical

% inpl -active
desi gn_t ypi cal

%inpl -add rev_1 identify mxed -type identify
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job

The job command, for place and route job support, creates, removes, identi-
fies, runs, cancels, and sets/gets options for named P&R jobs.

Syntax

job jobName [-add jobType |-remove |-type |-run [mode] |-cancel |
-option optionName [optionValue] ]

job -list

The following table describes the command options.

Option

-run

-add jobType
-cancel
-remove
-list
-remove
-option

optionName
[optionValue]

-type

Examples

Description

Runs the P&R job, according to the specified options:
Creates a new P&R job for the active implementation.
Cancels a P&R job in progress.

Removes a P&R job from an active implementation

Returns a list of the P&R jobs in the active implementation.
Removes a P&R job from the active implementation

Get/set options for jobName.

Returns the P&R job type.

% job pr_2 -add par
%job pr_2 -run
% job pr_2 -option enable run 1
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log_filter

This command lets you filter errors, notes, and warning messages. The GUI
equivalent of this command is the Warning Filter dialog box, which you access
by selecting the Warnings tab in the Tcl window and then clicking Filter. For
information about using this command, see Filtering Messages in the
Message Viewer, on page 202 in the User Guide.

Syntax

log_filter field fieldName==value
log_filter -show_matches
log_filter -hide_matches
log_filter -enable

log_filter -disable

log_filter -clear

The following table shows valid fieldName and value values for the -field
option:

Fieldname Value

type Error | Warning | Note
id The message ID number. For example, MF138
message The text of the message. You can use wildcards.

source_loc  The name of the HDL file that generated the message.

log_loc The corresponding srr file (log).
time The time the message was generated.
report The log file section. For example, Compiler or Mapper.
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.

January 2020 Synopsys Confidential Information 73



Tcl Synthesis Commands

Example

log filter -hide_matches

log filter -field type==Warning -field message==*Una*
-field source_| oc==sendpacket.v -field | og_| oc==usbHost S ave. srr
-field report=="Conpiler Report"

log filter -field type==Note

log filter -field i d==BNL32

log filter -field i d==CL169

log filter -field message=="Input *"

log filter -field report=="Conpiler Report”
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log_report

This command lets you write out the results of the log_filter command to a file.
For information about using this command, see Filtering Messages in the
Message Viewer, on page 202 in the User Guide.

Syntax

You specify this command after the log_filter commands.

log_report -print fileName

Example

log report -print output.txt
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message_override

Allows you to suppress or override the log file message ID specifications with
another type or limit.

Use -limit and -count, to limit the number of occurrences for all messages or
specific messages in each log file. Messages that exceed the limit still show up
in the Report Summary page and can be retrieved later from the message
database. Suppressing messages is the same as -limit ID -count 0; errors cannot
be suppressed or limited.

Syntax

message_override [-suppress value] [-read_file value] [-error value]
[-warning value] [-note value] [-remove value] [-global] [-clear]
[-limit value] [-count value]

The following table describes the command arguments and options.

Option Description

-suppress value Lists message IDs to suppress in the log file.
-read_file value Reads the specified message override file.

-error value Lists the message ID type as an error.

-warning value Lists the message ID type as a warning.

-note value Lists the message ID type as a note.

-remove value Removes the override and resets the message type to

its original value.

-global Allows message operations to be applied globally.
Otherwise, the override operation is only applied on
messages for the current project.
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Option Description

-clear Removes all overrides and resets messages to their
original types.

-limit value Lists message IDs for a specific log file to the specified
limit. Use with the -count argument. Also, use

* message_override -limit default -count 1000 7 - Changes
the default limits for all messages

* message_override -limit default -count unlimited - Changes
the default limits for all messages to unlimited

-count value Counts the message IDs specified with the -limit
argument.

Examples

It is recommended that you set the default limit to something other than
unlimited, if possible. To do this, you can specify the following:

nmessage_override -default _limt 100
More examples are shown below:
1. Upgrade messages with ID MF446 to be treated as an error.
nessage_override -error M446
2. Suppress messages with ID BN101 (cannot be done for errors):
nmessage_override -suppress BNLO1

3. Limit the number of occurrences of messages with IDs MF580 and
MF581 to 1000 each in each log file:

nmessage_override -limt {M580 M581} -count 1000

4. Unlimit the number of occurrences of messages with ID CL118 in logs
and reports:

nessage _override -limt CL118 -count unlinted
S. Clear existing message overrides:

nessage_override -cl ear
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open_design

The open_design command specifies a netlist file (.srs or .srm) that can be used
to search the database with the Tcl find command in batch mode. With
open_design, you can use find without having to open an RTL or Technology
view. Use open_design to read in the .srs or .srm file before issuing the find
command. See the example below.

Syntax
open_design filename

Where:

* filename is the RTL (.srs) or Technology (.srm) file that can be used to
search the database. The specified netlist is loaded on-demand to
minimize memory resources.

Example

project -load ../exanpl es/vhdl/prep2_2.prj
open_desi gn prep2_2.srs

set a [find -inst *]

c_print $a -file a.txt

open_desi gn prep2_2.srm

set b [find -net *]

c_print $b -file b.txt

In the example above, prep2_2 is loaded and the information from the RTL
view file is read in. Then, the find command searches for all instances in the
design and prints them to file a. Next, the technology view file is read in, then
find searches for all nets in the design and prints them to file b.

See Also
* find, on page 152.
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open _file

The open_file command opens views within the tool. The command accepts
two arguments: -rtl_view and -technology_view.

Syntax

open_file -rtl_view |-technology_view

The -rtl_view option displays the RTL view for the current implementation, and
the -technology view option displays the technology view for the current imple-
mentation. Views remain displayed until overwritten and multiple views can
be displayed.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 79



Tcl Synthesis Commands

partdata

The partdata command loads part files and returns information regarding a
part such as available families, family parts, vendors, attributes, grades,
packages.

Syntax

partdata
-load filename
-family
-part family
-vendor family
-attribute attribute family
-grade [family:]part
-package [family:]part
-oem [family:]part

Option Description

-load filename Loads part file.

-family Lists available technology families.

-part family Lists all parts in specified family.

-vendor family Returns vendor name for the specified family.
-attribute attribute Returns the value of the job attribute for the specified
family family.

-grade [family:]part Lists the speed grades available for the specified part.

-package [family:]Jpart  Lists the packages available for the specified part.

-oem [family:]part Returns true if the part entered is an OEM part.

Example

The following example prints out the available vendors, their supported
families, and the parts for each family.
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% f oreach vendor [partdata -vendorlist]

% put s VENDCR $vendor ;

%foreach famly [partdata -fam |y $vendor]
% puts \t FAMLY: $f am | y;

% puts \t\t PARTS: ;

% foreach part [partdata -part $famly]
%puts \t\t$part;

program_terminate

Immediately terminates the tool session without prompting or saving any
data.

Syntax

program_terminate

Arguments and Options

None

Description

The program_terminate command terminates a tool session without prompting
or saving data. Use this command with caution as any unsaved data is lost
and cannot be recovered.

Examples

programterninate
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program_version

Returns the product and software release version.

Syntax

program_version

Arguments and Options

None

Description

The program_version command returns the software product version number.

Examples

% pr ogr am ver si on
Synplify Pro L-2017.09
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project

The project command runs job flows to create, load, save, and close projects,
to change and examine project status, and to archive projects.

Syntax

project -run [-all] [-bg] implementationList [-impl implementationName]
[-clean] implementationList [-impl implementationName]

[-parallel] implementationList [-impl implementationName]

[-from proccessName] [-to processName]

project {-new [projectPath] |-load projectPath | -close [projectPath]
|-save [projectPath] |-insert projectPath} |

project {-active [projectName] |-dir |-file |-name |-list |-filelist |
-fileorder filepath1l filepath2 [... filepathN] |-addfile filepath |
-movefile filepathl [filepath2] |-removefile filepath}

project {-result_file resultFilePath |-log_file [logfileName]
project -propagate_params

project -copy [-project filename] [-implement implementationName]
[-dest_dir pathname] [-copy_type {full | local | customize}]
[-add_srs [fileList] -no_input]

project -unarchive [-archive_file pathname/filename] [-dest_dir pathname]

run option

The run option lets you synthesize selected implementations of a Project file.
You can choose to use the arguments for the run option independently or in
any combination. The arguments available are described in the table below.

You can also use the Batch Run Setup dialog box to set the arguments to use
with the run option. For details, see Run Implementations Setup Command,
on page 377.

Option Description
-run [-all] [-bg] [-clean] Synthesizes the project, according to the specified
[-from] [-parallel] [-to] options:
[processName]
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Option Description

You can use run with any of the following arguments:
« -all - Runs all implementations of the active project.

* -bg - Runs specified implementations in
non-blocking background mode. This is the default.

¢ -clean - Runs specified implementations, while
ignoring up-to-date checking. This option cleans all
previous results and forces a complete rerun.

e -parallel - Runs specified implementations
concurrently. Additional licenses are required for
each job.

e -from - Runs from and including the specified
process name.

¢ -to - Runs up to and including the specified process
name.

* processName - Specifies the process name.
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Option Description

The mode can be one of the following keywords:

« compile - Compiles the active project, but does not
map it.

» constraint_check - Validates the syntax and
applicability of constraints defined in one or more
constraint files.

e fsm_explorer - Selects optimum FSM-encoding style
for finite-state machines.

netlist_optimizer - Runs netlist optimization.

¢ syntax_check - Verifies that the HDL is syntactically
correct; errors are reported in the log file.

» synthesis - Default mode if no mode is specified.
Compiles (if necessary) and synthesizes the
currently active project. If followed by the -clean
option (project -run synthesis -clean), resynthesizes the
entire project, including the top level and all compile
points, whether or not their constraints,
implementation options or source code changed
since the last synthesis. If not followed by -clean,
only compile points that have been modified are
resynthesized.

¢ synthesis_check - Verifies that the design is
functionally correct; errors are reported in the log
file.

¢ timing - Runs the Timing Analyst. This is equivalent
to clicking the Generate Timing button in the Timing
Report Generation dialog box with user-specified
values.

¢ write_netlist - Writes the mapped output netlist to
structural Verilog (vn) or VHDL (vhn) format. You
can also use this command in an incremental
timing analysis flow. For details, see Run Menu, on
page 374 and Generating Custom Timing Reports
with STA, on page 363.

The following table describes the rest of the Project file command options.
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Option

-new [projectPath]

-load projectPath

-close [projectPath]

-save [projectPath]

-insert projectPath

-active [projectName]

-dir

file

-name

-list

filelist

-fileorder filepathl
filepath2 [... filepathN]
-addfile filepath

-movefile filepathl
[filepath2]

-removefile filepath

-result_file resultFilePath

-log_file [logfileName]

Description

Creates a new project in the current working
directory. If projectPath is specified, creates the project
in the specified directory.

For the Hierarchical Project Management flow, you
can create a new subproject for the top-level project.

Opens and loads the project file specified by
projectPath.

Closes the currently active project. If projectPath is
specified, closes the specified project.

Saves the currently active project. If projectPath is
specified, saves the specified project.

Adds the specified project to the workspace project.

Shows the active project. If projectName is specified,
makes the specified project the active project.

Shows the project directory for the active project.
Returns the path to the active project.

Returns the filename (prj) of the active project.
Returns a list of the loaded projects.

Returns the pathnames of the files in the active
project.

Reorders files by adding the specified files to the end
of the project file list.

Adds the specified file to the project.

Moves filepathl to follow filepath2 in project file list. If
filepath2 is not specified, moves filepathl to top of list.

Removes the specified file from the project.

Changes the name of the synthesis result file to the
path specified.

Reports the name of the project log file. If logfileName
is specified, changes the base name of the log file.
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Option

-archive
-project filename
[-root_dir pathname]
-archive_file
filename.sar
-archive_type
{full | local | customize}
-add_srs [fileList]
-no_input

Description

« project filename - copies a project other than the
active project. If you do not use this option, by
default the active project is copied.

« root_dir pathname - specifies the top-level directory
containing the project files.

« archive_file filename - is the name of the archived
project file.

« archive_type - specifies the type of archive:

o full - performs a complete archive; all input and
result files are contained in the archive file.

* customize - performs a partial archive; only the
project files that you select are included in the
archive.

* local - includes only project input files in the
archive; does not include result files.

e add_srs - adds the listed sr s files to the archived
project. Use the -no_input option with this command.
If fileList is omitted, adds all sr s files for the
project/implementations. The srs files are the RTL
schematic views that are output when the design is
compiled (Run->Compile Only).

For more information about, and examples of the
project -archive command, see Archive Utility, on
page 89.
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Option

-copy
-project filename
-implement
implementationName
-dest_dir pathname

-copy_type
{full | local | customize}

-add_srs [fileList]
-no_input

-unarchive

-archive_file
pathname/filename

-dest_dir pathname

Description

« project filename - copies a project other than the
active project. If you do not use this option, by
default the active project is copied.

* implement implementation_name - archives all files in
the specified implementation.

« dest_dir directory _pathname - specifies the directory
in which to copy the project files.

« copy_type - specifies the type of file/project copy:

e full - performs a complete copy; all input and
result files are contained in the archive file.

 customize - performs a partial copy; only the
project files that you select are included in the
archive.

¢ local - includes only project input files in the copy;
does not include result files.

e add_srs - adds the listed sr s files to the archived
project. Use the -no_input option with this command.
If fileList is omitted, adds all sr s files for the
project/implementations. The Srs files are the RTL
schematic views that are output when the design is
compiled (Run->Compile Only).

For more information about, and examples of the

project -copy command, see Archive Utility, on

page 89.

« archive_file pathnameffilename - is the name of the
archived project file.

* dest_dir pathname - specifies the directory in which
to write the project files.

For more information about, and examples of the

project -unarchive command, see Archive Utility, on

page 89.

project Command Examples

Load the project top.prj and compile the design without mapping it. Compiling
makes it possible to create a constraint file with the SCOPE spreadsheet and
display an RTL schematic representation of the design.

% project -load top.prj
% project -run conpile
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Load a project and synthesize the design.

% project -load top.prj
% proj ect -run synthesis

In the example above, you can also use the command project -run, since the
default is synthesis.

Archive Utility

The archive utility provides a way to archive, extract, or copy your design
projects. An archive file is in Synopsys proprietary format and is saved to a
file name using the .sar extension. You can also use this utility to submit your
design along with a request for technical support.

The archive utility is available through the Project menu in the GUI or through
the project Tcl command. See the following for details:

For information about ... See ...

Archiving, un-archiving, or =~ Archiving Files and Projects, on page 100 in the
copying projects User Guide

Project Archive Examples

The following example archives all files in the project and stores the files in
the specified .sar file:

project -archive -project c:/projl.prj
-archive file c:/archivel/projl. sar

The next example archives the project file (.prj) and all local input files into the
specified .sar file.

project -archive -project c:/projl.prj -archive_type |ocal
-archive_file c:/archivel/projl. sar

The following example archives the project file (.prj) only for selected .srs files
into the specified sar file. Any input source files that are in the project are not
included.

project -archive -project c:/projl.prj -archive_type custom ze
-add_srs -no_input -archive file c:/archivel/projl.sar
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Project Unarchive Example

The following example extracts the project files from c:/archive/proj1.sar to direc-
tory c:/proj1. All directories and sub-directories are created if they do not
already exist.

project -unarchive -archive_file c:/archivel/projl.sar
-dest _dir c:/projl

Project Copy Examples
The following example copies only selected .srs files for the project to the desti-
nation project file directory.

project -copy -project d:/test/proj_2.prj -copy_type custom ze
—add_srs -no_input -dest dir d:/test 1

The next example copies all input source files and .srs files selected for the
project to the destination project file directory.

project -copy -project d:/test/proj_2.prj -copy_type custom ze
-dest _dir d:/test 1
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project_data

The project_data command shows or sets properties of a project.

Syntax
project_data {-active [projectName] | -dir | -file}

The following table describes the command options.

Option Description

-active Set/show active project. With no argument, shows the active
project. If projectName is specified, changes the active project to
projectName.

-dir Show directory of active project.

-file Show the project file for the active project. The full path is included

with the file name.
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project_file

The project_file command manipulates and examines project files.

Syntax

project_file {-lib fleName [libName ] | -name fileName [newPath ] |

-time fileName [format ] | -date fileName | -type fileName |

-savetype fileName [relative | absolute ] -move fileNamel [fleName2] |
-remove fileName | -top topModule |

-tooltag applicationTagName | -toolargs [arguments ] fileName }

The following table describes the command options.

Option Description

-lib Shows the project file library associated with fileName. If libName is
specified, changes the project file library for the specified file to
libName.

-name Shows the project file path for the specified file. If newPath is
specified, changes t1he location of the specified project file to the
directory path specified by newPath.

-time Shows the file time stamp. If a format is specified, changes the
composition of the time stamp according to the combination of the
following time formatting codes:

%H (hour 00-23)

%M (minute 00-59)

%S (second 00-59)

%d (day 01-31)

%b (abbreviated month)
%Y (year with century)

-date Shows the file date.

type Shows the file type.

-savetype Sets or shows whether a file is saved relative to the project or its
absolute path.

-move Positions fileNamel after fileName2 in HDL file list. If fileName2 is not
specified, moves fileNamel to the top of the list.

-remove Removes the specified file from the project file list.
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Option Description

-top Sets or shows the top-level module of the specified file for the active
implementation.

-tooltag Sets or shows the third-party tool tag for the specified file.

-toolargs 1§lets or shows the third-party tool tag arguments for the specified
ile.

Examples

List the files added to a project. Remove a file.

% project -filelist path_nanmel/cpu.v path_namel/cpu_cntrl.v
pat h_nane2/ cpu_cntrl . vhd

% project _file -renove path_name2/cpu_cntrl.vhd
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project_folder

The project_folder command manipulates and examines attributes for project
folders.

Syntax

project_folder [folderName] [-folderlist] [-filelist] [-printout] [-add] [-remove] [-I]
[tooltag] [-toolargs]

The following table describes the command options.

Option Description

folderName Specifies the name of the folder for which attributes are
examined.

-folderlist Lists folders contained in the specified project folder.

filelist Lists files contained in the specified project folder.

-printout Prints the specified project folder hierarchy including its files.

-add Adds a new project folder.

-remove Removes the specified project folder.

-r Removes the specified project folder and all its containing

sub-folders. Files are removed from the project folder, but are
not deleted.

-tooltag Sets or shows the third-party tool tag name.

-toolargs Sets or shows the additional arguments for the third-party tool
tag.

Examples

Add a folder and list the files added to a project folder.
% proj ect _fol der -add newf ol der

% project_folder -filelist newfol der
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query_available_metrics

Shows metrics that can be queried for the design. If specified, only metrics
matching the required values are shown. Otherwise, shows all metrics for all
tables. You should use the query_available_metrics command primarily for
scripting, since it returns a Tcl list. For a more readable format, use the
dump_metrics command.

Syntax

query_available_metrics [[table.Jname]

[table.]Jname
Name of the metric to query, optionally preceded by 'table.’.

For details about specifying metrics, see the Naming Conventions for Metrics,
on page 50.

Examples

This command returns values in a list of the form as follows:
{{namel objectl jobnamel} {name2 object2 jobname2}...}

1. Show a Tcl list of metrics that can be queried for the current
implementation:

% query_avail abl e_netrics

Format is {{nanel objectl jobnanel} {nanme2 object2 jobnane2}...}:

{cl ock_conversion.icg_renoved {} prenap} {cl ock_conversion.icg_retained {}
premap} {cl ock_conversion. cl ean_cl ock_trees {} fpga_mapper}

cl ock_conversi on. cl ean_cl ock_pi ns {} fpga_mapper}

cl ock_conversi on. gated_cl ock_trees {} fpga_mapper}

cl ock_conver si on. gat ed_cl ock_pins {} fpga_mapper}

cl ock_conversi on. i nstances_converted {} fpga_mapper}

cl ock_conversi on. i nst ances_not converted {} fpga_mapper}

hdl _conpil e.nodified files {} conpiler} {hdl _conpi I e. nodi fi ed_nodul es {}
conpi l er} {hdl _conpile.total nodul es {} conpiler} {hdl _conpile.total files
} conpiler} {msc.Part {} fpga_mapper } {runtime.realtine {} conpiler}
runtime.cputime {} conpiler} {runtine.realtine {} premap}
runtine.cputinme {} prenmap} {runtinme.realtine {} fpga_mapper}

runtime. cputime {} fpga mapper} {{timng.Wrst S ack} {} fpga_napper}
utilization.LUT1 {} fpga_mapper} {utilization.LUT2 {} fpga_napper}
utilization.LUT3 {} fpga_mapper} {utilization.LUT4 {} fpga_rapper}

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 95



Tcl Synthesis Commands

{utilization.LUT5 {} fpga_napper} {utilization.LUT6 {} fpga_napper}
{utilization.IBUF {} fpga nmapper} {utilization.|BUG {} fpga_mapper}

{utilization.| GBBUF {} fpg

a_mapper} {{utilization.l/O primtives} {}

fpga_napper} {utilization. BUFG {} fpga_nmapper} {{utilization.l/O Register

bits} {} fpga_mapper} {{utilization. Total

Luts} {} fpga_napper}

2. Use a simple loop to show the values of all available metrics:

% foreach anmt [query available netrics] {set metric

[lindex $anmt 0];
set job [lindex $ant 2];

set object [lindex $ant 1];
puts "$netric $object:

[query_netric $metric -object $object -jobnane $job]"}

Format is {{nanel objectl jobnamel} {nane2 object2 jobname2} ...}:

cl ock_conver si on.
cl ock_conver si on.
cl ock_conver si on.
cl ock_conver si on.
cl ock_conver si on.
cl ock_conver si on.
cl ock_conver si on.

cl ock_conver si on.

icg_renmoved : O
icg_retained : 0
clean_clock trees : 1
clean_cl ock_pins : 270
gated_clock_trees : 0
gated_clock_pins : O

i nstances _converted : 0

i nstances_not converted : 0

hdl _conpile.nodified files : 28
hdl _conpi | e. nodi fi ed_nodul es : 11
hdl _conpi | e.total _nodules : 11
hdl _conpile.total _files : 28

m sc. Part xc7vx485tffglls7-1
runtime.realtine : 9.881000
runtime.cputime : 9.828063
timng. VWrst Slack : -0.445800
utilization. LUTL : 31
utilization. LUT2 : 64
utilization.LUT3 : 45
utilization.LUT4 : 84
utilization. LUT5 : 57
utilization.LUT6 : 160
utilization. IBUF : 1
utilization.IBUFG: 1
utilization. lBU : 24
utiIization.I/Oprinitives: 26
utilization.BUFG: 1
utilization.|/O Register bits : 0
utilization. Total Luts : 411

© 2020 Synopsys, Inc.

. Show a Tcl list of metrics for the specified metric name:

% query_avail abl e_netrics cputime

Format is {{nanel objectl jobnanmel} {nane2 object2 jobname2} ...}:

{runtine.cputime {} conpiler} {runtine.cputine {} premap} {runtime.cputine
{} fpga_mapper}
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4. Optionally, show a Tcl list of metrics for the specified table value:

% query_avail abl e_netrics runtine. cputine

Format is {{nanel objectl jobnanel} {nane2 object2 jobname2} ...}:

{runtinme.cputime {} conpiler} {runtine.cputime {} prenmap} {runtine.cputine
{} fpga_mapper}

5. Enclose within curly braces {} whenever metrics contain spaces.
% query_avail abl e_metrics {timng.worst slack}

Format is {{nanel objectl jobnamel} {name2 object2 jobname2} ...}:

{{timng. Wrst Sl ack} {} fpga_napper}

See Also

See the related query commands below:
* dump_metrics, on page 48
* query_metric, on page 98

* query_metric_details, on page 100
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query_metric

Queries specific QoR metrics for the current implementation of a design.

Syntax

query_metric table.name [-object value] [jobname value]

table.name
Name of the metric to query, preceded by 'table.’.

-object value
Queries metrics associated with a specific object or global metrics if not
specified.

-jobName value
Queries metrics associated with a specific job name or any job name if
not specified.

For details about specifying metrics, see the Naming Conventions for Metrics,
on page 50.

Examples
Here are examples of how to query metrics for a design:

% query_netric cl ock_conversion.icg_renoved
0

% query_netric cl ock_conversion.instances_converted -jobnane
f pga_napper

1

% query_netric runtime.realtine -jobnamre conpiler

3. 15400

% query_netric {timng.worst slack} -jobname fpga_napper
- 0. 445800

% query _netric {utilization.total |uts}

411

Suppose you have a design with compile points.
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dunp_netrics -show queries
dﬂér y_metric {timng. Wrst Sl ack} -object r2p_cordic -jobnanme fpga nmapper

Then you can query worst slack for one of the compile points.

% query_metric {timng.Wrst Sl ack} -object r2p cordic
-j obnane fpga_nmapper

-1.339500 ns {Estimated slack during conpile point synthesis}

See Also
See the related query commands below:
* dump_metrics, on page 48
* query_available _metrics, on page 95

* query_metric_details, on page 100
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query_metric_details

Queries information about a QoR metric from the current implementation.
Exactly one metric must match.

Syntax

query_metric table.name [-object value] [jobname value]

table.name
Name of the metric to query, preceded by 'table.'.

-object value
Queries metrics associated with a specific object or a global metric if not
specified.

-jobName value
Queries metrics associated with a specific job name or any job name if
not specified.

For details about specifying metrics, see the Naming Conventions for Metrics,
on page 50.

Examples
The Tcl command returns a list of three values: <value> <units> <comment>.

% query_netric_details clock _conversion. cl ean_cl ock_pi ns

270 {} {MNunber of clock pins driven by non-gated/ non-generated cl ock
trees}

% query_metric_details clock_conversion.icg_renoved

0 {} {Nunmber of 1GG|atches renoved}

% query _metric _details runtine.realtinme -jobname conpiler

3. 154000 seconds {}

% query _metric_details runtine.cputinme -jobname fpga_napper

9. 828063 seconds {}

% query_metric_details {timng.worst slack} -jobnane fpga_ mapper
-0. 445800 ns {}

% query metric_details utilization.lutl
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31 {} {}

Suppose you have a design with compile points.

dunp_netrics -show queries
dhér y_metric {timng. Wrst Sl ack} -object r2p_cordic -jobnanme fpga_mapper

Then you can query worst slack for one of the compile points.

% query netric _details {timng. Wrst Sl ack} -object r2p cordic
- j obnane f pga_mapper

-1.339500 ns {Estimated slack during conpile point synthesis}

See Also
See the related query commands below:
* dump_metrics, on page 48
* query_available_metrics, on page 95

* query_metric, on page 98
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recording

Allows you to record and store the Tcl commands generated when you work
on your projects in the GUI. You can use this command for creating job
scripts. The complete syntax for the recording command is:

recording
-on|-off
-file [historyLogFile]
-save [historyLogFile]
-state
-edit [filename]

In the command line:

¢ -on|off- turns Tcl command recording on or off. Recording mode is off by
default.

* ile - if you specify a history log file name, this option uses the specified
file in which to store the recorded Tcl commands for the current session.
If you do not specify a history log name, reports the name of the current
history log file.

* -save - if you do not specify a file name, updates the current history log.
If you specify a history log file name, saves Tcl command history to the
specified file.

* -state - returns the Boolean value of recording mode.

¢ -edit - displays the Tcl command log file in a text editor.

Examples

Turn on recording mode and save the Tcl commands in the cpu_tcl_log file
created.

% recordi ng -on
%recording -file cpu_tcl _|og
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report_clocks

Reports the clocks in the design database.

Syntax

report_clocks -netlist [srsNetlistFile] [-csv_format] [-out fileName]

Arguments and Options

srsNetlistFile
The name of the srs netlist file. If this optional argument is not specified,
the netlist file is taken from the active project implementation.

-csv_format
Displays the report in spread-sheet format.

-out
Specifies the name of the output report file (default name is design-
Name_clk.rpt).

Description

The report_clocks command generates a report of the clocks found in the
design database. The report includes a listing of the clock domain, parent
clock, and clock type for each clock. If the -csv_format option is included, the
report is output in spread-sheet format.

Examples

report_clocks c:/designs/memctrl/memctrl.srs -csv_fornat
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report_external_tool_versions

Displays third-party external tool information, including installation environ-
ment variable settings and supporting tool versions.

Syntax
report_external_tool_versions [tool] -list -run_requirements

tool
Shows the version data for the tool specified. By default, the data is
displayed for all external tools.

-list
Lists the names of all recognized external tools specified with this
command.

-run_requirements
Shows the version data for all tools required to run the active/current

job flow.

Examples
1. Show version information for all external tools.
report _external tool version
2. Show names of all recognized external tools.

report_external _tool _version -1ist
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report_messages

Queries messages from jobs based on ID or severity. This can be used to
show duplicate messages that were suppressed in the log files.

Syntax

report_messages logFile [-id value] [-severity value] [-out value] [-outa value]

logFile
Specifies one or more log files to query for message details.

-id value
Restricts report to messages matching this id. Use the * or % wildcard to
match any string.

-severity value
Limits messages to a specific severity. Can specify one or more messages
as an error, warning, note, or advice. Multiple severities can be specified.
If none is specified, all types are shown.

-out value
Name of the output file to be written rather than writing to the Tcl
window.

-outa value
Name of the output file to be appended rather than writing to the Tcl
window.

Output Format

Running the report_messages command produces a list of messages. Messages
are displayed in the following format with each message beginning on a new
line:

ID {messageText}
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Examples
1. Query BN132 messages from the test.srr log file.
report _nessages test.srr -id BNL32
2. Query error and warning messages from the test.srr log file.
report _nessages test.srr -severity error warning

3. Query critical warnings (CW) or downgradable errors (DE). You can
search for these messages using wildcards. For example:

report _nessages test.srr -id DE*

4. Query error and warning messages from the test.srr log file. and writes
output to a file called messages in the current working directory.

report_nessages test.srr -severity not warning -out nessages
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report_message_summary

Retrieves a summary of the messages in the log file. This summary contains a
list of the message IDs and the number of occurrences for each type, along
with their message descriptions.

Syntax
report_message_summary logFile

logFile
Specifies a log file to query for the message summary.

Examples

report_nessage_summary test.srr
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run_tcl

The run_tcl command lets you synthesize your project using a Tcl script file
from the Tcl Script window of the synthesis tool.
Syntax
run_tcl [ -fg ] tclFile
You can also use the following command:
source tclFile
These commands are equivalent.

The following table describes the run_tcl command options.

Option Description

fg Synthesizes the project in foreground mode.
TclFile Specifies the name of the Tcl file used to synthesize the project. To
create a Tcl Script file, see Creating a Tcl Synthesis Script, on
page 508.
© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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select

Selects specified objects.

Syntax

select collection
-append
-clear
-instances

The following table describes the select command options.

Option Option
-append Appends objects to the existing
selection list.
-clear Clears the selection list.
-instances Selects all instances in the current
view.
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sdc2fdc

Translates legacy FPGA timing constraints to Synopsys FPGA timing
constraints.

Syntax
sdc2fdc

Run it from the Tcl window in the synthesis tool.

See also
* Converting SDC to FDC, on page 159 in the User Guide

* sdc2fdc Conversion, on page 132 in the Reference Manual

Examples of sdc2fdc Translation

The following are examples of feedback after running the command. For
information about the translated FDC file and handling the error messages,
see sdc2fdc Conversion, on page 132 in the Reference Manual.

% sdc?2f dc

INFQ Transl ation successful.

See: "D /bugs/timng 88/clk _prior/scratch/ FDC constraints/rev_2
/top_transl ated. fdc"

Repl ace your current *.sdc files with this one.

INFQ Autonatically updating your project to reflect the new
constraint file(s)
Do "Qrl+S' to save the new settings.

% sdc2f dc

ERRCR Bad -fromlist for define false path: {ny_inst}

Mssing qualifier(s) (i: p: n: ...)

ERRCOR Transl ati on probl ens V\ere found

See: "D /bugs/timng 88/clk_prior/scratch/ FDC constraints/rev_2
/top_translate.log" for details.

_translate.log

ERRCR Bad -fromlist for define false path {ny_inst}
Mssing qualifier(s) (i: p: ni ...)
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"define_false path -from{ny_inst} -to i:abc.def.g_reg
-through {n:bar}"

Synplicity SDC source file: D /bugs/timng 88/clk prior/scratch
/t op. sdc.

Li ne nunber: 79
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set_option

The set_option command sets options for the technology (device) as well as for
the design project.

Syntax
set_option -optionName optionValue

For syntax and descriptions of the options and related values, see one of the
following tables:

* Device Options for set_option/get_option

* Project Options for set_option/get_option

Device Options for set_option/get_option

The following table lists generic device arguments for the technology, part,
and speed grade. These are the options on the Implementation Options-> Device
tab.

Information on all other Implementation Options tabs are listed in the next
section, Project Options for set_option/get option, on page 113.

Option Name Description

-technology parameter Sets the target technology for the implementation.
parameter is the string for the vendor architecture.
Check the Device panel in the GUI or see Device Panel,
on page 346, for a list of supported families.

-part part_name Specifies a part for the implementation. Check the
Device panel of the Implementation Options dialog box (see
Device Panel, on page 346) for available choices.

-speed_grade -value Sets the speed grade for the implementation. Check the
Device panel of the Implementation Options dialog box (see
Device Panel, on page 3406) for available choices.
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Option Name Description

-package value Sets the package for the implementation. This option is
not available for certain vendor families, because it is
set in the place-and-route software. Check the Device
panel of the Implementation Options dialog box (see Device
Panel, on page 346) for available choices.

-grade -value Same as -speed_grade. Included for backwards
compatibility.

In general, device options are technology-specific, or have technology-specific
defaults or limitations. For vendor-specific details, see synhooks File Syntax,
on page 547.

Project Options for set_option/get_option
Below is a list of options for the set_option and get_option commands. Click the
option below for the corresponding description and GUI equivalents. Options
set through the Device tab are listed in Device Options for set_option/get_op-
tion, on page 112.

¢ allow_duplicate_modules

* analysis_constraint

* areadelay

* area_delay_percent

* auto_constrain_io

* autosm

* beta_vfeatures

* block

* compiler_compatible

* compiler_constraint

* constraint

* default_enum_encoding

e disable_io_insertion
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dup

enable64bit
fanout_limit
frequency auto
frequency
globalthreshold
hdl_param

hdl define

help

identify_debug mode
ignore_undefined_libs
include_path

job (PR)

job (SP)

libext

library_path
local_tmr rename

log file

looplimit

maxfan
max_parallel_jobs
multi_file_compilation_unit
no_sequential_opt
num_critical_paths
num_startend_points
opcond

project_relative_includes
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* preserve_registers

* report_path

* reporting reportType

* resolve_multiple_driver
* resource_sharing

* result file

* retiming

* run_prop_extract

* rw_check on_ram

* supporttypedflt

* symbolic_fsm_compiler
* synthesis_onoff_pragma
* top_module

* update_models_cp

* use_fsm_explorer

* vlog std

* write_apr_constraint

* write_verilog

* write_vhdl
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Option

-allow_duplicate_modules

-analysis_constraint
path/filename.adc

-areadelay percentValue

-area_delay_percent

percentValue

-auto_constrain_io 1|0

-autosm 1|0

-symbolic_fsm_compiler

10

© 2020 Synopsys, Inc.
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Description

For Verilog designs, allows the use
of duplicate module names. When
true, the last definition of the

module is used by the software and

any previous definitions are
ignored.

You should not use duplicate
module names in your Verilog
design, therefore, this option is

disabled by default. However, if you
need to, you can allow for duplicate
modules by setting this option to 1.

Specifies the analysis design
constraint file (.adc) you can use to
modify constraints for the
stand-alone Timing Analyst only.

Sets the percentage of paths you
want optimized. This option is
available only in certain device
technologies.

Determines whether default
constraints are used for I/O ports
that do not have user-defined
constraints.

When disabled, only
define_input_delay or
define_output_delay constraints are
considered during synthesis or
forward-annotated after synthesis.

When enabled, the software
considers any explicit
define_input_delay or
define_output_delay constraints, as
before.

Enables/disables the FSM
compiler.

GUI Equivalent

Allow Duplicate
Modules, Verilog
Panel

Constraint File
section on the
Timing Report
Generation
Parameters
dialog box

Percent of design to
optimize for timing,
Device Panel

Use clock period for
unconstrained 1O
check box,
Constraints
Panel

FSM Compiler
check box,
Options Panel
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Option
-beta_vfeatures 1|0

-block 1|0

-disable_io_insertion 1|0

-compiler_compatible
110

-compiler_constraint
constraintFile

-constraint -option

-default_enum_encoding
defaultjonehot|gray |
sequential

Description

Enables/disables the use of Verilog
compiler beta features.

Enables/disables I/O insertion in
some technologies.

Disables pushing of tristates across
process/block boundaries.

When multiple constraint files are
defined, specify which constraint
files are to be used from the
Constraints tab of the Implementation
Options panel.

Manipulates constraint files in the
project:

-enable/disable filename - adds or
removes constraint file from active
implementation

-list - lists all enabled constraint
files in active implementation

-all - enables all constraint files in
active implementation

-clear - disables all constraint files in
active implementation

(VHDL only) Sets the default for
enumerated types.

Synplify Pro for Microsemi Edition Command Reference

January 2020

Synopsys Confidential Information

GUI Equivalent

Beta Features for
Verilog, Verilog
Panel

Disable I/O Insertion
check box,
Device Panel

Complement of
the Push Tristates
Across Process/
Block Boundaries
check box, VHDL
Panel and Verilog
Panel

Constraints Files,
Constraints
Panel

Constraint Files,
Constraints
Panel

Default Enum
Encoding, VHDL
panel (see VHDL
Panel and Verilog
Panel)
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Option
-dup

-enable64bit 1|0

-fanout_limit value

-maxfan value

-frequency value

-frequency auto

-globalthreshold value

© 2020 Synopsys, Inc.
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Description

For Verilog designs, allows the use
of duplicate module names. When
true, the last definition of the
module is used by the software and
any previous definitions are
ignored.

You should not use duplicate
module names in your Verilog
design, therefore, this option is
disabled by default. However, if you
need to, you can allow for duplicate
modules by setting this option to 1.

Recommended to use
-allow_duplicate_modules option
instead of -dup option.

Enables/disables the 64-bit
mapping switch. When enabled,
this switch allows you to run client
programs in 64-bit mode, if
available on your system.

Sets the fanout limit guideline for
the current project.

Sets the global frequency.

Enables/disables auto constraints.

Microsemi

Sets the minimum number of
fanout loads. Signals that exceed
the load value are promoted to
global signals. Global buffers are
assigned by the synthesis tool to
drive the global signals.

GUI Equivalent

Allow Duplicate
Modules, Verilog
Panel

Enable 64-bit
Synthesis, Options
Panel

Fanout Guide,
Device Panel

Frequency,
Constraints
Panel

Auto Constrain,
Constraints
Panel

Device Panel
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Option
-hdl_define

-hdl_param

-help

-identify_debug_mode 1|0

-ignore_undefined_libs
110

Description

For Verilog designs; used for
extracting design parameters and
entering compiler directives.

Shows or sets HDL parameter
overrides. See hdl_param, on
page 66 for command syntax.

This option is useful for getting
syntax help on the various
implementation options used for
compiling and mapping a design.
For examples, see help for
set_option, on page 129.

When set option is 1, creates an
Identify implementation in the
Project view. Then, you can launch
the Identify Instrumentor or
Debugger from within the FPGA
synthesis tool.

(VHDL only) When enabled
(default), the compiler will ignore
any declared library files not
included with the source file. In
previous releases, the missing
library file would cause the
synthesis tool to error out.

To set this option to error out when
a library file is missing (as in
previous releases), use 0 for the
command value.
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GUI Equivalent

Compiler
Directives and
Design
Parameters,
Verilog Panel

Use this
command in the
Tcl window of the
UL

Use this
command in the
Tcl window of the
Ul

Select the
Identify
implementation,
then launch:

¢ Launch Identify
Instrumentor
or

+ Launch Identify
Debugger

Not available in
the Ul
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Option Description GUI Equivalent

-include_path path (Verilog only) Defines the search Include Path Order,
path used by the ‘include Verilog panel (see

Jextra_input/ commands in Verilog design files.  Verilog Panel)

Argument path is a string that is a
semicolon-delimited list of
directories where the included
design files can be found. The
software searches for include files
in the following order:

¢ First, the source file directory.

¢ Then, looks in the included path
directory order and stops at the
first occurrence of the included
file it finds.

* Finally, the project directory.

The include paths are relative. Use
the project_relative_includes option to
update older project files.

The archive utility allows you to add
the extra_input directory path for all
include files and copies them to
your project. Use the Add extra input
path to project option on the
Un-Archive Utility dialog box.

-job PR_job_name If enabled, runs the specified Specify the
place-and-route job with the place-and-route
-option enable_run 1|0 appropriate vendor-specific job you want to
place-and-route tool after run for the
synthesis. specified
implementation.

See Place and
Route Panel.

-libext Adds library extensions to Verilog Library Extensions
libextNamel .libextName?2 ... library files included in your design (space separated)
for the project and searches the for each unique

directory paths you specified that file extension,
contain these Verilog library files.  Verilog Panel.
To use library extensions, see Using

Library Extensions for Verilog

Library Files, on page 44 in the

User Guide.
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Option Description GUI Equivalent
-library_path For Verilog designs, specifies the Library Directories
directory_pathname paths to the directories which on Verilog Panel.

contain the library files to be
included in your design for the
project. Defines the search path
used by the tool to include all the
Verilog design files for your project.
The argument directory_pathname is
a string that specifies the
directories where these included
library files can be found. The
software searches for all included
Verilog files and the tool determines
the top-level module. The names of
files read from the library path
must match module names.
Mismatches result in error

messages.
-log_file logFileName Allows you to change the name for Enter command

the default log file. For example: from the Tcl

set_option -log file test window

generates the

synl og\t est _f pga_mapper. srr
file in the Implementation Directory
after synthesis is run.

looplimit loopLimitValue Allows you to override the default  Loop Limit, Verilog
compiler loop limit value of 2000 in Panel and VHDL
the HDL. You can also apply loop  Panel.
limits using the Verilog loop_limit or
the VHDL syn_looplimit directive.

For details about these directives,
see loop_limit, on page 22 and
syn_looplimit (VHDL), on page 67
in the Attribute Reference.

-maxfan value Sets the fanout limit for the current Fanout Guide,
project. The limit is value is Device Panel
sfanout_guide value guideline for the tool rather than a
- hard limit.
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Option Description

max_parallel_jobs n Lets you run multiprocessing with
compile points. This allows the

GUI Equivalent

Maximum number of
parallel mapper

synthesis software to run multiple, jobs, on the

independent compile point jobs
simultaneously, providing
additional runtime improvements
for the compile point synthesis flow.

For information on setting the
maximum number of parallel
synthesis jobs, see Setting Number
of Parallel Jobs, on page 507 in the
User Guide.

-multi_file_compilation_unit When you enable the Multiple File
1|0 Compilation Unit switch, the Verilog
compiler uses the compilation unit
for modules defined in multiple
files.

-no_sequential_opt 1|0 Enables or disables the sequential
optimizations for the design. (Note
that unused registers will still be
removed from the design.) The
default value is true (sequential
optimizations not performed). When
true, delay and area size might
increase. Value can be 1 or true, O or
false.

With this option enabled, the FSM
Compiler and FSM Explorer options
are effectively disabled.

-num_critical_paths value Specifies the number of critical
paths to report in the timing report.

-num_startend_points value Specifies the number of start and
end points to include when
reporting paths with the worst

Configure Compile
Point Process
dialog box.

Verilog Panel

Device Panel

Number of Critical
Paths, Timing
Report Panel

Number of Start/End
Points, Timing
Report Panel.

slack in the timing report. Number of Start/End
Points, Timing
Report Generation
dialog box.
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Option Description GUI Equivalent
-opcond value Microsemi Axcelerator and ProASIC Device Panel
technologies

Sets the operating condition for
device performance in the areas of
optimization, timing analysis, and
timing reports. Values are Default,
MIL-WC, IND-WC, COM-WC, and
Automotive-WC. See Operating
Condition Device Option, on

page 391 for more information.

-preserve_registers 1|0 Microsemi Conservative
When enabled, the software uses ~ Register
less restrictive register Optimization

optimizations during synthesis if ~ SWitch on the
area is not as great a concern for ~ D€vice Panel
your device. The default for this

option is disabled (0).

-project_relative_includes 1|0 Enables/disables the Verilog Include Path Order,
include statement to be relative to Verilog Panel
the project, rather than a verilog
file. For projects built with software
after 8.0, the include statement is no
longer relative to the files but is
relative to the project: project_relative
(1). See Updating Verilog Include
Paths in Older Project Files, on
page 64 in the User Guide for
information about updating older
project files.

-report_path integer Microsemi 500Kand ProASIC Max Number of
technologies Critical Paths in
Sets the maximum number of SDF, Device
critical paths in a Panel
forward-annotated SDF constraint
file

-reporting_reportType Sets parameters for the stand-alone Analysis->Timing
Timing Analyst report. Analyst command:

See Timing Report Parameters for Liming Report

set_option, on page 127 for details. Generation
Parameters
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Option Description GUI Equivalent

-resolve_multiple_driver 10 When a net is driven by a VCC or ~ Resolve Multiple
GND and active drivers, enable this Drivers, Device
option to connect the net to the Panel
VCC or GND driver.

The default for this option is
disabled (0).

See Resolve Mixed Drivers Option,
on page 130 for details.

-resource_sharing 1|0 Enables or disables resource Resource Sharing,
sharing globally. This is a Device Panel
compiler-specific optimization, and
does not affect resource sharing in
the mapper.

To enable or disable individual
modules, use the syn_sharing

directive.
-result_file filename Specifies the name of the results Result File Name
file. and Result Format,
Implementation
Results Panel
-retiming 1|0 When enabled (1), registers may be Retiming, Device

moved into combinational logic to  Panel
improve performance. The default
value is O (disabled).

-run_prop_extract 1|0 Enables/disables the annotation of Options Panel
certain generated properties
relating to clocks and expansion
onto the RTL view. This enables the
Tcl expand and find commands to
work correctly with clock
properties.
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Option Description GUI Equivalent

-rw_check_on_ram 1|0 Enabling this option automatically Automatic
inserts bypass logic when required Read/Write Check
to prevent simulation mismatch in Insertion for RAM,
read-during-write scenarios. For Device Panel
asynchronous clocks, the tool will
not generate bypass logic which can
cause unintended CDC paths
between the clocks.

For more information about using
this option in conjunction with the
syn_ramstyle attribute, see
syn_ramstyle, on page 106.

-supporttypedflt 1|0 When enabled (1), the compiler Implicit Initial Value
passes init values through a syn_init Support, VHDL
property to the mapper. For more  Panel
information, see VHDL Implicit
Data-type Defaults, on page 294.

-symbolic_fsm_compiler 1|0 Enables/disables the FSM FSM Compiler
compiler. Controls the use of FSM check box,
-autosm 1|0 synthesis for state machines. The Device Panel

default is false (FSM Compiler
disabled). Value can be 1 or true, 0
or false.

When this option is true, the FSM
Compiler automatically recognizes
and optimizes state machines in the
design. The FSM Compiler extracts
the state machines as symbolic
graphs, and then optimizes them by
re-encoding the state
representations and generating a
better logic optimization starting
point for the state machines.

However, if you turn off sequential
optimizations for the design, FSM
Compiler and/or the
syn_state_machine directive and
syn_encoding attribute are effectively
disabled.

See -no_sequential_opt 1|0 for more
information on turning off
sequential optimizations.
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Option Description GUI Equivalent

-synthesis_onoff_pragma 1|0 Determines whether code between Synthesis on/off
synthesis on/off directives is ignored. Implemented as

When enabled, the software ignores Iranslate on/Off,
VHDL Panel

-top_module name

-update_models_cp 1|0

-use_fsm_explorer 1|0

-vlog_std v2001|v95 | sysv

-write_apr_constraint 1|0

-write_verilog 1|0

-write_vhdl 1|0

© 2020 Synopsys, Inc.

any VHDL code between
synthesis_on and synthesis_off
directives. It treats these
third-party directives like
translate_on/ off directives (see
translate_off/translate_on, on
page 138 for details).

Specifies the top-level module.

If the top-level entity does not use
the default work library to compile
the VHDL/Verilog files, you must
specify the library file where the

top-level entity can be found. To do
this, the top-level entity name must

be preceded by the VHDL/Verilog
library followed by the dot (. ).

Determines whether (1) or not (0)

changes inside a compile point can

cause the compile point (or
top-level) containing it to change
accordingly.

Enables/disables the FSM
Explorer.

The default Verilog standard for
new projects is SystemVerilog.
Turning off both options in the
Verilog panel defaults to v95.

Writes vendor-specific constraint
files.

Writes Verilog or VHDL mapped
netlists.

Top-level
Entity/Module,
VHDL Panel or
Verilog Panel

Update Compile
Point Timing Data,
Device Panel

FSM Explorer,
Device Panel

Verilog 2001,
SystemVerilog,
Verilog Panel

Write Vendor
Constraint File,
Implementation
Results Panel

Write Mapped
Verilog/VHDL
Netlist,
Implementation
Results Panel
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Timing Report Parameters for set_option

The following lists the parameters for the stand-alone timing report (.ta file).

async_clock margin

ctd netlist
filename number_paths
filter output_srm

gen_output_srm

Reporting Option Description

-reporting_async_clock Generates a report for paths that cross
between clock groups using the stand-alone

Timing Analyst.

-reporting_ctd slack | end_point| Controls how the desi gn_ct d.t xt

off (correlation timing dump) file is generated
when the Timing Analyst is run. You can
specify one of the following values:

e slack - The timing information in the ctd
file is sorted by slack. This is the default.

* end_point - The timing information in the
ct d file is sorted by end points.

e off - Turns off generating the ct d file.

The ct d file contains a timing summary of
the design that is used by the Timing Report
View to display and analyze the synthesis
timing for the design and correlate this
synthesis timing with the P&R timing in the

GUL

-reporting_filename filename.ta Specifies the standard timing report file (t a)
generated from the stand-alone Timing

Analyst.
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Reporting Option Description

-reporting_filter filter options Generates the standard timing report based
on the filter options you specify for paths,
such as:

* From points

e Through points

* To points

For more information, see:

* Timing Report Generation Parameters,
on page 394.

* Combining Path Filters for the Timing
Analyzer, on page 399

e Timing Analyzer Through Points, on
page 397.

* Specifying From, To, and Through Points,
on page 247.

-reporting_gen_output_srm 1|0 Specifies the new name of the output SRM
File when you change the default name. If
this option is set to 1, this new name is used
for the output sr mfile after you run the
stand-alone Timing Analyst.

-reporting_margin slackValue You can specify a slack margin to obtain a
range of paths within the worst slack time
for the design after you run the stand-alone

Timing Analyst.

-reporting_netlist filename.srm Specifies the associated gate-level netlist file
(srm generated from the stand-alone Timing
Analyst.

-reporting_number_path You can specify the number of critical paths

numberOfPaths to report after you run the stand-alone
Timing Analyst.

-reporting_output_srm 1|0 Allows you to change the name of the output

sr mfile. If you enable the output SRM File
option, you can change this default name.

For GUI equivalent switches for these parameters, see Timing Report Genera-
tion Parameters, on page 394.
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help for set_option

This option is useful for getting syntax help on the various implementation
options used for compiling and mapping a design, especially since this list of
options keeps growing.

Syntax

% set_option -help
Usage:
set_option optionName optionValue [-help [value]]
Where:
* optionName—specifies the option name.
* optionValue—specifies the option value.

* -help [value]—to get help on options. Use:
— ~-help * for the list of options
— -help optionName for a description of the option

Examples
To list all option commands in the Tcl window:

set_option -help *
To list all option commands beginning with the letters fi in the Tcl window:
% set_option -help fi*
fixsmult
To get help on a specific option in the Tcl window:
% set_option -help retimng
Use the following Tcl commands to print a description of the options:

% set_option -help c*
% set hl [set_option -help c*]

% put s $hl
% foreach option $hl { puts "$option:\t [set_option -help
$option]"; }
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This example will print a list of set_option options that begin with the letter c.

Resolve Mixed Drivers Option

Use the Resolve Mixed Drivers option when mapping errors are generated for
input nets with mixed drivers. You might encounter the following messages
in the log file:

@\ BN313 | Found mi xed driver on pin pin:data out inst:dpramlut3
of work.dpram(verilog), use option "Resolve Mxed Drivers" in
"Device" tab of "Inplenmentation ptions" to automatically resolve
this

@ BN314 | Net "G\D' in work.test(verilog) has nixed drivers

@\ BN313 | Found m xed driver on pin pin: 0] inst:dff1.q of
PrinLib.sdffr(prin), use option "Resolve Mxed Drivers" in
"Device" tab of "Inplenmentation ptions" to automatically resol ve
this

@ BN314) | Net "VCC' in work.test(rtl) has mxed drivers

Whenever a constant net (GND or VCC) and an active net are driving the
same output net, enable the Resolve Mixed Drivers option so that synthesis can
proceed. To set this switch:

* Check Resolve Mixed Drivers on the Device tab of the Implementation Options

panel.

Divice Mapping Cpoons
Ciotion vale
Fanaut Gude 100
Disable [0 Inserfion ™
Fix Gated Clocks 3
Fix Generated Cocks 3
Update Comple Point Timing Data [l
Forre 558 1sans o
Reschez Mzed Crivers [

¢ Use the Tcl command, set_option -resolve nultiple driver 1.
By default this option is disabled and set to:

set_option -resolve multiple driver O.
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When you rerun synthesis, you should now see messages like the following in
the log file:

@VBN312 | Resolving mxed driver on net G\D, connecting out put
pi n: data_out inst:dpramlut3 of work.dpran{verilog) to GQ\D

@\ BNL16) | Renoving sequential instance dpram | ut 3. dout of
view PrinLib.dffe(prin) because there are no references to its
out put s

@\ BNL16 | Renovi ng sequential instance dpram| ut 3. mem of

view PrinbLib.ranl(prin) because there are no references to its
out put s

@VBN312 | Resolving mxed driver on net VCOC, connecting out put
pin:@O0] inst:dffl.q of PriniLib.sdffr(prin) to VCC

@\ BNL16 | Renoving sequential instance dffl.q of

view PrinLib.sdffr(prin) because there are no references to its
out put s

Example - Active Net and Constant GND Driving Output Net (Verilog)

nmodul e test(clk,data_in, data_out, radd, wadd, w, rd);
i nput cl k,wr, rd;
i nput data_in;
i nput [5: 0] radd, w add;
out put data_out;
/1 conponent instantiation for shift register nodul e
shrl srl _lutO (
.cl k(cl k),
.sren(w),
.srin(data_in),
.srout (data out)
);
// Instantiation for ram
dpram dpram | ut 3 (
.cl k(cl k),
.data in(data_ in),
.data_out (data out),
.radd(radd),
. W add(wr add) ,
S (wr ),
.rd(rd)
);

endnodul e

nmodul e shrl (clk, sren,srin,srout);
i nput cl k;
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i nput sren
i nput srin;
out put srout;

paraneter width = 32;
reg [width-1:0] sr;

al ways @ posedge cl k)

begi n
if (sren == 1)
begi n
sr <= {sr[width-2:0], srin};
end
end

/!l Constant net driving

/1 the output net
assign srout = 1'bO;
endnodul e

nodul e dpran{cl k, data_in, data_out, radd, wadd, w, rd);
i nput cl k,w,rd;

i nput data_in;

i nput [5:0]radd, w add;

out put data out;

reg dout;
reg [0:0]nenj63 :0];

al ways @ (posedge cl k)
begi n
if(w)
menj w add] <= data_ in;
end

al ways @ (posedge cl k)
begi n
if(rd)
dout <= nenjradd];
end

assign data_out = dout;

endnodul e
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See the following RTL and Technology views; the Technology view shows the
constant net tied to the output.

Technology View
RTL View
[rd === !
(o QBUF
B
—— ck " a
- Sl -
arl_lutd [gstain ==
[ck_—— data_out_obuf
dpram
e 3
E; _-__._ - L] _-__-'m'
o |
dpram_jut3

Example - Active Net and Constant VCC Driving Output Net (VHDL)

library ieee;
use ieee.std_| ogic_1164. al |

entity test is
port (clk,rst : in std_logic;
sr_en : in std_|logic;
data : in std_|logic;
data op : out std logic );
end entity test;

architecture rtl of test is

conponent shrl

generic (sr_length : natural);

port (clk : in std_|l ogic;
sr_en : in std_|logic;
sr_ip: in std_logic;
sr_op : out std logic );

end conponent shrl;

conponent d_ff
port (data, clk, rst : in std_|ogic;
g : out std logic );
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end conponent d_ff;

begi n
-- instantiation of shift register
shift_register : shrl
generic map (sr_length => 64)
port map (clk => clKk,
Sr_en => sr_en,
sr_ip => data,
sr_op => data_op );
-- instantiation of flipflop

dffl : d_ff
port map (data => data
clk => clk,
rst => rst,
q => data op );
end rtl;
library ieee;

use ieee.std |l ogic_1164.all;
use ieee.nuneric_std.all

entity shrl is

generic (sr_length : natural);

port (clk : in std_|logic;
sr_en : in std | ogic;
sr_ip: in std |ogic;
sr_op : out std logic );

end entity shrl

architecture rtl of shrl is
signal sr_reg : std_logic_vector(sr_length-1 downto 0);
begi n
shreg_lut: process (clk)
begi n
if rising_edge(clk) then
if sr_en ="1" then
sr_reg <= sr_reg(sr_length-2 downto 0) & sr_ip;
end if;
end if;
end process shreg | ut;
-- Constant net driving output net
sr_op <='1";
end architecture rtl;

l'ibrary | EEE
use | EEE std_| ogic_1164. al | ;
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entity d ff is

port (data, clk, rst : in std_|ogic;
g : out std logic);
end d _ff;

architecture behav of d ff is
begi n
FF1: process (clk) begin
if (clk'event and clk ='1") then
if (rst ="'1") then
g<='0;
el se g <= data
end if;
end if;
end process FF1;
end behav;

See the following RTL and Technology views; the Technology view shows the
constant net tied to the output.

RTL View
s
[ = —e— dt
[=ren "= | —e— ar =1 arop —e——Ho op
ETA —
shift_reqister Technology View
[dats == OBUF
(s en =
g [E— R
] EiL-J:E-1 g I P data_op
aff1 data_op_obuf
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status_report

Writes out the results of reports displayed in the Project Status view after

synthesizing a design.

Syntax

status_report -name reportName [-parameter reportSectionName]
[-csv] [-output_file fleName] [-msgtype msgStatus] [-status] [-help]

Examples
st at us_r eport - nane
status_report -nane
status_report -name
status_report -name

status_report -nane

Option

-name reportName

-parameter reportSectionName

-Csv

-output_file fileName

© 2020 Synopsys, Inc.

area_report

timng_report -csv -output_file reports
area_report -paraneter io_port
run_status -nsgtype warni ngs

timng_report -help

Description

The type of report to access. Use any of the
following keywords for reportName:

» area_report

« timing_report

* opt_report

* cp_report

* hier_area_report

* run_status

Specifies a specific section of the area, timing, or
message reports to access. See Parameters, on
page 137 for details of the appropriate keywords to
use for the section names.

Generates the report as a comma-separated list.

Specifies the name of the file that writes out the
report. If you do not specify an output file, the
report is displayed in the Tcl window.
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Option Description
-msgtype msgStatus Generates the number of messages found for the
following types of messages:
e Errors
* Warnings
* Notes

-status Generates the status for a job. The results of the
job can be specified with one of the following
conditions:
¢ Completed

e Failed

-help Allows you to get help on a parameter list.
Use -help * for a list of parameters.

Parameters

For the area, timing, and message reports you can report results for specific
sections by specifying the appropriate keywords for the -parameter argument.

Area Report section keywords for -parameter io_port
non_io_reg
total_io_reg
v_ram
dsp_used
total_luts

Timing Report section keywords for -parameter  clock_name
req_freq
est_freq slack

Run Status section keywords for -parameter compiler
premap
fpga_mapper
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For example:

% status_report -nane area_report

I/O ports(io_port) 26

Non 1/ O Register bits(non_io_reg) 242 (0%
I/O Register bits(total _io reg) 24

Bl ock Rams(v_ran) 0 (1030)
MATHL8X18s(dsp_used) 1 (2800)

LUTs(total _luts) 310 (0%

Additional Reporting Commands

There are other commands available from the command line to report
commonly-required information: report_timing_summary, report_area, and
report_opt.

* Report Timing Summary

% report _timng_sumrary

Ti mng Summary

O ock Nane Req Freq Est Freq Sl ack

eight bit _uc|clock 198.9 M 169.1 MHz-0. 887

* Report Area

% report_area

LUTs for conbinational functionsO
Non I/ O Registers 0

I/OPins 66

I/Oregisters 0

DSP Bl ocks 0 (256)

Menory Bits 32768

* Report Optimizations

% report _opt
Conbi ned d ock Conversion 1/ O
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Messages Reporting Commands

Here are examples of commands available from the command line to report
message information using the option: run_status.

%t at us_report -name run_status

{conpiler {notes "8"}{warnings "0"}{errors "0"}
{job_status "Conpl eted"}}

{fpga_mapper {notes "46"}{warnings "1"}{errors "0"}
{job_status "Conpl eted"}}

{premap {notes "3"}{warnings "2"}{errors "0"}
{job_status "Conpl eted"}}

%status_report - name run_status -nsgtype warni ngs
{conpiler {warnings "0"}}

{f pga_mapper {warnings "10"}}

{premap {warnings "0"}}

% status _report - nane run_status -paraneter {conpiler prenap}
- msgt ype war ni ngs

{conpiler {warnings "0"}}

{premap {warnings "0"}}

% status_report -nane run_status -paranmeter conpiler -status
{conpiler {job_status "Conpleted"}}

%status_r eport -nanme run_status -paraneter prenmap -status
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sub_impl

Sub-implementation editing command.

Syntax

sub_impl
impIName -add jobType
impIName -remove
implName -type
impIName -run mode
impIName -cancel
impIName -option optionName [optionValue]
-list

Arguments and Options

Option Description

implName -add jobType Creates a new sub-implementation that belongs to
an active implementation.

implName -remove Removes an active sub-implementation.

implName -type Lists a sub-implementation type.

implName -run mode Runs sub-implementation.

implName -cancel Cancels a running sub-implementation.

implName -option optionName Sets option for sub-implementation.

[optionValue]
-list Lists all sub-implementations for an active
implementation.
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syn_connect

Microsemi

Specifies the connectivity between the module/instance being monitored for
the error with the error monitoring IP port or top-level port for the error
monitoring module. It is used with the syn_create_err_net command and the
syn_radhardlevel, syn_ramstyle or syn_fsm_correction attributes to probe the error
flag in high-reliability designs.

Syntax

syn_connect
-from {n:netName}
-to {n:existingNetpath | t:inputPinEMIPpath | p:topErrorport}

-from {i:netName} Specifies the new net name for the error flag
connection used with the syn_create_err_net
command. See syn_create_err_net, on page 142.

-to Specifies the path to an existing net, the input pin
{n:existingNetpath | for the Error Monitoring IP (EMIP), or the top-level
t:inputPinEMIPpath | error port.

p:topErrorport}

Example

syn_connect {-from{n:dwc_err0 net} -to {n:enp[0]}}

Limitation

Currently, when using the -to argument with the t: | p: option, an existing net
must be present that feeds into the ports.
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syn_create_err_net

Microsemi

Specifies the connectivity between the module/instance being monitored for
the error with the error monitoring IP port or top-level port for the error
monitoring module. It is used with the syn_connect command, and the syn_rad-
hardlevel, syn_ramstyle or syn_fsm_correction attributes to probe the error flag in
high-reliability designs.

This is the syntax:

sync_create_err_net -name {netName}
-inst {i:highRellnstance}
-err_pipe_num {numPipelineStages}
-err_clk {n:clkSourceForPipelineStages}
-err_reset {n:resetSourceForPipelineStages}
-err_set {n:setSourceForPipelineStages}
-err_enable {n:enableSourceForPipelineStages}
-err_synch {synchValue}
-single_bit | -double_bit

netName Specifies the new net name for the error flag
connection.

-inst highRellnstantiation Specifies the high reliability instance being
monitored for the error.

-err_pipe_num Specifies the number of pipeline stages using

{numPipelineStages} the retiming property. The default value is 0.

Note: If err_pipe_num=N, then the property
syn_allow_retiming=0 is set on the Nth stage of the
pipeline register and syn_allow_retiming=1 is set on
the first (N-1)th stage of the pipeline registers by
the synthesis tool.

Where N>0 and err_clk is specified.

-err_clk Specifies the hierarchical path to the input pin
{n:clkSourceforPipelineStages} for the clock.

Note: You must define the -err_clk for the pipeline
stages if you specify -err_pipe_num. Otherwise,
the pipeline stages to stabilize the error signals
are not added.
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-err_reset Specifies the hierarchical path to the input pin
{n:resetSourceforPipelineStages}  for the reset signal.

-err_set Specifies the hierarchical path to the input pin
{n:setSourceforPipelineStages} for the set signal.

-err_enable Specifies the hierarchical path to the input pin

{n:enableSourceforPipelineStages} for the enable signal.

-err_synch {synchValue} Specifies the boolean value for synchronous or
asynchronous set/reset. The default is TRUE.

-single_bit | -double_bit Specifies monitoring of single-bit or double-bit
error flags. This argument is used only with
hamming3_ded or hamming3_ded_recovery values of
syn_fsm_correction attribute.

Example

syn_create_err_net {-name {dwc_err0_net} -inst {i:instl}
-err_pipe_num{2} -err_clk {n:instl.clk}
-err_reset {n:instl.rst} -err_synch {TRUE}}
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synplify_pro

Starts the FPGA synthesis tool and runs synthesis from the command line.
Use the appropriate command for the tool you are using. The command to
start the synthesis tool from the command line includes a number of
command line options.

Syntax

synplify_pro
[options ... ]
[projectFile]

projectFile  Specifies the project (prj) file to use. If no file is specified, the tool
defaults to the last project file opened.

options Any of the command line options described in the next table. These
options control tool action on startup and, in many cases, can be
combined on the same command line. See the next table for a
description of the options you can specify.

The following table describes the options you can specify:

Option Description

-batch Synplify Pro (except node-locked)

Starts the synthesis tool in batch mode from the specified
project or Tcl file without opening the Project window.

-compile Compiles the project, but does not map it.

-evalhostid Reports host ID for node-locked and floating licenses.
-help Lists available command line options and descriptions.
-history filename Records all Tcl commands and writes them to the specified

history log file when the command exits.

-Identify_dir dir Specifies the location of the Identify installation directory for
launching the Identify tool set. The installation path
specified appears in the Configure Identify Launch dialog box
(Options->Configure Identify Launch).

-impl impName Runs only the specified implementation. You can use this
option in conjunction with the -batch keyword.
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Option Description

-ip_license_wait Specifies how long to wait for a Synopsys DesignWare IP

waitTime license when one is not immediately available. If you do not
specify the -ip_license_wait option, license queuing is not
enabled.

If all requested licenses are checked out or if the specified
wait time elapses, the tool excludes the IP and continues to
process the rest of the design. Any IP block without a license
is treated either as an error or a black box.

License queuing allows you to wait until a license becomes
available or specify a wait time in seconds. You can use this
option in conjunction with the -batch keyword. For details,
see Queuing Licenses, on page 502 in the User Guide.

The waitTime value determines license queuing and sets a
maximum wait time:

* Undefined or O = Queuing off
* 1 = Queuing enabled, indefinite wait time
* >1 = Queuing enabled for the specified time

-license_release Releases FPGA synthesis licenses for a session after the
place-and-route job is launched. The software allows place
and route to continue running even after exiting the
synthesis tool so that it does not consume an FPGA license.

This command option must be run in batch mode. Specify
the following command:

t ool Name -batch -1icense rel ease

For details, see Releasing the Synthesis License During
Place and Route, on page 543.

-licensetype Specifies a license if you work in an environment with
featureName multiple Synopsys FPGA licenses. You can use this option in
conjunction with the -batch keyword.

If you have licenses for multiple products, separate each
feature license by a colon so that licenses can be searched in
the order they are read until an available license is found.
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Option

-license_wait
waitTime

-log filename
-loga filename

-max_parallel_jobs
value

-nopopup
-run implName

-runall

-shell

-tcl prjFile | Tclscript

-tclemd command
-verbose_log

-version

© 2020 Synopsys, Inc.
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Description

Specifies how long to wait for a Synopsys FPGA license. If
you do not specify the -license_wait option, license queuing is
not enabled.

License queuing allows you to wait until a license becomes
available or specify a wait time in seconds. You can use this
option in conjunction with the -batch keyword. For details,
see Queuing Licenses, on page 502 in the User Guide.

The waitTime value determines license queuing and sets a
maximum wait time in seconds:

¢ Undefined or O = Queuing off
¢ 1 = Queuing enabled, indefinite wait time
* >1 = Queuing enabled for the specified wait time

Writes all output to the specified log file.
Writes all output to be appended to the specified log file.

Specifies the maximum number of concurrent processes
used for synthesis.

Suppresses popup dialog boxes.
Runs the specified implementation in the project file.

Runs all the implementations in the project file.
The Synplify tool supports only a single implementation.

Starts synthesis tool in shell mode.

Note: The FPGA synthesis tools only support the -shell option
on UNIX and Linux platforms.

Starts the synthesis tool in the graphical user interface
using the specified project or Tcl file.

Specifies Tcl command to be executed on startup.
Writes messages to stdout.log in verbose mode.

Reports version of specified synthesis tool.
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Tcl Command Categories

The following tables group Tcl commands together by type or functionality.
Log File Commands, on page 147
High Reliability Commands, on page 147

Technology-Specific Tcl Commands, on page 148

Log File Commands

These Tcl commands let you filter messages in the log file.

log_filter Lets you filter errors, notes, and warning messages.

log_report Lets you write out the results of the log_filter command to a
file.

message_override Allows you to suppress or override the log file message ID
specification.

High Reliability Commands

Microsemi
High-reliability commands specify I/O redundancy in high-reliability designs.

syn_connect Specifies the connectivity between the module/instance
being monitored for the error with the error monitoring IP
port or top-level port for the error monitoring module. It is
used with the syn_create_err_net command.

syn_create_err_net Specifies the connectivity between the module/instance
being monitored for the error with the error monitoring IP
port or top-level port for the error monitoring module. It is
used with the syn_connect command.
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Technology-Specific Tcl Commands

You can find vendor-specific Tcl commands in the appropriate vendor
chapter.

Vendor/Family Tcl Command Lists
Microsemi Microsemi Tcl set_option Command Options, on
page 401
© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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Silicon to Software

CHAPTER 3

Tcl Find, Expand, and Collection
Commands

The FPGA synthesis software includes powerful search functionality in the
Tcl find and expand commands. Objects located by these commands can be
grouped into collections and manipulated. The following sections describe the
commands and collections in detail:

* find, on page 152

* find -filter, on page 159

* expand, on page 166

* Collection Commands, on page 169

* Query Commands, on page 178

* Synopsys Standard Collection Commands, on page 202

The find, expand, and collection commands are listed alphabetically in the
following table.

* add_to_collection
e all clocks

e all fanin

e all fanout

e all_inputs

* all_outputs
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all_registers
append_to_collection
c_diff

c_info

c_intersect

c_list

c_print

c_symdiff

C_union
copy_collection
define_collection
define_scope_collection
expand

find (Tcl find)
foreach_in_collection
get_cells

get_clocks

get_nets
get_object_name
get_pins

get_ports

get_prop
index_collection
object_list
remove_from_collection
report_timing

set

© 2020 Synopsys, Inc.
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* sizeof collection
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find

The Tcl find command identifies design objects based on specified criteria. Use
this command to locate multiple objects with a common characteristic. If you
want to locate objects that share connectivity, use the expand command
instead of the find command (expand, on page 166).

You can specify the find command from the SCOPE environment or enter it as
a Tcl command. This command operates on the RTL database.

You can define objects identified by find as a group or collection, and operate
on all the objects in the collection at the same time. To do this, you embed the
find command as part of a collection creation or manipulation command to do
this in a single step. The combination of find and collection commands
provides you with very powerful functionality to operate on and manipulate
multiple design objects simultaneously.

The table summarizes where to find detailed information:

For ...
Command syntax

Syntax details: object
types, expressions, case
sensitivity, and special
characters

Examples of find syntax

Filtering find searches by
property

Using find search
patterns and using find
in collections

Tcl Find Syntax

Finds design objects based on specified criteria.

See ...
Tcl Find Syntax, on page 152

Tcl Find Command Object Types, on page 154
Wildcards and Special Characters, on page 155
Tcl Find Command Case Sensitivity, on page 155

Tcl Find Syntax Examples, on page 156

find -filter, on page 159
Find Filter Properties, on page 160

Refining Tcl Find Results with -filter, on page 140 in the
User Guide.

Finding Objects with Tcl find and expand, on page 146
in the User Guide.

Find is available as part of the HDL Analyst tool.
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Syntax

find
[-flat]
[-inst]
[-net]
[-port]
[-pin]
[-view]
[-nocase]
[-print]
[-depth value]
[-filter expression]
[-seq]
[pattern]

-flat
Extends the search to all levels. The * wildcard character matches
hierarchy separators as well as characters. See Wildcards and Special
Characters, on page 155 for additional information.

-inst
Finds matching instances. If no -type (-inst, -net, -port, -pin, or -view) option
is set, results include instances, nets, and ports.

-net
Finds matching nets. If no -type (-inst, -net, -port, -pin, or -view) option is set,
results include instances, nets, and ports.

-port
Finds matching ports. If no -type (-inst, -net, -port, -pin, or -view) option is
set, results include instances, nets, and ports.

-pin
Finds matching pins. If no -type (-inst, -net, -port, -pin, or -view) option is set,
results include instances, nets, and ports.

-view
Finds matching views. If no -type (-inst, -net, -port, -pin, or -view) option is
set, results include instances, nets, and ports.

-nocase
The -nocase option makes the search case-insensitive.

-print
Prints the first 20 search results. For a full list of objects found, use
c_print or c_list. If you use find from the shell, the results are printed to the
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Tcl window; if you find in the constraint file, the results are printed to the
log file at the beginning of the Mapper section. Reported object names
have prefixes that identify the object type and are contained in curly
braces ({}).

-depth value
Sets the starting depth for the search. Value may be a single number or
a range. When -depth with a range is used, for example - dept h 4-7, -hier
and -flat arguments are ignored.

-filter expression
Further refines the results of find by filtering the results using the speci-
fied object property. For syntax details, refer to find -filter, on page 159.

-seq
Finds sequential (clocked) instances (the -inst object type is not required).
This argument is equivalent to -filter @is_sequential.

pattern

The value to search for.

Tcl Find Command Object Types

You can specify the following types of objects:

Object Prefix Example Synopsys
view v: work.cpu.rt1|p:rst is the hierarchical rst port in lib_cell
(Design) the cpu view which points to all

instances of cpu.
inst i Default object type. i:core.i_cpu.reg1 points to the  cell
(Instance) reg1 instance inside i_cpu.
port p: p:data_in[3] points to bit 3 of the primary data_in port

port. work.cpu.rt1|p:rst is the hierarchical rst port in
the cpu view which eventually points to all
instances of cpu.

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
154 Synopsys Confidential Information January 2020



find Tcl Find, Expand, and Collection Commands

Object Prefix Example Synopsys

pin t: t:core.i_cpu.rst points to the hierarchical rst pin of  pin
instance i_cpu.

net n: n:core.i_cpu.rst points to the rst net driven in i_cpu. net

seq i izcore.i_cpu.reg[7:0] cell

(Sequential

instance)

Wildcards and Special Characters

The Tcl find command significantly differs from a simple Tcl search. A simple
Tcl search does not treat any character, except for the backslash (\), as a
special character, so * matches everything in a string. The Tcl find command
uses various special characters, as shown in the following table.

Use curly brackets {} or double quotes to prevent the interpretation of special
characters within a pattern, and the backslash to escape a single character.

Syntax Matches ...

* A sequence of O or more matches
If you do not specify -hier, the search is restricted to the current view only.
To traverse downward through the hierarchy, either use the -hier
argument or specify the hierarchical levels to be searched by adding the
hierarchical delimiter to the pattern. For example, *.* matches objects one
level below the current view.

? A sequence of 0 or 1 matches

Tcl Find Command Case Sensitivity

Case sensitivity depends on the rules of the language used to specify the
object. In mixed-language designs, the case-sensitivity rules for the parent
object prevail, even when another language is used to define the lower-level
object.
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Tcl Find Syntax Examples

The following are examples of find syntax:

Example

find {a*}

find {a*} -hier -nocase
find -net {*synp*} -hier
find -seq * -filter {@clock==myclk}

find -flat -seq {U1.*}

find -hier -flat -inst {i:A.B.C.*} -filter
@view==ram*

find -hier-seq {*} -filter
@clock_enable==ena

find -hier-seq {*} -filter @slack <{-0.0}
find -hier-seq {*} -filter {@clock ==clk1}
find -hier-net {*} -filter {@fanout >20}

find -hier-seq * -in $all_inst_coll

find -net -regexp {[a-b].*}

Description

Finds any object in the current view that
starts with a

Finds any object that starts with a or A
Finds any net the contains synp

Finds any register in the current view that is
clocked by myclk

Finds all sequential elements at any
hierarchical level under U1 (* matches
hierarchy separator)

Finds all RAM instances starting from a
submodule and all lower hierarchical levels
from A downwards

Finds all registers enabled by the ena signal

Finds all sequential elements with negative
slack

Finds all sequential elements within the clk1
clock domain

Finds high fanout nets that drive more than
20 destinations

Finds sequential elements inside the
all_inst_coll collection

Finds all nets in hierarchy a and b. This
means {n:a.*} and {n:b.* ; regular expressions
are only supported in the earlier standard
version of the HDL Analyst and are not

supported in the current version.

Use the {} characters to protect patterns that contain [] from Tcl evaluation.
For example, use the following command to find instance reg[4]:
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find -inst {reg[4]}

Example: Custom Report Showing Paths with Negative Slack

Use the following commands:

open_design i npl enentation_a/top.srm
set find negslack[find -hier -seq -inst {*} -filter @lack <

{-0.0}]

c_print -prop slack -prop view $find_negslack -file negsl ack. txt
The result of running these commands is a report called negslack.txt:

(bj ect Nane slack view
{i: CPU_A SCC. CPU. DATAPATH GBR[ 0]} -3.264 "FDE'
{i: CPU_A SCC. CPU. DATAPATH GBR{ 1] } -3.158 "FDE
{i: CPU_A SCC. CPU. DATAPATH GBR 2]} -3.091 "FDE

Example: Custom Report for Negative Slack FFs in a Clock Domain

The following procedure steps through the commands used to find all
negative slack flip-flops with a given clock domain:

1. Create a collection that contains all sequential elements with negative
slack:

set negFF [find -tech -hier -seq {*} -filter @lack < {-0.0}]
2. Create a collection of all sequential elements within the clk clock domain
set clklFF find -hier -seq * -filter {@l ock==cl k1}
3. Isolate the common elements in the two collections:
set clklSl ack [c_intersect $negFF $cl k1FF]
4. Generate a report using the ¢_print command:
c_print [find -hier -net * -filter @anout>=2]
{n:ackl_t np}
{n:ack2_t np}

{n bl k_xfer_cntrl _inst.|fsr_data[20: 14]}
{n:bl k_xfer_cntrl_inst.lfsr_inst.blk_size[6:0]}
{n:blk xfer_cntrl _inst.lfsr_inst.clk_c}
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find

Custom Fanout Report Example

The following command generates a fanout report:

%c_print -prop fanout [find -hier -net * -filter @ anout>=2]

This is an example of the report generated by the command:

hj ect Nane
{n: ackl_t np}
{n:ack2_t np}

{n bl k_ xfer_cntrl __inst.|fsr_data[14]}
{n:bl k xfer_cntrl _inst.|fsr_data]15]}
{n:blk xfer _cntrl _inst.|fsr_data[ 16]}

f anout
3
4

3
3
2

You can add additional information to the report, by specifying more proper-

ties. For example:

%c_print -prop fanout [find -hier -net * -filter @anout>=2] -prop

pi ns

This command generates a report |ike the one shown bel ow

hj ect Nane Fanout Pi ns
{n: ackl_t np} 3 "t:word xfer_cntrl _inst.ackl tnp
t:word xfer_inst.ackl tnp"
{n: ack2_t np} 4 "t:blk_ xfer_cntrl _inst.ack2_tnp
t: bl k_xfer_inst.ack2_ tnp"
{n:adr_o_axb_1} 2 "t:blk xfer_inst.adr_o_axb 1
t:adr o cry 1 0.St:adr_ o s 1.LI"
{n:adr_o_axb 2} 2 "t:blk xfer_inst.adr_o _axb 2
t:adr_ o cry 2 0.St:adr_ o s 2.LI"
{n:adr_o_axb_3} 2 "t:blk_xfer_inst.adr_o_axb_3
t:adr_o cry 3 0.St:adr_o s 3.LI"
{n:adr_o_axb_4} 2 "t:blk xfer_inst.adr_o_axb 4
t:adr o cry 4 0.St:adr_o s 4.LI"
{n:adr_o_axb 5} 2 "t:blk xfer_inst.adr_o axb 5

t:adr_ o cry 50.St:adr_o s 5. LI"

{n:adr_o_axb_6} 2 "t: bl k_xfer_

inst.adr_o _axb 6

t:adr_o cry 6 0.St:adr_o s 6.LI"

To save the report as a file, use a command like this one:

c_print -prop fanout [find -hier -net
-prop pins -file prop.txt

* -filter @anout>=2]
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find -filter

The Tcl find command includes the optional -filter option, which provides a
powerful way to further refine the results of the find command and filter
objects based on properties. See the following for details about the find -filter
command:

* Find -filter Syntax, on page 159
* Find Filter Properties, on page 160
* Find Filter Examples, on page 164

For the Tcl find command syntax, see

Find -filter Syntax

find pattern otherOtions -filter {[!|@propertyName operator value}

! Optional character to specify the negative. Include the !
character if you are checking for the absence of a property;
leave it out if you are checking for the presence of a

property.

@propertyName  Property name to use for filtering. The name must be
prefixed with the @ character. For example, if clock is the
property name, specify {@clock==myclk}.

operator Evaluates and determines the property value used for the
filter expression. For the operators you can use in the
expressions, see Filter Operators, on page 160.

value Property value for the property in the filter expression, when
the property has a value. The value can either be an object
name such as myclk in {@clock==myclk}, or a value, such as
60 in {@fanout>=60}.

When specified, the -filter option must be the last option specified for the find
command.
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Filter Operators
You can use the following relational operators with the -filter option:

== Equal

1= Not equal

> Greater than

< Less than

>= Greater than or equal to
<= Less than or equal to

=~ Matches pattern

I~ Does not match pattern

You can use the following logical operators with the -filter option:

&& And
| Or
! Not

Find Filter Properties

The object properties are based on the design or constraint, and are used to
qualify searches and build collections. To generate these properties, open
Project->Implementation Options->Device and enable the Annotated Properties for
Analyst check box. The properties display in the Tcl window when the RTL or
Technology view is active. Some properties are only available in a certain
view. The tool creates .sap and .tap files (design and timing properties, respec-
tively) in the project folder.

The table below lists the common filter object properties. It does not include
some vendor-specific properties. Use the table as a guide to filter the proper-
ties you want. Here is how to read the columns:
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Property Name Property Value

Common Properties

type view | port| net|instance |
pin

View Properties

compile_point locked

is_black box 1

is_verilog 0|1

is_vhdl 0|1

orig_inst_of viewName

syn_hier remove | flatten | soft | firm
| hard

Synplify Pro for Microsemi Edition Command Reference

HDL View

All

Tech

All

All

All

RTL and
Tech

Tech
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Description

Specifies the type of
object to be filtered
from the netlist

find * -filter -object -print

Filters the view based
on compile point
properties

find * -view -filter
@compile_point==locked
-print

Filters the black box
view

find * -view -filter
@is_black_box==1 -print

Filters the Verilog
based view

find * -view -filter
@is_verilog=={0|1} -print

Filters the VHDL based
view

find * -view -filter
@is_vhdI=={0|1} -print

Filters the view based
on original instance
find * -view -filter
@orig_inst_of==viewName
-print

Filters the view based
on the syn_hier
attribute value

find * -view -filter
@syn_hier=={remove|
flatten|soft|firm|hard} -print
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find -filter

Property Name Property Value

Port Properties

direction input | output | inout

fanout value

Instance Properties
area areaValue

arrival_time value

async_reset n:netName

async_set n:netName
clock clockName
clock_edge rise | fall |
high | low
clock_enable n:netName

compile_point locked
hier_rtl_name hierInstanceName
inout_pin_count value
input_pin_count value

inst_of viewName

is_black _box 1 (Property added)

© 2020 Synopsys, Inc.

HDL View

All

All

Tech
Tech

All
All
All

All

All

Tech

All
All
All
All
All

Description

Filters the port based
on port direction

find * -port -filter
@direction=={input|output|
inout} -print

Filters the port based
on fanout value

find * -port -filter
@fanout==value -print

Corresponds to worst
slack

Could be a list if there
are multiple clocks

Could be a list if there
are multiple clocks

Highest branch name in
the hierarchy, and
closest to the driver

Automatically inherited
from its view

Automatically inherited
from its view
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Tcl Find, Expand, and Collection Commands

Property Name
is_hierarchical
is_sequential
is_combinational
is_pad

is_tristate
is_keepbuf
is_clock_gating

is_vhdl

is_verilog

kind

location

name
orientation
output_pin_count
pin_count
placement_type
rtl_name

slack

slow
sync_reset
sync_set

syn_hier

view

Property Value

1 (Property added)
1 (Property added)
1 (Property added)
1 (Property added)
1 (Property added)
1 (Property added)
1 (Property added)
0]1

01

primitive

For example: inv | and |dff |

mux | statemachine | ...)

(x Y)
instanceName
N|S|E|W
value
value

unplaced | placed
nonhierinstanceName
value

1

n:netName
n:netName

remove | flatten |
soft| firm | hard

viewName

Synplify Pro for Microsemi Edition Command Reference
January 2020

HDL View Description

All

All

All

All

All

All

All

All Automatically inherited
from its view

All Automatically inherited
from its view

All Tech view contains
vepdpr_—speciﬁc
primitives

Tech Format can differ

All

Tech

All

All

All

All

Tech Worst slack of all arcs

Tech

All

All

Tech Automatically inherited
from its view

All

© 2020 Synopsys,
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Property Name Property Value HDL View Description

Pin Properties

arrival_time timingValue Tech

clock clockName All Could be a list if there
are multiple clocks

clock_edge rise | fall | All Could be a list if there

high | low are multiple clocks
direction input | output | All
inout

fanout value All Total fanout (integer)

is_clock 01 All

is_const 01 All

is_gated_clock 01 All Set in addition to
is_clock

slack value Tech

Net Properties

clock clockName All Could be a list if there
are multiple clocks

is_clock 01 All

is_gated_clock 01 All Set in addition to
is_clock

fanout value All Total fanout (integer)

Find Filter Examples

The following examples show how find -filter is used to check for the presence
or absence of a property, with the ! character indicating a negative check:

c_print [find -hier -view {*} -filter Finds all objects that are black

(@s_bl ack_box) ] boxes.
c_print [find -hier -view {*} -filter Finds all objects that are not black
(' @s_bl ack_box) ] boxes

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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Positive Check Examples
Finds all ports, pins, and nets from the top level with a fanout greater than 8:

find * -filter {@anout >8}
Finds all instances other than andv and orv in the design:
find * -hier -filter {!(@iew=andv|| @i ew=orv)}
Finds all instances of statemachine throughout the hierarchy:
find -hier -inst * -filter {@nst_of ==st at emachi ne}
find -hier -inst * -filter {@i nd==statenachi ne}

Finds all instances throughout the hierarchy that include the string reg and
are clocked by CLK:

find -hier -inst {*reg*} -filter {@l ock==CLK}
Finds all nets throughout the hierarchy that have a fanout greater than 4:

find -hier -net {*} -filter {@anout >4}

Negative Check Example

Finds all instances from the top level that have the include string big, that are
not black boxes, and that have more than 10 pins:

find -inst *big* -filter {! @s_bl ack_box& @i n_count >10) }

Example of Boolean Expression Specified on Multiple Properties

Finds all instances from the top level that have more than eight pins and
negative slack:

find * -filter {(@i n_count>8)&& @l ack<0)}

Example of Pin Property Specified for Constants

Finds pins driven by constant O or constant 1:
find -pin *.* -filter @onst==value -print

Where value of 1 lists all the pins that are tied to a constant.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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expand

The expand command identifies objects based on their connectivity, by
expanding forward from a given starting point. For more information, see
Using the Tcl Find Command to Define Collections, on page 142 of the User

Guide.

Tcl expand Syntax

The syntax for the expand command is as follows:

expand [-objectType] [-from object] [-thru object] [-to object] [-level integer]
[-hier] [-leaf] [-seq] [-print]

Argument

-from object

-hier

-leaf

-level integer

-objectType

© 2020 Synopsys, Inc.
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Description

Specifies a list or collection of ports, instances, pins, or nets for
expansion forward from all the pins listed. Instances and input
pins are automatically expanded to all output pins of the
instances. Nets are expanded to all output pins connected to the
net.

If you do not specify this argument, backward propagation stops
at all sequential elements.

Searches for the pattern from every level of hierarchy, instead of
just the top level and identifies objects to be expanded based on
their connectivity.

The default for the current view is the top level and is defined
with the define_current_design command as in the compile-point
flow.

Returns only non-hierarchical instances.

Limits the expansion to N logic levels of propagation. You cannot
specify more than one -from, -thru, or -to point when using this
option.

Optionally specifies the type of object to be returned by the
expansion. If you do not specify an objectType, all objects are
returned. The object type is one of the following:

¢ -instance returns all instances between the expansion points.
This is the default.

¢ -pin returns all instance pins between the expansion points.
* -net returns all nets between the expansion points.
e -port returns all top-level ports between the expansion points.

Synplify Pro for Microsemi Edition Command Reference
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Argument Description

-print Evaluates the expand function and prints the first 20 results. If
you use this command from HDL Analyst, these results are
printed to the Tcl window; for constraint file commands, the
results are printed to the log file at the start of the Mapper
section.

For a full list of objects found, you must use c_print or c_list.
Reported object names have prefixes that identify the object
type. There are double quotes around each name to allow for
spaces in the names. For example:

"i:regl”

"i:reg2"

"i:\weird _name[ f oo$] "

"i:reg3"

<<found 233 objects. Displaying first 20 objects. Use
c_print or c_list for all. >>

-seq Modifies the range of any expansion to include only sequential
elements. By default, the expand command returns all object
types. If you want just sequential instances, make sure to define
the object_type with the -inst argument, so that you limit the
command to just instances.

-thru object Specifies a list or collection of instances, pins, or nets for
expansion forward or backward from all listed output pins and
input pins respectively. Instances are automatically expanded to
all input/output pins of the instances. Nets are expanded to all
input/output pins connected to the net. You can have multiple
-thru lists for product of sum (POS) operations.

-to object Specifies a list or collection of ports, instances, pins, or nets for
expansion backward from all the pins listed. Instances and
output pins are automatically expanded to all input pins of the
instances. Nets are expanded to all input pins connected to the
net.

If you do not specify this argument, forward propagation stops at
all sequential elements.
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Tcl expand Syntax Examples

Example Description

expand -hier -from {i:reg1} -to {i:reg2} Expands the cone of logic between two
registers. Includes hierarchical instances
below the current view.

expand -inst -from {i:reg1} Expands the cone of logic from one register.
Does not include instances below the current
view.

expand -inst -hier -to {i:reg1} Expands the cone of logic to one register.

Includes hierarchical instances below the
current view.

expand -pin -from {t:i_and2.z} -level 1 Finds all pins driven by the specified pin.
Does not include pins below the current
view.

expand -hier -to {t:i_and2.a} -level 1 Finds all instances driving an instance.
Includes hierarchical instances below the
current view.

expand -hier -from {n:cen} Finds all elements in the transitive fanout of
a clock enable net, across hierarchy.

expand -hier -from {n:cen} -level 1 Finds all elements directly connected to a
clock enable net, across hierarchy.

expand -hier -thru {n:cen} Finds all elements in the transitive fanout
and transitive fanin of a clock enable net,
across hierarchy.

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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Collection Commands

A collection is a group of objects. Grouping objects lets you operate on
multiple group members at once; for example you can apply the same
constraint to all the objects in a collection. You can do this from both the
SCOPE editor (see Collections, on page 223) or in a Tcl file.

The following table lists the commands for creating, copying, evaluating,
traversing, and filtering collections, and subsequent sections describe the
collections, except for find and expand, in alphabetical order. For information
on using collections, see Using Collections, on page 147 in the User Guide.

Command Description

Creation

define_collection Creates a collection from a list
set modules Creates a collection

set modules_copy $modules  Copies a collection

Creation from Objects Identified by Embedded Commands

find Does a targeted search and finds objects.
Embedding the find command in a collection creation
command first finds the objects, and then creates a
collection out of the identified group of objects.

expand Identifies related objects by expanding from a
selected point. Embedding the expand command in a
collection creation command first finds the objects,
and then creates a collection out of the identified
group of objects.

Operators for Comparison and Analysis

c_diff Identifies differences between lists or collections
c_intersect Identifies objects common to a list and a collection
c_symdiff Identifies objects that belong exclusively to only one
list or collection
C_union Concatenates a list to a collection
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Command Description

Operators for Evaluation and Statistics

c_info Prints statistics for a collection
c_list Converts a collection to a Tcl list for evaluation
c_print Displays collections or properties for evaluation

Tel Collection Commands that
manipulate two or mone collections

©_union @
c_diﬁ @

Identifies differences by comparing collections, or a list and a collection. For
this command to work, the design must be open in the GUI.

Syntax
c_diff {$collection1 $collection2 | $collection {list}} [-print]

This command also includes a -print option to display the result.

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
170 Synopsys Confidential Information January 2020



Collection Commands Tcl Find, Expand, and Collection Commands

Examples

The following examples combine the set with the c_diff command to create a
new collection that contains the results of the c_diff command. The first
example compares two collections and puts the results in diffCollection:

set diffCollection [c_diff $collectionl $collection2]

The next example creates collection1 consisting of objects i:reg1 and irreg2,

compares this collection to a Tcl list containing object i:reg1, puts the results
in the collection diffCollection and prints the result (i:reg2).

%et collectionl {i:regl i:reg2}
%et diffCollection [c_diff $collectionl {i:regl}]
% _print $diffCollection
{i:reg2}
c_info
Returns specifics of a collection, including database name, number of objects

per type, and total number of objects. You can save the results to a Tcl
variable (array) using the -array name option.

Syntax

c_info $mycollection [-array name]

c_intersect

>

Defines common objects that are included in each of the collections or lists
being compared.

Syntax
c_intersect $collectionl $collection2 | list [-print]

This command also includes a -print option to display the result.

Synplify Pro for Microsemi Edition Command Reference
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Example

The following example uses the set command to create a new collection that
contains the results of the c_intersect command. The example compares a list
to a collection (myCollection) and puts the common elements in a new collec-

tion called commonCollection:
%et nyCollection {i:regl i:reg2}

%et commonCol I ection [c_intersect $nyCollection {i:regl i:reg3}]
% print $commonCol | ection

{i:regl}

c_list

Converts a collection to a Tcl list of objects. You can evaluate any collection
with this command. If you assign the collection to a variable, you can then
manipulate the list using standard Tcl list commands like lappend and Isort.

Syntax

c_list $collection|list

Example
%et nyMdules [find -view *]

% _list $nyModul es
{v:top}{v:block_a}{v: bl ock b}

c_print
Displays collections or properties in column format. Object properties are

printed using one or more -prop propertyName options.

Syntax

c_print {$collection | {list}} [-prop propertyName]* [-file filename] [-append]

To print to a file, use the -file option. Use -append to append to the specified file

instead of overwriting it. The following command in a constraint file prints the
whole collection to a file:

c print -file foo.txt $col

© 2020 Synopsys, Inc.
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Note that the command prints the file to the current working directory. If you
have multiple projects loaded, check that the file is written to the correct
location. You can use the pwd command in the Tcl window to echo the current
directory and then use cd directoryName to change the directory as needed.

Example

%et nmodules [find -view *]
%_print $nmodul es

{v:top}

{v: bl ock_a}

{v: bl ock_b}

% print -prop is_vhdl -prop is_verilog $modul es
Nane is_vhdl is_verilog

{vitop}0 1

{viblock a}1 0

{v:block_b}1 0

c_symdiff

¢

Compares a collection to another collection or Tcl list and finds the objects
that are unique, not shared between the collections or Tcl lists being
compared. It is the complement of the c_intersect command (c_intersect, on
page 171).

Syntax

c_symdiff {$collection1 $collection2 | $collection {list}} [-print]

This command also includes a -print option to display the result.

Examples

The following example uses the set command together with the c_symdiff
command to compare two collections and create a new collection (symDiffCol-
lection) that contains the results of the ¢_symdiff command.

set synDiff_collection [c_syndiff $collectionl $collection2]
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The next example is more detailed. It compares a list to a collection (collection1)
and creates a new collection called symDiffCollection from the objects that are
different. In this case, reg1 is excluded from the new collection because it is
common to both the list and collection1.

set collectionl {i:regl i:reg2}

set synDiffCollection [c_symdiff $collectionl {i:regl i:reg3}]

c_list $synDiffCollection

{"i:reg2" "i:reg3"}

You can also use the command to compare two collections:

C_union

\ 4

Adds a collection, or a list to a collection, and removes any redundant
instances. For this command to work, the design must be open in the GUI.

Syntax
c_union {$collection1 $collection2 | $collection {list}} [-print]

The ¢_union command automatically removes redundant elements. This
command also includes a -print option to display the result.

Examples

You can concatenate two collections into a new collection using the c_union
and set commands, as shown in the following example where collection1 and
collection2 are concatenated into combined_collection:

set conbi ned_col | ection [c_uni on $col | ectionl $col |l ecti on2]

The following example creates a new collection called sumCollection, which is
generated by adding a Tcl list with one object (reg3) to collection1, which
consists of reg1 and reg2. The new collection created by ¢_union contains reg 1,
reg2, and reg3.
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%et collectionl [find -instance {reg?} -print]
{i:regl}
{i:reg2}
%et suntollection [c_union $collectionl {i:reg3}]
% |ist $suncollection

{i:regl} {i:reg2} {i:reg3}

If instead you added reg2 and reg3 to collection1 with the ¢_union command, the
command removes redundant instances (reg2), so that the new collection still
consists of reg1, reg2, and reg3.

%et collectionl {i:regl i:reg2}

%et suncol l ection [c_union $collectionl {i:reg2 i:reg3}]
% _list $suncollection

{i:regl} {i:reg2} {i:reg3}

define_collection

Creates a collection from any combination of single elements, Tcl lists, and
collections. You get a warning message about empty collections if you define
a collection with a leading asterisk and then define an attribute for it, as
shown here:

set noretinmesh [define collection [find -hier -seq *uc_al u]]
define_attribute {$noretinesh} {syn_allowretimng} {0}

To avoid the error message, remove the leading asterisk and change *uc_al u
to uc_al u.

Example
set nodul es [define collection {v:top} {v:cpu} $nycoll $nylist]

define_scope_collection

The define_scope_collection command combines set and define_collection to create
a collection and assigns it to a variable.

define_scope collection ny regs {find -hier -seq *ny*}
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get_prop

Returns a single property value for each member of the collection in a Tcl list.

Examples
get _prop
get _prop
get _prop
get _prop
get _prop
get _prop

-prop clock [find -seq *]

-array arr [find Al] -all

$l i st Expandedl nst -prop rtl_nane LOROMB2X1i nst
$l i st Expandedl nst -prop | ocation SLI CE_X1y36
$l i st Expandedl nst -prop bel GsLUT

$l i st Expandedl nst -prop slack 0.678

If this command is used in a Tcl script and the results need to be printed, use
a puts command.

foreach cel

set

[c_list $all_hier] {puts [get_prop -prop view $cel ];}

Copies a collection to create a new collection. This command copies the
collection but not the name, so the two are independent. Changes to the
original collection do not affect the copied collection.

Syntax

set collectionName collectionCriteria

set copyName $collectionName

collectionName

collectionCriteria

copyName

$collectionName

© 2020 Synopsys, Inc.
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The name of the new collection.

Criteria for defining the elements to be included in the collection.
Use this argument to embed other commands, like Tcl find and
expand, as shown in the examples below, or other collection
commands like define_collection, c_intersect, c¢_diff, c_union, and
c_symdiff. Refer to these commands for examples.

The name assigned to the copied collection.

Name of an existing collection to copy.
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Examples
The following syntax examples illustrate how to use the set command:
* Use the set command to copy a collection:
set ny_nod_copy $ny_nodul e

* Use the set command with a variable name and an embedded find
command to create a collection from the find command results:

set ny_nodul e [find -view *]
* Use the set command with define_collection to create a collection:
set ny_nodul e [define collection {v:top} {v:cpu} $col | $nylist]

For more examples of the set command used with embedded Tcl collec-
tion commands, see the examples in c_diff, on page 170, c_intersect, on
page 171, c_symdiff, on page 173, c_union, on page 174, and define_col-
lection, on page 175.
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Query Commands

The query commands are Synopsys SDC commands from the Design
Compiler® tool for creating collections of specific object types. Functionally,
they are equivalent to the Tcl find and expand commands (find, on page 152
and expand, on page 166).

These query commands are intended to be used in the FDC file or the HDL
Analyst view (see Query Commands in HDL Analyst Tool, on page 179) to
create collections of objects for constraints. This section describes the syntax
for the query commands supported in the FPGA synthesis tool. For complete
documentation on these commands, see the Design Compiler documentation.

e all clocks

e all fanin

e all fanout

¢ all_inputs

¢ all_outputs
¢ all registers
* get_cells

¢ get_clocks

* get nets

* get pins

* get ports

* object_list

* report_timing

Note: Since all the query commands above are used to create Tcl collections of
objects for constraints, they must be enclosed in [ ] to be applied. For
example:

set_input_delay 0.5 [all __inputs] -clock clk
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Query Commands in HDL Analyst Tool

Most of the query commands can be used in both the FDC file and the HDL
Analyst view to create collections of objects for constraints. However, the
all_clocks command cannot be implemented in the HDL Analyst view.

To use the query commands in the HDL Analyst RTL view:

1. Enable the option: Implementation Options->Device->Annotate Properties for
Analyst.

2. If results are not as expected, check that this option is turned on during
compile and before you open the SRS view.

[ Annotated Properties for Analyst
Verification Mode
Resolve Mixed Drivers
Read Write Check on RAM

) ) (Y

Query Commands and Tcl find and expand Commands

The Synopsys get* commands and all* commands are functionally similar to
the Tcl find and expand commands. The get* commands and all* commands
are better suited to use with constraints and the fdc file, because they handle
properties like @clock better than the Tcl find and expand commands. In
certain cases, the .fdc file does not support the find and expand commands,
although you can still enter them in the Tcl window. See Query Commands
and Tcl find and expand Commands, on page 179 for examples.
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Query and Tcl find/expand Examples

The following table lists parallel examples that compare how to use either the
Tcl find/lexpand or the get/all commands to query design objects and set
constraints.

Return the output pins of top-level registers clocked by clkb (e.g. inst1.inst2.my_reg.Q)

all_registers FDC Constraint:
set_multicycle_path {4} -from [all_registers -no_hierarchy -output_pins -clock
[get_clocks {clkb}]]
set_multicycle_path {4} -from [get_pins -of objects [get_cells * -filter {@clock
== clkb}] -filter {@name == Q}]
find Tcl Window:
% define_collection [regsub -all {i:(["\s]+)} [join [c_list [find -inst * -filter @clock
== clkfx]]] {t:\1.Q}]
Return all registers in the design clocked by the rising edge of clock clkfx

all_registers FDC Constraint:
set_multicycle_path {3} -to [all_registers -cells -rise_clock [get_clocks {clkfx}]]
set_multicycle_path {3} -to [get_cells -hier * -filter {@clock == clkfx &&
@clock_edge == rise}]
find Tcl Window:
find -hier -inst * filter {@clock == clkfx && @clock_edge == rise}

Return clock pins of all registers clocked by the falling edge of cklifx

all_registers FDC Constraint:
set_multicycle_path {2} -from [all_registers -clock_pins -fall_clock [get_clocks
{clkfx}]]
set_multicycle_path {2} -from [get_pins -of_objects [get_cells -hier * filter
{@clock == clkfx && @clock_edge == fall}] -filter {@name == C}]
find Tcl Window:
% find -hier -inst * -filter {@clock == clkfx && @clock_edge == fall}

Return the E pins of all instances of dffre cells (e.g. inst1.inst2.my_reg.E)

get_pins FDC Constraint:
set_multicycle_path -to [get_pins -filter {@name == E} -of objects [get_cells
-hier * filter {@inst_of == dffre}]
find Tcl Window and FDC Constraint:
% regsub -all {i:(["s]+)} [join [c_list [find -hier -inst * -filter @inst_of == dffre]]]
{t\1.E}]
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all_clocks

Use this command in the .fdc constraint file to return a collection of objects.
This command is not supported in the HDL Analyst view.

Returns a collection of clocks in the current design.

Syntax
This is the supported syntax for the all_clocks command:
all_clocks

This command has no arguments. All clocks must be defined in the design
before using this command. To create clocks, you can use the create_clock
command.

Example
The following constraint sets a multicycle path from all the starting points.

set_multicycle path 3 -fromJ[all_cl ocks]

all_fanin

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Reports pins, ports, or cells for the fanin of the specified sinks in the to list.

Syntax

This is the supported syntax for the all_fanin command:

all_fanin
[-break_on_bboxes]
[-endpoints_only]
[-exclude_bboxes]
[-flat]
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[-levels integer]
[-only_cells]
[-startpoints_only]

-to listC

[-trace_arcs all | timing]

Arguments

-break_on_bboxes Stops timing fanin from traversing on black boxes.

-endpoints_only Returns only timing end points.

-exclude_bboxes Excludes black boxes from the final result.

-flat The fanin function operates in flat mode.

This function can be specified in hierarchical (default) or
flat mode. For hierarchical mode, only objects in the
same hierarchy level as the current sink are returned.
The pins within a level of hierarchy below the sink are
traversed, but are not reported.

-levels integer Stops traversal when the perimeter of the search integer
hops is reached. For example, a level 2 hop traverses
through two levels of combinational logic and stops,
instead of hopping through all levels and stopping at the
first sequential or port object. Counting is performed for
the layers of cells that are equidistant from the sink.

-only_cells Results include a set of all cells from the timing fanin for
listC.

-startpoints_only Returns only timing start points.

-to listC Required. Reports a list of sink pins, ports, or nets in the

design and the timing fanin of each sink in the listC Tcl
list or collection specified. When you specify a net,
effectively all drivers on the net are listed.

-trace_arcs all | timing  Specifies the type of combinational arcs to trace while
traversing the fanin. You can specify either:

¢ all - Permits tracing of all combinational arcs. This is
the default.

¢ timing - Permits tracing of valid timing arcs only.
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Examples
The following examples show the timing fanin of a port in the design.

all fanin -to [get_ports y*]
{t:y obuf[4].0t:y obuf[3].0Ot:y obuf[0].Ot:y obuf[1].0O
t:y obuf[2].0Ot:y obuf[5].0t:y obuf[6].0t:y obuf[7].0t:QG\D. G
t:rmoduley inst.y c[0] t:modul ey inst.y c[1]
t:moduley inst.y c[2]}

all _fanin -to [get_ports y*] -startpoints_only -flat
{t:moduley inst.q[2].Qt:moduley_inst.q[1].Q
t:noduley inst.q[0].Q

all _fanin -to [get_ports y*] -startpoints_only -flat -only cells
{i:noduley _inst.q[0] i:rmoduley inst.q[1] i:moduley inst.q[2]}

all_fanout

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Returns a set of pins, ports, or cells for the fanout of the specified sources in
the from list.

Syntax

This is the supported syntax for the all_fanout command:

all_fanout
[-break_on_bboxes]
-clock_tree | -from listC
[-endpoints_only]
[-exclude_bboxes]
[-flat]
[-levels integer]
[-only_cells]
[-trace_arcs all |timing]

Arguments
-break_on_bboxes Stops timing fanout from traversing on black boxes.
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.

January 2020 Synopsys Confidential Information 183



Tcl Find, Expand, and Collection Commands Query Commands

-clock_tree Uses all clock source pins and/or ports in the design as
its list of sources. Clock sources are specified with the
create_clock command. If there are no clocks or clocks
have no sources, then the report is empty. The -clock_tree
option generates a report displaying the clock trees or
networks in the design.

The -clock_tree and -from options are mutually exclusive.

-endpoints_only Returns only timing end points.
-exclude_bboxes Excludes black boxes from the final result.
-flat The fanout function operates in flat mode.

This function can be specified in hierarchical (default) or
flat mode. For hierarchical mode, only objects in the
same hierarchy level as the current source are returned.
The pins within a level of hierarchy below the source are
traversed, but are not reported.

-from listC Specifies a list of source pins, ports, or nets in the
design. The timing fanout for each source of the listC Tcl
list or collection is reported. When you specify a net,
effectively all load pins on the net are listed.

The -clock_tree and -from options are mutually exclusive.

-levels integer Stops traversal when the perimeter of the search integer
hops is reached. For example, a level 2 hop traverses
through two levels of combinational logic and stops,
instead of hopping through all levels and stopping at the
first sequential or port object. Counting is performed for
the layers of cells that are equidistant from the source.

-only_cells Results include a set of all cells from the timing fanout
for the listC.

-trace_arcs all | timing  Specifies the type of combinational arcs to trace while
traversing the fanout. You can specify either:

¢ all - Permits tracing of all combinational arcs. This is
the default.

e timing - Permits tracing of valid timing arcs only.

Examples

The following examples show the timing fanout of a port in the design.
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all _fanout -from[get ports {a*}]
{t:a_ibuf[0].] t:a_ibuf[1].] t:a_ibuf[2].] t:hold_a.D
t:nmodul ex_inst.a c[0] t:nodul ex_inst.a c[1]
t: modul ex_inst.a_c[ 2]}

all _fanout -from[get ports {a*}] -level 1
{t:a_ibuf[O].] t:a_ibuf[1].] t:a_ibuf[2].1}

all _fanout -from/[get ports {a*}] -flat -endpoints_only

{t:hold_a.D t:nodul ex_inst.qa[0].D t:modul ex_inst.qa[1].D
t:modul ex_inst.qa[2].D t:modul ex_inst.qa fast[0]. D}

all_inputs

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Returns a collection of input or inout ports in the current design.

Syntax

This is the supported syntax for the all_inputs command:

all_inputs
[-clock clockName]
[-exclude_clock_port]

Arguments

-clock clockName Limits the search to ports that have input delay relative to
clockName.

-exclude_clock_port Excludes clock ports from the search.

Examples

The following constraints set a default input delay.
set_input _delay 3 [all _inputs]
set _input_delay 3 -clock {clk} [all_inputs]
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all_outputs

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Returns a collection of output or inout ports in the current design.

Syntax

This is the supported syntax for the all_outputs command:

all_outputs
[-clock clockName]

Arguments

-clock clockName Limits the search to ports that have output delay relative to
clockName.

Examples

The following constraints set a default output delay.
set _output_delay 2 [all _outputs]
set _output _delay 2 -clock {clk} [all_outputs]

all_registers

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Returns a collection of sequential cells or pins in the current design.
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Syntax
This is the supported syntax for the all_registers command:

all_registers
[-clock clockName]
[-rise_clock clockName]
[fall_clock clockName]
[-cells]
[-data_pins]
[-clock_pins]
[~output_pins]
[-no_hierarchy]

Arguments

-clock clockName Searches only sequential cells that are clocked by the
specified clock.
By default, all sequential cells in the current design are
searched.

-rise_clock Searches only sequential cells triggered by the rising edge of

clockName the specified clock.
By default, all sequential cells in the current design are
searched.

-fall_clock Searches only sequential cells triggered by the falling edge of

clockName the specified clock.
By default, all sequential cells in the current design are
searched.

-cells Returns a collection of sequential cells that meet the search
criteria.
If you do not specify any of the object types, the command
returns a collection of sequential cells.

-data_pins Returns a collection of data pins for the sequential cells that
meet the search criteria.

-clock_pins Returns a collection of clock pins for the sequential cells
that meet the search criteria.

-output_pins Returns a collection of output pins for the sequential cells
that meet the search criteria.
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-no_hierarchy Limits the search to only the current level of hierarchy.
Sub-designs are not searched.

By default, the entire hierarchy is searched.

Examples

The following constraint sets a max delay target for timing paths leading to all
registers.

set_nmax_delay 10.0 -to [all _registers]

The following constraint sets a max delay target for timing paths leading to all
registers clocked by PHI2.

set_max_delay 10.0 -to [all _registers -clock [get_clocks PH 2]]

get_cells

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Creates a collection of cells from the current design that is relative to the
current instance.

Syntax
This is the supported syntax for the get_cells command:
get_cells
[-hierarchical]
[-nocase]
[-regexp]
[-filter expression]
[pattern]
Arguments
-hierarchical Searches each level of hierarchy for cells in the design relative to
the current instance. The object name at a particular level must
match the patterns. For the cell bl ockl/ adder, a hierarchical
search uses "adder" to find this cell name.
By default, the search is not hierarchical.
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-nocase Ensures that matches are case-insensitive. This applies for both
the patterns argument and the filter operators (=~ and !~).

-regexp Views the patterns argument as a regular expression rather
than a simple wildcard pattern. The behavior of the filter
operators (=~ and !~)have also been modified to use regular

expression rather than simple wildcard patterns.

When using the - r egexp option, be careful how you quote the
patterns argument and filter expression. Rigidly quoting with
curly braces around regular expressions is recommended.
Regular expressions are always anchored; that is, the
expression assumes matching begins at the beginning of the
object name and ends matching at the end of an object name.
You can expand the search by adding ". *" to the beginning or
end of the expressions, as needed.

-filter expressions Filters the collection with the specified expression.

For each cell in the collection, the expression is evaluated based
on the cell’s attributes. If the expression evaluates to true, the
cell is included in the result.

pattern Creates a collection of cells whose names match the specified
patterns. Patterns can include the * (asterisk) and ? (question
mark) wildcard characters. Pattern matching is case sensitive
unless you use the -nocase option.

Examples

The following example creates a collection of cells that begin with o and refer-
ence an FD2 library cell.

get_cells "o*" -filter "@ef_nane =~ FD2"

The following example creates a collection of cells connected to a collection of
pins.

set pinsel [get_pins o*/cp]
get _cells -of objects $pinsel

The following example creates a collection of cells connected to a collection of
nets.

set netsel [get_nets tnp]
get cells -of objects $netsel

This example creates a collection of cells with the string BSCAN in its name.
Make sure to use the "=~" operator when performing wildcard matching.
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get _cells -hier * -filter {@ier_rtl_nane =~ *BSCAN‘}

get_clocks

Use this command in the .fdc constraint file and in the HDL Analyst view (on a
limited basis) to return a collection of objects.

Creates a collection of clocks from the current design.

Syntax

This is the supported syntax for the get clocks command:

get_clocks
[-nocase]
[-regexp]
[-filter expression]
[pattern | -of_objects objects]
[-include_generated_clocks]

Arguments

-nocase Ensures that matches are case-insensitive. This applies for
both the patterns argument and the filter operators (=~ and

1~).

-regexp Views the patterns argument as a regular expression rather
than a simple wildcard pattern. The behavior of the filter
operators (=~ and !~) have also been modified to use regular
expression rather than simple wildcard patterns.

When using the - r egexp option, be careful how you quote
the patterns argument and filter expression. Rigidly quoting
with curly braces around regular expressions is
recommended. Regular expressions are always anchored;
that is, the expression assumes matching begins at the
beginning of the object name and ends matching at the end
of an object name. You can expand the search by adding
".*" to the beginning or end of the expressions, as needed.

-filter expressions Filters the collection with the specified expression.

For each clock in the collection, the expression is evaluated
based on the clock’s attributes. If the expression evaluates
to true, the clock is included in the result. This option is not
supported in the HDL Analyst view.
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pattern Creates a collection of clocks whose names match the
specified patterns. Patterns can include the * (asterisk) and
? (question mark) wildcard characters. Pattern matching is
case sensitive unless you use the -nocase option.

-of_objects objects Creates a collection of clocks that are defined for the given
net or pin objects.

-include_generated_ Creates a collection of clocks matching the search criteria

clocks and includes any clocks derived from the source clocks
found. Use this option to propagate exception constraints
through MMCM/PLL or to derived clocks.

This option is not supported in the HDL Analyst view.

Examples

The following example creates a collection of clocks that match the wildcard
pattern.

get clocks {*BUF_1*deri ved_cl ock*}

The following example creates a collection of clocks that match the given
regular expression.

get _clocks -regexp {.*derived_cl ock}

The following example creates a collection that includes clka and any derived
clocks of clka.

get _cl ocks -incl ude_generated_cl ocks {cl ka}
The following example propagates exception constraints on derived clocks:

set _fal se path -from ][ get clocks -include_generated clocks GCLK2] -to
[ get_clocks -include_generated_clocks GCLK1]

get_nets

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.
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Creates a collection of nets from the current design.

Syntax
This is the supported syntax for the get_nets command:

get_nets
[-hierarchical]
[-nocase]
[-regexp | -exact]
[-filter expression]
[pattern | -of_objects objects]

Arguments

-hierarchical Searches each level of hierarchy for nets in the design relative
to the current instance. The object name at a particular level
must match the patterns. For the net bl ockl/ nuxsel a
hierarchical search uses muxsel to find this net name.

By default, the search is not hierarchical.

-nocase Ensures that matches are case-insensitive. This applies for
both the patterns argument and the filter operators (=~ and
1~).

-regexp Views the patterns argument as a regular expression rather
than a simple wildcard pattern. The behavior of the filter
operators (=~ and !~) have also been modified to use regular
expression rather than simple wildcard patterns.

When using the - r egexp option, be careful how you quote the
patterns argument and filter expression. Rigidly quoting with
curly braces around regular expressions is recommended.
Regular expressions are always anchored; that is, the
expression assumes matching begins at the beginning of the
object name and ends matching at the end of an object name.
You can expand the search by adding " . *" to the beginning or
end of the expressions, as needed.

filter expressions  Filters the collection with the specified expression.

For any nets in the collection, the expression is evaluated
based on the net’s attributes. If the expression evaluates to
true, the net is included in the result.
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pattern Creates a collection of nets whose names match the specified
patterns. Patterns can include the * (asterisk) and ? (question
mark) wildcard characters. Pattern matching is case sensitive
unless you use the -nocase option.

The patterns and -of_objects arguments are mutually exclusive;
you can specify only one. If you do not specify any of these
arguments, the command uses * (asterisk) as the default
pattern.

-of_objects objects Creates a collection of nets connected to the specified objects.
Each object can be a pin, port, or cell.

Examples

The following example creates a collection of nets connected to a collection of
pins.

set pinsel [get_pins {o_regl. Qo _reg2. @]
get _nets -of objects $pinsel

The following example creates a collection of nets connected to the E pin of
any cell in the modulex_inst hierarchy.

get_nets {*.*} -filter {@ins =~ nodul ex_inst.*. E}

get_pins

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects. Creates a
collection of pins from the current design that match the specified criteria.

When used without -hierarchical, include a dot (.) as a pin separator between
the name of the instance and the pin name. Not including the hierarchy
separator results in a warning message.
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Syntax
This is the supported syntax for the get_pins command:

get_pins
[-hierarchical]
[-nocase]
[-regexp | -exact]
[-filter expression]
[pattern |-of_objects objects [-leaf]

Arguments

-hierarchical

Searches each level of hierarchy for pins, relative to the current
instance, and reports all instances with that pin name. By default,
searches are not hierarchical.

You can use wildcards with the -hier argument. The object name at a
particular level must match the pattern. For the cell block1/adder/D[0], a
hierarchical search uses adder/D[0] to find pin names.

The pin separator is not required with -hier, although it is required if you
use get_pins without -hier (see Examples of get_pins, on page 195).
However, when narrowing searches by specifying instance names as well
as pin names, make sure to include the hierarchy separator. Otherwise,
you will not get any search results:

%get _pins -hier {*reset pipe*QG
{}

% get _pins -hier {*reset_pipe*. G
{t:sysip_inst.l_haps80 core\.l _unr_clk_gen\.reset pipe[0].Q

t:sysip_inst.l_haps80 core\.l _unr_clk_gen\.reset_ pipe[l].Q
t:sysip_inst.l_haps80 core\.l _unr_clk_gen\.reset pipe[2].Q
t:sysip_inst.l_haps80 core\.l _unr_clk gen\.reset pipe[3].Q
t:sysip_inst.l_haps80 core\.l _unmr_clk _gen\.reset pipe[4].Q
t:sysip_inst.l_haps80 core\.l _unmr_clk _gen\.reset pipe[5].Q
t:sysip_inst.l_haps80 core\.l_unr_clk _gen\.reset pipe[6].Q
t:sysip_inst.l_haps80 core\.l _unr_clk _gen\.reset _pipe 0[7].CQ

You cannot use the -hierarchical option with the -of objects option.
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-nocase
Ensures that matches are case-insensitive. This applies for both the
pattern argument and the filter operators (== and !=).

-regexp|-exact
Views the patterns argument as a regular expression rather than a
simple wildcard pattern. The behavior of the filter operators (== and !=)
have also been modified to use regular expressions rather than simple
wildcard patterns. When using the -regexp option, be careful how you
quote the patterns argument and filter expression. Rigidly quoting with
curly braces around regular expressions is recommended. Regular
expressions are always anchored; that is, the expression assumes
matching begins at the beginning of the object name and ends matching
at the end of an object name. You can expand the search by adding ".*"
to the beginning or end of the expressions, as needed. he -exact option
treats wildcards as plain characters, so the meanings of these wildcard
are not interpreted.

-filter expressions
Filters the collection with the specified expression. For each pin in the
collection, the expression is evaluated based on the pin’s attributes. If
the expression evaluates to true, the pin is included in the result.

pattern |-of_objects objects [-leaf]
Creates a collection of pins whose names match the specified patterns.
Patterns can include the * (asterisk) and ? (question mark) wildcard
characters. Pattern matching is case sensitive unless you use the -nocase
option. The -of objects option creates a collection of pins connected to the
specified objects. Each object can be a cell or net. By default, the
command considers only pins connected to the specified nets at the
same hierarchical level. To consider only pins connected to leaf cells on
the specified nets, use the -leaf option (the tool can cross hierarchical
boundaries to find pins on leaf cells). You cannot use the -hierarchical
option with the -of_objects option.

Examples of get_pins
This example creates a collection of all pins in the design.
get_pins -hier *. *

This example shows that without a separator, the command returns no
results and generates a warning message:

%get_pins {Q
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Varning: No pin separator ('.') specified. Pattern nust include a
pi n separat or.

The following example creates a collection of pins from the top-level hierarchy
that match the regular expression.

get _pins -regexp {.*\.ena}

The following example creates a collection of pins throughout the hierarchy
that match the regular expression.

get _pins -hier - regexp {.*\.ena}

This example illustrates that you do not need the pin separator when you
specify the -hier argument:

%get _pins -hier {Q

{t: haps_system capi mcapi _di[0].Qt: haps_systemcapi mcapi _di[1].Q
t: haps_systemcapimcapi _di[2].Qt:haps_systemcapimcapi _di[3].Q
:haps_system capi mcapi _di[4].Q t: haps_systemcapimcapi _di[5].Q
:haps_system capimcapi _di[6].Q t:haps_systemcapimcapi _di[7].Q
“haps_system capi mcapi _di[8].Q t:haps_systemcapimcapi _di[9].Q
: haps_syst em capi m capi _di[10].Q

s haps_system capi mcapi _di[11].Q

—~ —~ —~ —~ —

The next example creates a collection of hierarchical pin names for the library
cell pin DQSFOUND, and for each instantiation of a library cell named
PHASER_IN_PHY.

get pins -filter {@ame == DQBFOUND} -of objects [get _cells -hier
* -filter {@nst_of == PHASER | N PHY}]

The following example creates a collection of library cell pins with the string
DRCK in its name, for each instantiation of a library cell with the string
BSCAN in its name. Whenever you use wildcards to match names, make sure
to specify the "=~" operator instead of the "==" operator.

[get _pins -filter {@ane=~*DRCK} -of _objects [get _cells -hier *
-filter {@ier_rtl_name =~ *BSCAN‘}]]

get_ports
Use this command in the .fdc constraint file to return a collection of objects

and/or in the HDL Analyst view to return a Tcl list of objects.
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Creates a collection of top-level ports from that match the specified criteria.

Syntax
This is the supported syntax for the get_ports command:
get_ports
[-nocase]
[-regexp]
[-filter expression]
[pattern]
Arguments
-nocase Ensures that matches are case-insensitive. This applies for both
the patterns argument and the filter operators (=~ and !~).
-regexp Views the patterns argument as a regular expression rather
than a simple wildcard pattern. The behavior of the filter
operators (=~ and !~) have also been modified to use regular

expression rather than simple wildcard patterns.

When using the - r egexp option, be careful how you quote the
patterns argument and filter expression. Rigidly quoting with
curly braces around regular expressions is recommended.
Regular expressions are always anchored; that is, the
expression assumes matching begins at the beginning of the
object name and ends matching at the end of an object name.
You can expand the search by adding ". *" to the beginning or
end of the expressions, as needed.

-filter expressions Filters the collection with the specified expression.

For each port in the collection, the expression is evaluated
based on the port’s attributes. If the expression evaluates to
true, the port is included in the result.

pattern Creates a collection of ports whose names match the specified
patterns. Patterns can include the * (asterisk) and ? (question
mark) wildcard characters. Pattern matching is case sensitive
unless you use the -nocase option.
The patterns and -of objects arguments are mutually exclusive,

so only specify one of them. If you do not specify either
argument, the command uses * (asterisk) as the default pattern.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 197



Tcl Find, Expand, and Collection Commands Query Commands

Examples
The following example queries all input ports beginning with mode.

get ports node* -filter {@irection =~ input}

object_list
Translates object strings returned by query commands in the HDL Analyst
tool to proper Tcl lists. This allows you to process the results using Tcl
commands.
Syntax

This is the supported syntax for the object list command:

object_list objectString

Arguments

objectString Converts the object string returned by an FDC query command
to proper Tcl lists.

Examples

For example:

%foreach x [object list [get cells -hier {g[*]}]]
{puts "Match: $x"}

Mat ch: i:modul ex_inst.q[7:0]
Match: i:rmoduley inst\[4\].q[7:0]

report_timing

Alternatively, use this command to generate timing reports for a design from
the Tcl window, which follows the standards set for the Design Compiler or
PrimeTime® commands. One advantage this command has over the Timing
Analyst GUI in the synthesis tool is that the filter options (for example,
-from/-to/-through) support the FDC query commands.
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Syntax

This is the supported syntax for the report_timing command:

report_timing
[-delay_type max]
[-fall_from clock]
[-fall_to clock]
[-file string]
[-from list]
[-max_paths int]
[-nworst 1]
[-path_type full]
[-rise_from clock]
[-rise_to clock]
[-slack_margin float]
[-through instance]
[-to list]

Arguments

-delay_type max Specifies the path type for the end points. This default value
can be specified as max; the maximum delay. All other values
are ignored.

-fall_from clock Reports paths from the falling edge of the specified clock. For a
given clock, selects the starting points for paths clocked on the
falling edge of the clock source.

-fall_to clock Reports paths to the falling edge of the specified clock. For a
given clock, selects the ending points for paths clocked on the
falling edge of the clock source.

-file string Allows the report to be re-directed to the specified file.

-from list Reports paths from the specified port, register, register pin, or
clock.

-max_paths int Reports the number of paths to report for the path group. The

default integer value is 1.

-nworst 1 Reports the maximum number of paths to report for each
timing end point. The default is 1, which reports the single
worst path at a given end point. All other values are ignored.
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-path_type full Specifies how to display the timing path. This default value can
be specified as full. A complete timing report is displayed, for
example, containing timing start and end points, required
time, and slack. All other values are ignored.

-rise_from clock Reports paths from the rising edge of the specified clock. For a
given clock, selects the starting points for paths clocked on the
rising edge of the clock source.

-rise_to clock Reports paths to the rising edge of the specified clock. For a
given clock, selects the ending points for paths clocked on the
rising edge of the clock source.

-slack_margin float Reports paths for the specified slack margin, which allows you
to specify a floating point value for the range of worst slack
times.

-through instance = Reports paths that pass through the specified pins or nets.

-to list Reports paths to the specified ports, register, register pin, or
clock.

Examples
The following example reports timing to all registers clocked by clkb.
% eport _timng -to [all _registers -clock {clkb}]

###H START CF TI M NG REPORT ###H#H
# Timng Report witten on Mon Dec 16 10: 35: 02 2013|
#

Top Vi ew top

Request ed Frequency: 50.0 Mz

Wre | oad node: top

Pat hs request ed: 1

to: nmodul ey_i nst. ga[ 7: 0] nodul ey_i nst. gb[ 7: 0]

Wrst From To Path | nformation

R R R R R R R o A R R R R

Path information for path nunber 1:

Request ed Peri od: 10. 000
- Setup tine: -1. 000
+ O ock delay at ending point: 0. 909
= Required tinme: 11.909
- Propagation tine: 0. 000
= Slack : 11. 909
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Nunber of logic |evel(s): 1
Starting point: c[7:0] / c[Q]
Endi ng poi nt: nmodul ey_inst.qga[0] / D
The start point is clocked by clkb [rising]
The end point is clocked by clkb [rising] on pin C
I nst ance/ Net Pin Pin Arrival No. of
Narre Type Narre Dr Del ay Ti me Fan Qut(s)
c[7:0] Por t c[0] In 0. 000 0.000 -
c[0] Net - - 0. 000 - 1
c_i buf[0] | BUF I In - 0.000 -
c_i buf[0] | BUF O Qut 0. 000 0.000 -
c_c[0] Net - - 0. 000 - 1
nmodul ey_i nst.ga[ 0] FDE D In - 0.000 -

Pat h del ay conpensated for clock skew. O ock skewis added to cl ock-to-out
value, and is subtracted fromsetup time val ue

End cl ock pat h:

I nst ance/ Net Pin Pin Arrival No. of
Nare Type Nare Dr Del ay Ti me Fan Qut(s)
cl kb Port c[ 0] In 0. 000 0.000 -

cl kb Net - - 0. 000 - 1

cl kb_I BUFG | BUF I I'n - 0.000 -

cl kb_I BUFG | BUF O Qut 0. 000 0.000 -

cl kb_i Net - - 0. 000 - 1

nodul ey_i nst.ga[ 0] FDE D In - 0.000 -

#Hi#H#E END OF TI M NG REPCRT #####]

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 201



Tcl Find, Expand, and Collection Commands Synopsys Standard Collection Commands

Synopsys Standard Collection Commands

There are a number of Synopsys standard SDC collection commands that can
be included in the .fdc file. These commands are not compatible with the
define_scope_collection command.

The collection commands let you manipulate or operate on multiple design
objects simultaneously by creating, copying, evaluating, iterating, and
filtering collections. This section describes the syntax for the following collec-
tion commands supported in the FPGA synthesis tool; for the complete
syntax for these commands, refer to the Design Compiler documentation.

add_to_collection append_to_collection
copy_collection foreach_in_collection
get_object_name index_collection
remove_from_collection sizeof collection

Use these commands in the FDC constraint file to facilitate the shared
scripting of constraint specifications between the FPGA synthesis and Design
Compiler tools.

add_to_collection

Adds objects to a collection that results in a new collection. The base collec-
tion remains unchanged. Any duplicate objects in the resulting collection are
automatically removed from the collection.

Syntax
This is the supported syntax for the add_to_collection command:

add_to_collection
[collection1]
[objectSpec]

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
202 Synopsys Confidential Information January 2020



Synopsys Standard Collection Commands Tcl Find, Expand, and Collection Commands

Arguments

collectionl Specifies the base collection to which objects are to be added. This
collection is copied to a resulting collection, where objects matching
objectSpec are added to this results collection.

objectSpec Specifies a list of named objects or collections to add.

Depending on the base collection type (heterogeneous or
homogeneous), the searches and resulting collection may differ. For
more information, see Heterogeneous Base Collection, on page 203
and Homogeneous Base Collection, on page 203.

Description

The add_to_collection command allows you to add elements to a collection. The
result is a new collection representing the objects added from the objectSpec
list to the base collection. Objects are duplicated in the resulting collection,
unless they are removed using the -unique option. If objectSpec is empty, then
the new collection is a copy of the base collection. Depending on the base
collection type (heterogeneous or homogeneous), the searches and resulting
collection may differ.

Heterogeneous Base Collection

If the base collection is heterogeneous, then only collections are added to the
resulting collection. All implicit elements of the objectSpec list are ignored.

Homogeneous Base Collection

If the base collection is homogeneous and any elements of objectSpec are not
collections, then the command searches the design using the object class of
the base collection.

When collectionl is an empty collection, special rules apply to objectSpec. If
objectSpec is not empty, at least one homogeneous collection must be in the
objectSpec list (can be any position in the list). The first homogeneous collec-
tion in the objectSpec list becomes the base collection and sets the object
class for the function.

Examples

set result [get cells{u*}]
get _obj ect _nane $result
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==> {u:ul} {i:u2} {i:u3}

set result_1 [add_to_collection $result {get_cells {i:clkb_lBUFG]
get _obj ect_nanme $result_1

==> {i:ul} {i:u2} {i:u3} {i:clkb_|IBUG

See Also

* append_to_collection

append_to_collection

Adds objects to the collection specified by a variable, modifying its value.
Objects must be unique, since duplicate objects are not supported.

Syntax

This is the supported syntax for the append_to_collection command:

append_to_collection]
[variableName]
[objectSpec]

Arguments

variableName Specifies a variable name. The objects matching objectSpec
are added to the collection referenced by this variable.

objectSpec Specifies a list of named objects or collections to add to the
resulting collection.

Description

The append_to_collection command allows you to add elements to a collection.
This command treats the variableName option as a collection, and appends
all the elements of objectSpec to that collection. If the variable does not exist,
it creates a collection with elements from the objectSpec as its value. So, a
collection is created that was referenced initially by variableName or
automatically if the variableName was not provided. However, if the variable
exists but does not contain a collection, then an error is generated.

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
204 Synopsys Confidential Information January 2020



Synopsys Standard Collection Commands Tcl Find, Expand, and Collection Commands

The append_to_collection command can be more efficient than the add to_collec-
tion command (add_to_collection, on page 202) when you are building a
collection in a loop.

Examples

set result [get_cells{u*}]
get _obj ect _nane $resul t

==> {u:ul} {i:u2} {i:u3}

append_to_collection result {get _cells {i:clkb |BUFG]
get _obj ect _nane $resul t

==> {i:ul} {i:u2} {i:u3} {i:clkb_|BUFG

See Also

* add_to_collection

copy_collection
Duplicates the contents of a collection that results a new collection. The base

collection remains unchanged.

Syntax

This is the supported syntax for the copy_collection command:

copy_collection
[collection1]

Arguments
collection1 Specifies the collection to be copied.
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Description

The copy_collection command is an efficient mechanism to create a duplicate of
an existing collection. It is sometimes more efficient and usually sufficient to
simply have more than one variable referencing the same collection. However,
whenever you want to copy the collection instead of reference it, use the
copy_collection command.

Be aware that if an empty string is used for the collection] argument, the
command returns an empty string. This means that a copy of the empty
collection is an empty collection.

Examples

set insts [define_collection {ul u2 u3 u4}]
set result_copy [copy_collection $insts]
get _obj ect _name $result _copy

==> {ul} {u2} {u3} {u4}

foreach_in_collection

Iterates on the elements of a collection.

Syntax

This is the supported syntax for the foreach_in_collection command:

foreach_in_collection

[iterationVariable]
[collections]
[body]
Arguments
iterationVariable Specifies the name of the iteration variable. It is set to a

collection of one object. Any argument that accepts
collections as an argument can also accept the
iterationVariable, as they are the same data type.

collections Specifies a list of collections on which to iterate.
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body Specifies a script to execute for the iteration. If the body of
the iteration is modifying the netlist, all or part of the
collection involved in the iteration can be deleted. The
foreach_in_collection command is safe for such operations. A
message is generated that indicates the iteration ended
prematurely.

Description

The foreach_in_collection command is a Design Compiler and PrimeTime
command used to iterate on each element of a collection. This command
requires the following arguments: an iteration variable (do not specify a list),
the collection on which to iterate, and the script to apply for each iteration.

You can nest this command within other control structures, including
another foreach_in_collection command.

You can include the command in an FDC file, but if you are using the Tcl
window and the HDL Analyst tool, you must use the standard Tcl foreach
command instead of foreach_in_collection.

Examples

The following examples show valid methods to reference a collection for this
command:

set segs[all _registers]
set port[all _inputs]

foreach_in_collection
foreach_in_coll ection
foreach_in_coll ection
foreach_in_coll ection
foreach_in_col |l ection

[all _registers] {body}
$ports {body}

[list $segs $ports] {body}
{$seqgs} {body}

{$seqs $ports} {body}

X X X X X
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get_object_name

Returns a list of names for objects in a collection.

Syntax

This is the supported syntax for the get_object name command:

get_object_name
[collectionl]

Arguments

collectionl Specifies the name of the collection that contains the
requested objects.

Examples

set cl[define_collection {ul u2}]
get _obj ect _nane $cl

==> {ul} {u2}

index_collection

Creates a new collection that contains only the single object for the index
specified in the base collection. You must provide an index to the collection.

Syntax

This is the supported syntax for the index_collection command:

index_collection
[collection1]

[index]
Arguments
collectionl Specifies the collection to be searched.
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index Specifies an index to the collection. Allowed values are
integers from O to sizeof_collection -1.

Description

You can use the index_collection command to extract a single object from a
collection. The result is a new collection that contains only this object. The
range of indices can be from O to one less than the size of the collection. If the
specified index is outside that range, an error message is generated.

Commands that create a collection of objects do not impose a specific order
on the collection, but they do generate the objects in the same, predictable
order each time. Applications that support the sorting of collections allow you
to impose a specific order on a collection.

If you use an empty string for the collectionl argument, then any index to the
empty collection is not valid. This results in an empty collection and gener-
ates an error message.

Be aware that all collections cannot be indexed.

Examples

set cl[get_cells {ul u2}]]
get _object _nane [index_collection $cl 0]

==> {ul}

See Also

* sizeof collection
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remove_from_collection

Removes objects from a collection that results in a new collection. The base
collection remains unchanged.

Syntax
This is the supported syntax for the remove_from_collection command:

remove_from_collection
[-intersect]
[collectionl]
[objectSpec]

Arguments

-intersect Removes objects from the base collection that are not found
in objectSpec.
By default, when this option is not specified, objects are
removed from the base collection that are found in the
objectSpec.

collectionl Specifies the base collection that is copied to a resulting
collection, where objects matching objectSpec are removed
from this results collection.

objectSpec Specifies a list of named objects or collections to remove.

The object class for each element in this list must be the
same in the base collection. If the name matches an existing
collection, that collection is used. Otherwise, objects are
searched in the design using the object class for the base
collection.

Description

The remove_from_collection command removes elements from a collection and
creates a new collection.

When the -intersect option is not specified and there are no matches for
objectSpec, the resulting collection is just a copy of the base collection. If
everything in the collectionl option matches the objectSpec, this results in an
empty collection. When using the -intersect option, nothing is removed from
the resulting collection.
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Heterogeneous Base Collection

If the base collection is heterogeneous, then any elements of objectSpec that
are not collections are ignored.

Homogeneous Base Collection

If the base collection is homogeneous and any elements of objectSpec are not
collections, then the command searches the design using the object class of
the base collection.

Examples

set cl[define_collection {ul u2 u3}]]
set c2[define_collection {u2 u3 u4}]]
get _object_nane [renove fromcol |l ection $cl $c2]

==> {ul}

get _object _nane [renmove fromcollection $c2 $cl]

==> {u4}

get _obj ect_nane [renove fromcollection -intersect $cl $c2]

==> {u2} {us}

See Also

* add_to_collection

sizeof_collection

Returns the number of objects in a collection.

Syntax

This is the supported syntax for the sizeof collection command:

sizeof_collection
[collection1]
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Arguments

collectionl Specifies the name of the collection for which the number of
objects is requested.
If no collection argument is specified, then the command
returns O.

Examples

set cl[define_collection {ul u2 u3}]
si zeof col |l ection $ci1

==> 3
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CHAPTER 4

Constraint Commands

The SCOPE (Synthesis Constraints OPtimization Environment®) editor
automatically generates syntax for synthesis constraints. Enter information
in the SCOPE tabs, panels, columns, and pull-downs to define constraints
and parameter values. You can also drag and drop objects from the HDL
Analyst Ul to populate values in the constraint fields.

This interface creates Tcl-format Synopsys Standard timing constraints and
Synplify-style design constraints and saves the syntax to an FPGA design
constraints (FDC) file that is automatically added to your synthesis project.
See Constraint Types, on page 124 for definitions of synthesis constraints.

Topics in this section include:
* SCOPE Constraints Editor, on page 214
* SCOPE Tabs, on page 215
* Industry I/O Standards, on page 239
* Delay Path Timing Exceptions, on page 242
* Specifying From, To, and Through Points, on page 247
* Conflict Resolution for Timing Exceptions, on page 255

You can also specify Tcl equivalents for the timing and design constraints
that are included in the SCOPE editor or a constraint file. For the constraint
command syntax, see:

* Timing Constraints, on page 259
* Design Constraints, on page 298
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SCOPE Constraints Editor

The SCOPE editor contains a number of panels for creating and managing
timing constraints and design attributes. This GUI offers the easiest way to
create constraint files for your project. The syntax is saved to a file using an
FDC extension and can be included in your design project.

constrRmt fic >

Cuent Desion: | <Top Level> =| [ ched Corstraints

Enablel Wame |0hject Period |l'|'a'.zeform| Agd |Clock Group | Latency | Uncestainky | Comenent [ﬂ
n L
L |
s |
|
2 :

Cldis Generated Clocks | Collactions | Inpubs{Outputs Registars DCielay Paths Attrithes 1jD Standards Compil= Paints TO Viese |

From this editor, you specify timing constraints for clocks, ports, and nets as
well as design constraints such as attributes, collections, and compile points.
However, you cannot set black-box constraints from the SCOPE window.

To bring up the editor, use one of the following methods from the Project view:

* For a new file (the project file is open and the design is compiled):

— Choose File->New-> FPGA Design Constraints; select FPGA Constraint File
(SCOPE).

— Click the SCOPE icon in the toolbar; select FPGA Constraint File (SCOPE).

* You can also open the editor using an existing constraint file.
Double-click the constraint file (FDC), or use File->Open, specifying the
file type as FPGA Design Constraints File (*.fdc).

For more information about using FPGA timing constraints with your project,
see Using the SCOPE Editor, on page 114 in the User Guide.
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SCOPE Tabs

Here is a summary of the constraints created through the SCOPE editor:

SCOPE Panel
Clocks
Generated Clocks
Collections
Inputs/Outputs
Registers

Delay Paths
Attributes

I/O Standards
Compile Points

TCL View

See ...

Clocks, on page 216
Generated Clocks, on page 220
Collections, on page 223
Inputs/Outputs, on page 225
Registers, on page 228

Delay Paths, on page 229
Attributes, on page 232

I/O Standards, on page 233
Compile Points, on page 234
TCL View, on page 237

If you choose an object from a SCOPE pull-down menu, it has the appropriate
prefix appended automatically. If you drag and drop an object from an RTL
view, for example, make sure to add the prefix appropriate to the language
used for the module. See Naming Rule Syntax Commands, on page 295 for

details.
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Clocks
You use the Clocks panel of the SCOPE spreadsheet to define a signal as a
clock.
|Enab\\e | ame | Object | Period |'|.'.-'a'\.~efum| Aod | Cladk Group Latency Uncertainty Cimrment i
1

2

m
i |

Oodez

The Clocks panel includes the following options:

Field Description

Name Specifies the clock object name.
Clocks can be defined on the following objects:
* Pins
* Ports
* Nets

For virtual clocks, the field must contain a unique name not
associated with any port, pin, or net in the design.

Period Specifies the clock period in nanoseconds. This is the
minimum time over which the clock waveform repeats. The
period must be greater than zero.

Waveform Specifies the rise and fall edge times for the clock waveforms of
the clock in nanoseconds, over an entire clock period. The first
time in the list is a rising transition, typically the first rising
transition after time zero. There must be two edges, and they
are assumed to be rise and then fall. The edges must be
monotonically increasing. If you do not specify this option, a
default waveform is assumed, which has a rise edge of 0.0 and
a fall edge of period/2.

Add Delay Specifies whether to add this delay to the existing clock or to
overwrite it. Use this option when multiple clocks must be
specified on the same source for simultaneous analysis with
different clock waveforms. When you use this option, you
must also specify the clock, and clocks with the same source
must have different names.
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Field Description

Clock Group Assigns clocks to asynchronous clock groups. The clock
grouping is inclusionary (for example, clk2 and clk3 can each be
related to clk1 without being related to each other). For details,
see Clock Groups, on page 217.

Latency Specifies the clock latency applied to clock ports and clock
aliases. Applying the latency constraint on a port can be used
to model the off-chip clock delays in a multichip environment.
Clock latency can only:

* Apply to clocks defined on input ports.
¢ Be used for source latency.
e Apply to port clock objects.

Uncertainty Specifies the clock uncertainty (skew characteristics) of the
specified clock networks. You can only apply latency to clock
objects.

Clock Groups

Clock grouping is associative; two clocks can be asynchronous to each other
but both can be synchronous with a third clock.

The SCOPE GUI prompts you for a clock group for each clock that you define.
By default, the tool assigns all clocks to the default clock group. When you
add a name that differs from the default clock group name, the clock is
assigned its own clock group and is asynchronous to the default clock group
as well as all other named clock groups.

This section presents scenarios for defining clocks and includes the following
examples:

* Example 5 - Legacy Clock GroupingExample 1 - SCOPE Definition
* Example 2 - Equivalent Tcl Syntax

* Example 3 - Establish Clock Relationships

* Example 4 - Using a Single Group Option
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Example 5 - Legacy Clock GroupingExample 1 - SCOPE Definition

A design has three clocks, clk1, clk2, clk3. You want clk1 and clk2 to be in the
same clock group—synchronous to each other but asynchronous to clk3. You
can apply this clock definition by adding a name in the Clock Group column, as
shown below:

RO R g5 T [Tt

iourent Desgr: | <To Leved = L |f Chedk Corsrants
_l = | Manie Oiject | Period | l&'awfmnl Add | Dok Grous | Latendy | u
'L_ + il il ? d graupl

| gll mezlkl 10 | groupl

# okl i 12 ] +default>

|n.|n... .|.||...|h..

This definition assigns clk1 and clk2 to clock group group1, synchronous to
each other and asynchronous to clk3. The equivalent Tcl command for this
appears in the text editor window as follows:

set _cl ock_groups -derive -asynchronous -nare {groupl}
-group {{c:clkl} {c:clk2}}

Example 2 - Equivalent Tcl Syntax

A design has three clocks: clk1, clk2, clk3. Use the following commands to set
clk2 synchronous to clk3, but asynchronous to clk1:

set _cl ock_groups -asynchronous -group [get_clocks {cl k3 cl k2}]

set _cl ock_groups -asynchronous -group [get_clocks {cl kl}]
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Example 3 - Establish Clock Relationships
A design has the following clocks defined:

create_clock -name {clka} {p:clka} -period 10 -waveform{0 5.0}
create_clock -nane {clkb} {p:clkb} -period 20 -waveform {0 10. 0}
create_clock -name {ny_sys} {p:sys_clk} -period 200 -waveform {0
100. 0}

You want to define clka and clkb as asynchronous to each other and clka and
clkb as synchronous to my_sys.

For the tool to establish these relationships, multiple -group options are
needed in a single set_clock_groups command. Clocks defined by the first
—group option are asynchronous to clocks in the subsequent -group option.
Therefore, you can use the following syntax to establish the relationships
described above:

set _cl ock_groups -asynchronous -group [get_cl ocks {cl ka}]
-group [get _cl ocks {cl kb}]

Example 4 - Using a Single Group Option
set_clock_groups has a unique behavior when a single -group option is specified

in the command. For this example, the following constraint specifications are
applied:

set _cl ock_groups -asynchronous -nane {default_cl kgroup 0} -group
[get _cl ocks {cl ka ny_sys}]

set _cl ock_groups -asynchronous -nane {default_cl kgroup_ 1} -group
[get _cl ocks {cl kb ny_sys}]

The first statement assigns clka AND my_sys as asynchronous to clkb, and the
second statement assigns clkb AND my_sys as asynchronous to clka. Therefore,
with this specification, all three clocks are established as asynchronous to
each other.

Example 5 - Legacy Clock Grouping

This section shows how the legacy clock group definitions (Synplify-style
timing constraints) are converted to the Synopsys standard timing syntax
(FDC). Legacy clock grouping can be represented through Synopsys standard
constraints, but the multi-grouping in the Synopsys standard constraints
cannot be represented in legacy constraints.
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For example, the following table shows legacy clock definitions and their
translated FDC equivalents:

Legacy define_clock -name{clka}{p:clka}-period 10 -clockgroup default_clkgroup_0
Definition  define_clock -name {clkb}{p:clkb} -freq 150 -clockgroup default_clkgroup_1
define_clock -name {clkc} {p:clkc} -freq 200 -clockgroup default_clkgroup_1

FDC ###==== BEGIN Clocks - (Populated from SCOPE tab, do not edit)

Definition  create_clock -name {clka} {p:clka} -period 10 -waveform {0 5.0}
create_clock -name {clkb} {p:clkb} -period 6.667 -waveform {0 3.3335}
create_clock -name {clkc} {p:clkc} -period 5.0 -waveform {0 2.5}

set_clock_groups -derive -name default_clkgroup_0 -asynchronous
-group {c:clka}

set_clock_groups -derive -name default_clkgroup_1 -asynchronous
-group {c:clkb c:clkc}

###t==== END Clocks

The create_generated_clock constraints used in legacy SDC are preserved in
FDC. The -derive option directs the create_generated_clock command to inherit
the -source clock group. This behavior is unique to FDC and is an extension of
the Synopsys SDC standard functionality.

Generated Clocks

Use the Generated Clocks panel of the SCOPE spreadsheet to define a signal as
a generated clock. The equivalent Tcl constraint is create_generated_clock; its
syntax is described in create_generated_clock, on page 262.

_LEnd:\ie_] [sme | Sourc= ||‘_‘I:vpct|r'|nshu' Cloak: | Genersts T'\_-'DE|GEI'HEDEPHI!IIELEIS "au'umer-lnﬂrferlmadﬁupamlz:sl:.1'.'51 | Add | Comment

i

Generated Clocks
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The Generated Clocks panel includes the following options:

Field Description

Name Specifies the name of the generated clock.

If this option is not used, the clock gets the name of the first
clock source specified in the source.

Source Specifies the master clock pin, which is either a master
clock source pin or a fanout pin of the master clock driving
the generated clock definition pin. The clock waveform at
the master pin is used for deriving the generated clock
waveform.

Object Generated clocks can be defined on the following objects:
e Pins
* Ports
* Nets
* Instances

Master Clock Specifies the master clock to be used for this generated
clock, when multiple clocks fan into the master pin.

Generate Type Specifies any of the following:

edges - Specifies a list of integers that represents edges from
the source clock that are to form the edges of the generated
clock. The edges are interpreted as alternating rising and
falling edges and each edge must not be less than its
previous edge. The number of edges must be an odd number
and not less than 3 to make one full clock cycle of the
generated clock waveform. For example, 1 represents the
first source edge, 2 represents the second source edge, and
SO on.

divide_by - Specifies the frequency division factor. If the
divide factor value is 2, the generated clock period is twice
as long as the master clock period.

multiply_by - Specifies the frequency multiplication factor. If
the multiply factor value is 3, the generated clock period is
one-third as long as the master clock period.

Generate Parameters  Specifies integers that define the type of generated clock.

Generate Modifier Defines the secondary characteristics of the generated
clock.
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January 2020 Synopsys Confidential Information 221



Constraint Commands

SCOPE Tabs

Field
Modify Parameters

Invert

Add

Examples

Description
Defines modifier values of the generated clock.

Specifies whether to use invert - Inverts the generated clock
signal (in the case of frequency multiplication and division).

Either add this clock to the existing clock or overwrite it.
Use this option when multiple generated clocks must be
specified on the same source, because multiple clocks fan
into the master pin. Ideally, one generated clock must be
specified for each clock that fans into the master pin. If you
specify this option, you must also specify the clock and
master clock. The clocks with the same source must have
different names.

In the following example, the generated clock genclk1 is created with the same
frequency as the source clock clkin, but its phase is shifted by 180. Each of
the edges of the generated clock shifts by 5 ns, which is specified by the
-edges and -edge_shift options.

Example 1

create_generaled_clock -master_clock[ost j_w:

Master Clock CIOCK MName

Source

-add-source[get_ports {clkin}]-edoes {12 3} -edge_shift/5 5 5} [oet_pins {i_clkgen/clk_g'Qi0T]

Generate Type  Modify Parameters

Chbject

zeneratz Modifer

Generate Parameters

For this example, a generated clock is created with half the frequency of the

source clock.

© 2020 Synopsys, Inc.
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Example 2

Generate Type

creale_generated_clock—name divelk-source [get_ports {clkin}]-divide_br 2 [get_pins {un1_diwd k. 2UTTOT

(GENErate Parameers

For more information about other SCOPE options, see SCOPE Tabs, on
page 215.

Collections

The Collections tab allows you to set constraints for a group of objects you
have defined as a collection with the Tcl command. For details, see Creating
and Using SCOPE Collections, on page 148 of the User Guide.

Enable | Name | Command Comment
|
Collections
Field Description
Enable Enables the row.
Name Enter the collection name.
Command Select a collection creation command from the drop-down

menu. See Collection Commands, on page 224 for
descriptions of the commands.

Comment Enter comments that are included in the constraints file.

You can crossprobe the collection results to an HDL Analyst view. To do this,
right-click in the SCOPE cell and select the option Select in Analyst.
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Collection Commands

You can use the collection commands on collections or Tcl lists. Tcl lists can
be just a single element long.

To ...

Use this command ...

Create a collection

Copy a collection

Evaluate a collection

Concatenate a list to a
collection

Identify differences
between lists or
collections

Identify objects
common to a list and a
collection

Identify objects
common to two or more
collections

Identify objects that
belong exclusively to
only one list or
collection

set modules

To create and save a collection, assign it to a variable.
You can also use this command to create a collection
from any combination of single elements, TCL lists and
collections:

set modules [define_collection {v:top} {v:cpu} $Smycoll $mylist]

Once you have created a collection, you can assign
constraints to it in the SCOPE interface.

set modules_copy $modules
This copies the collection, so that any change to $modules
does not affect $modules_copy.

c_print

This command returns all objects in a column format.
Use this for visual inspection.

c_list

This command returns a Tcl list of objects. Use this to
convert a collection to a list. You can manipulate a Tcl
list with standard Tcl list commands.

C_union

c_diff

Identifies differences between a list and a collection or
between two or more collections. Use the -print option to
display the results.

c_intersect
Use the -print option to display the results.

c_sub
Use the -print option to display the results.

c_symdiff

Use this to identify unique objects in a list and a
collection, or two or more collections. Use the -print
option to display the results.

© 2020 Synopsys, Inc.
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For information about all SCOPE panels, see SCOPE Tabs, on page 215.

Inputs/Outputs

The Inputs/Outputs panel models the interface of the FPGA with the outside
environment. You use it to specify delays outside the device.

|Enable | DelavT}rpe| Fort | Rise | Fall | Max | Min | Clock | Clock Fall |r\|:||:| Delav| Value | Comment
1
2
3

The Inputs/Outputs panel includes the following options:

Inputs/Outputs

Field Description

Delay Type Specifies whether the delay is an input or output delay.

Port Specifies the name of the port.

Rise Specifies that the delay is relative to the rising transition on

specified port.

Currently, the synthesis tool does not differentiate between
the rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -rise option is preserved and forward annotated to
the place-and-route tool.

Fall Specifies that the delay is relative to the falling transition on
specified port

Currently, the synthesis tool does not differentiate between
the rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -fall option is preserved and forward annotated to
the place-and-route tool.

Max Specifies that the delay value is relative to the longest path.

Note: The -max delay values are reported in the top-level log file
and are forward annotated to the place-and-route tool.
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Field Description

Min Specifies that the delay value is relative to the shortest path.

Note: The synthesis tool does not optimize for hold time

violations and only reports -min delay values in the

synl og/ t opLevel _f pga_napper. srr_M n timing report
section of the log file. The -min delay values are forward

annotated to the place-and-route tool.

Clock Specifies the name of a clock for which the specified delay is
applied. If you specify the clock fall, you must also specify the
name of the clock.

Clock Fall Specifies that the delay relative to the falling edge of the clock.
For examples, see Input Delays, on page 226 and Output
Delays, on page 227.

Add Delay Specifies whether to add delay information to the existing
input delay or overwrite the input delay. For examples, see
Input Delays, on page 226 and Output Delays, on page 227.

Value Specifies the delay path value.

Input Delays
Here is how this constraint applies for input delays:

* Clock Fall - The default is the rising edge or rising transition of a reference
pin. If you specify clock fall, you must also specify the name of the clock.

* Add Delay - Use this option to capture information about multiple paths
leading to an input port relative to different clocks or clock edges.

For example, set_input_delay 5.0 -max -rise -clock phi1 {A} removes all
maximum rise input delay from A, because the -add_delay option is not
specified. Other input delays with different clocks or with -clock_fall are
removed.

In this example, the -add_delay option is specified as set_input_delay 5.0
-max -rise -clock phi1 -add_delay {A}. If there is an input maximum rise delay
for A relative to clock phi1 rising edge, the larger value is used. The
smaller value does not result in critical timing for maximum delay. For
minimum delay, the smaller value is used. If there is maximum rise
input delay relative to a different clock or different edge of the same
clock, it remains with the new delay.
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Output Delays
Here is how this constraint applies for output delays:

* Clock Fall - If you specify clock fall, you must also specify the name of the
clock.

* Add Delay - By using this option, you can capture information about
multiple paths leading from an output port relative to different clocks or
clock edges.

For example, the set_output_delay 5.0 -max -rise -clock phi1 {OUT1} command
removes all maximum rise output delays from OUT1, because the
-add_delay option is not specified. Other output delays with a different
clock or with the -clock_fall option are removed.

In this example, the -add_delay option is specified: set_output_delay 5.0 -max
-rise -clock phi1 -add_delay {Z}. If there is an output maximum rise delay for
Z relative to the clock phi1 rising edge, the larger value is used. The
smaller value does not result in critical timing for maximum delay. For
minimum delay, the smaller value is used. If there is a maximum rise
output delay relative to a different clock or different edge of the same
clock, it remains with the new delay.

Priority of Multiple I/0 Constraints

You can specify multiple input and output delays constraints for the same
I/O port. This is useful for cases where a port is driven by or feeds multiple
clocks. The priority of a constraint and its use in your design is determined
by a few factors:

* The software applies the tightest constraint for a given clock edge, and
ignores all others. All applicable constraints are reported in the timing
report.

* You can apply I/O constraints on three levels, with the most specific
overriding the more global:

— Global (top-level netlist), for all inputs and outputs
— Port-level, for the whole bus

— Bit-level, for single bits
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If there are two bit constraints and two port constraints, the two bit
constraints override the two port constraints for that bit. The other bits
get the two port constraints. For example, take the following constraints:

a[3:0]3 clkl:r
a[3:0]3 clk2:r
a[0]2 clkl:r

In this case, port a[0] only gets one constraint of 2 ns. Ports a[1], a[2], and
a[3] get two constraints of 3 ns each.

* If at any given level (bit, port, global) there is a constraint with a refer-
ence clock specified, then any constraint without a reference clock is
ignored. In this example, the 1 ns constraint on port a[0] is ignored.

a[0]2 clkl:r
a[0]1
See Also
For equivalent Tcl syntax, see:
* set_input_delay, on page 281
* set_output_delay, on page 291

For information about all SCOPE panels, see SCOPE Tabs, on page 215.

Registers

This panel lets the advanced user add delays to paths feeding into/out of
registers, in order to further constrain critical paths. You use this constraint
to speed up the paths feeding a register. See set_reg input_delay, on

page 294, and set_reg output_delay, on page 295 for the equivalent Tcl
commands.

CurrentDesign: | <Top Level - *| |l check Constrants |

Enatle IDeIavT\rpel Register | Route | camment

—
m
H

REgIsters
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The Registers SCOPE panel includes the following fields:

Field Description

Enabled (Required) Turn this on to enable the constraint.

Delay Type (Required) Specifies whether the delay is an input or output
delay.

Register (Required) Specifies the name of the register. If you have

initialized a compiled design, you can choose from the
pull-down list.

Route (Required) Improves the speed of the paths to or from the
register by the given number of nanoseconds. The value shrinks
the effective period for the constrained registers without
affecting the clock period that is forward-annotated to the
place-and-route tool.

Comment Lets you enter comments that are included in the constraints
file.
Delay Paths
Use the Delay Paths panel to define the timing exceptions.
Enak | DclowTwee | From | Thoush | ™ | MaxDoay | St | SwtEd | Crdes | Corment |
O - L]
Mulicyde !

False

Max Delay
Aeset Path
Dratapath Only

Dielay Paths
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The Path Delay panel includes the following options:

Field Description

Delay Type Specifies the type of delay path you want the synthesis tool to
analyze. Choose one of the following types:

¢ Multicycle

¢ False

e Max Delay

* Reset Path

¢ Datapath Only

From Starting point for the path. From points define timing start
points and can be defined for clocks (c:), registers (i:), top-level
input or bi-directional ports (p:), black box output pins (i:) or
sequential cell clock pins. For details, see the following:

* Defining From/To/Through Points for Timing Exceptions
¢ Naming Rule Syntax Commands, on page 295

Through Specifies the intermediate points for the timing exception.
Intermediate points can be combinational nets (n:),
hierarchical ports (t:), or instantiated cell pins (t:). If you click
the arrow in a column cell, you open the Product of Sums (POS)
interface where you can set through constraints. For details, see
the following:

* Product of Sums Interface
¢ Defining From/To/Through Points for Timing Exceptions
* Naming Rule Syntax Commands, on page 295

To Ending point of the path. To points must be timing end points
and can be defined for clocks (c:), registers (i:), top-level output
or bi-directional ports (p:), or black box input pins (i:). For
details, see the following:

¢ Defining From/To/Through Points for Timing Exceptions
* Naming Rule Syntax Commands, on page 295

Max Delay Specifies the maximum delay value for the specified path in
nanoseconds.
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Field Description

Setup Specifies the setup (maximum delay) calculations used for
specified path.

Start/End Used for multicycle paths with different start and end clocks.
This option determines the clock period to use for the
multiplicand in the calculation for clock distance. If you do not
specify a start or end clock, the end clock is the default.

Cycles Specifies the number of cycles required for the multicycle
path.

See Also
* For equivalent Tcl syntax, see:
— set_multicycle_path, on page 287
— set_false path, on page 278

— set_max_delay, on page 284

reset_path, on page 266

* For more information on timing exception constraints and how the tool
resolves conflicts, see:

— Delay Path Timing Exceptions, on page 242

— Conlflict Resolution for Timing Exceptions, on page 255

* For information about all SCOPE panels, see SCOPE Tabs, on page 215.
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Attributes

You can assign attributes directly in the editor.

l:IEnabIed Object Type Obiject Attribute Yalue | val Type
1 output_port | <global= syn_noclockbuf -
syvn_clean_resst B
z svn_dspstyle
svn_edif_bit_format
3 svn_edif_scalar_Format
syn_forwaronstrainks ——
4 svn_mulkstyle
svn_netlisk_hierarchy
= SyN_Noarrayvporks
sy _noclockbuf
| syn_ramstyle = —

Here are descriptions for the Attributes columns:

Column
Enabled
Object Type

Object

Attribute

Value

© 2020 Synopsys, Inc.
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Description
(Required) Turn this on to enable the constraint.

Specifies the type of object to which the attribute is assigned.
Choose from the pull-down list, to filter the available choices
in the Object field.

(Required) Specifies the object to which the attribute is
attached. This field is synchronized with the Attribute field, so
selecting an object here filters the available choices in the
Attribute field.

(Required) Specifies the attribute name. You can choose from
a pull-down list that includes all available attributes for the
specified technology. This field is synchronized with the Object
field. If you select an object first, the attribute list is filtered. If
you select an attribute first, the Synopsys FPGA synthesis
tool filters the available choices in the Object field. You must
select an attribute before entering a value.

If a valid attribute does not appear in the pull-down list,
simply type it in this field and then apply appropriate values.

(Required) Specifies the attribute value. You must specify the
attribute first. Clicking in the column displays the default
value; a drop-down arrow lists available values where
appropriate.
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Val Type

Description

Comment

Specifies the kind of value for the attribute. For example, string
or boolean.

Contains a one-line description of the attribute.

Lets you enter comments about the attributes.

Enter the appropriate attributes and their values, by clicking in a cell and
choosing from the pull-down menu.

To specify an object to which you want to assign an attribute, you may also
drag-and-drop it from the RTL or Technology view into a cell in the Object
column. After you have entered the attributes, save the constraint file and
add it to your project.

See Also
For information about all SCOPE panels, see SCOPE Tabs, on page 215.

I/0 Standards

You can specify a standard I/O pad type to use in the design. Define an I/O
standard for any port appearing in the I/O Standards panel.

|End:||cd Port Tyoe L Stendard bl | [WZ | dew Rate | Crive Srenath | Termingtion | Cescripkion| * |
1 A <inpat defolks inpus |LWCMODE_15 Fask B palup 1.5 valk- £,
z |~ Zoutput defauk = autput
3 | <hidr default = bidir
L8 | iBsELn inpue :
Al I Kl
0 Stardards

Field Description

Enabled (Required) Turn this on to enable the constraint, or off to
disable a previous constraint.

Port (Required) Specifies the name of the port. If you have
initialized a compiled design, you can select a port name from
the pull-down list. The first two entries let you specify global
input and output delays, which you can then override with
additional constraints on individual ports.
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Type (Required) Specifies whether the delay is an input or output
delay.

I/O Standard Supported I/0O standards by Synopsys FPGA products. See
Industry I/O Standards, on page 239 for a description of the
standards.

Slew Rate The values for these parameters are based on the selected

Drive Strength I/0 standard.

Termination

Power

Schmitt

Description Describes the selected I/O Standard.

Comment Enter comments about an I/O standard.

See Also

* The Tcl equivalent of this constraint is define_io_standard.

* For information about all SCOPE panels, see SCOPE Tabs, on page 215.

Compile Points

Use the Compile Points panel to specify compile points in your design, and to
enable/disable them. This panel, available only if the device technology
supports compile points, is used to define a top-level constraint file.

\:I Enabled Madule Type Comment ﬂ
1 =
= ilocked ]
locked, partition
soft
3 hard
black_box -
: 8
Compile Points
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Here are the descriptions of the fields in the Compile Points panel.

Field Description
Enabled (Required) Turn this on to enable the constraint.
Module (Required) Specifies the name of the compile-point module.

You must specify a view module, with a v: prefix to identify
the module as a view. For example: v:alu.

Type (Required) Specifies the type of compile point:

* locked (default) - no timing reoptimization is done on the
compile point. The hierarchical interface is unchanged
and an interface logic model is constructed for the
compile point.

* locked, partition - locked compile point, for which compile
point information is forward annotated to the place and
route tool. This mode provides place and route runtime
advantages and allows for obtaining stable results for a
completed design.

* soft - compile point is included in the top-level synthesis,
boundary optimizations can occur.

* hard - compile point is included in the top-level synthesis,
boundary optimizations can occur, however, the
boundary remains unchanged. Although, the boundary is
not modified, instances on both sides of the boundary
can be modified using top-level constraints.

For details, see Compile Point Types, on page 439 in the
User Guide.

Comment Lets you enter a comment about the compile point.

Constraints for Compile Points

You can set constraints at the top-level or for modules to be used as the
compile points from the Current Design pull-down menu shown below. Use the
Compile Points tab to select compile points and specify their types.
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Current Degign: | <Top Lavels [»] | cneck canctrants |
PR
| | Enble | work IN5_RO . | | Type Comment
wark.aly
E work.data_muo
work.ins_d=mod=
3 work.io
work.mult
I work.preod —
Wk prgm _anlr |k
E warkareg_fie bl |
S
B
7
B |
I |
Compir Foints
See Also

The Tcl equivalent is define_compile_point.

For more information on compile points and using the Compile Points
panel, see Compile Point Synthesis, on page 449 in the User Guide.

For information about all SCOPE panels, see SCOPE Tabs, on page 215.
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TCL View

The TCL View is an advanced text file editor for defining FPGA timing and

design constraints.

Current Desgn: | <Too Level» =] |'ylcheck Corstraints
146 [4' | E
147 sst_rol_rf_names {2} Marne -
148 st gfrs [deflme_eollection [find -seg -hier {g&l+] Bt FDC Constrairts
49 ==t £ _max 150 bus_dimension_separat...
150 crest=_clock {clks} [get_ports [clkal] 10 -ws bus_naming_stylz
151 cre=te clock {clkb} [get_porta [=lkbl] E.EEEE create_cleck
152 ==t _zinput_delay lg=t_clocks [czlkal] —add creste_generated_clock
155 act output dalay [get_clocks [elka]] 0.0d define_attnbute
154 act input delay [g=t_elocks [olkal] Z.00 dr:ﬁne_compile pcint
155 act_inmput_dselay [get_elooka [olkal] o [gs dr:ﬂne:glnl: al_a;tribme L
:;f_ “‘Il “29‘ ete e ) ) define_io_standard
53 I :' B_pETh smip ' define_scope_collection
159 [get_pocts read_sdc
&0 [a* % reset_path
©1 B A seb_clock_groups =
162 14 seb_clock_latency e
Tz “to 4 P I
164 [find —seg -hisr [g7[*1} 1 Consiraint Syntax:
o o set_rt_ff_names
166 a=t_molcicycle_path 3 value =string vaues
167 -from
168 [find -=eq {*y*.g[*1} 1]
169
10 s=t_clock_groups defauls_clkgrocug D \ ~
7 -group [get_clocks {clkas dem|elkl derived clock dom|clk |-
A [41]¢
Ade syntaxtzp | Ln| 1 ool 1 ol 173

Click on Hide Syntax Help
to close this browser

This text editor provides the following capabilities:

* Uses dynamic keyword expansion and tool tips for commands that

— Automatically completes the command from a popup list

— Displays complete command syntax as a tool tip

— Displays parameter options for the command from a popup list

Includes a keyword command syntax help

* Checks command syntax and uses color indicators that

— Validate commands and command syntax

— Identifies FPGA design constraints and SCOPE legacy constraints

Synplify Pro for Microsemi Edition Command Reference
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* Allows for standard editor commands, such as copy, paste,
comment/un-comment a group of lines, and highlighting of keywords

For information on how to use this Tcl text editor, see Using the TCL View of
SCOPE GUI, on page 126.

See Also
* For Tcl timing constraint syntax, see Timing Constraints, on page 259.
* For Tcl design constraint syntax, see Design Constraints, on page 298.

* You can also use the SCOPE editor to set attributes.
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Industry 1/O Standards

The synthesis tool lets you specify a standard I/O pad type to use in your

design. You can define an I/O standard for any port supported from the
industry standard and proprietary I/O standards.

For industry I/O standards, see Industry I/O Standards, on page 239.

Industry I/O Standards

The following table lists industry I/O standards.

I/0 Standard

BLVDS_25
CTT

DIFF_HSTL_15_Class_I

DIFF_HSTL_15_Class_II

DIFF_HSTL_18_Class_I

DIFF_HSTL_18_Class_II

DIFF_SSTL_18_Class_II

DIFF_SSTL_2_Class_I

DIFF_SSTL_2_Class_II

Description

Bus Differential Transceiver

Center Tap Terminated - EIA/JEDEC Standard JESD8-4

1.5 volt - Differential High Speed Transceiver Logic
- EIA/JEDEC Standard JESDS8-6

1.5 volt - Differential High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.8 volt - Differential High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-9A

1.8 volt - Differential High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-9A

1.8 volt - Differential Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-6

2.5 volt - Pseudo Differential Stub Series
Terminated Logic - EIA/JEDEC Standard JESD8-9A

2.5 volt - Pseudo Differential Stub Series
Terminated Logic - EIA/JEDEC Standard JESD8-9A

GTL Gunning Transceiver Logic

- EIA/JEDEC Standard JESD8-3
GTL+ Gunning Transceiver Logic Plus
GTL25 Gunning Transceiver Logic

- EIA/JEDEC Standard JESD8-3
GTL+25 Gunning Transceiver Logic Plus
GTL33 Gunning Transceiver Logic

- EIA/JEDEC Standard JESD8-3
GTL+33 Gunning Transceiver Logic Plus
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1/0 Standard
HSTL 12

HSTL_15_Class_II
HSTL_18_Class_I
HSTL_18_Class_II
HSTL_18_Class_III
HSTL_18_Class_IV
HSTL_Class_I
HSTL_Class_II
HSTL_Class_III
HSTL_Class_IV

HyperTransport

© 2020 Synopsys, Inc.
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Description
1.2 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.8 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.8 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.8 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.8 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

2.5 volt - Hypertransport - HyperTransport Consortium
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I/0 Standard

LVCMOS_12
LVCMOS_15
LVCMOS_18
LVCMOS_25
LVCMOS_33
LVCMOS_5
LVDS
LVDSEXT 25
LVPECL
LVTTL
MINI_LVDS

PCI33
PCI66
PCI-X_133

PCML
PCML_12
PCML_14
PCML_15
PCML_25
RSDS

SSTL_18_Class_I
SSTL_18_Class_II
SSTL_2_Class_I
SSTL_2_Class_II

SSTL_3_Class_I

SSTL_3_Class_II

ULVDS_25

Synplify Pro for Microsemi Edition Command Reference
January 2020

Description

1.2 volt - EIA/JEDEC Standard JESD8-16

1.5 volt - EIA/JEDEC Standard JESD8-7

1.8 volt - EIA/JEDEC Standard JESD8-7

2.5 volt - EIA/JEDEC Standard JESD8-5

3.3 volt CMOS - EIA/JEDEC Standard JESD8-B
5.0 volt CMOS

Differential Transceiver - ANSI/TIA/EIA-644-95
Differential Transceiver

Differential Transceiver - EIA/JEDEC Standard JESD8-2
3.3 volt TTL - EIA/JEDEC Standard JESD8-B
Mini Differential Transceiver

3.3 volt PCI 33MHz - PCI Local Bus Spec. Rev. 3.0
(PCI Special Interest Group)

3.3 volt PCI 66MHz - PCI Local Bus Spec. Rev. 3.0
(PCI Special Interest Group)

3.3 volt PCI-X - PCI Local Bus Spec. Rev. 3.0
(PCI Special Interest Group)

3.3 volt - PCML
1.2 volt - PCML
1.4 volt - PCML
1.5 volt - PCML
2.5 volt - PCML
Reduced Swing Differential Signalling

1.8 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-15

1.8 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-15

2.5 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-9B

2.5 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-9B

3.3 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-8

3.3 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-8

Differential Transceiver
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Delay Path Timing Exceptions

For details about the following path types, see:
¢ Multicycle Paths, on page 242
* False Paths, on page 245

Multicycle Paths

Multicycle paths lets you specify paths with multiple clock cycles. The
following table defines the parameters for this constraint. For the equivalent
Tcl constraints, see set_multicycle_path, on page 287. This section describes
the following:

* Multi-cycle Path with Different Start and End Clocks, on page 242

¢ Multicycle Path Examples, on page 243

Multi-cycle Path with Different Start and End Clocks

The start/end option determines the clock period to use for the multiplicand in
the calculation for required time. The following table describes the behavior of
the multi-cycle path constraint using different start and end clocks. In all
equations, n is number of clock cycles, and clock distance is the default,
single-cycle relationship between clocks that is calculated by the tool.

Basic required time for a multi-cycle path clock_distance + [(n-1) * end_clock_period]
Required time with no end clock defined  clock_distance + [(n-1) * global_period]

Required time with -start option defined clock_distance + [(n-1) * start_clock_period]

Required time with no start clock defined clock_distance + [(n-1) * global_period]
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If you do not specify a start or end option, by default the end clock is used for
the constraint. Here is an example:

| Jenatted| etz Type Fram o Thiough | Start/End | cydes | Max Delayins) | commers [+

|j 3] Multicyele End = _I

E Start

3

:
| Deley Paths J

Multicycle Path Examples

Multicycle Path Example 1

If you apply a multicycle path constraint from D1 to D2, the allowed time is
#cycles x normal time between D1 and D2. In the following figure, CLK1 has a
period of 10 ns. The data in this path has only one clock cycle before it must
reach D2. To allow more time for the signal to complete this path, add a
multiple-cycle constraint that specifies two clock cycles (10 x 2 or 20 ns) for
the data to reach D2.

required time required time
e—10ns —r: T4—20ns —p"
E H H
i u2 az a1 ¢ X po
_I_Dﬂ_g D1 —pa Q D2 az
b aas
CLK1 CLK1 l_
wilhout corstraint wilh multiple-cycle path=2
CLK1

1. - —— ] -

{multiple-cyele path=2)
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Multicycle Path Example 2

The design has a multiplier that multiplies signal_a with signal_b and puts the
result into signal_c. Assume that signal_a and signal_b are outputs of registers
register_a and register_b, respectively. The RTL view for this example is shown
below. On clock cycle 1, a state machine enables an input enable signal to
load signal_a into register_a and signal_b into register_b. At the beginning of clock
cycle 2, the multiply begins. After two clock cycles, the state machine enables
an output_enable signal on clock cycle 3 to load the result of the multiplication
(signal_c) into an output register (register_c).

——t

(1.0l oIv ol 1707 § 70 — b
register_a[7:0]

; S
register_c_9[15:0] register_c]15:0]

m—lﬂl—-.r I et

register_b[7:0]

The design frequency goal is 50 MHz (20 ns) and the multiply function takes
35 ns, but it is given 2 clock cycles. After optimization, this 35 ns path is
normally reported as a timing violation because it is more than the 20 ns
clock-cycle timing goal. To avoid reporting the paths as timing violations, use
the SCOPE window to set 2-cycle constraints (From column) on register_a and
register_b, or include the following in the timing constraint file:

# Paths fromregister_a use 2 clock cycles
set multicycle path -fromregister_a 2

# Paths fromregister_b use 2 clock cycles
set multicycle path -fromregister b 2

Alternatively, you can specify a 2-cycle SCOPE constraint (To column) on
register_c, or add the following to the constraint file:

# Paths to register_c use 2 clock cycles
set_ multicycle path -to register_c 2

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
244 Synopsys Confidential Information January 2020



Delay Path Timing Exceptions Constraint Commands

False Paths

You use the Delay Paths constraint to specify clock paths that you want the
synthesis tool to ignore during timing analysis and assign low (or no) priority
during optimization. The equivalent Tcl constraint is described in set_false_-
path, on page 278.

This section describes the following:
* Types of False Paths, on page 245
* False Path Constraint Examples, on page 246

Types of False Paths

A false path is a path that is not important for timing analysis. There are two
types of false paths:

* Architectural false paths

These are false paths that the designer is aware of, like an external reset
signal that feeds internal registers but which is synchronized with the
clock. The following example shows an architectural false path where
the primary input x is always 1, but which is not optimized because the
software does not optimize away primary inputs.

* Code-introduced false paths

These are false paths that you identify after analyzing the schematic.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 245



Constraint Commands Delay Path Timing Exceptions

False Path Constraint Examples

In this example, the design frequency goal is 50 MHz (20ns) and the path
from register_a to register_c is a false path with a large delay of 35 ns. After
optimization, this 35 ns path is normally reported as a timing violation
because it is more than the 20 ns clock-cycle timing goal. To lower the
priority of this path during optimization, define it as a false path. You can do
this in many ways:

¢ [If all paths from register_a to any register or output pins are not
timing-critical, then add a false path constraint to register_a in the
SCOPE interface (From), or put the following line in the timing constraint
file:

#Paths fromregister_a are ignored
set false path -from{i:register_a}

¢ If all paths to register_c are not timing-critical, then add a false path
constraint to register_c in the SCOPE interface (To), or include the
following line in the timing constraint file:

#Paths to register_c are ignored
set false path -to {i:register_c}

* If only the paths between register_a and register_c are not timing-critical,
add a From/To constraint to the registers in the SCOPE interface (From
and To), or include the following line in the timing constraint file:

#Paths to register_c are ignored
set false path -from{i:register_a} -to {i:register_c}
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Specifying From, To, and Through Points

The following section describes from, to, and through points for timing excep-
tions specified by the multicycle paths, false paths, and max delay paths
constraints.

* Timing Exceptions Object Types, on page 247
* From/To Points, on page 247

* Through Points, on page 249

* Product of Sums Interface, on page 250

* Clocks as From/To Points, on page 253

Timing Exceptions Object Types
Note the following timing exceptions for object types:

* Timing exceptions must contain the type of object in the constraint
specification. You must explicitly specify an object type, n: for a net, or i
for an instance, in the instance name parameter of all timing exceptions.
For example:

set_mlticycle_path -from{i:inst2.loweg_output|[7]}
-to {i:instl. DATAO[7]} 2

If you use the SCOPE GUI to specify timing exceptions, it automatically
attaches the object type qualifier to the object name.

* When defining constraints for the fdc file from the Tcl View window in
SCOPE, it is recommended you use get_* as the object type qualifier.

For example, use get_ports, get_nets, get pins, or get_cells instead of p:, ni, t;,
ori.

From/To Points

From specifies the starting point for the timing exception. To specifies the
ending point for the timing exception. When you specify an object, use the
appropriate prefix (see syn_black box, on page 29) to avoid confusion. The
following table lists the objects that can serve as starting and ending points:
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From Points

Clocks. See Clocks as From/To Points,
on page 253 for more information.

Registers
Top-level input or bi-directional ports

Instantiated library primitive cells (gate
cells)

Black box outputs

To Points

Clocks. See Clocks as From/To Points,
on page 253 for more information.

Registers
Top-level output or bi-directional ports

Instantiated library primitive cells (gate
cells)

Black box inputs

You can specify multiple from points in a single exception. This is most
common when specifying exceptions that apply to all the bits of a bus. For
example, you can specify constraints From A[0:15]to B - in this case, there is an
exception, starting at any of the bits of A and ending on B.

Similarly, you can specify multiple to points in a single exception. If you
specify both multiple starting points and multiple ending points such as From
AJ0:15] to B[0:15], there is actually an exception from any start point to any end
point. In this case, the exception applies to all 16 * 16 = 256 combinations of

start/end points.
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Through Points

Through points are limited to nets, hierarchical ports, and pins of instanti-
ated cells. There are many ways to specify these constraints.

* Single Point

* Single List of Points

* Multiple Through Points
* Multiple Through Lists

You define these constraints in the appropriate SCOPE panels, or in the POS
GUI (see Product of Sums Interface, on page 250). When a port and net have
the same name, preface the name of the through point with n: for nets or t: for
hierarchical ports. For example, you can specify n:regs_mem[2] or t:dmux.bdpol.
The n: prefix must be specified to identify nets; otherwise, the associated
timing constraint will not be applied for valid nets.

Single Point

You can specify a single through point. In this case, the constraint is applied to
any path that passes through net regs_mem[2] as follows:

set _fal se_path -through n:regs_nenj 2]
set _false path -through [get nets {regs_nenj2]}]

Single List of Points

If you specify a list of through points, the through option behaves as an OR
function and applies to any path that passes through any of the points in the
list. In the following example, the constraint is applied to any path through
regs_mem[2] OR prgcntr.pc[7] OR dmux.alub[0] with a maximum delay value of 5
ns (-max 5):

set _max_del ay
-through {t:regs_menj2] t:prgcntr.pc[7] t:dmux.alub[0]} 5
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Multiple Through Points

You can specify multiple points for the same constraint by preceding each
point with the -through option. In the following example, the constraint
operates as an AND function and applies to paths through regs_mem[2] AND
prgentr.pc[7] AND dmux.alub[0]:

set _max_del ay

-through t:regs_nenj 2]
-through t:prgcntr. pc[ 7]
-t hrough t:dnux.al ub[0] 5

Multiple Through Lists

If you specify multiple -through lists, the constraint is applied as an AND/OR
function and is applied to the paths through all points in the lists. The
following constraint applies to all paths that pass through nets {A; or A,
or...A,} AND nets {B; or B, or B3}:

set_fal se_path -through {n: Ay n: A,...n: A} -through {n:B; n: B, n: By}
In this example,

set_multicycle_path
-through {n:netl n:net2}
-through {n:net3 n:net4} 2

all paths that pass through the following nets are constrained at 2 clock
cycles:

netl AND net3

CR netl AND net 4
CR net2 AND net 3
CR net2 AND net 4

Product of Sums Interface

You can use the SCOPE GUI to format -through points for nets with multicycle
path, false path, and max delay path constraints in the Product of Sums (POS)

interface of the SCOPE editor. You can also manually specify constraints that
use the -through option. For more information, see Defining From/To/Through
Points for Timing Exceptions, on page 132 in the User Guide.
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The POS interface is accessible by clicking the arrow in a Through column cell
in the following SCOPE panels:

* Multi-Cycle Paths
* False Paths

* Delay Paths

Editing POS throughs for row 1 e |
| Surm 1 Sum 2 Sum 3 | Sum 4 Sum S Sum & Sum 7 [;
Prod 1 L
Prod 2
Prod 3
Prod 4
Y
Prod 5 -
‘] | KA
Drag and Drop: Drag and Drop goes:
@ Inserts Mew Cells ® Along Row
Crverwrites Cells Down Column

Field Description

Prod 1, 2, etc. Type the first net name in a cell in a Prod row, or drag the
net from a HDL Analyst view into the cell. Repeat this
step along the same row, adding other nets in the Sum
columns. The nets in each row form an OR list.

Sum 1, 2, etc. Type the first net name in the first cell in a Sum column,
or drag the net from a HDL Analyst view into the cell.
Repeat this step down the same Sum column. The nets in
each column form an AND list.
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Drag and Drop Goes

Drag and Drop

Save/Cancel

© 2020 Synopsys, Inc.
252

Along Row - places objects in multiple Sum columns,
utilizing only one Prod row.

Down Column - places objects in multiple Prod rows, utilizing
only one Sumcolumn.

Inserts New Cells - New cells are created when dragging and
dropping nets.

Overwrites Cells - Existing cells are overwritten when
dragging and dropping nets.

Saves or cancels your session.
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Clocks as From/To Points

You can specify clocks as from/to points in your timing exception constraints.
Here is the syntax:

set_timing_exception -from | -to {c:clock_name [:edge]}
where

* timing_exception is one of the following constraint types: multicycle path,
false path, or max delay

* c:clock_name:edge is the name of the clock and clock edge (r or f). If you do
not specify a clock edge, by default both edges are used.

See the following sections for details and examples on each timing exception.

Multicycle Path Clock Points

When you specify a clock as a from or to point, the multicycle path constraint
applies to all registers clocked by the specified clock.

The following constraint allows two clock periods for all paths from the rising
edge of the flip-flops clocked by clk1:

set_multicycle path -from{c:clkl:r} 2

You cannot specify a clock as a through point. However, you can set a
constraint from or to a clock and through an object (net, pin, or hierarchical
port). The following constraint allows two clock periods for all paths to the
falling edge of the flip-flops clocked by clk1 and through bit 9 of the hierar-
chical net:

set_multicycle path -to {c:clkl:f} -through (n: Ml NST. nybus2[9]} 2
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False Path Clock Points

When you specify a clock as a from or to point, the false path constraint is set
on all registers clocked by the specified clock. False paths are ignored by the
timing analyzer. The following constraint disables all paths from the rising
edge of the flip-flops clocked by clk1:

set false path -from{c:clkl:r}

You cannot specify a clock as a through point. However, you can set a
constraint from or to a clock and through an object (net, pin, or hierarchical
port). The following constraint disables all paths to the falling edge of the
flip-flops clocked by clk1 and through bit 9 of the hierarchical net.

set false path -to {c:clkl:f} -through (n: MYl NST. nybus2[ 9]}

Path Delay Clock Points

When you specify a clock as a from or to point for the path delay constraint,
the constraint is set on all paths of the registers clocked by the specified
clock. This constraint sets a max delay of 2 ns on all paths to the falling edge
of the flip-flops clocked by clk1:

set_max_delay -to {c:clkl:f} 2

You cannot specify a clock as a through point, but you can set a constraint
from or to a clock and through an object (net, pin, or hierarchical port). The
next constraint sets a max delay of 0.2 ns on all paths from the rising edge of
the flip-flops clocked by clk1 and through bit 9 of the hierarchical net:

set_nax_delay -from{c:clkl:r} -through (n: MW NST. nybus2[9]}. 2
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Conflict Resolution for Timing Exceptions

The term timing exceptions refers to the false path, max path delay, and
multicycle path timing constraints. When the tool encounters conflicts in the
way timing exceptions are specified through the constraint file, the software
uses a set priority to resolve these conflicts. Conflict resolution is categorized
into four levels, meaning that there are four different tiers at which conflicting
constraints can occur, with one being the highest. The table below summa-
rizes conflict resolution for constraints. The sections following the table
provide more details on how conflicts can occur and examples of how they are
resolved.

Conflict Constraint Conflict Priority For Details, see ...
Level

1 Different timing 1 - False Path Conflicting Timing
exceptions set on the 2 - Path Delay Exceptions, on
same object. 3 - Multi-cycle Path page 256.

2 Timing exceptions of 1 - From Same Constraint
the same constraint 2 - To Type with Different
type, using different Semantics, on
semantics S - Through page 257.
(from/to/through).

3 Timing exceptions of 1 - Ports/Instances/Pins Same Constraint
the same constraint 2 - Clocks and Semantics with
type using the same Different Objects,
semantic, but set on on page 258.
different objects.

4 Identical timing Tightest, or most Identical

Constraints with
Different Values, on
page 258.

constraints, except constricting constraint.

constraint values differ.

In addition to the four levels of conflict resolution for timing exceptions, there
are priorities for the way the tool handles multiple I/O delays set on the same
port and implicit and explicit false path constraints. For information on
resolving these types of conflicts, see Priority of Multiple I/O Constraints, on
page 227.
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Conflicting Timing Exceptions

The first (and highest) level of resolution occurs when timing exceptions—
false paths, max path delay, or multicycle path constraints—conflict with
each other. The tool follows this priority for applying timing exceptions:

1. False Path
2. Path Delay
3. Multicycle Path

For example:

A {}7 g C1=3 ns

1 | I

set_false path -from{c: Cl:r}
set_max_delay -from{i: A} -to {i:B} 10
set multicycle path -from{i:A} -to {i:B} 2

These constraints are conflicting because the path from A to B has three
different constraints set on it. When the tool encounters this type of conflict,
the false path constraint is honored. Because it has the highest priority of all
timing exceptions, set false_path is applied and the other timing exceptions are
ignored.

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
256 Synopsys Confidential Information January 2020



Conflict Resolution for Timing Exceptions Constraint Commands

Same Constraint Type with Different Semantics

The second level of resolution occurs when conflicts between timing excep-
tions that are of the same constraint type, use different semantics
(from/to/through). The priority for these constraints is as follows:

1. From
2. To
3. Through

If there are two multicycle constraints set on the same path, one specifying a
from point and the other specifying a to point, the constraint using -from takes
precedence, as in the following example.

I %7 5 C1=3 ns

set_multicycle path -from{i: A 3
set_multicycle path -to {i:B} 2

In this case, the tool uses:
set_multicycle_path -from{i: A} 3

The other constraint is ignored even though it sets a tighter constraint.
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Same Constraint and Semantics with Different Objects

The third level resolves timing exceptions of the same constraint type that use
the same semantic, but are set on different objects. The priority for design
objects is as follows:

1. Ports/Instances/Pins
2. Clocks

If the same constraints are set on different objects, the tool ignores the
constraint set on the clock for that path.

set_multicycle_path -from{i:macl.datax[0]} -start 4
set_multicycle_path -from{c:clkl:r} 2

In the example above, the tool uses the first constraint set on the instance
and ignores the constraint set on the clock from i:mac1.datax[0], even though
the clock constraint is tighter.

For details on how the tool prioritizes multiple I/O delays set on the same
port or implicit and explicit false path constraints, see Priority of Multiple I/O
Constraints, on page 227.

Identical Constraints with Different Values

Where timing constraints are identical except for the constraint value, the
tightest or most constricting constraint takes precedence. In the following
example, the tool uses the constraint specifying two clock cycles:

set multicycle path -from{i:special _regs.trisa[7:0]} 2
set multicycle path -from{i:special regs.trisa[7:0]} 3
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Timing Constraints

The FPGA synthesis tools support FPGA timing constraints for a subset of the
clock definition, I/O delay, and timing exception constraints.

The remainder of this section describes the constraint file syntax for the
following FPGA timing constraints in the FPGA synthesis tools.

create_clock create_generated_clock
reset path
set_clock_groups set_clock_latency

set_clock_uncertainty

set false path

set_input_delay set_max_delay
set_multicycle_path set_output_delay
set_reg_input_delay set_reg_output_delay

Note: When adding comments for constraints, use standard Tcl syntax
conventions. Otherwise, invalid specifications can cause the constraint to be
ignored. The (#) comment must begin on a new line or needs to be preceded
by a (;), if the comment is on the same line as the constraint. For example:

create_clock -period 10 [get _ports CLK]; # comment text

# coment text
set _cl ock_groups -asynchronous -group
MVCM nodul e| ¢l k100_90 MMOM deri ved_cl ock_CLKI NL
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create_clock

Creates a clock object and defines its waveform in the current design.

Syntax

The supported syntax for the create_clock constraint is:

create_clock

-name clockName [-add] {objectList} |
-name clockName [-add] [{objectList}] |
[-name clockName [-add]] {objectList}

-period value

[-waveform {riseValue fallValue}]

[-disable]

[<comment commentString]

Arguments

-name Specifies the name for the clock being created, enclosed in quotation

clockName marks or curly braces. If this option is not used, the clock gets the
name of the first clock source specified in the objectList option. If you
do not specify the objectList option, you must use the -name option,
which creates a virtual clock not associated with a port, pin, or net.
You can use both the -name and objectList options to give the clock a
more descriptive name than the first source pin, port, or net. If you
specify the -add option, you must use the -name option and the clocks
with the same source must have different names.

-add Specifies whether to add this clock to the existing clock or to
overwrite it. Use this option when multiple clocks must be specified
on the same source for simultaneous analysis with different clock
waveforms. When you specify this option, you must also use the
-name option.

-period value Specifies the clock period in nanoseconds. This is the minimum time
over which the clock waveform repeats. The value type must be
greater than zero.
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-waveform Specifies the rise and fall edge times for the clock waveforms of the

riseValue clock in nanoseconds, over an entire clock period. The first time is a

fallValue rising transition, typically the first rising transition after time zero.
There must be two edges, and they are assumed to be rise followed
by fall. The edges must be monotonically increasing. If you do not
specify this option, a default waveform is assumed, which has a rise
edge of 0.0 and a fall edge of periodValue/2.

objectList Clocks can be defined on the following objects: pins, ports, and nets

The FPGA synthesis tools support nets and instances, where
instances have only one output (for example, BUFGs).

-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool honors
textString the annotation and preserves it with the object so that the exact

string is written out when the constraint is written out. The
comment remains intact through the synthesis, place-and-route,
and timing-analysis flows.

Examples

Refer to the following examples.

Example 1

A clock named clk_in1 is created for port clk_in1 that uses a period of 10 with
rising edge of O and falling edge of 5.

create_clock -name {clk_inl} -period 10 [get_ports {cl k_inl}]

Example 2

A clock named clk is created for port clk_in that uses a period of 10.0 with
rising edge of 5.0 and falling edge of 9.5.

create_clock -name {clk} -period 10 -waveform{5.0 9.5}
[get_ports {clk_in}]

Example 3

A virtual clock named CLK is created that uses a period of 12 with a rising
edge of 0.0 and falling edge of 6.0.

create_cl ock -name {CLK} -period 12
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create_generated_clock

Creates a generated clock object.

Syntax
The supported syntax for the create_generated_clock constraint is:

create_generated_clock
-name clockName [-add]] | {clockObject}
-source masterPinName
[-master_clock clockName]
[-divide_by integer | -multiply_by integer [-duty_cycle value]]
[-invert]
[-edges {edgeList}]
[-edge_shift {edgeShiftList}]
[-combinational]
[-disable]
[-comment commentString]

Arguments

-name Specifies the name of the generated clock. If this option is not

clockName used, the clock gets the name of the first clock source specified
in the -source option (clockObject). If you specify the -add option,
you must use the -name option and the clocks with the same
source must have different names.

-add Specifies whether to add this clock to the existing clock or to
overwrite it. Use this option when multiple generated clocks
must be specified on the same source, because multiple clocks
fan into the master pin. Ideally, one generated clock must be
specified for each clock that fans into the master pin. If you
specify this option, you must also use the -name and
-master_clock options.

clockObject The first clock source specified in the -source option in the
absence of clockName. Clocks can be defined on pins, ports, and
nets. The FPGA synthesis tools support nets and instances,
where instances have only one output (for example, BUFGs).
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-source
masterPinName

-master_clock
clockName

-divide_by
integer

-multiply_by
integer

-duty_cycle

percent

-invert

-edges edgelList

-edge_shift
edgeShiftList

-combinational

-disable
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Specifies the master clock pin, which is either a master clock
source pin or a fanout pin of the master clock driving the
generated clock definition pin. The clock waveform at the master
pin is used for deriving the generated clock waveform.

Specifies the master clock to be used for this generated clock,
when multiple clocks fan into the master pin.

Specifies the frequency division factor. If the divideFactor value
is 2, the generated clock period is twice as long as the master
clock period.

Specifies the frequency multiplication factor. If the
multiplyFactor value is 3, the generated clock period is one-third
as long as the master clock period.

Specifies the duty cycle, as a percentage, if frequency
multiplication is used. Duty cycle is the high pulse width.

Note: This option is valid only when used with the -multiply_by
option.

Inverts the generated clock signal (in the case of frequency
multiplication and division).

Specifies a list of integers that represents edges from the source
clock that are to form the edges of the generated clock. The
edges are interpreted as alternating rising and falling edges and
each edge must not be less than its previous edge. The number
of edges must be set to 3 to make one full clock cycle of the
generated clock waveform. For example, 1 represents the first
source edge, 2 represents the second source edge, and so on.

Specifies a list of floating point numbers that represents the
amount of shift, in nanoseconds, that the specified edges are to
undergo to yield the final generated clock waveform. The
number of edge shifts specified must be equal to the number of
edges specified. The values can be positive or negative; positive
indicating a shift later in time, while negative indicates a shift
earlier in time. For example, 1 indicates that the corresponding
edge is to be shifted by one library time unit.

The source latency paths for this type of generated clock only
includes the logic where the master clock propagates. The
source latency paths do not flow through sequential element
clock pins, transparent latch data pins, or source pins of other
generated clocks.

Disables the constraint.
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-comment Allows the command to accept a comment string. The tool

textString honors the annotation and preserves it with the object so that
the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

Examples

Refer to the following examples.

Example 1
A frequency of -divide_by 2 is used for the generated clock.

create _generated_cl ock -name {gen_cl k} -source
[get _pins {DCOWD. CLKO}] [get _pins {BUFGMUX inst.CG] -divide by 2

Example 2

A generated clock is created whose edges are 1, 3, and 5 of the master clock
source. If the master clock period is 30 and the master waveform is {24 30},
then the generated clock period becomes 60 with waveform {24 54;}.

create _generated_cl ock -name {gencl k} -source
[get _ports {clk inl}] [get_nets {dut.clk out2}] -edges {1 3 5}

Example 3

This example shows the generated clock from the previous example with each
derived edge shifted by 1 time unit. If the master clock period is 30 and the
master waveform is {24 36}, then the generated clock period becomes 60 with
waveform {25 55}.

create_generated_cl ock -nane {gencl k}
-source [get_ports {clk_inl}] [get_nets {dut.clk out2}]
-edges {1 3 5} -edge shift {1 1 1}

Example 4

This example shows the generated clock with the same edges as the master
clock, where edge 2 is shifted by 0.8 time unit and edge 3 is shifted by -0.4
time unit. If the master clock period is 4 and the master waveform is {0 2},
then the generated clock period becomes 3.6 and the waveform is {0 2.8}.
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create_generated_cl ock -name {gencl k}
-source [get_ports {clk inl}] [get_nets {dut.clk out?2}]
-edges {1 2 3} -edge shift {0 0.8 -0.4}
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reset_path

Resets the specified paths to single-cycle timing.

Syntax

The supported syntax for the reset path constraint is:

reset_path [-setup]
[-from {objectList}]
[-through {objectList} [-through {objectList} ...] ]
[-to {objectList}]
[-disable]
[-comment commentString]

Arguments

-setup Specifies that setup checking (maximum delay) is reset to
single-cycle behavior.

-from Specifies the names of objects to use to find path start points.
The -from objectList includes:
* Clocks
* Registers
* Top-level input or bi-directional ports)
¢ Black box outputs
¢ Sequential cell clock pins
When the specified object is a clock, all flip-flops, latches, and
primary inputs related to that clock are used as path start
points

© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference

266 Synopsys Confidential Information January 2020



Timing Constraints Constraint Commands

-through Specifies the intermediate points for the timing exception. The
-through objectList includes:
¢ Combinational nets
* Hierarchical ports
* Pins on instantiated cells
By default, the through points are treated as an OR list. The
constraint is applied if the path crosses any points in objectList.
If more than one object is included, the objects must be
enclosed either in quotation marks ("") or in braces ({}). If you
specify the -through option multiple times, reset_path applies to
the paths that pass through a member of each objectList. If you
use the -through option in combination with the -from or -to
options, reset_path applies only if the -from or -to and the -through
conditions are satisfied.

-to Specifies the names of objects to use to find path end points.
The -to objectList includes:

* Clocks

* Registers

* Top-level output or bi-directional ports
¢ Black box inputs

* Sequential cell data input pins

If a specified object is a clock, all flip-flops, latches, and primary
outputs related to that clock are used as path end points.

-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool
textString honors the annotation and preserves it with the object so that

the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.
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set_clock_groups

Specifies clock groups that are mutually exclusive or asynchronous with each
other in a design. Clocks created with create_clock are considered synchro-
nous as long as no set_clock_groups constraints specify otherwise. Paths
between asynchronous clocks are not considered for timing analysis.

Clock grouping in the FPGA synthesis environment is inclusionary or exclu-
sionary. For example, clk2 and clk3 can each be related to clk1 without being
related to each other.

Syntax

set_clock_groups
-asynchronous | -physically_exclusive | -logically_exclusive
[-name clockGroupname]
-group {clockList} [-group {clockList} ... ]
-derive
[-disable]
[-comment commentString]

Arguments

-asynchronous Specifies that the clock groups are asynchronous to each
other (the default assumes all clock groups are
synchronous). Two clocks are asynchronous with respect
to each other if they have no phase relationship at all.

-physically_exclusive  Specifies that the clock groups are physically exclusive to
each other. An example is multiple clocks that are defined
on the same source pin.

Synthesis accepts this option, but treats it as -asynchronous.

-logically_exclusive Specifies that the clock groups are logically exclusive to
each other. An example is multiple clocks that are selected
by a multiplexer, but might have coupling with each other
in the design.

Synthesis accepts this option, but treats it as -asynchronous.

-name Specifies a unique name for a clock grouping. This option

{clockGroupName} allows you to easily identify specified clock groups, which
are exclusive or asynchronous with all other clock groups
in the design.
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-group {clockList} Specifies a space-separated list of clocks in {clockList} that
are asynchronous to all other clocks in the design, or
asynchronous to the clocks specified in other -group
arguments in the same command.

If you specify only one group, the clocks in that group are
exclusive or asynchronous with all other clocks in the
design. Whenever a new clock is created, it is automatically
included in the default “other” group that includes all the
other clocks in the design.

If you specify -group multiple times in a single command
execution, the listed clocks are only asynchronous with the
clocks in the other groups specified in the same command.
You can include a clock in only one group in a single
command execution. To include a clock in multiple groups,
use multiple set _clock_groups commands.

Do not use commas between clock names in the list. See
-group Option, on page 269.

-derive Specifies that generated and derived clocks inherit the
clock group of the parent clock. By default, a generated
clock and its master clock are not in the same group when
the exclusive or asynchronous clock groups are defined.
The -derive option lets you override this behavior and allow
generated or derived clocks to inherit the clock group of
their parent source clock.

-disable Disables the constraint.

-comment textString Allows the command to accept a comment string. The tool
honors the annotation and preserves it with the object so
that the exact string is written out when the constraint is
written out. The comment remains intact through the
synthesis, place-and-route, and timing-analysis flows.

Restrictions

Be aware of the restrictions for the following set_clock_groups options:

-group Option

Do not insert commas between clock names when you use the -group option,
because the tool treats the comma as part of the clock name. This is true for
all constraints that contain lists. This means that if you specify the following
constraint, the tool generates a warning that it cannot find clk1,:

set _cl ock_groups -asynchronous -group {cl k1, clk2}
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Examples

The following examples illustrate how to use this constraint.

Example 1
This set_clock_groups constraint specifies that clk4 is asynchronous to all other
clocks in the design.

set _cl ock_groups -asynchronous -group {cl k4}

Example 2

This set_clock_groups constraint specifies that clock clk1, clk2, and clk3 are
asynchronous to all other clocks in the design. If a new clock called clkx is
added to the design, clk1, clk2, and clk3 are asynchronous to it too.

set _cl ock_groups -asynchronous -group {cl k1l cl k2 cl k3}

Example 3
The following set_clock groups constraint has multiple -group arguments, and
specifies that clk1 and clk2 are asynchronous to clk3 and clk4.

set _cl ock_groups -asynchronous -group {cl k1l cl k2}
-group {cl k3 cl k4}

Example 4

The following set_clock_groups constraint specifies that clk1 and clk2 which were
synchronous when defined with the create_clock command, are now asynchro-
nous.

create clock [get _ports {cl1l}] -nane clkl -period 10

create clock [get _ports {c2}] -nane cl k2 -period 16

create _clock [get_ports {c3}] -nane clk3 -period 5

set _cl ock_groups -asynchronous -group [get _clocks {cl kl}]
-group [get clocks {clk2}]

The following constructs are equivalent:
set _cl ock_groups -asynchronous -group [get_clocks {cl kl}]

set _cl ock_groups -asynchronous -group {cl kl}
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Example 5

The following constraint specifies that test|clkoutO_derived_clock_CLKIN1 and
test|clkout1_derived_clock_CLKIN1 are asynchronous to all other clocks in the
design:

set _cl ock_groups -asynchronous -group [get_cl ocks {*cl kout *}]

Example 6
This example defines the clock on the u1.clkoutO net is asynchronous to all
other clocks in the design:

set _cl ock_groups -asynchronous -group [get_cl ocks -of _objects
{n: ul. cl kout 0}]

Examples of Asynchronous Clocks

Example 1: Multiple -group Arguments for Asynchronous Clock Definition

This method uses multiple -group arguments in one constraint:

set _cl ock_groups -asynchronous -group {clkl clk2} -group {clk3
bcl k4} -group {cl k5 ccl k6}

With this constraint, members of the same group are synchronous, but
relationships between clocks from different groups defined in this constraint
are asynchronous. This has the following implications:

* clk1 and clk2 are synchronous to each other, but asynchronous to clocks
in all other groups defined in this constraint

* clk3 and clk4 are synchronous to each other, but asynchronous to clocks
in all other groups defined in this constraint

* clkb and clk6 are synchronous to each other, but asynchronous to clocks
in all other groups defined in this constraint

Example 2: Single -group Argument for Asynchronous Clock Definition

Asynchronous clocks defined with a single -group argument in a constraint
are asynchronous to all other clocks in the design. You can specify multiple
such constraints. In this example, all six clocks are asynchronous, because
each individual constraint makes that clock asynchronous to all others.
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set _cl ock_groups -asynchronous -group {cl kl}
set _cl ock_groups -asynchronous -group {cl k2}
set _cl ock_groups -asynchronous -group {cl k3}
set _cl ock_groups -asynchronous -group {cl k4}
set _cl ock_groups -asynchronous -group {cl k5}
set _cl ock_groups -asynchronous -group {cl k6}

Examples of Defining Clocks for Clock Muxes

The definition of clocks that are to be muxed together varies slightly,
depending on whether the clocks have the same frequency or not. The
following procedures use this example as an illustration:

ck2 = —0 —
]_. . L
[ i—— —]i clo] o] fe————— Dfd] Qo] F—oun =
clk tmp outl
e

Defining Muxed Clocks with Different Frequencies
If the clocks are asynchronous, separate clock paths must be defined, as
described below.

1. Define the clocks with create_clock constraints.

For the example, two clocks are defined:

create_clock -name {clk1} [get_nets {clk1}] -period 10.0
-waveform {0 5.0}
create_clock -name {clk2} [get_nets {clk2}] -period 10.0 -waveform {0 5.0}

2. Use multiple set_clock_groups constraints to mark them as asynchronous
to each other:

set_clock_groups -derive -asynchronous -name {default_clkgroup_0} -group
[get_clocks {clk1}]

set_clock_groups -derive -asynchronous -name {default_clkgroup_1} -group
[get_clocks {clk2}]

3. Check the timing report.
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For the example, the tool reports two separate clock paths, one for each
clock.

Defining Muxed Clocks with the Same Frequency

If the clocks have the same phase and frequency, follow this procedure to
define the clocks.

1. Define the clock at the net connected to the output pin of the mux.
For example:

create_clock -name {clk} [get_nets {clk}] -period 10.0
-waveform {0 5.0}

2. Define the mux output clock as asynchronous to all other clocks, using
a set_clock_groups constraint:

set_clock_groups -derive -asynchronous -name {default_clkgroup_2} -group
[get_clocks {clk}]

3. Check the timing report.

In this case, there should be a single clock path, instead of separate
paths.
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set_clock_latency

Specifies clock network latency.

Syntax
The supported syntax for the set_clock_latency constraint is:

set_clock_latency
-source
[-clock {clockList}]
delayValue
{objectList}
[-disable]

Arguments

-source Indicates that the specified delay is applied to the clock source
latency.

-clock clockList Indicates that the specified delay is applied with respect to the
specified clocks. By default, the specified delay is applied to all
specified objects.

delayValue Specifies the clock latency value.
objectList Specifies the input ports for which clock latency is to be set
Description

In the FPGA synthesis tools, the set_clock_latency constraint accepts both clock
objects and clock aliases. Applying a set_clock_latency constraint on a port can
be used to model the off-chip clock delays in a multi-chip environment.

In the above syntax, objectList references either input ports with defined
clocks or clock aliases defined on the input ports. When more than one clock
is defined for an input port, the -clock option can be used to apply different
latency values to each alias.

Restrictions

The following limitations are present in the FPGA synthesis environment:
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* Clock latency can only be applied to clocks defined on input ports.
* The set_clock_latency constraint is only used for source latency.
* The constraint only applies to port clock objects.

* Latency on clocks defined with create_generated_clock is not supported.
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set_clock_uncertainty

Specifies the uncertainty (skew) of the specified clock networks.

Syntax

The supported syntax for the set_clock_uncertainty constraint is:

set_clock_uncertainty

{objectList}

-from fromClock |-rise_from riseFromClock | -fall_from fallFromClock
-to toClock |-rise_to riseToClock | -fall_to fallToClock

value

Arguments

objectList

-from fromClock

-rise_from
riseFromClock

-fall_from
fallFromClock

-to toClock

-rise_to
riseToClock
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Specifies the clocks for simple uncertainty. The uncertainty is
applied to the capturing latches clocked by one of the specified
clocks. You must specify either this argument or a clock pair
with the -from/-rise_from/-fall_from and -to/-rise_to/-fall_to options;
you cannot specify both an object list and a clock pair.

Specifies the source clocks for interclock uncertainty. You can
use only one of the -from, -rise_from, and -fall_from options and you
must specify a destination clock with one of the -to, -rise_to, and
-fall_to options.

Specifies that the uncertainty applies only to the rising edge of
the source clock. You can use only one of the -from, -rise_from,
and -fall_from options and you must specify a destination clock
with one of the -to, -rise_to, and -fall_to options.

Specifies that the uncertainty applies only to the falling edge of
the source clock. You can use only one of the -from, -rise_from,
and -fall_from options and you must specify a destination clock
with one of the -to, -rise_to, and -fall_to options.

Specifies the destination clocks for interclock uncertainty. You

can use only one of the -to, -rise_to, and -fall_to options and you

must specify a source clock with one of the -from, -rise_from, and
-fall_from options.

Specifies that the uncertainty applies only to the rising edge of
the destination clock. You can use only one of the -to, -rise_to,
and -fall_to options and you must specify a source clock with one
of the -from, -rise_from, and -fall_from options.
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-fall_to fallToClock Specifies that the uncertainty applies only to the falling edge of
the destination clock. You can use only one of the -to, -rise_to,
and -fall_to options and you must specify a source clock with one
of the -from, -rise_from, and -fall_from options.

value Specifies a floating-point number that indicates the uncertainty
value. Only positive uncertainty numbers are acceptable.

Examples

Refer to the following examples.

Example 1

All paths to registers clocked by clk are specified with setup uncertainty of 0.4
in the following example:

set _clock uncertainty 0.4 -setup [get_cl ocks clk]

Example 2
For this example, interclock uncertainties are specified between clock clk and
clk2:

set _clock uncertainty -from[get clocks clk] -to
[get clocks cl k2] 0.2

set _clock uncertainty -from[get clocks clk2] -to
[get _clocks clk] 0.1

Example 3
For this example, interclock uncertainties are specified between clock clk and
clk2 with specific edges:

set _clock uncertainty -rise from[get _clocks clk2] -to
[get _clocks clk] 0.5

set _clock uncertainty -rise from[get _clocks clk2] -rise_to
[get _clocks clk] 0.1

set _clock uncertainty -from[get clocks clk2] -fall _to
[get _clocks clk] 0.1
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set_false path

Removes timing constraints from particular paths.

Syntax

The supported syntax for the set_false_path constraint is:

set_false_path

[-setup]

[-from {objectList}]
[-through {objectList} [-through {objectList} ...] ]
[-to {objectList}]

[-disable]

[-comment commentString]

Arguments

-setup

-from

Specifies that setup checking (maximum delay) is reset to
single-cycle behavior.

Specifies the names of objects to use to find path start points.
The -from objectList includes:
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Clocks

Registers

Top-level input or bi-directional ports
Black box outputs

Sequential cell clock pins

Sequential cell data output pins

When the specified object is a clock, all flip-flops, latches, and
primary inputs related to that clock are used as path start
points.
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-through Specifies the intermediate points for the timing exception. The
-through objectList includes:
¢ Combinational nets
* Hierarchical ports
* Pins on instantiated cells
By default, the through points are treated as an OR list. The
constraint is applied if the path crosses any points in objectList.
If more than one object is included, the objects must be
enclosed either in quotation marks ("") or in braces ({}). If you
specify the -through option multiple times, set_path applies to the
paths that pass through a member of each objectList. If you use
the -through option in combination with the -from or -to options,
set_false_path applies only if the -from or -to and the -through
conditions are satisfied.

-to Specifies the names of objects to use to find path end points.
The -to objectList includes:

* Clocks

* Registers

* Top-level output or bi-directional ports
¢ Black box inputs

* Sequential cell data input pins

If a specified object is a clock, all flip-flops, latches, and primary
outputs related to that clock are used as path end points.

-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool
textString honors the annotation and preserves it with the object so that

the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

Examples

Refer to the following examples.

Example 1

All the paths from the sequential cell output pins and clock pins in module
gen_sub\["\].u_sub with names matching out* (i.e. registers out1 and out2 in
modules gen_sub\[0\].u_sub, gen_sub\[1\].u_sub, and gen_sub\[2\].u_sub) are set as
false paths.
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set_false path -from|[get_pins {gen_sub\[*\]\.u_sub.out*.*}]

Note: Only sequential clock pins are valid pins that can be used as
start points for a timing path. Note that hierarchical module pins
are not valid as starting points for a timing path.

Example 2

All the paths from the sequential cells in module gen_sub\[*\].u_sub with names
matching out® (i.e. registers out1 and out2 in modules gen_sub\[0\].u_sub,
gen_sub\[1\].u_sub, and gen_sub\[2\].u_sub) are set as false paths.

set_false path -from|[get_cells {gen_sub\[*\]\.u_sub. out*}]

Example 3
All paths from top-level input ports with names in* are set as false paths.

set_false path -from[get_ports {in*}]

Note: Only top-level ports are valid port based start points for timing
paths. Do not use the get ports command to reference hierar-
chical module pins.

Example 4
All paths with end points clocked by clock clka are set as false paths.

set false path -to [get_clocks {cl ka}]
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set_input_delay

Sets input delay on pins or input ports relative to a clock signal.

Syntax

The supported syntax for the set_input_delay constraint is:

set_input_delay
[-clock clockName [-clock_fall]]

[-rise|-fall]

[-min|-maXx]
[-add_delay]

delayValue

{portPinList}

[-disable]

[-comment commentString]

Argument

-clock clockName

-clock_fall

-rise
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Specifies the clock to which the specified delay is related. If
-clock_fall is used, -clock clockName must be specified. If -clock is
not specified, the delay is relative to time zero for combinational
designs. For sequential designs, the delay is considered relative
to a new clock with the period determined by considering the
sequential cells in the transitive fanout of each port.

Specifies that the delay is relative to the falling edge of the clock.
The default is the rising edge.

Specifies that delayValue refers to a rising transition on the
specified ports of the current design. If neither -rise nor -fall is
specified, rising and falling delays are assumed to be equal.

Currently, the synthesis tool does not differentiate between the
rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -rise option is preserved and forward annotated to
the place-and-route tool.
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fall

-min

-max

-add_delay

-disable

-comment
textString

delayValue

portPinList
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Specifies that delayValue refers to a falling transition on the
specified ports of the current design. If neither -rise nor -fall is
specified, rising and falling delays are assumed equal.

Currently, the synthesis tool does not differentiate between the
rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -fall option is preserved and forward annotated to
the place-and-route tool.

Specifies that delayValue refers to the shortest path. If neither
-max nor -min is specified, maximum and minimum input delays
are assumed equal.

Note: The synthesis tool does not optimize for hold time
violations and only reports -min delay values in the

synl og/ t opLevel fpga mapper. srr_M n timing report section
of the log file. The -min delay values are forward annotated to the
place-and-route tool.

Specifies that delayValue refers to the longest path. If neither
-max nor -min is specified, maximum and minimum input delays
are assumed equal.

Note: The -max delay values are reported in the top-level log file
and are forward annotated to the place-and-route tool.

Specifies if delay information is to be added to the existing input
delay or if is to be overwritten. The -add_delay option enables you
to capture information about multiple paths leading to an input
port that are relative to different clocks or clock edges.

Disables the constraint.

Allows the command to accept a comment string. The tool
honors the annotation and preserves it with the object so that
the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

Specifies the path delay. The delayValue must be in units
consistent with the technology library used during optimization.
The delayValue represents the amount of time the signal is
available after a clock edge. This represents a combinational
path delay from the clock pin of a register.

Specifies a list of input port names in the current design to
which delayValue is assigned. If more than one object is
specified, the objects are enclosed in quotes ("") or in braces ({}).
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Examples

Refer to the following examples.

Example 1
This example sets an input delay of 1.0 relative to the rising edge of clk.

set_input_delay 1.00 -clock clk [get_ports {dinl din2}]

Example 2
The following example sets an input delay of 1.0 relative to the rising edge of
clk for all inputs in the design.

set_input_delay 1.00 -clock clk [all _inputs]

Example 3

In this scenario, there are two paths to the input port din1. The input delay for
the first path is relative to the rising edge of clk. For the second path, the
input delay is relative to the falling edge of clk. The -add_delay option indicates
that the new input delay information does not cause old information to be
removed.

set _input_delay 1.00 -clock clk [get_ports {dinl}]

set_input_delay 2.00 -clock clk [get_ports {dinl}] -add _del ay
-clock _fall
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set_max_delay

Specifies a maximum delay target for paths in the current design.

Syntax

The supported syntax for the set_max_delay constraint is:

set_max_delay
[-from {objectList}]
[-through {objectList} [-through {objectList} ...] ]
[-to {objectList}]

delayValue
[-disable]

[-comment commentString]

Arguments

-from

© 2020 Synopsys, Inc.
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Specifies the names of objects to use to find path start points.
The -from objectList includes:

e Clocks

* Registers

¢ Top-level input or bi-directional ports

¢ Black box outputs

* Sequential cell clock pins

When the specified object is a clock, all flip-flops, latches, and
primary inputs related to that clock are used as path start
points. All paths from these start points to the end points in the
-from objectList are constrained to delayValue. If a -to objectList is
not specified, all paths from the -from objectList are affected. If

you include more than one object, you must enclose the objects
in quotation marks ("") or braces ({}).
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-through Specifies the intermediate points for the timing exception. The
-through objectList includes:

¢ Combinational nets
e Hierarchical ports
¢ Pins on instantiated cells

By default, the through points are treated as an OR list. The
constraint is applied if the path crosses any points in objectList.
The max delay value applies only to paths that pass through
one of the points in the -through objectList. If more than one
object is included, the objects must be enclosed either in
quotation marks ("") or in braces ({}). If you specify the -through
option multiple times, set_max_delay applies to the paths that
pass through a member of each objectList. If you use the -through
option in combination with the -from or -to options, set_max_delay
applies only if the -from or -to and the -through conditions are
satisfied.

-to Specifies the names of objects to use to find path end points.
The -to objectList includes:

* Clocks

* Registers

* Top-level output or bi-directional ports
¢ Black box inputs

¢ Sequential cell data input pins

If a specified object is a clock, all flip-flops, latches, and primary
outputs related to that clock are used as path end points. All
paths to the end points in the -to objectList are constrained to
delayValue. If a -from objectList is not specified, all paths to the
-to objectList are affected. If you include more than one object,

you must enclose the objects in quotation marks ("") or braces
(6)-
-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool
textString honors the annotation and preserves it with the object so that

the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.
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delayValue Specifies the value of the desired maximum delay for paths
between start and end points. You must express delayValue in
the same units as the technology library used during
optimization. If a path start point is on a sequential device,
clock skew is included in the computed delay. If a path start
point has an input delay specified, that delay value is added to
the path delay. If a path end point is on a sequential device,
clock skew and library setup time are included in the computed
delay. If the end point has an output delay specified, that delay
is added into the path delay.

Examples

Refer to the following example.

Example 1

This example shows how to specify that all paths from cell temp1 to cell temp2
must be less than 4.0 units.

set_max_delay -from[get cells {tenpl}] -to [get cells {tenp2}] 4
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set_multicycle_path

Modifies the single-cycle timing relationship of a constrained path.

Syntax

The supported syntax for the set_multicycle_path constraint is:

set_multicycle_path
[-setup |-hold]
[-start |-end]
[-from {objectList}]
[-through {objectList} [-through {objectList} ...] ]
[-to {objectList}]
pathMultiplier

[-disable]

[-comment commentString]

Arguments

-setup |-hold

-start | -end

Synplify Pro for Microsemi Edition Command Reference
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The option -setup specifies the pathMultiplier to be used for the
setup (maximum delay) calculations.

The option -hold enables you to over-ride the default hold
multiplier—{pathMultiplier — 1}— that is forward annotated to the
vendor constraint file. If you use this option, you must specify
the hold value for each of the defined multicycle constraints.

If you do not provide -setup or -hold, the pathMultiplier is used
for setup.

Specifies if the multi-cycle information is relative to the period of
either the start clock or the end clock. These options are only
needed for multi-frequency designs; otherwise start and end are
equivalent. The start clock is the clock source related to the
register or primary input at the path start point. The end clock
is the clock source related to the register or primary output at
the path endpoint. The default is to move the setup check
relative to the end clock, and the hold check relative to the start
clock. A setup multiplier of 2 with -end moves the relation
forward one cycle of the end clock. A setup multiplier of 2 with
-start moves the relation back one cycle of the start clock. A hold
multiplier of 1 with -start moves the relation forward one cycle of
the start clock. A hold multiplier of 1 with -end moves the
relation back one cycle of the end clock. If you do not provide
-start or -end, -end is assumed.

© 2020 Synopsys, Inc.
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-from Specifies the names of objects to use to find path start points.
The -from objectList includes:
* Clocks
* Registers
¢ Top-level input or bi-directional ports
* Black box outputs
* Sequential cell clock pins
¢ Sequential cell data output pins
When the specified object is a clock, all flip-flops, latches, and
primary inputs related to that clock are used as path start
points. If a -to objectList is not specified, all paths from the -from

objectList are affected. If you include more than one object, you
must enclose the objects in quotation marks (") or braces ({}).

-through Specifies the intermediate points for the timing exception. The
-through objectList includes:

¢ Combinational nets
* Hierarchical ports
¢ Pins on instantiated cells

The multi-cycle values apply only to paths that pass through
one of the points in the -through objectList. If more than one
object is included, the objects must be enclosed either in double
quotation marks ("") or in braces ({}). If you specify the -through
option multiple times, set_multicycle_delay applies to the paths
that pass through a member of each objectList. If the -through
option is used in combination with the -from or -to options, the
multi-cycle values apply only if the -from or -to conditions and
the -through conditions are satisfied.

-to Specifies the names of objects to use to find path end points.
The -to objectList includes:

* Clocks

* Registers

* Top-level output or bi-directional ports
¢ Black box inputs

¢ Sequential cell data input pins

If a specified object is a clock, all flip-flops, latches, and primary
outputs related to that clock are used as path end points. If a
-from objectList is not specified, all paths to the -to objectList are
affected. If you include more than one object, you must enclose
the objects in quotation marks ("") or braces ({})..

-disable Disables the constraint.
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-comment Allows the command to accept a comment string. The tool

textString honors the annotation and preserves it with the object so that
the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

pathMultiplier Specifies the number of cycles that the data path must have,
relative to the start point or end point clock, before data is
required at the end point.

Examples

Refer to the following examples.

Example 1

All the paths from the sequential cell output pins and clock pins in module
gen_sub\[*\].u_sub with names matching out* (i.e. registers out1 and out2 in
modules gen_sub\[0\.u_sub, gen_sub\[1\].u_sub, and gen_sub\[2\].u_sub) provide 2
timing cycles before the data is required at the end point.

set_multicycle_path -from|[get_pins{gen_sub\[*\]\.u_sub.out*.*}] 2

Note: Only sequential clock pins are pins that can be used as valid
start points for a timing path. Note that hierarchical module pins
cannot be used as starting points for a timing path.

Example 2

All the paths from the sequential cells in module gen_sub\[*\].u_sub with names
matching out” (i.e. registers out1 and out2 in modules gen_sub\[0\].u_sub,
gen_sub\[1\].u_sub, and gen_sub\[2\].u_sub) support the timing cycle set to 2.

set_multicycle_path -from[get_cells {gen_sub\[*\]\.u_sub.out*}] 2

Example 3

All paths from top-level input ports with names in* provide 2 timing cycles
before the data is required at the end point.

set_multicycle_path -from[get_ports {in*}] 2
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Note: Only top-level ports are valid port based start points for timing
paths. Do not use the get_ports command to reference hierar-
chical module pins.

Example 4

All paths with end points clocked by clock clka provide 2 timing cycles before
the data is required at the end point.

set_multicycle path -to [get_clocks {clka}] 2
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set_output_delay

Sets output delay on pins or output ports relative to a clock signal.

Syntax

The supported syntax for the set_output_delay constraint is:

set_output_delay
[-clock clockName [-clock_fall]]

[-rise|[-fall]

[-min|-maXx]
[-add_delay]

delayValue

{portPinList}

[-disable]

[-comment commentString]

Arguments

-clock clockName

-clock_fall

-rise

Synplify Pro for Microsemi Edition Command Reference

January 2020

Specifies the clock to which the specified delay is related. If
-clock_fall is used, -clock clockName must be specified. If -clock is
not specified, the delay is relative to time zero for combinational
designs. For sequential designs, the delay is considered relative
to a new clock with the period determined by considering the
sequential cells in the transitive fanout of each port.

Specifies that the delay is relative to the falling edge of the clock.
If -clock is specified, the default is the rising edge.

Specifies that delayValue refers to a rising transition on the
specified ports of the current design. If neither -rise nor -fall is
specified, rising and falling delays are assumed to be equal.

Currently, the synthesis tool does not differentiate between the
rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -rise option is preserved and forward annotated to
the place-and-route tool.
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fall

-min

-max

-add_delay

-disable

-comment
textString

delayValue

© 2020 Synopsys, Inc.
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Specifies that delayValue refers to a falling transition on the
specified ports of the current design. If neither -rise nor -fall is
specified, rising and falling delays are assumed equal.

Currently, the synthesis tool does not differentiate between the
rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -fall option is preserved and forward annotated to
the place-and-route tool.

Specifies that delayValue refers to the shortest path. If neither
-max nor -min is specified, maximum and minimum output
delays are assumed equal.

Note: The synthesis tool does not optimize for hold time
violations and only reports -min delay values in the

synl og/ t opLevel fpga mapper. srr_M n timing report section
of the log file. The -min delay values are forward annotated to the
place-and-route tool.

Specifies that delayValue refers to the longest path. If neither
-max nor -min is specified, maximum and minimum output
delays are assumed equal.

Note: The -max delay values are reported in the top-level log file
and are forward annotated to the place-and-route tool.

Specifies whether to add delay information to the existing
output delay or to overwrite. The -add_delay option enables you
to capture information about multiple paths leading to an
output port that are relative to different clocks or clock edges.

Disables the constraint.

Allows the command to accept a comment string. The tool
honors the annotation and preserves it with the object so that
the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

Specifies the path delay. The delayValue must be in units
consistent with the technology library used during optimization.
The delayValue represents the amount of time that the signal is
required before a clock edge. For maximum output delay, this
usually represents a combinational path delay to a register plus
the library setup time of that register. For minimum output
delay, this value is usually the shortest path delay to a register
minus the library hold time
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portPinList A list of output port names in the current design to which
delayValue is assigned. If more than one object is specified, the
objects are enclosed in double quotation marks (") or in braces

(&)

Examples

Refer to the following examples.

Example 1
This example sets an output delay of 1.00 relative to the rising edge of clk for
all the output ports in the design.

set_output _delay 1.00 -clock clk [all_outputs]

Example 2

The following example sets an output delay of 2.00 relative to the falling edge
of clk for the output port dout1. The -add_delay option indicates that this delay
value is to be added to any existing output delays defined on this port.

set_output_delay 2.0 -clock clk [get_ports {doutl}] -add_del ay
-clock _fall
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set_reg_input_delay

Speeds up paths feeding a register by a given number of nanoseconds.

Syntax

set_reg_input_delay {registerName} [-route ns] [-disable] [-comment textString]

Arguments

registerName A single bit, an entire bus, or a slice of a bus.

-route Advanced user option that you use to tighten constraints during
resynthesis, when the place-and-route timing report shows the
timing goal is not met because of long paths to the register.

-comment Allows the command to accept a comment string. The tool honors the
annotation and preserves it with the object so that the exact string is
written out when the constraint is written out. The comment remains
intact through the synthesis, place-and-route, and timing-analysis
flows.

-disable Disables the constraint.

Description

The set_reg_input_delay timing constraint speeds up paths feeding a register by
a given number of nanoseconds. The Synopsys FPGA synthesis tool attempts
to meet the global clock frequency goals for a design as well as the individual
clock frequency goals (set with create_clock). Use this constraint to speed up
the paths feeding a register. For information about the equivalent SCOPE
spreadsheet interface, see Registers, on page 228.

Use this constraint instead of the legacy constraint, define_reg_input_delay.
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set_reg_output_delay

Speeds up paths coming from a register by a given number of nanoseconds.

Syntax

set_reg_output_delay {registerName} [-route ns] [-disable] [-comment textString]

Arguments

registerName A single bit, an entire bus, or a slice of a bus.

-route Advanced user option that you use to tighten constraints during
resynthesis, when the place-and-route timing report shows the
timing goal is not met because of long paths from the register.

-comment Allows the command to accept a comment string. The tool honors
the annotation and preserves it with the object so that the exact
string is written out when the constraint is written out. The
comment remains intact through the synthesis, place-and-route,
and timing-analysis flows.

-disable Disables the constraint.

Description

The set_reg_output_delay constraint speeds up paths coming from a register by
a given number of nanoseconds. The synthesis tool attempts to meet the
global clock frequency goals for a design as well as the individual clock
frequency goals (set with create_clock). Use this constraint to speed up the
paths coming from a register. For information about the equivalent SCOPE
spreadsheet interface, see Registers, on page 228.

Use this constraint instead of the legacy constraint, define_reg_output_delay.

Naming Rule Syntax Commands

The FPGA synthesis environment uses a set of naming conventions for design
objects in the RTL when your project contains constraint files. The following
naming rule commands are added to the constraint file to change the
expected default values. These commands must appear at the beginning of
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the constraint file before any other constraints. Similarly, when multiple
constraint files are included in the project, the naming rule commands must
be in the first constraint file read.

set_hierarchy_separator Command

The set_hierarchy_separator command redefines the hierarchy separator
character (the default separator character is the period in the FPGA synthesis
environment). For example, the following command changes the separator
character to a forward slash:

set _hi erarchy_separator {/}

Embedded Tcl commands, such as get pins must be enclosed in brackets []
for the software to execute the command. Also, the curly brackets {} are
required when object names include the escape (\) character or square
brackets. For example, the following syntax is honored by the tool:

set _hierarchy separator {/}

create _clock -nane {cl kl} [get pins

{pdp_c/ib_phy c/port_g\.21\.phy c/c7_g\.gtxe2 comron_O i/ GIREFCLK] 0] }]
-period {10}

set _rtl ff names Command

The set_rtl_ff names command controls the stripping of register suffixes in the
object strings of delay-path constraints (for example, set_false_path, set_multicy-
cle_path). Generally, it is only necessary to change this value from its default
when constraints that target ASIC designs are being imported from the
Design Compiler (in the Design Compiler, inferred registers are given a _reg
suffix during the elaboration phase; constraints targeting these registers
must include this suffix). When importing constraints from the Design
Compiler, include the following command to change the value of this naming
rule to {_reg} to automatically recognize the added suffix.

set rtl _ff _nanes { _reg}
For example, using the above value allows the DC exception
set _false path -to [get _cells {register_bus reg[0]}]

to apply to the following object without having to manually modify the
constraint:

[get_cells {register_bus[0]}]
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bus_naming_style Command

The bus_naming_style command redefines the format for identifying bits of a
bus (by default, individual bits of a bus are identified by the bus name
followed by the bus bit enclosed in square brackets). For example, the
following command changes the bus-bit identification from the default
busName[busBit] format to the busName_busBit format:

bus_nam ng_styl e {%_ %}

bus_dimension_separator_style Command

The bus_dimension_separator_style command redefines the format for identifying
multi-dimensional arrays (by default, multidimensional arrays such as row 2,
bit 3 of array ABC[n x m] are identified as ABC[2][3]). For example, the
following command changes the bus-dimension separator from individual
square bracket sets to an underscore:

bus_di nensi on_separator_style {_}

The resulting format for the above example is:

ABJ[ 2_3]

read_sdc Command

Reads in a script in Synopsys FPGA constraint format. The supported syntax
for the read_sdc constraint is:

read_sdc fileName
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Design Constraints

This section describes the constraint file syntax for the following non-timing
design constraints:

* define_compile_point, on page 299
* define_current_design, on page 300

* define_io_standard, on page 301
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define_compile_point

The define_compile_point command defines a compile point in a top-level
constraint file. You use one define_compile_point command for each compile
point you define. For the equivalent SCOPE spreadsheet interface, see
Compile Points, on page 234. (Compile points are only available for certain
technologies.)

This is the syntax:

define_compile_point [-disable ] {moduleName}
-type {soft|hard|locked|locked, partition} [-comment textString ]

-disable Disables a previous compile point definition.

-type Specifies the type of compile point. This can be soft, hard, locked, or
locked, partition. See Compile Point Types, on page 439 for more
information.

Refer to Guidelines for Entering and Editing Constraints, on page 129 for
details about the syntax and prefixes for naming objects.

Here is a syntax example:

define_conpile_point {v:work.prgmcntr} -type {l ocked}
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d

efine_current_design

The define_current_design command specifies the module to which the
constraints that follow it apply. It must be the first command in a block-level
or compile-point constraint file. The specified module becomes the top level
for objects defined in this hierarchy and the constraints applied in the respec-
tive block-level or compile-point constraint file.

This is the syntax:
define_current_design {regionName | libraryName.moduleName}

Refer to Guidelines for Entering and Editing Constraints, on page 129 for
details about the syntax and prefixes for naming objects.

Here is an example:
define current _design {libl. prgmcntr}

Objects in all constraints that follow this command relate to prgm_cntr.
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define_io_standard

Specifies a standard I/O pad type to use for various vendor-specific families.
See I/O Standards, on page 233 for details of the SCOPE equivalent.

define_io_standard [-disable] {p:portName} -delay_type input|output|bidir
syn_pad_type {IO_standard} [parameter {value}...]

In the above syntax:

portName
is the name of the input, output, or bidirectional port.

-delay_type
identifies the port direction which must be input, output, or bidir.

syn_pad_type
is the I/O pad type (I/O standard) to be assigned to portName.

parameter
is one or more of the parameters defined in the following table. Note that
these parameters are device-family dependent.

Parameter Function

syn_io_termination The termination type; typical values are pullup and
pulldown.

syn_io_drive The output drive strength; values include low and high
or numerical values in mA.

syn_io_dv2 Switch to use a 2x impedance value (DV2).

syn_io_dci Switch for digitally-controlled impedance (DCI).

syn_io_slew The slew rate for single-ended output buffers; values

include slow and fast or low and high.

Examples:

define_io_standard {p: DATAL[7: 0]} -del ay_type input
syn_pad_type {LVCMOS 33} syn_io_slew {high}
syn_io_drive {12} syn_io_termnation {pul | down}

define_io_standard {p:en} -delay_type input
syn_pad_type {LVOMXG 18} syn_io _dci {Dd}
syn_io_dv2 {Dv2}
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Silicon to Software

CHAPTER 5

User Interface Commands

The following describe the commands and ways to access them in the graph-
ical user interface (GUI).

File Menu, on page 304

File Menu, on page 304

Edit Menu, on page 309

View Menu, on page 323

Project Menu, on page 331
Implementation Options Command, on page 345
Run Menu, on page 374
Analysis Menu, on page 393
HDL Analyst Menu, on page 405
Options Menu, on page 417
Web Menu, on page 443

Help Menu, on page 444

For information about context-sensitive commands accessed from right-click
popup menus, see Chapter 6, GUI Popup Menu Commands.
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File Menu

File Menu

Use the File menu for opening, creating, saving, and closing projects and files.
The following table describes the File menu commands.

Command

New

E Open

Close

Save

Save As

Save All

Print

Print Setup

Create Image

Build Project

[j Open Project
New Project

© 2020 Synopsys, Inc.

Description

Creates one of the following types of files: Text, Tcl Script,
VHDL, Verilog, Synopsys Design Constraints, Constraint,
Analysis Design Constraint, and Project. See New Command,
on page 305.

Opens a project or file.

Closes a project or file.

Saves a project or a file.

Saves a project or a file to a specified name.
Saves all projects or files.

Prints a file. For more information about printing, see the
operating system documentation.

Specify print options.

This command is available in the following views:
e HDL Analyst Views
* FSM Viewer

A camera pointer ([Z]) appears. Drag a selection rectangle
around the region tor which you want to create an image, then
release the mouse button. You can also simply click in the
current view, then the Create Image dialog appears. See Create
Image Command, on page 307.

Creates a new project based on the file open in the Text Editor
(if active), or lets you choose files to add to a new project. See
Build Project Command, on page 308.

Opens a project. See Open Project Command, on page 309.

Creates a new project. If a project is already open, it prompts
you to save it before creating a new one. If you want to open
multiple projects, select Allow multiple projects to be opened in the
Project View dialog box. See Project View Options Command, on
page 422.
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Command Description

New Workspace Creates a new project workspace. Prompts you to select
projects to add to the workspace. See Edit Menu, on page 309.

Close Project Closes the current project.

Recent Projects Lists recently accessed projects. Choose a project listed in the

submenu to open it.

Recent files Lists the last six files you opened as separate menu items.
(listed as separate Choose a file to open it.
menu items)

Exit Exits the session.

New Command

Select File->New to display the New dialog box, where you can select a file type
to be created (for example, Verilog, VHDL, text, Tcl script, P&R options,
design constraints, analysis design constraints, or project). For most file
types, a text editor window opens to allow you to define the file contents. You
must provide a file name. You can automatically add the new file to your
project by enabling the Add To Project checkbox before clicking OK.
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[ P MNew - &‘g
| ———
File Type:(Select a type)
i Verilog File _DK
# VHDL File
% Text Flle Cancel
T Tcl Script
£ Synopsys Design Constraints I
B constraint File (Scope) Hel
B3, Analysis Design Constraints
P Project File (Project) |
Add To Project
Mew File Mame:
File Location:
[C:‘nlsg-fnpI'rﬁ-r_pru:u‘-LtutoriaI'nl ] E I
Full Path:
[C:‘l.s:.fnpl'rfy _pro\tutorialy ] I
File Type Opens Window Directory Name Extension
Verilog Text Editor Verilog .V
VHDL Text Editor VHDL . vhd
Text Text Editor Other . ixt
Tel Script Text Editor Tel Script . tel
FPGA Design SCOPE Constraint . fdc
Constraints
Constraint SCOPE Constraint . sdc
Analysis Design SCOPE Analysis Design Constraint . adc
Constraints
Project None None . prj
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Create Image Command

Select File->Create Image to create a capture image from any of the following
views:

* HDL Analyst Views
* FSM Viewer

Drag the camera cursor to define the area for the image. When you release
the cursor, the Create Image dialog box appears. Use the dialog box to copy the
image, save the image to a file, or to print the image.

Copy To Clipboard

I Copy to Clipboard |

Save To File

[ C:\designs\Designs_Premier\design_version2.bmp ] E]
Add to Project

V | Save to File |

Print

| Print |

Options
Max Pixelz (Save, Copy)

] I 1l

Caption
Design Version 2
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Field/Option Description

Copy to Clipboard Copies the image to the clipboard so you can paste it into a
selected application (for example, a Microsoft Word file).
When you copy an image to the clipboard, a green check
mark appears in the Copy To Clipboard field.

Save to File Saves the image to the specified file. You can save the file
in a number of formats (platform dependent) including
bmp, jpg, png, ppm, tif, xbm, and xpm.

Add to Project Adds the saved image file to the Images folder in the Project
view. This option is enabled by default.

Save to File button You must click this button to save an image to the
specified file. When you save the image, a green check
mark appears in the Save To File field.

Print Prints the image. When you print the image, a green check
mark appears in the Print field.

Options Allows you to select the resolution of the image saved to a
file or copied to the clipboard. Use the Max Pixels slider to
change the image resolution.

Caption Allows you to enter a caption for a saved or copied image.
The caption is overlayed at the top-left corner of the image.

Build Project Command

Select File->Build Project to build a new project. This command behaves differ-
ently if an HDL file is open in the Text Editor.

* When an active Text Editor window with an HDL file is open, File->Build
Project creates a project with the same name as the open file.

* If no file is open, File->Build Project prompts you to add files to the project
using the Select Files to Add to New Project dialog box. The name of the new
project is the name of the first HDL file added. See Add Source File
Command, on page 332.
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Open Project Command

Select File->Open Project to open an existing project or to create a new project.

Recent Projects

C:\tools'ycert201103_130R\doc\add.prj
C:\designs\ACFest2010\Lab2\proj_1.prj

C:\designs\ACFest2010\Lab2\proj.pri
C:\designs\Designss_certify \multi-term\proto'\synthesis_files\mb_uA'\mb_uA_srs.prj
C:\designs\Designs6_certify \multi-termproj_1.prj
C:\designs\Designs6_certify\proj_1.prj

OK | | Cancel
Field/Option Description
Existing Project Displays the Open Project dialog box for opening an existing
project.
New Project Creates a new project and places it in the Project view.

Edit Menu

You use the Edit menu to edit text files (such as HDL source files) in your
project. This includes cutting, copying, pasting, finding, and replacing text;
manipulating bookmarks; and commenting-out code lines. The Edit menu
commands available at any time depend on the active window or view
(Project, Text Editor, SCOPE spreadsheet, RTL or Technology views).

The available Edit menu commands vary, depending on your current view.
The following table describes all of the Edit menu commands:

Command Description

Basic Edit Menu Commands

Undo Cancels the last action.
ﬂ Redo Performs the action undone by Undo.
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Command Description

Cut Removes the selected text and makes it available to
Paste.

Copy Duplicates the selected text and makes it available to
Paste.

Paste Pastes text that was cut (Cut) or copied (Copy).

Delete Deletes the selected object.

Find Searches the file for text matching a given search

string. See Find Command (Text), on page 312. In the
RTL view, opens the Object Query dialog box, which lets
you search your design for instances, symbols, nets,
and ports, by name; see Find Command (HDL
Analyst), on page 315. In the project view, searches
files for text strings; see Find Command (In Project),

on page 313.
Find Next Continues the search initiated by the last Find.
Find in Files Performs a string search of the target files (see Find in

Files Command, on page 319).
Edit Menu Commands for the Text Editor

Select All Selects all text in the file.

Replace Finds and replaces text. See Replace Command, on
page 321.

Goto Goes to a specific line number. See Goto Command, on
page 322.

Toggle bookmark Toggles between inserting and removing a bookmark on
the line that contains the text cursor.

Next bookmark Takes you to the next bookmark.

Previous bookmark Takes you to the previous bookmark.

Delete all bookmarks Removes all bookmarks from the Text Editor window.

Advanced->Comment Code Inserts the appropriate comment prefix at the current
text cursor location.

Advanced-> Uncomment Removes comment prefix at the current text cursor
Code location.
© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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Command Description
Advanced->Uppercase Makes the selected string all upper case.
Advanced->Lowercase Makes the selected string all lower case.
Select->All Selects all text in the file (same as All).
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Find Command (Text)

Select Edit->Find to display the Find dialog box. In the SCOPE window, the FSM
Viewer and the Text Editor window, the command has basic text-based
search capabilities. Some search features, like regular expressions and line-
number highlighting, are available only in the Text Editor. See Find
Command (In Project), on page 313, to search for files in the Project.

The HDL Analyst Find command is different; see Find Command (HDL
Analyst), on page 315 for details.

Find 2]
Find what: [zercBvTE] ] -] | eI S COPE Find =)
[ Match whole word anly Direction | Mark &Il | 3earch For: |l |
[_] Match case O Up Options
] Reqular expression (@ Down | ol [ Reverse
Wirap
In Text Editor et G I Find Mext I | Cancel

In SCOPE

Field/Option Description

Find What/Search for ~ Search string matching the text to find. In the text editor,
you can use the pull-down list to view and reuse search
strings used previously in the current session.

Match whole word only When enabled, matches the entire word rather than a

(text editor only) portion of the word.

Match Case When enabled, searching is case sensitive.

Regular expression When enabled, wildcard characters (* and ?) can be used in
(text editor only) the search string: ? matches any single character; * matches

any string of characters, including an empty string.

Direction/Reverse Changes search direction. In the text editor, buttons select
the search direction (Up or Down).
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Field/Option Description
Find Next Initiates a search for the search string (see Find What/Search

for). In the text editor, searching starts again after reaching

the end (Down) or beginning (Up) of the file.
Wrap When enabled, searching starts again after reaching the end
(SCOPE only) or beginning (Reverse) of the spread sheet.
Mark All Highlights the line numbers of the text matching the search
(Text editor only) string and closes the Find dialog box.

Find Command (In Project)

Select Edit->Find to display the Find File dialog box. In the Project view, the
command has basic text-based search capabilities to locate files in the

project.

Al or part of the File name:

21

[ eight_bit_uc.v

Look. in:

| All Projects

Find options

[ Makch case
[] Search up
Exclude path

| Find Mezxt | | Zancel

Field/Option Description

All or part of the file ~ Search string matching the file to find. You can specify all or
name part of the file name.

Look in Search for files in all projects or limit the search to files only in

the specified project.

Match Case When enabled, searching is case sensitive.
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Field/Option Description
Search up Searches in the up direction (search terminates when an end
of tree is reached in either direction).
Exclude path Excludes the path name during the search.
Find Next Initiates a search for the file name string.
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Find Command (HDL Analyst)

In the RTL or Technology view, use Edit->Find to display the Object Query
dialog box. For a detailed procedure about using this command, see Using
Find for Hierarchical and Restricted Searches, on page 313 of the User Guide.

. Instances Symbals ets Ports
Type of objects
to find Search
( Entire Design () Current Level and Below ® Current Level Om/ Level(s) to
search
‘UnH\ghI\ghted: 0of 36 = |High|ighted: 0of 0 |
H lock_pad . .
Objects decede. I Objects to find
matching filter dx in schematic
(search T (and select)
i M_2608_i
candidates) ]
porta_pad[1]
k. d[Z
e &
Highlight: Search {*7 Un-Highlight Selection (*7):
Filter string ——Ff=— [+ ( [~
—MName Space Search by
Get more [ Dot | T ® Tech View A Name Space
candidates () Netliet (Tech view
only)
[ ]

The available Find menu commands vary, depending on your current view.
The following table describes all of the Find menu commands:

Field/Option Description

Instances, Tabbed panels for finding different kinds of objects. Choose a panel
Symbols, for a given object type by clicking its tab. In terms of memory
Nets, Ports consumption, searching for Instances is most efficient, and searching

for Nets is least efficient.

Search Where to search: Entire Design, Current Level & Below, or Current Level
Only. See Using Find for Hierarchical and Restricted Searches,
on page 313 of the User Guide.
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Field/Option
UnHighlighted

Highlight
Search (*?)

->

© 2020 Synopsys, Inc.
316

Description

Names of all objects of the current panel type, in the level(s) chosen
to Search, that match the Highlight Search (*?) filter. This list is
populated by the Find 200 and Find All buttons.

To select an object as a candidate for highlighting, click its name in
this list. The complete name of the selected object appears near the
bottom of the dialog box. You can select part or all of this complete
name, then use the Ctrl-C keyboard shortcut to copy it for pasting.

You can select multiple objects by pressing the Ctrl or Shift key while
clicking; press Ctrl and click a selection to deselect it. The number of
objects selected, and the total number listed, are displayed above the
list, after the UnHighlighted: label: # selected of # total.

To confirm a selection for highlighting and to move the selected
objects to the Highlighted list, click the -> button.

Determines which object names appear in the UnHighlighted area,
based on the case-sensitive filter string that you enter. For tips
about using this field, see Using Wildcards with the Find
Command, on page 316 of the User Guide.

The filter string can contain the following wildcard characters:
 * (asterisk) — matches any sequence of characters;
¢ ? (question mark) — matches any single character;

* . (period) — does not match any characters, but indicates a change
in hierarchical level.

Wildcards * and ? only match characters within the current
hierarchy level; a*b*, for example, will not cross levels to match
alpha.beta (where the period indicates a change in hierarchy).

If you must match a period character occurring in a name, use \.
(backslash period) in the filter string. The backslash prevents
interpreting the period as a wildcard.

The filter string is matched at each searched level of the hierarchy
(the Search levels are described above). Use filter strings that are as
specific as possible to limit the number of unwanted matches.
Unnecessarily extensive search can be costly in terms of memory
performance.

Moves the selected names from the UnHighlighted area to the
Highlighted area, and highlights their objects in the RTL and
Technology views.

Moves the selected names from the Highlighted area to the
UnHighlighted area, and unhighlights their objects in the RTL and
Technology views.

Synplify Pro for Microsemi Edition Command Reference
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Field/Option
All ->

<-All

Highlighted

Un-Highlight
Selection (*?)

Jump to
location
Name Space:

Tech View

Name Space:
Netlist

Synplify Pro for Microsemi Edition Command Reference
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Description

Moves all names from the UnHighlighted to the Highlighted area, and
highlights their objects in the RTL and Technology views.

Moves all names from the Highlighted to the UnHighlighted area, and
unhighlights their objects in the RTL and Technology views.

Complementary and analogous to the UnHighlighted area. You select
object names here as candidates for moving to the UnHighlighted list.
(You move names to the UnHighlighted list by clicking the <- button
which unselects and unhighlights the corresponding objects.)

When you select a name in the Highlighted list, the view is changed to
show the (original, unfiltered) schematic sheet containing the object.

Complementary and analogous to the Highlight Search area: selects
names in the Highlighted area, based on the filter string you input
here.

When enabled, jumps to another sheet if necessary to show target
objects.

Searches for the specified name using the mapped (srm) database.
For more information, see Using Find for Hierarchical and
Restricted Searches, on page 313 of the User Guide.

Searches for the specified name using the output netlist file. For
more information, see Using Find for Hierarchical and Restricted
Searches, on page 313 of the User Guide.
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Field/Option Description

Find 200 Adds up to 200 more objects that match the filter string to the
UnHighlighted list. This button becomes available after you enter a
Highlight Search (*?) filter string. This button does not find objects in
HDL Analyst views. It matches names of design objects against the
Highlight Search (*?) filter and provides the candidates listed in the
UnHighlighted list, from which you select the objects to find.

Using the Enter (Return) key when the cursor is in the Highlight
Search (*?) field is equivalent to clicking the Find 200 button.

Usage note:

Click Find 200 before Find All to prevent unwanted matches in case the
Highlight Search (*?) string is less selective than you expect.

Find All Places all objects that match the Highlight Search (*?) filter string in the
UnHighlighted list. This button does not find objects in HDL Analyst
views. It matches names of design objects against the Highlight
Search (*?) filter and provides the candidates listed in the
UnHighlighted list, from which you select the objects to find. (Enter a
filter string before clicking this button.) See Usage Note for Find 200,
above.

For more information on using the Object Query dialog box, see Using Find for
Hierarchical and Restricted Searches, on page 313 of the User Guide.
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Find in Files Command

The Find in Files command searches the defined target for the occurrence of a
specified search string. The list of files containing the string is reported in the
display area at the bottom of the dialog box. For information on using this
feature, see Searching Files, on page 96 of the User Guide.

Find in Files 7] x|
Find what:
[int_crcls_set ] - ]
~Find In:

Files Contained in Project: IC:'l,DesignsII'l,usb_hub'l,usb_hub.prj | vI

[ tmplementation Directary: Ifcedemo | v|

[ Directary: [ ] D

[ Result Window {search anly in results windaw below)

Include sub-folders For directory searches

File filter: &.g. srrjv;vhd;a® bxt
[ ]~

~Search Options

[ Match case [ Match whole word [ Use Reqular Expressions

| Find | | Close I

[32 matches found in 5 files. Total files seached: 40

Ci\DesignsITush_hubisroiusbf _ep_rf.w{100): int_crcl6_set, int_to_set, int_seqerr_set,
C\DesignsIush_hublsrciusbf_ep_rf.w{128): input int_crclé_set; [/} Set CRCLE error inkerrupt
Ci\DesignsITiusb_hublsrelusbf _ep_rf.w{305): if{int_crcl6_sethis[1] <= #1 1'b1;

C:\DesignsITiush_hublsralusbf _pe.w(146): int_crclé_set, int_to_set, int_seqerr_set,

CiiDesignsINush_hubisroiusbf _pe.v(202): output int_crel6_set;  ff Set CRCLE error interrupt
CiiDesignsIush_hublsroiusbf_pe, (7810 assign ink_crcl6_set = rx_data_done & crolé_err; @
S TR SO W PP il ets cb b iwib e o

Field/Option Description
Find what: Text string object of search.
Files Contained in Drop-down menu identifying the source project of the files to
Project be searched.
Implementation Drop-down menu restricting project search to a specific
Directory implementation or all implementations.
Directory Identifies directory for files to be searched.
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.

January 2020 Synopsys Confidential Information 319



User Interface Commands Edit Menu

Field/Option Description

Result Window Allows a secondary search string (Find what) to be applied to
the targets reported from the initial search.

Include sub-folders When checked, extends the search to sub-directories of the
for directory searches target directory.

File filter Excludes files from the search by filename extension.

Search Options Standard string search options; check to enable.

Find Initiates search.

Result Display List of files containing search string. Status line lists the
number of matches in each file and the number of files
searched.
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Replace Command

Use Edit->Replace to find and optionally replace text in the Text Editor.

Replace 2| x|

Find what: [rising_edge(CLK) ]v] | Find Mext I
Replace with: IFaIIing_edge(CLK) I v]
[ "] Match whale word only Replace In
[ Match case () Selection
[ ] Regular expression (@) Whaole Fil
& heete [ concel |
Feature Description
Find What Search string matching the text to find. You can use the pull-
down list to view and reuse search strings used previously in
the current session.
Replace With The text that replaces the found text. You can use the pull-

Match whole word
only

Match case

Regular expression

Selection
Whole file
Find Next

Replace

Replace All

Synplify Pro for Microsemi Edition Command Reference
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down list to view and reuse replacement text used previously
in the current session.

Finds only occurrences of the exact string (strings longer than
the Find what string are not recognized).

When enabled, searching is case sensitive.

When enabled, wildcard characters (* and ?) can be used in
the search string: ? matches any single character; * matches
any string of characters, including the empty string.

Replace All replaces only the matched occurrence.
Replace All replaces all matching occurrences.
Initiates a search for the search string (see Find What).

Replaces the found text with the replacement text, and locates
the next match.

Replaces all text that matches the search string.

© 2020 Synopsys, Inc.
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Goto Command

Use Edit->Goto to go to a specified line number in the Text Editor.

B synplify [ 2]
G0 ko line (1-108):

B )

I Ok II Zancel I
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View Menu

Use the View menu to set the display and viewing options, choose toolbars,
and display result files. The commands in the View menu vary with the active
view. The following tables describe the View menu commands in various
views.

* View Menu Commands: All Views, on page 323
* View Menu: Zoom Commands, on page 324
* View Menu: RTL and Technology Views Commands, on page 324

* View Menu: FSM Viewer Commands, on page 325

View Menu Commands: All Views

Command Description

Font Size Changes the font size in the Project Ul of the synthesis tools.
You can select one of the following options:

¢ Increase Font Size
» Decrease Font Size
* Reset Font Size (default size)

Toolbars Displays the Toolbars dialog box, where you specify the
toolbars to display. See Toolbar Command, on page 326.

Status Bar When enabled, displays context-sensitive information in the
lower-left corner of the main window as you move the mouse
pointer over design elements. This information includes
element identification.

Refresh Updates the Ul display of project files and folders.

Output Windows Displays or removes the Tcl Script/Messages and Watch
windows simultaneously in the Project view. Refer to the Tcl
Window and Watch Window options for more information.

Tel Window When enabled, displays the Tcl Script and Messages
windows. All commands you execute in the Project view
appear in the Tcl window. You can enter or paste Tcl
commands and scripts in the Tcl window. Check for notes,
warning, and errors in the Messages window.
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Command Description

Watch Window When enabled, displays selected information from the log
file in the Watch window.

View Log File Displays a log file report that includes compiler, mapper,
and timing information on your design. See View Log File
Command, on page 328.

View Result File Displays a detailed netlist report.

View Menu: Zoom Commands

Command Description

Zoom In Lets you Zoom in or out. When selected, a Z-shaped mouse
pointer ( Z ) appears. Zoom in or out on the view by clicking or

37 0 dragging a box around (lassoing) the region. Clicking zooms in

oom Out or out on the center of the view; lassoing zooms in or out on

the lassoed region. Right-click to exit zooming mode.

In the SCOPE spreadsheet, selecting these commands
increases or decreases the view in small increments.

Pan Lets you pan (scroll) a schematic or FSM view using the
mouse.

If your mouse has a wheel feature, use the wheel to pan up
and down. To pan left and right, use the Shift key with the

wheel.
Full View Zooms the active view so that it shows the entire design.
Normal View Zooms the active view to normal size and centers it where you
click. If the view is already normal size, clicking centers the
view.

View Menu: RTL and Technology Views Commands

These commands are available when the RTL view or Technology view is
active. These commands are available in addition to the commands described
in View Menu Commands: All Views, on page 323 and View Menu: Zoom
Commands, on page 324.
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Command

Push/Pop
ierarchy

Previous Sheet

Next Sheet

View Sheets

Visual Properties

Back
Forward

Filter

Description

Traverses design hierarchy using the push/pop mode — see
Exploring Design Hierarchy (Standard), on page 303 of the
User Guide.

Displays the previous sheet of a multiple-sheet schematic.
Displays the next sheet of a multiple-sheet schematic.

Displays the Goto Sheet dialog box where you can select a
sheet to display from a list of all sheets. See View Sheets
Command, on page 327.

Toggles the display of information for nets, instances, pins,
and ports in the HDL Analyst view.

To customize the information that displays, set the values
with Options->HDL Analyst Options->Visual Properties. See Visual
Properties Panel, on page 441.

Goes backward in the history of displayed sheets for the
current HDL Analyst view.

Goes forward in the history of displayed sheets for the current
HDL Analyst view.

Filters the RTL/Technology view to display only the selected
objects.

View Menu: FSM Viewer Commands

The following commands are available when the FSM viewer is active. These
commands are in addition to the common commands described in View
Menu Commands: All Views, on page 323 and View Menu: Zoom Commands,

on page 324.

Command

E— Filter->Selected

Filter->By input
transitions

transitions

Synplify Pro for Microsemi Edition Command Reference
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Filter->By output

Description

Hides all but the selected state(s).

Hides all but the selected state(s), their output transitions,
and the destination states of those transitions.

Hides all but the selected state(s), their input transitions,
and the origin states of those transitions.
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Command Description

Filter->By any Hides all but the selected state(s), their input and output

transition transitions, and their predecessor and successor states.

Unfilter Restores a filtered FSM diagram so that all the states and
transitions are showing.

Cross Probing Enables cross probing between FSM nodes and RTL view
schematic.

Select All States Selects all the states.

FSM Table Toggles display of the transition table.

FSM Graph Toggles FSM state diagram on or off.

Annotate Transitions Toggles display of state transitions on or off on FSM state
diagram

Selection Transcription

Tool Tips Toggles state diagram tool tips on or off.

FSM Properties Displays FSM Properties dialog box.

Unselect All Unselects all states and transitions.

Toolbar Command
Select View->Toolbars to display the Toolbars dialog box, where you can:
* Choose the toolbars to display

* Customize their appearance
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Customize Toolbars 2=

Toolbars

Project Shiow Tooltips
Analysk

Vi;f\lys [ Large Buttons

Physical Analyst

Text Editar

FaM Wiewer

Feature Description
Toolbars Lists the available toolbars. Select the toolbars that you want to
display.

Show Tooltips When selected, a descriptive tooltip appears whenever you position
the pointer over an icon.

Large Buttons When selected, large icons are used.

View Sheets Command

Select View->View Sheets to display the Goto Sheet dialog box and select a sheet
to display. The Goto Sheet dialog box is only available in an RTL or Technology
view, and only when a multiple-sheet design is present.
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P Goto Sheet 2|

| Sheet 1 |

Sheet 3

I K ” Cancel |

To see if your design has multiple sheets, check the sheet count display at
the top of the schematic window.

View Log File Command

View->View Log File displays the log file report for your project. The log file is
available in either text (project_name.str) or HTML (project_name_srr.htm)
format. To enable or disable the HTML file format for the log file, select the
View log file in HTML option in the Options->Project View Options dialog box.

When opening the log file, a table of contents appears. Selecting an item from
the table of contents takes you to the corresponding HTML page. To go back
to the Table of Contents, right-click on the HTML page and select Back from
the menu.
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Feport: example {rev_1)
=1 Synthesis
Compiler Report
E- Pre-mapping Report
- Mapper Report
Backannotation Report .
Place and Route
Session Log (08:39 28-Maov)

[ ] cEm

Refresh

atiant

#Inplament

% Start of Compile

#FWed Mov 28 Cd:4E8:0

Synopsy=z HDL Compiler; wersion compdevb,
Il | Eunning inm §4¢-bic mode
Copyright [C} 1994-2012 Synopsya, Imc.

Synopeys YVHDL Compiler, Versicn compdevi,

EH: : | RBunmning im &4-bic mode

Copyright [C} 1994-2012 Synopsya, Inc. This sofiWare
BH:CDF20 : std.whd(125) | S=tting time rescluticn to o
@M: : ipa rom whdil3) | Top enticy is set co THS ROM.
4

This software

[+

Build 28Z0B, 1

Builc ZEB2OR,
cl

i

You can use the search field to find an item in the table of contents. Enter all
or part of the header name in the search field, then click Find. The log file
displays the resulting section.

Report: example (rev_1)

-

El- Synthesis
Compiler Report
El-Mapper Report
Clock Conversion

Timing Report

Detailed Report for Clock: clock

Resource Utilizati

Backannotation Report (08:48 28-...

Place and Route

Pre-mapping Report

:

on

[ Clock conversion

[

Find searches within collapsed tables. It expands the tables to show your

results.
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‘ Report: physical_synthsys :‘
Synthesis

Place and Rou N -
Place and Rou.‘Report: physical_synthsy

Session Log (0 = Synthesis
Compiler Report

» El- Pre-mapping Re...

Clock Summ...
El-Mapper Report ...
Clock Conver..
Timing Report

Detailed Rep...
Eﬂ: Detailed Rep...
D Resource Util... E

clock | Find I

If the file changes while the search window is open, click the Refresh button to
update the table of contents.

E- Synthesis
Compiler Report
El- Pre-mapping Report
Clock Summary
El-Mapper Report
Clock Conversion
E-Timing Report
Performance Summary
Clock Relationships
Interface Information
E- Detailed Report for Clock: clock
Starting Points with Worst Slack ]
Ending Points with Worst Slack
Worst Path Information
Resource Utilization E
Rarkannntatinn Renart (0748 30-Oirty

clock | Fna |

=)
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Project Menu

You use the Project menu to set implementation options, add or remove files
from a project, change project filenames, create new implementations, and
archive or copy the project. The Project menu commands change, depending
on the view you are in. For example, the HDL Analyst RTL and Technology
views only include a subset of the Project menu commands.

The Synplify Pro tools provide a graphical user interface (GUI) with views that
help you manage hierarchical designs that can be synthesized independently
and imported back to the top-level project in a team design flow called Hierar-
chical Project Management. This feature is not available for Microsemi
technologies.

The following table describes the Project menu commands.

Command Description

Implementation Options Displays the Implementation Options dialog box, where you
set options for implementing your design. See
Implementation Options Command, on page 345.

Add Source File Displays the Select Files to Add to Project dialog box. See
Add Source File Command, on page 332.

Tcl equivalent: add_file -fileType filename

Remove Implementation Displays the Remove Implementation dialog box that allows
you to remove the selected implementation. See Remove
Implementation, on page 334.

Tcl equivalent: impl -remove implementationName

Remove File From Project Removes selected files from your project.
Tcl equivalent: project_file -remove filename

Change File Replaces the selected file in your project with another
that you choose. See Change File Command, on
page 335.
Tcl equivalent: project_file -name "originalFile" "newFile"
Set VHDL Library Displays the File Options dialog box, where you choose

the library (Library Name) for synthesizing VHDL files. The
default library is called work. See Set VHDL Library
Command, on page 335.
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Command

Add Implementation

New Identify
Implementation

Archive Project

Un-Archive Project

Copy Project

Hierarchical Project
Options

Add SubProject
Implementation

Description

Creates a new implementation for a current design.
Each implementation pertains to the same design, but it
can have different options settings and/or constraints
for synthesis runs. See Add Implementation Command,
on page 336).

Tcl equivalent: impl -add implementation_1 implementation
-type implementationType

Creates a new Identify implementation for a current
design. To launch the Identify tool set, see the Identify
Instrumentor Command, on page 379 and Launch
Identify Debugger Command, on page 381.

Tcl equivalent: impl -add implementation_1 implementation

Archives a design project. Use this command to archive
a full or partial project, or to add files to or remove files
from an archived project. See Archive Project
Command, on page 337 for a description of the utility
wizard options.

Loads an archived project file to the specified directory.
See Un-Archive Project Command, on page 339 for a
description of the utility wizard options.

Creates a copy of a design project. Use this command to
create a copy of a full or partial project. See Copy Project
Command, on page 341 for a description of the utility
wizard options.

Not applicable for Microsemi technologies.

Not applicable for Microsemi technologies.

Add Source File Command

Select Project->Add Source File to add files, such as HDL source files, to your
project. This selection displays the Select Files to Add to Project dialog box.

© 2020 Synopsys, Inc.
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Add Files to Project 3 2=

Look im: |.3C:\syn|:%:rem\erl\verilug v‘ 0 = | 0 J [%]

alu.v

X

' My Computer |
| data_musx.w

) joannSYNPL TS cighk bk uc.y

#] ins_decode.y

5] o

S mule,y )

%) pew Select files to add

| req_file.w

=] spel_regs.w

| state_mc.v

Specify file type

CIEERCD
File name: [' "eight_bit_uc.+" "ins_decode.v" "io.v" "mult.v" "pcf "req_file." "spc_regs. " "statefmc‘v"]
Files of type: |HDL Files (*.vhd *.vhdl *.% *.s% *,vma) '|
wHDLib: [ |+

Files ta add ta praject: (10 file(s) selected) Use relative paths Add files ko Folders Fn\der Optmns

:}:z::igg}iﬁuﬁ_@ux‘v Add flle

Awerilogheight_bit_uc.v

FileS to be .iver\:ngiing_d;maey buttons

JVEriogo.y
Added | | lreredmicy
ey Remove fie
Jverilogistate_me.y
buttons

Feature Description

Look in The directory of the file to add. You can use the pull-down
directory list or the Up One Level button to choose the
directory.

File name The name of a file to add to the project. If you enter a name
using the keyboard, then you must include the file-type
extension.

Files of type The type (extension) of files to be added to the project.

Only files in the active directory that match the file type
selected from the drop-down menu are displayed in the list
of files. Use All Files to list all files in the directory.
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Feature Description

Files To Add To Project The files to add to the project. You add files to this list with
the <-Add and <-Add All buttons. You remove files from this
list with the Remove -> and Remove All -> buttons.

For information about adding files to custom folders, see
Creating Custom Folders, on page 65.

Tcl equivalent: add_file -type filename

Use relative paths When you add files to the project, you can specify either to
use the relative path or full path names for the files.

Add files to Folders When you add files to the project, you can specify whether
or not to automatically add the files to folders. See the
Folder Options described below.

Folder Options When you add files to folders, you can specify the folder
name as either the:

¢ Operating System (OS) folder name
* Parent path name from a list provided in the display

Remove Implementation

Displays the Remove Implementation dialog box that allows you to remove the
selected implementation. You can select any of the following:

* Remove implementation only - Removes the implementation from the project
only.

* Remove impl. and delete directory - Removes the implementation from the
project and deletes the directory on the disk.

* No - Do not remove the implementation.

Choose the appropriate option shown in the dialog box below.

< Remove Implementation X

Do you wish to remove the selected implementations?

Remaove implementation cnlyl |Rem0ve impl. and delete direc:tcry| | No
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Change File Command

Select Project->Change File to replace a file in the project files list with another
of the same type. This displays the Source File dialog box, where you specify
the replacement file. You must first select the file to replace, in the Project

view, before you can use this command.

[original_linux -
£ @ C\Designsiusb_hubiusb_hub,pri
El- g Verilog
-~ [ usbf_crel6.e -SNOTES: L
[ usbf_creS.v - »NOTES: 1
D usbf_ep_rf.v -=WARNINGS: 10 -=MNOTES: 101
B usbf_ep_rF_dummey. - =MOTES: 1

[ usbf _idma.v - WaRNINGS: 7 -=HOTES: 87
D usbf_mem_arb. v - SWARMNINGS: 1 -=MNOTES: 1

First select a file in the Project view

Source File
Look in: | =3 prep I N e e
Then choose .the pr—y p—
replacement file prepB.y
prepd.y
preph. v
File namne: Ip[epS_v Change I

Files of type:  [Verilog Files [*.v".vma]

=] Cancel |

7z

Set VHDL Library Command

Select Project->Set VHDL Library to display the File Options dialog box, where you
view VHDL file properties and specify the VHDL library name. See File
Options Popup Menu Command, on page 472. This is the same dialog box as
that displayed by right-clicking a VHDL filename in the Project view and

choosing File Options.

Synplify Pro for Microsemi Edition Command Reference
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Add Implementation Command

Select Project->Add Implementation to create a new implementation for the
selected project. This selection displays the Implementation Options dialog box,
where you define the implementation options for the project — see Implemen-
tation Options Command, on page 345. This is the same dialog box as that
displayed by Project->Implementation Options, except that there is no list of Imple-
mentations to the right of the tabbed panels.
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Archive Project Command

Use the Project->Archive Project command to store files for a design project into
a single archive file in Synopsys Proprietary Format (sar). You can archive an
entire project or selected files from the project.

The Archive Project command displays the Synopsys Archive Utility wizard
consisting of either two (all files archived) or three (custom file selection) tabs.

Synopsys Archive Utlity - [C:/tools/temp/prof_1.pri]

Step 3: Please review the archiving summary and specify destination file then press ARCHIVE buttan.

(Archive Summars

Local File rev_LJrpt_counter_self.areasrr E]
Local File vev_tjrpt_rourker_self_areasrr.htm

Local File vev_tjrun_jse.tel

Local File rev_tjrun _options.txt

Local File rev_t/syn.db

Local File vew_t/synplcity.uck

Local File veu

Local File Synopsys As [C: /tools/temp/proj_1.piil 1ol x|
Local File

Local File

Local File,

Local File Step 2: Please select files to be archived,

Local File

Local File

Local File ~Project File List

Local File

Local File Create project using: (@ Source Files o)t Add Extra Fies. .
Local File

Local File

Locdl File . . . _ I
Local File Archive Summary:  Total file(s): 51  Total Size:2.2™M

Local File, Synopsys Archive Ulility - [C:/tools/temp/proj_1.pril

Lﬂta} F\}E Critoalsitempipr

Local Fi

Loca Fie 5 O e

Extra File : B Step 1: Please select the type of archiving

[ rev.
O Files

S (¥ Estr|  Fraject Path and Flename [ Ciftaclsftemp/prol_Lpr) ]
Destination Fie |Cif :
Rook Directory [Ciftodisftemp ] [ change... |
Destination File [Citodisftempfproi_t.sar L ]
~Archive Sty

® Create afully self-contained copy ( File: 52 Size: 2.30M)

All Implementation @ Active Implementation : rev_{

() Customized file st

e ) Local copy For inkernal network ( File: 0 Size: 0)
Active Impl,

[ Archive Type ] - Create a fully self-cantained copy

Allthe input files and files in implement ation result directories For the project will be archived in this mode, All the remote reference files will be added into the archive file with 2 special
"local type filename",

#llthe source files (verilog, vhd), e, etc.), constraint fies {.sde Fies), and other reference files {option, plan files) are considersd as input files.

The purpose of this type of archive is for users in different network enviranment., E.g., customers can archive their project in this mode and send it to Synopsys for debugging.
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Option Description

Project Path and Filename Path and filename of the .prj file.

Root Directory Top-level directory that contains the project files.
Destination Directory Pathname of the directory to store the archive .sar file.
Archive Style The type of archive:

* Create a fully self-contained copy — all project files are
archived; includes project input files and result files.

 If the project contains more than one implementation:
- All Implementation includes all implementations in the
project.
- Active Implementation includes only the active
implementation.

* Customized file list — only project files that you select are
included in the archive.

* Local copy for internal network — only project input files are
archived, no result files will be included.

Create Project using If you select the Customized file list option in the wizard,
you can choose one the following options on the second
tab:

* Source Files — Includes all design files in the archive.
You cannot enable the SRS option if this option is
enabled.

* SRS - Includes all .srs files (RTL schematics) in the
archive. You cannot enable the Source Files option
when this option is enabled.

Add Extra Files If you select the Customized file list option in the wizard,
you can use this button on the second tab to add
additional files to the archive.

For step-by-step details on how to use the archive utility, see Archive Project
Command, on page 337.
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Un-Archive Project Command

Use the Project->Un-Archive Project command to extract the files from an
archived design project.

This command displays a Synplicity Un-Archive Utility wizard.

Synplify Un-Archive Utility

IS[=]E3

Step 21 Please fix unresolved file reference. Uncheck any input fils you wish ko comment out in the project fils,

External File Reference [ Please fix unresolved file reference. Uncheck filename to remove it from project file )

| Resolved File Reference Resolved File Reference -
Designs_ramCktl/spel_regs.v Designs_ramCktl/spel_regs.v Change
Designs_ramCtrlfreg_file.v Designs_ramCtrlfreg_file.v mange
ML 6 ynplify Un-Archive Utility (O[]
Designs_ram(t
i Step 1: Please select archive File and destination directory.
Diesigns_rarniCk
Designs_ram(t
| Archive Filename [C:Itools\templpm]_l Jsar ] | |
Diesigns_rarniCk
Project Marne [ proj_1.prj ]
I File exists in archive

Destination Directary | DnihomePurResources),

Option

Archive Filename

Description

Path and filename of the .prj file.
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Option Description

Project Name Top-level directory that contains the project files.
Destination Directory Pathname of the directory to store the archive .sar file.
Original File Reference/ Displays the files in the archive that will be extracted.

Resolved File Reference You can exclude files from the .sar by unchecking the file
in the Original File Reference list. Any unchecked files are
commented out in the .prj file.

If there are unresolved reference files in the .sar file, you
must fix (Resolve button) or uncheck them. Or, if there
are files that you want to change when project files are
extracted, use the Change button and select files, as
appropriate. See Resolve File Reference, next for more
details.

For step-by-step details on how to use the un-archive utility, see Un-Archive
Project Command, on page 339.

Resolve File Reference

When you use the Un-Archive Utility wizard to extract a project, if there are
unresolved file references, use the Resolve button next to the file to point to a
new file location. You can also optionally replace project files in the destina-
tion directory by clicking the Change button next to the file you want to
replace. The Change and Resolve buttons bring up the following dialog box:

Synplicity Un-Archive Utility - Beszolve File Reference

~File Referance

Filename [prgm_cntr.v l

Criginal Direckory [ Dresigns_ramiZkrl l

Replace directory with I_Designs_ramCtr“ I | I

Final Filename [ Designs_ramZkrl/prgm_cntr. v l

Replace ” Replace Unresolved ” Replace all
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Option

Filename

Original Directory

Replace directory with

Final Filename

Replace buttons

Description

Specifies the path and name of the file you want to
change or resolve.

Specifies the location of the project at the time it was
archived.

Specifies the new location of the project files you want to
use to replace files.

Specifies the path name of the directory and the file
name of the replace file.

* Replace — replaces only the file specified in the Filename
field when the project is extracted.

* Replace Unresolved - replaces any unresolved files in the
project, with files of the same name from the Replace
directory.

* Replace All — replaces all files in the archived project
with files of the same name from the Replace directory.

* To undo any replace-file references, clear the Replace
directory with field, then click Replace. This causes the
utility to point back to the Original Directory and
filenames.

Copy Project Command

Use the Project->Copy Project command to create a copy of a design project. You
can copy an entire project or selected files from the project.

The Copy Project command displays the Synopsys Copy Utility wizard consisting of
either two (all files copied) or three (custom file selection) tabs.
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Synplicity Copy Ulility - [C:/tools/tempZproi_1.pril

Step 3: Please review the capy summary and specify destination diectory then press COPY button.

(~ Copy Summar,

Tokal Size :

Project Fis : Cijtoolsjtempproj_Lpri
Root Directory : Ciftoolsitemp]
Date : Mon Dec 1 15:23:56 2008
Files : = 3 =
Synplicity Copy Utility - [C:/tools/temp/proi_1.pril

- [Ofx]

‘ Step 2: Ploase select flles to be copied.

Project File
Stnmary Fie ~Project File List
Remote Ref. Create project using: @) Source Files ) SRS Add Extra Fik
Local File
Local File
Local File Archive Summary:  Total file(s): 52 Total Size: 2.3 M
Lacal File
Lacal Fil =
ocal Fie T ] . Lo o T2l )
Local File Synplicity Copy Utility - [C:/tools/temp/proi_1.pril
Local File & [ vel =
Lacal File B
Local File
t“ﬁa} :}E O] Fik Step 1 Please select the type of copying,
ocal File
= & Ex
Destination Directory Project Path and Fiename [Ciftoolsjtempiproj_Lpri ]
Raot Directory [ ftoclsftempi ] [ change.. |
Destination Directory [ | —
~Copy Styl

Option

® Create a fully self-contained copy

*) Customized file st

O Local copy for internal network

[ Copy Type ] - Create a fully self-contained copy

Allthe input files and files in implementation resul directories for the project wil be copied in this made. &llthe remate reference files will be added inta the copy fie with a special "local
type filename",

Allthe source files (verilog, vhd, =df, etc.), constraint files (.sdc files), and other reference files (option, plan files) are considered s input files.

The purpose of this type of copy is for users in different network environment. E.q., customers can copy their project in this mods and send it to Synopsys for debugging.

Description

Project Path and Filename
Root Directory

Destination Directory
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Path and filename of the .prj file.
Top-level directory that contains the project files.

Pathname of the directory to store the archive .sar file.
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Option
Copy Style

Create Project using

Add Extra Files

Description

The type of archive:

* Create a fully self-contained copy — all project files are
archived; includes project input files and result files.

* If the project contains more than one implementation:
- All Implementation includes all implementations in the
project.
- Active Implementation includes only the active
implementation.

¢ Customized file list — only project files that you select are
included in the archive.

* Local copy for internal network — only project input files are
archived, no result files will be included.

If you select the Customized file list option in the wizard,
you can choose one the following options on the second
tab:

¢ Source Files — Includes all design files in the archive.
You cannot enable the SRS option if this option is
enabled.

* SRS - Includes all .srs files (RTL schematics) in the

archive. You cannot enable the Source Files option if
this option is enabled.

If you select the Customized file list option in the wizard,
you can use this button on the second tab to add
additional files to the archive.

For step-by-step details on how to use the copy utility, see Copy Project

Command, on page 341.
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Hierarchical Project Options Command

The Project->Hierarchical Project Options command is not available for Microsemi
technologies.
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Implementation Options Command

You use the Implementation Options dialog box to define the implementation
options for the current project. You can access this dialog box from
Project->Implementation Options, by clicking the button in the Project view, or by
clicking the text in the Project view that lists the current technology options.

Dewvice Mapping Options

Option Value
Fanout Guide 24
Disable IfQ Insertion ]
Update Compile Point Timing Data ]
Promote Global Buffer Threshold 50
Operating Conditions COMWC
Anmnotated Properties for Analyst
Max number of critical paths in SDF 1]
Conservative Register Optimization |:|
Resolve Mixed Drivers ]

Click on an option for description

System Designer Board File

[ [ ]

This section describes the following:

* Device Panel, on page 346. For device-specific details of the options,
refer to the appropriate vendor chapter.

* Options Panel, on page 347

* Constraints Panel, on page 349

* Implementation Results Panel, on page 351
* Timing Report Panel, on page 353
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* VHDL Panel, on page 354
* Verilog Panel, on page 358
* Place and Route Panel, on page 372

Device Panel

You use the Device panel to set mapping options for the selected technology.

Technology Vendor Part Package Speed Grade
DeNge
Techndipgy: Part: Package: Speed:
Microsemi SmartFusion +| [azFzoomzr | ~| [FEGAZSS ~| [std -
Device Mapping Options
Option Value
Fanout Guide 24
Disable 1f0 Insertion O
Device Update Compile Paint Timing Data O
Mapplng ] Promote Global Buffer Threshold 50
Optlons Operating Conditions COMWC
Annotated Properties for Analyst
Max number of critical paths in SDF 1]
Conservative Register Optimization D
Resolve Mixed Drivers O
. Guide for fanout-based optimizations (such as replication)
Option
Description

System Designer Board File

System Designer
Board File ——+ (-]

The mapping options vary, depending on the technology. See Setting Device
Options, on page 75 in the User Guide for a procedure, and the relevant
vendor sections in this reference manual for technology-specific descriptions
of the options.
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The table below lists the following category of options. Not all options are
available for all tools and technologies.

Option Description
Technology Specify the device technology you want to synthesize. You can also
Vendor select the part, package, and speed grade to use.

For more information, see the appropriate vendor appendix in the
Reference manual.

Device The device mapping options vary depending on the device

Mapping technology you select.

Options For more information, see the appropriate vendor appendix in the
Reference manual.

Option Click on a device mapping option to display its description in this

Description field. Refer to the relevant vendor sections for technology-specific
descriptions of the options.

System Not applicable for Microsemi technologies.

Designer

Board File

Options Panel

You use the Options panel of the Implementation Options dialog box to define
general options for synthesis optimization. See Setting Optimization Options,
on page 78 of the User Guide for details.
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Ciptions
Optimization Switches

FSM Campiler
[_|FSM Explarer

Resource Sharing
Synthesis [CRetiming
optimization |
options

Option Description

Click on an option for a description.

The following table lists the options alphabetically. Not all options are avail-
able for all tools and technologies.

Option Description

Enable 64-bit Enables/disables the 64-bit mapping switch. When enabled, this

Synthesis switch allows you to run client programs in 64-bit mode, if available
on your system. For batch mode, use this Tcl command in your
project file: set_option -enable64bit 1

This option is supported on the Windows and Linux platforms.
Tcl equivalent: set_option -enable64bit 0|1

FSM Compiler Determines whether the FSM Compiler is run. See Running the
FSM Compiler, on page 423 and Optimizing State Machines, on
page 421 in the User Guide.

Tcl equivalent: set_option -symbolic_fsm_compiler 0|1
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Option
FSM Explorer

Resource
Sharing

Retiming

Description

Determines whether the FSM Explorer is run. See Running the FSM
Explorer, on page 426 in the User Guide.

Tcl equivalent: set_option -use_fsm_explorer 0|1

Controls whether you optimize area by sharing resources. See
Sharing Resources, on page 419 in the User Guide.

Tcl equivalent: set_option -resource_sharing 0|1

Determines whether the tool moves storage devices across
computational elements to improve timing performance in
sequential circuits. Note that the tool might retime registers
associated with RAMs and DSPs regardless of the Retiming setting.

For details about using this feature, see Retiming, on page 402 in
the User Guide.

Tcl equivalent: set_option -retiming 0|1

Constraints Panel

You use the Constraints panel of the Implementation Options dialog box to specify
target frequency and timing constraint files for design synthesis. See Speci-
fying Global Frequency and Constraint Files, on page 79, in the User Guide

for details.
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Constraints

Frequency [MHz)

® Auto Constrain (Opbmize to obtain maximum frequency)

[_] Use clack period for unconstrzined 10

Constrant Flas

[Creck fles to apphy to this implementation. Cick + to add new fie.

FOC Power |

¥ Chsynplify_pro\tuteralitutoral. fde

<clck to add fle...>

Option

Frequency

Auto Constrain
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Description

Sets the default global frequency. You can either set the
global frequency here or in the Project view. To override the
default you set here, set individual clock constraints from the
SCOPE interface.

Tcl equivalent: set_option -frequency frequency

When enabled and no clocks are defined, the software
automatically constrains the design to achieve the best
possible timing. It does this by reducing periods of each
individual clock and the timing of any timed I/O paths in
successive steps. See Auto Constraints, on page 142 for an
explanation, and Using Auto Constraints, on page 373 in the
User Guide for information about using this option.

You can also set this option in the Project view.
Tcl equivalent: set_option -frequency auto
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Option Description

Use clock period for  Determines whether default constraints are used for I/O
unconstrained 10 ports that do not have user-defined constraints.

When disabled, only set_input_delay or set_output_delay
constraints are considered during synthesis or forward-
annotated after synthesis.

When enabled, the software considers any explicit
set_input_delay or set_output_delay constraints, as before. In
addition, for all ports without explicit constraints, it uses
constraints based on the clock period of the attached
registers. Both the explicit and implicit constraints are used
for synthesis and forward-annotation. The default is off
(disabled) for new designs.

Tcl equivalent: set_option -auto_constrain_io 0|1

Constraint Files Specifies which timing constraints files to use for the
SDC. FDC implementation. Enable the checkbox to select a file.

For the Synplify Pro tool, block-level files in the compile-point
flows, the Module column shows the name of the module or
compile point.

Identify (IDC) Specifies the instrumentation design constraints (IDC) files
that add compiler pragmas in these files to the design RTL for
the instrumented signals and break points. Enable the check
box to select a file.

Implementation Results Panel

You use the Implementation Results panel to specify the implementation name
(default: rev_1), the results directory, and the name and format of the top-level
output netlist file (Result File). You can also specify output constraint and
netlist files. See Specifying Result Options, on page 81 of the User Guide for
details.

The results directory is a subdirectory of the project file directory. Clicking
the Browse button brings up the Select Run Directory dialog box to allow you to
browse for the results directory. You can change the location of the results
directory, but its name must be identical to the implementation name.

Enable optional output file check boxes to generate the corresponding Verilog
netlist, VHDL netlist, or vendor constraint files.
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Implementation
name

Results
directory

Result filename

Result

Implementation Results

Implementation Mame:

[ rev_1 ]

Results Directary:

—{ eight_bit_uc.edf

[C:'l,synplifyjro_actel'l,rev_l ]| Browse. .. |
Results File Mame: Result Farmat:
Nledfn [~

format

Optional
output files

Option
Implementation
Name

Results Directory
Result Base Name

Result Format

Write Mapped Verilog
Netlist

Write Mapped VHDL
Netlist

Write Vendor
Constraint File
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Cptional Gukput Files

[ Write Mapped Verilog Meklist
[ write Mapped YHDL Metlist
‘Wite Vendor Constraint File

Description

Displays implementation name, directory path for results,
and the base name for the result files.

Tcl equivalent: set_option -result_file pathtoResultFile

Select the output that corresponds to the technology you are
using. See the Appendix of the Reference manual for a list of
netlist formats.

Tcl equivalent: set_option -result_format format

Generates mapped Verilog or VHDL netlist files.
Tcl equivalent: set_option -write_verilog 0|1
Tcl equivalent: set_option -write_vhdl 0|1

Generates a vendor-specific constraint file for forward
annotation.

Tcl equivalent: set_option -write_apr_constrain 0|1
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Timing Report Panel

Use the Timing Report panel (Implementation Options dialog box) to set criteria for
the (default) output timing report. Specify the number of critical paths and
the number of start and end points to appear in the timing report. See Speci-
fying Timing Report Output, on page 82 in the User Guide for details. For a
description of the report, see Timing Reports, on page 161.

Timing Report

MNumber of Critical Paths: [ ]

Mumber of Start/End Points: [ ]

Desaription

Configure the timing report by specifying the number of paths to indude in the "Starting/Ending Points
with worst slack™ and "Worst Paths™ report sections.

Option Description
Number of Critical Set the number of critical paths you want the software to
Paths report.

Tcl equivalent: set_option -num_critical_paths numberOfPaths

Number of Start/End  Specify the number of start and end points you want to see
Points reported in the critical path sections.

Tcl equivalent: set_option -num_startend_points numberOfPoints

See also:

* Timing Reports, on page 161, for more information on the default timing
report, which is affected by the Timing Report panel settings.
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VHDL Panel
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* Analysis Menu, on page 393, information on creating additional custom
timing reports for certain device technologies.

You use the VHDL panel in the Implementation Options dialog box to specify
various language-related options. With mixed HDL designs, the VHDL and
Verilog panels are both available. See Setting Verilog and VHDL Options, on
page 83, of the User Guide for details.

Top Level Entity:

VHDL

Default Enum Enceding:

[

| [default e
Push Tristates
[ synthesis On/Off Implemented as Translate On/Off
[ vHOL 2008
[Tl Beta Features for VHOL
Generics
Generic Name Value
Extract Generic Constants
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The following table describes the options available:

Feature Description

Top Level Entity The name of the top-level entity of your design.

If the top-level entity does not use the default work
library to compile the VHDL files, you must specify the
library file where the top-level entity can be found. To
do this, the top-level entity name must be preceded by
the VHDL library followed by a period (.). To specify
VHDL library files, see Project Menu, on page 331 for
the Set VHDL Library command, or the File Options
Popup Menu Command , on page 472.

Tcl equivalent: set_option -top_module topLevelName

Default Enum Encoding The default enumeration encoding to use. This is only
for enumerated types; the FSM compiler automatically
determines the state-machine encoding, or you can
specify the encoding using the syn_encoding attribute.

Tcl equivalent: set_option -default_enum_encoding
encodingType

Note: Enable FSM Compiler before attempting to
change the encoding style.

Push Tristates When enabled (default), tristates are pushed across
process/block boundaries. For more information, see
Push Tristates Option, on page 361.

Tcl equivalent: set_option -compiler_compatible 0|1

Synthesis On/Off When enabled, the software ignores any VHDL code
Implemented as Translate between synthesis_on and synthesis_off directives. It
On/Off treats these third-party directives like

translate_on/translate_off directives (see
translate_off/translate_on, on page 138 for details).

Tcl equivalent: set_option -synthesis_onoff_pragma 0|1

VHDL 2008 When enabled, allows you to use VHDL 2008 language
standards.

Tcl equivalent: set_option -vhdi2008 0|1
VHDL 2019 When enabled, allows you to implement VHDL 2019

conditional analysis. See VHDL 2019 Conditional
Analysis, on page 356.
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Feature

Implicit Initial Value Support

Beta Features for VHDL

Loop Limit

Generics

Extract Generic Constants

Description

When enabled, the compiler passes init values through
a syn_init property to the mapper. For more information,
see VHDL Implicit Data-type Defaults, on page 294.

Tcl equivalent: set_option -supporttypedfit 0|1

Enables use of any VHDL beta features included in the
release. Enabling this checkbox is equivalent to
including a set_option -hdl_define -set
_BETA_FEATURES_ON_ directive in the project file.

Tcl equivalent: set_option -beta_vhfeatures 0|1

Overrides the default compiler loop limit value of 2000
in the RTL and sets a new global default. You can apply
limits on a per-loop basis using the Verilog loop_limit or
the VHDL syn_looplimit directive for individual loops.

For details about these directives, see loop_limit, on
page 73 and syn_looplimit, on page 355 in the
Attribute Reference.

Tcl equivalent: set_option -looplimit loopLimitValue

Shows generics extracted with Extract Generic Constants.
You can override the default and set a new value for the
generic constant. The value is valid for the current
implementation.

Extracts generics from the top-level entity and displays
them in the table.

VHDL 2019 Conditional Analysis

Beta

This section describes how to implement VHDL 2019 conditional analysis

identifiers and values:

1. Open the Implementation Options dialog box and select the VHDL tab.
2. Click the VHDL 2019 option to specify VHDL analysis.

© 2020 Synopsys, Inc.
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VHOL [4 ]
Top Lavel Entity: Dafault Enum Encoding:
eight_bil_uc default - |

Incremental Compile

Push Trictates

Synthesis On/Off Implemented as Translate On/Off
VHDL 2008

VHDL 2019

MANTE &N

Implicit Initial Value Support

Beta Features for WVHDL

Loop Limit | 2000

A K

3. Add a file, condparams.dat, into the synwork folder of your implementation
directory. The file should have one identifier name and one string value pair,
per line of the file.

For example:

VHDL_VERSI ON " 2019"
TOOL_TYPE " SYNTHESI S
DEBUG LEVEL "2"

The VHDL 2019 LRM includes predefined identifiers with their default
values:

VHDL_VERSI ON " 2019"
TOOL_TYPE " SYNTHES! S
TOOL_VENDCR " SYNOPSYS'
TOOL_NAME " FPGA_COMWPI LER'
TOOL_ED TI ON * SYNPLI FY"
TOOL_VERSI ON " P- 2019. 03"

4. You can edit the condparams.dat file to override these defaults.
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Verilog Panel

You use the Verilog panel in the Implementation Options dialog box to specify
various language-related options. With mixed HDL designs, the VHDL and
Verilog panels are both available. See Setting Verilog and VHDL Options, on
page 83 of the User Guide for details.

Verilog

Top Level Module: Compiler Directives and Parameters

[ Parameter Name Value =

Verilog Language

verilog 2001
[ System Verilog

Push Tristates
[ Allow Duplicate Modules
[ Multiple File Compilation Unit

[ Beta Features for Verilog Extract Parameters

Compiler Directives: e.g. SIZE=8

[ ]
Indude Path Order: {Relative to Project File) l I ] I . I

-

-

Library Directories: | I [ I I

Feature Description

Top Level Module The name of the top-level module of your design.
Tcl equivalent: set_option -top_module moduleName

Compiler Directives and Shows design parameters extracted with Extract

Parameters Parameters. You can override the default and set a new
value for the parameter. The value is valid for the
current implementation.

Extract Parameters Extracts design parameters from the top-level module
and displays them in the table. See Compiler Directives
and Design Parameters, on page 363.
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Feature Description

Compiler Directives Provides an interface where you can enter compiler
directives that you would normally enter in the code with
‘ifdef and ‘define statements. See Compiler Directives and
Design Parameters, on page 363.

Verilog Language — When enabled, the default Verilog standard for the

Verilog 2001 project is Verilog 2001. When both Verilog 2001 and
SystemVerilog are disabled, the default standard is Verilog
95. For information about Verilog 2001, see Verilog
2001 Support, on page 17.

You can override the default project standard on a per
file basis by selecting the file, right-clicking, and
selecting the File Options command (see File Options
Popup Menu Command , on page 472).

Tcl equivalent: set_option -viog_std v2001

Verilog Language — When enabled, the default Verilog standard for the

SystemVerilog project is SystemVerilog which is the default standard
for all new projects. Enabling SystemVerilog automatically
enables Verilog 2001.

Tcl equivalent: set_option -vlog_std sysv

Push Tristates When enabled (default), tristates are pushed across
process/block boundaries. For details, see Push
Tristates Option, on page 361.

Tcl equivalent: set_option -compiler_compatible 0|1
Allow Duplicate Modules  Allows the use of duplicate modules in your design.

When enabled, the last definition of the module is used
by the software and any previous definitions are ignored.

You should not use duplicate module names in your
Verilog design, therefore, this option is disabled by
default. However, if you need to, you can allow for
duplicate modules by enabling this option.

Tcl equivalent: set_option -allow_duplicate_modules 0|1

Multiple File Compilation When enabled (the default), the Verilog compiler uses the
Unit compilation unit for modules defined in multiple files.

See SystemVerilog Compilation Units, on page 207 for
additional information.

Tcl equivalent: set_option -multi_file_compilation_unit 0|1
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Feature

Beta Features for Verilog

Loop Limit

Include Path Order

Library Directories

Library Extensions (space
separated)

© 2020 Synopsys, Inc.
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Description

Enables use of any Verilog beta features included in the
release. Enabling this checkbox is equivalent to
including a set_option -hdl_define -set
_BETA_FEATURES_ON_ directive in the project file.

Tcl equivalent: set_option -beta_vfeatures 0|1

Overrides the default compiler loop limit value of 2000 in
the RTL and sets a new global default. You can apply
limits on a per-loop basis using the Verilog loop_limit or
the VHDL syn_looplimit directive for individual loops.

For details about these directives, see loop_limit, on
page 73 and syn_looplimit, on page 355 in the Attribute
Reference.

Tcl equivalent: set_option -looplimit loopLimitValue

Specifies the search paths for the include commands in
the Verilog design files of your project. Use the buttons
in the upper right corner of the box to add, delete, or
reorder the paths. The include paths are relative. See
Updating Verilog Include Paths in Older Project Files,
on page 64 in the User Guide for additional information.

Specifies all the paths to the directories which contain
the Verilog library files to be included in your design for
the project. You can also add custom library files with
module definitions for the design in a single file. See
Verilog Single Library File Support, on page 362. The
names of files read from the library path must match
module names. Mismatches result in error messages.

Tcl equivalent:
set_option -library_path ./libraryPath or libraryFile

Adds library extensions to Verilog library files included
in your design for the project and searches the directory
paths you specified that contain these Verilog library
files. To use library extensions, see Using Library
Extensions for Verilog Library Files, on page 78 in the
User Guide.

Tcl equivalent:
set_option -libext .libextName

Enter a space between each unique library extension.
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Push Tristates Option

Pushing tristates is a synthesis optimization option you set with Project->Imple-
mentation Options->Verilog or VHDL.

Description

When the Push Tristates option is enabled, the Synopsys FPGA compiler
pushes tristates through objects such as muxes, registers, latches, buffers,
nets, and tristate buffers, and propagates the high-impedance state. The
high-impedance states are not pushed through combinational gates such as
ANDs or ORs.

Puish Tristates on: tristate is pushed through the fip-fop so that the
result matches RTL simulation

ok = -
an_ o0 [-..J_
unl_en L~ {gin ==
q_fin_2
b
[EETET i — ey R
q_in_1

Push Tristates off: tristate is not pushed through the flip-flop

[

B - .

data in - L____.'.

If there are multiple tristates, the software muxes them into one tristate and
pushes it through. The software pushes tristates through loops and stores
the high impedance across multiple cycles in the register.

Advantages and Disadvantages

The advantage to pushing tristates to the periphery of the design is that you
get better timing results because the software uses tristate output buffers.
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The Synopsys FPGA software approach to tristate inference matches the
simulation approach. Simulation languages are defined to store and propa-
gate O, 1, and Z (high impedance) states. Like the simulation tools, the
Synopsys FPGA synthesis tool propagates the high-impedance states instead
of producing tristate drivers at the outputs of process (VHDL) or always
(Verilog) blocks.

The disadvantage to pushing tristates is that you might use more design
resources.

Effect on Other Synthesis Options

Tristate pushing has no effect on the syn_tristatetomux attribute. This is
because tristate pushing is a compiler directive, while the syn_tristatetomux
attribute is used during mapping.

Verilog Single Library File Support

You can add a single library file to your project for easier migration from a
VCS environment and to ensure their behaviors are consistent for the design.
To do this, either:

* Select the Add a file icon from the Verilog tab of the Implementation
Options panel. Then, specify the library file to be added to the project
from the Library Directories and Files option.

Include Path Order: (Relative to Project Filg) BD:I:'
Library Dircctorics or Files: !l . - .
Csynplify_prolsoftwarcitutoriallibVlio 1. v -t

Library Extcnsions (space scparated)

¢ Add the following Tcl command to your project file:

set_option -library_path {./libPath/libFile.v}
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Compiler Directives and Design Parameters

When you click the Extract Parameters button in the Verilog panel (Implementation
Options dialog box), parameter values from the top-level module are displayed
in the table. You can also override the default by setting a new value for the
parameter. The value is valid for the current implementation only.

The Compiler Directives field provides an interface where you can enter compiler
directives that you would normally enter in the code using ‘ifdef and ‘define
statements. Use spaces to separate the statements. The directives you enter
are stored in the project file. For example, if you enter the directive shown
below to the Compiler Directives field of the Verilog panel:

Top Level Module: Compiler Directives and Parameters

Verilog

[ ]

Parameter Name

Verilog Language

Value ﬂ

verilog 2001

[] system Veriog

Push Tristates
] Allow Duplicate Modules

Compiler Directives: e.g. SIZE=8
[] Muttiple File Compilation Unit

Extract Parameters

[ABC=30

]

] Beta Features for Verilog

|Include Path Order: (Relative to Project File)

the software writes the following statement to the project file:

PEnn

set_option -hdl _define -set "ABC=30"
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To define multiple variables in the GUI, use a space delimiter. For example:

Verilog

Top Level Module: Compiler Directives and Parameters

Verilog Language

Verilog 2001
[] system Verilog

Push Tristates Extract Parameters

] Allow Duplicate Modules
[J Multiple File Compilation Unit
[] Beta Features for Verilog

|Include Path Order: (Relative to Project File) | I I I - I

The software writes the following statement to the prj file:

Parameter Name Value ﬂ

Compiler Directives: e.g. SIZE=8
[ABC=30%vZ=12 y |

set _option hdl _define -set "ABC=30 XYZ=12 vj"

More information is provided for the following Verilog compiler directives:

Compiler Directive Description

_ ALLOWNESTEDBLOCKCOMMENTSTART__  Allows for nested comment blocks.

_BETA_FEATURES_ON_ Explicitly enables beta HDL
language features.

IGNORE_VERILOG_BLACKBOX_GUTS Ignores the contents of a black box.

_SEARCHFILENAMEONLY_ Provides workarounds for archive

utility limitations.

SYN_COMPATIBLE Ensure compatibility between
different Synopsys tools.

__SYN_COMPATIBLE_INCLUDEPATH___ Specifies that the search path order
for includes to be the same as the

one used by the simulation tool
(VCS).

_ SYN_STRICT_MODPORTS___ Requires that modports defined
strictly access the associated
interface ports specified in the
instantiation.
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IGNORE_VERILOG_BLACKBOX_GUTS

When you use the syn_black_box directive, the compiler parses the contents of
the black box and can determine whether illegal syntax or incorrect code is
defined within it. Whenever this occurs, an error message is generated. You
can specify the IGNORE_VERILOG_BLACKBOX_GUTS compiler directive to
ignore the contents of the black box. However, make sure that the black box
is syntactically correct.

If you want the tool to ignore the contents of your black box, set the:

Built-in compiler directive IGNORE_VERILOG_BLACKBOX_GUTS in the Compiler
Directives field of the Verilog panel on the Implementation Options dialog box.

Verilog
Top Level Module: Compiler Directives and Parameters
Verilog Language

Verlog 2001
[ system Verilog

Push Tristates Extract Parameters

[J Allow Duplicate Modules
[J Multiple File Compilation Unit
] Beta Features for Verilog

|Include Path Order: (Relative to Project File) | I I I I

The software writes the following command to the project file:

Parameter Name Value ﬂ

Compiler Directives: e.g. SIZE=8
[IGNORE_VERILOG_BLACKBOX_GUTS |

set_option -hdl _define -set "I GNORE VER LOG BLACKBOX QJUTS"
e “define | GNORE_VER LOG BLACKBOX_QUJTS directive in the Verilog file.

This option is implemented globally for the project file.

Example of the IGNORE_VERILOG BLACKBOX_ GUTS Directive

The IGNORE_VERILOG_BLACKBOX_GUTS directive ignores the contents of the
black box. However, whenever you use this directive, you must first define
the ports for the black box correctly. Otherwise, the IGNORE_VERILOG_BLACK-
BOX_GUTS directive generates an error. See the following valid Verilog
example:
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“define | GNORE_VER LOG BLACKBOX_QGJTS

nmodul e bl fpgal (A B,C D /* synthesis syn bl ack box */;
i nput B;

out put A

input [2:0] D

output [2:0] C

tenp;

assign A = B;

assign C = D

endnodul e

nmodul e bl fpgal top (inout A B, inout [2:0] C D;
bl fpgal bl fpgal inst(A B CD);
endnodul e

_BETA_FEATURES_ON_

Beta features for the Verilog, SystemVerilog, or VHDL language must be
explicity enabled. In the U, a Beta Features checkbox is included on the VHDL
or Verilog tab of the Implementations Options dialog box. A _BETA_FEATURES_ON_
compiler directive is also available. This directive is specified with a set option
-hdl_define command added to the project file as shown below:

set _option -hdl _define -set BETA FEATURES ON_

The directive can also be added to the Compiler Directives field of the Verilog
panel.

Verilog
Top Level Module: Compiler Directives and Parameters
Verilog Language

Verilog 2001
[] systemn Veriog

Parameter Name Value ﬂ

Push Tristates

[] Allow Duplicate Modules Extract Parameters

[] Muttiple File Compilation Unit

D Beta Features for Verilog Compiler Directives: e.g. SIZE=8
[_BETA_FEATURES_ON_ |
Auto Infer Blackbox
|Include Path Order: (Relative to Project File)
© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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Current beta features that must be explicitly enabled for the compiler include
the following:

HDL Language Constructs Descriptions

Aggregates e Multi-assignments for array aggregates
¢ Assignments for the union of variable types

_SEARCHFILENAMEONLY_

This directive provides a workaround for some known limitations of the
archive utility.

If Verilog 'include files belong in any of the following categories, you may
encounter problems when compiling a design after un-archiving:

1. The include paths have relative paths to the project file.
“include "../../../defines.h"

2. The include paths have absolute paths to the project file.
“include "c:/tenp/ parans. h"
“include "/renot e/ sbg_hone/ user/ par ans. h"

3. The include paths have the same file names, but are located in different
directories relative to the project file.

“include "../nyflop.v"

i nclude "../../nyflop.v"

Use the _SEARCHFILENAMEONLY _ directive to resolve categories 1 and 2
above. Category 3 is a known limitation; in this case it is recommended that
you adopt standard coding practices to avoid files with the same name and
different content.

When you un-archive a sar file that contains relative or absolute include
paths for the files in the project, you can add the _SEARCHFILENAMEONLY _
compiler directive to the unarchived project; this has the compiler remove the
relative/absolute paths from the ‘include and search only for the file names.

This directive is specified with a set_option -hdl_define command added to an
implementation within the project file as shown below:
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set_option -hdl _define -set " _ SEARCHFI LENAMECNLY "

The directive can also be added to the Compiler Directives field of the Verilog
panel as shown below.

Verilog

Top Level Module: Compiler Directives and Parametars
[ ] Parameter Name Value =

Verilog Language

Veriog 2001

[] System Veriog

-

Push Tristates =

[] Allow Duplicate Modules Extract Parameters

[] Muttiple File Compilation Unit

[] Beta Features for Veriog Compiler Directives: e.g. SIZE=8
"_SEARCHFILENAMEQNLY_"
Auto Infer Blackbox

|Include Path Order: (Relative to Project File) | I i I d I

The compiler generates the following warning message whenever it extracts
include files using this directive:

@V | Macro _SEARCHFI LENAMEONLY is set: fileNane not found
attenpting to search for base file nane fil eNare

_ ALLOWNESTEDBLOCKCOMMENTSTART__

Verilog/SystemVerilog comments can be included in RTL code as a

* One-line comment starting with the characters // and ending with a
new line

* Block comment starting with /* and ending with */

However, nested block comments are not supported according to the LRM, so
most tools generate a warning and ignore these comments in the RTL code.
To match this behavior, the synthesis tools must also ignore various nested
block comments, such as:

I* 0. I* 00 0%
(An incorrect pair)
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To do this, the compiler uses the __ ALLOWNESTEDBLOCKCOMMENTSTART__
directive and parses the first /* until it encounters the associated pair */, then
ignores all content between and including any number of these lines and the
block comments.

You can specify the _ ALLOWNESTEDBLOCKCOMMENTSTART__ directive with a
set_option -hdl_define command added to the project file as shown below:

set_option -hdl _define -set __ ALLONNESTEDBLCCKCOMVENTSTART

The directive can also be added to the Compiler Directives field of the Verilog

panel.
Verilog
Top Level Module: Compiler Directives and Parameters
Parameter Name Override Value

Verilog Language

Verilog 2001
System Verilog

[ | Incremental Compile @

Push Tristates
[ | Allow Duplicate Modules ExticiP ko
Multiple File Compilation Unit

l:l Beta Eeatures for Vesiog Compiler Directives: e.g. SIZE=8

__ALLOWNESTEDBLOCKCOMMENTSTART__

LI

Loop Limit | 2000

_ SYN_COMPATIBLE_INCLUDEPATH__

Specifies that the search path order for includes to be the same as the one
used by the simulation tool (VCS), instead of the following default search
order, which searches the current logical library of the file where the module
is instantiated first, then the library path for the current logical library, and
lastly other logical libraries.

With _ SYN_COMPATIBLE_INCLUDEPATH__, this is the search path order:
* Current working directory

* Include file directories, with first priority to RTL includes and then
include paths

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 369



User Interface Commands Implementation Options Command

You can specify the _ SYN_COMPATIBLE_INCLUDEPATH___ directive with a
set_option -hdl_define command added to the project file as shown below:

set_option -hdl _define -set _ SYN OCOWPATI BLE | NCLUDEPATH

The directive can also be added to the Compiler Directives field of the Verilog

panel.
Verilog |
Top Level Module: Compiler Directives and Parameters
Parameter Name | Override Value -

Verilog Language

Verilog 2001

Systermn Verilog
Push Tristates %
[ | Allow Duplicate Modules Extract Pammeter5|

Multiple File Compilation Unit

D Beta Features for Verilog Compiler Directives: e.q. SIZE=8

= _ SYWN_COMPATIBLE_INCLUDEPATH_
Loop Limit | 2000 -

Include Path Order: (Relative to Project File)

SYN_COMPATIBLE

Use the SYN_COMPATIBLE macro to ensure compatibility between different
Synopsys tools. Some Synopsys tools, such as Design Compiler (DC), ignore
dynamic initialization assignments, unlike the synthesis tool. In the following
example, note the line logic a=b; DC leaves the output unconnected, because
DC does not handle inline assignments. By contrast, the synthesis tool
handles inline assignments, so input b drives the output q.

nmodul e test (b, Q);
i nput b;

out put g;

logic a = b;

assign q = a;
endnodul e
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The tool warns you of the difference in handling (warning message @W:
CG879), and treats the assignment as a regular assign. If you are using
modules from DC and need it to be compatible with the synthesis tool, there
are two ways to match the behavior and ignore the non-constant initial
values:

1. Specify a macro with a Tcl command.
set_option -hdl_define -set SYN_COMPATIBLE=DC

2. Specify a macro through the GUI.

— To specify it from the GUI, go to the Verilog tab of the Implementation
Options dialog box.

— In the Compiler Directives field, set SYN_COMPATIBLE=DC.
Werilog

Top Level Module: Compiler Directives and Parameters

Parameter Name | Override Value
Werilog Language
Verilog 2001
System Verilog

Push Tristates E
[ Allow Duplicate Modules
Multiple File Compilation Unit
[] Beta Features for Verilog

Extract Parameters |

Compiler Directives: e.g. SIZE=8

SYN_COMPATIELE=DC
Loop Limit | 2000 =

__SYN_STRICT_MODPORTS__

Use the _ SYN_STRICT_MODPORTS__ macro to require that modports defined
strictly access the associated interface ports specified for the instantiation.
You might encounter the following error:

@E: CS172 The number of ports in the instantiation does not match the number of ports
in the module definition for instance instanceName
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This can occur if you have specified a global interface instantiation for

« %

modports using the “.*” syntax to access the ports. Set the __ SYN_STRICT_-
MODPORTS__ macro to ensure mapping completes successfully.

1. To specify the macro with a Tcl command.
set_option -hdl_define -set __ SYN_STRICT_MODPORTS__

2. To specify the macro through the GUI.

— To specify it from the GUI, go to the Verilog tab of the Implementation
Options dialog box.

— In the Compiler Directives field, set _ SYN _STRICT_MODPORTS__.

Verilog

Top Level Module: Compiler Directives and Parameters

eight_bit_uc

Farameter Mame | Override Value
Verilog Language

Verilog 2001
System Verilog

Push Tristates E
[] Allow Duplicate Modules
Multiple File Compilation Unit
[] Beta Features for Verilog

Extract Parameters |

Compiler Directives: .g. SIZE=8
__SYN_STRICT _MODPORTS__

-

Loop Limit | 2000

-

Place and Route Panel

The Place and Route panel allows you to run selected place-and-route jobs after
design synthesis. To create a place-and-route job, see Add P&R Implementa-
tion Popup Menu Command, on page 478 or Options for Place & Route Jobs
Popup Menu Command, on page 479 for details. The Place and Route Panel is
only available with certain technologies.
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Place and Route |

~—Place and Route

Check the Flace and Route jobs to run Fallowing main synthesis Flaw,
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Run Menu

You use the Run menu to perform tasks such as the following:
* Compile a design, without mapping it.
* Synthesize (compile and map) or resynthesize a design.
* Check design syntax and synthesis code, and check source code errors.

* Check constraint syntax and how/if constraints are applied to the
design.

* Run Tcl scripts.
* Run all implementations at once.

* Check the status of the current job.

The following table describes the Run menu commands.

Command Description

Run Synthesizes (compiles and maps) the top-level design. For
the compile point flow, this command also synthesizes
any compile points whose constraints, implementation
options, or source code changed since the last synthesis
run. You can view the result of design synthesis in the
RTL and Technology views.

Same as clicking the Run button in the Project view.
Tcl equivalent: project -run

Resynthesize All Resynthesizes (compiles and maps) the entire design,
including the top level and all compile points, whether or
not their constraints, implementation options, or source
code changed since the last synthesis. If you do not want
to force a recompilation of all compile points, then use
Run->Run instead.

Tcl equivalent: project -run synthesis -clean

Compile Only Compiles the design into technology-independent high-
level structures. You can view the result in the RTL view.

Tcl equivalent: project -run compile
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Command

Write Output Netlist Only

FSM Explorer

Syntax Check

Synthesis Check

Constraint Check

Arrange VHDL files

Synplify Pro for Microsemi Edition Command Reference

January 2020

Description

Generates an output netlist after synthesis has been run.
This command generates the netlists you specify on the
Implementation Results tab of the Implementation Options
dialog box.

You can also use this command in an incremental timing
analysis flow. See Generating Custom Timing Reports
with STA, on page 363 for details.

Tcl equivalent: project -run write_netlist

Analyzes finite state machines contained in a design, and
selects the optimum encoding style. This menu command
is not available in some views.

Tcl equivalent: project -run fsm_explorer

Runs a syntax check on design code. The status bar at
the bottom of the window displays any error messages. If
the active window shows an HDL file, then the command
checks only that file; otherwise, it checks all project
source code files.

Tcl equivalent: project -run syntax_check

Runs a synthesis check on your design code. This
includes a syntax check and a check to see if the
synthesis tool could map the design to the hardware. No
optimizations are carried out. The status bar at the
bottom of the window displays any error messages. If the
active window shows an HDL file, then the command
checks only that file; otherwise, it checks all project
source code files.

Tcl equivalent: project -run synthesis_check

Checks the syntax and applicability of the timing
constraints in the .fdc file for your project and generates a
report (projectName_cck.rpt). The report contains
information on the constraints that can be applied,
cannot be applied because objects do not exist, and
wildcard expansion on the constraints.

See Constraint Checking Report, on page 171.

Tcl equivalent: project -run constraint_check

Reorders the VHDL source files for synthesis.
Tcl equivalent: project -run hdl_info_gen fileorder
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Command Description
Launch Identify Launches the Identify instrumentor. For more
Instrumentor information, see: Working with the Identify Tools, on

page 545 of the User Guide.

To launch the Identify instrumentor in batch mode, use
the set_option -identify_debug_mode 1 Tcl command.

Launch Identify Debugger Launches the Identify debugger tool. For more
information, see: Working with the Identify Tools, on
page 545 of the User Guide.

To launch the Identify debugger in batch mode, use the
set_option -identify_debug_mode 1 Tcl command.

Launch SYNCore Opens the Synopsys FPGA IP Core Wizard. This tool helps
you build IP blocks such as memory or FIFO models for
your design.

See the Launch SYNCore Command, on page 382 for

details.
Configure and Launch Allows you to configure and launch the VCS simulator.
VCS Simulator See Configure and Launch VCS Simulator Command,
on page 383.
Run Tcl Script Displays the Open dialog box, where you choose a Tcl
script to run. See Run Tcl Script Command, on
page 377.
Run Implementations Runs all implementations of one project at the same time.
Setup Tcl equivalent: run -impl "implementation1 implementation2..."
-parallel
Job Status During compilation, tells you the name of the current job,

and gives you the runtime and directory location of your
design. This option is enabled during synthesis. See Job
Status Command, on page 379. Clicking in the status
area of the Project view is a shortcut for this command.

Next Error/Warning Shows the next error or warning in your source code file.
Previous Error/Warning Shows the previous error or warning in your source code
file.
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Run Tcl Script Command

Select Run->Run Tcl Script to display the Open dialog box, where you specify the
Tcl script file to execute. The File name area is filled automatically with the
wildcard string “*.tcl”, corresponding to Tcl files.

This dialog box is the same as that displayed with File->Open, except that no
Open as read-only check box is present. See Open Project Command, on
page 309, for an explanation of the features in the Open dialog box.

Choose the directory

Laok i I@ eight_bit_uc j & % Ef-
constrain Clrev 5
lib Cdrev B .
rev 1 Clrew 7 “*.tcl” matches Tcl files
rew_2 | rev_8 ) .
rev_3 20 werilog = Specify Tcl file type

Cdwhdl

rev_4

File name:  [~.cl Open |
Files of wpe: ITELFiIes[“.ch] j Cancel |

i

Run Implementations Setup Command

Select Run->Run Implementations Setup to run selected implementations of a
project file in batch mode. To use the Batch Run Setup dialog box, check one or
more implementations from the list displayed and click the Run button.
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Batch Run Setu

Select Implementations to Run

E-itutorial

rev_1
rev_2

TCL Comrrand

[% run -impl tutorial|rev_1 -impl tutorialirev_2 -bg

Run Options

|:| Parallel - Run implementations concurrently. May reguired additional license
|:| Force Rerun - Ignores up-to-date checking and does full run

Background - Run command non-blocking in background

|:| Run All - Run all implementations of active project

Run | Cancel

You can also choose to run the selected implementations with one or more of

the following options:

Command

Description

Parallel

Runs specified implementations concurrently. This
may require additional licenses.

Tcl equivalent: run -impl implName -parallel

Force Rerun

Runs specified implementations, while ignoring
up-to-date checking. This option clears all
previous results and forces a complete rerun.

Tcl equivalent: run -impl implName -clean

Background Runs specified implementations in non-blocking
background mode.
Tcl equivalent: run -impl implName -bg

Run All Runs all implementations of the active project.

Tcl equivalent: run -all
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378

Synplify Pro for Microsemi Edition Command Reference

Synopsys Confidential Information

January 2020



Run Menu User Interface Commands

Job Status Command

Select Run->Job Status to monitor the synthesis jobs that are running, their
run times, and their associated commands. This information appears in the
Job Status dialog box. This dialog box is also displayed when you click in the
status area of the Project view (see The Project View, on page 20).

You can cancel a displayed job by selecting it in the dialog box and clicking

Cancel Job.

| JobStatus 2]
|Jub Name |State |Run Time |Jub Command |
E] proj|rev_1 (synthesis) Done  00:00:06

F- Premap Flow (pre_map_flow) Done  00:00:03
i B Compie Flow (compile_flow) Done  00:00:02
“-HDL Compie (compiler) Done 00:00:02 c_verexe - C:\builds\syn201103act_001R\bin\c_ver.exe
; Pre-mapping (premapping) Done  00:00:01 m_proasic.exe - C:\buids\syn201103act_001R\bin\m_proasic.exe
E- Mapping Flow (mapping_flow) Done  00:00:03
Mapping (Fusion Mapper) Done  00:00:03 m_proasic.exe - C:\buids\syn201103act_001R\bin\m_proasic.exe

To cancel a job, select it,
then click the Cancel button

Identify Instrumentor Command

The Identify Instrumentor command lets you start the integrated or stand-alone
Identify instrumentor from within the synthesis interface. Before you can use
this command, you must define an Identify implementation in the project
view. For a description of the work flow using the Identify debugger, see
Working with the Identify Tools, on page 545 in the User Guide.

Configure Identify Launch Dialog Box

Select Options->Configure Identify Launch to display this dialog box or which is
automatically displayed when the location of the Identify executable has not
been previously defined.
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< Configure Identify Launch .S

Select Instrumentor
® [ntegrated
Stand-Alone
Select Debugger
® |egacy
Gen2 (beta)

Where is identify installed?

[C:\Synopsys\identify_m—zm?.DG—SF’1—1\ - E

Identify License Option

® Use current synthesis license

Use separate Identify license

oK || Cancal
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Command

Select Instrumentor

Locate Identify
Installation (for the
Identify Debugger)

Identify License Option

Description

Click the radio button to select which version of the
instrumentor to use. You can choose either the
integrated or stand-alone Identify Instrumentor.

A pointer to the Identify install directory. Use the (...)
button to navigate to the directory location.

Select Identify Installation Directory BB

Look in: | ©2 Ciitoolstident3ng_ S50~ | @ O @ 2 B8

My Computer

L
Csedtag

] garyl g doc

1) etc

]

| share

I tutorial

Direckory: [ bin ] | Choose |
Files of type: IDirectories vI | Cancel I
.

Radio buttons to select the Identify license option. Select
Use current synthesis license when only a single TSL license
is available; select Use separate Identify Instrumentor license
when multiple licenses are available. With a single TSL
license, you are prohibited from compiling or mapping in
the synthesis tool while the Identify instrumentor is
open.

Launch Identify Debugger Command

The Launch Identify Debugger command launches a stand-alone version the
Identify Debugger software from the synthesis interface. Before you can use
this command, you must have an active Identify implementation and an
instrumented design. For a description of the work flow using the

Identify /Identify RTL Debugger software, see Working with the Identify Tools,
on page 545 in the User Guide.
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Launch SYNCore Command

The SYNCore wizard helps you build IP cores. Currently, the wizard can
compile RAM and ROM memories including a byte-enable RAM, a FIFO, an
adder/subtractor, and a counter. The resulting Verilog models can be synthe-
sized and simulated. For details about using the wizard to build these
models, see the following topics:

SYNCore FIFO Compiler, on page 302

SYNCore RAM Compiler, on page 333

SYNCore Byte-Enable RAM Compiler, on page 355
SYNCore ROM Compiler, on page 371

SYNCore Adder/Subtractor Compiler, on page 386
SYNCore Counter Compiler, on page 410
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Configure and Launch VCS Simulator Command

The Configure and Launch VCS Simulator command enables you to launch VCS
simulation from within the Synopsys FPGA synthesis tools. Additionally,
configuration information, such as libraries and options can be specified on
the Run VCS Simulator dialog box before running VCS simulation. You can
launch this simulation tool from the synthesis tools on Linux platforms only.

For a step-by-step procedure on setting up and launching this tool, see
Simulating with the VCS Tool, on page 554 in the User Guide.

The Run VCS SimulationType Simulation dialog box contains unique pages for
specific tasks, such as specifying simulation type, VCS options, and libraries
or test bench files. From this dialog box:

* Choose a category, which simplifies the data input for each task.

* A task marked with (v ) means that data has automatically been filled
in; however, an (@ ) requires that data must be filled in.

* You are prompted to save, after cancelling changes made in the dialog
box.

Simulation Type

The following dialog box displays the Simulation Type task.
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:-] Run VCS Post-Synthesis Simulation ﬂil
Ch Cat
O Simulation Type
W iSimulation Type (Post-Synthesis) : .

W Top Level Module (test_bench)
W VCS Options

viendor Version

W Libraries

" Test Bench Files

W Run Directory

Post PER Netlist

() Pre-synthesis

'@ Post-Synthesis

) PostPER

Mote: The simulation type affects your libraries and run directory. These are

recorded separately for each simulation type.

View Script

Cancel

Load From...

Save As...

Restore Defaults
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The Run VCS Simulator dialog box contains the following options:

Command

Choose a Category
Simulation Type

Choose a Category
Top Level Module

Choose a Category
VCS Options

Choose a Category
Libraries

Synplify Pro for Microsemi Edition Command Reference

January 2020

Description

Select Simulation Type and choose the type of simulation to
run:

¢ Pre-synthesis — RTL simulation

¢ Post-synthesis — Post-synthesis netlist simulation

¢ Post-P&R — Post-P&R netlist simulation

See Simulation Type, on page 383 to view the dialog box.

Select Top Level Module and specify the top-level VCS module
or modules for simulation. You can use any combination of
the semi-colon (; ), comma (, ), or a space to separate
multiple top-level modules.

See Top Level Module, on page 387 to view the dialog box.

Select VCS Options and specify options for each VCS step:

* Verilog compiler - VLOGAN command options for compiling
and analyzing Verilog, like the -q option

¢ VHDL compiler - VHDLAN options for compiling and
analyzing VHDL

¢ Elaboration — VCS command options. The default setting is
-debug_all.

e Simulation — SIMV command options. The default setting is
-gui.

The default settings use the FPGA version of VCS and open

the VCS GUI for the debugger (DBE) and the waveform
viewer.

See VCS Options, on page 387 to view the dialog box.

Select Libraries and specify library files typically used for
Post-synthesis or Post-P&R simulation. These library files
are automatically populated in the display window. You can
choose to:

¢ Add a library
¢ Edit the selected library
* Remove the selected library

See Libraries, on page 388 and Changing Library and Test
Bench Files, on page 390 for more information.
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Command Description

Choose a Category Select Test Bench Files and specify the test bench files

Test Bench Files typically used for Post-synthesis or Post-P&R simulation.
These test bench files are automatically populated in the
display window. You can choose to:

¢ Add a test bench file
¢ Edit the selected test bench file
¢ Remove the selected test bench file

See Test Bench Files, on page 389 and Changing Library
and Test Bench Files, on page 390 for more information.

Choose a Category Select Run Directory and specify the results directory to run
Run Directory the VCS simulation.

See Run Directory, on page 389 to view the dialog box.

Choose a Category Select Post P&R Netlist and specify the post place-and-route
Post P&R Netlist netlist to run the VCS simulation.

See Post P&R Netlist, on page 390 to view the dialog box.
Run Runs VCS simulation.

View Script View the script file with the specified VCS commands and
options before generating it. For an example, see VCS Script
File, on page 392.

Load From Use this option to load an existing VCS script.
Save As Generates the VCS script. The tool generates the XML script
in the directory specified.
Restore Defaults Restores all the default VCS settings.
© 2020 Synopsys, Inc. Synplify Pro for Microsemi Edition Command Reference
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Top Level Module
The following dialog box displays the Top Level Module task.

l_-] Run VCS Post-Synthesis Simulation 21x

Choose a Category

k)

Top Level Module

W Simulation Type (Post-Synthesis,
W Top Level MgSUIS(Est_)l;enm) : [Dest,bench
W VCS Options
vendor Version
W Libraries iew Script
W Test Bench Files
W Run Directory
Post P&R. Netlist

] Run

Close

Cancel

Load From...

Save As...

Restore Defaults

VCS Options
The following dialog box displays the VCS Options task.

*

r-] Run VCS Post-Synthesis Simulation 2]

Choose a Category

VCS Options

W Simulation Type (Post-Synthesis) ’ Run

W Top Level Module (test bench) Verilog Compile [ +v2¢ ]

' iVCS Options

Vendor Version WHDL Compile [ ]

W Libraries . | View Script I

" Test Bench Files Beiimm [ ]

W Run Directory . .

Post PAR Netist smaton | ] || Close |
Use the FPGA version of VCS

Open the VCS GLI following simulation

Load From...

Save As...

Mote: the "FPGA™ and "GUI" options will be saved for future default values. Restore Defaults
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Vendor Version

The following dialog box displays the Vendor Versions task.

:-} Run V(S Post-Synthesis Simulation 2

Choose a Category

Ix

Vendor Version
W Simulation Type (Post-Synthesis)

" Top Level Module {test_bench) I
W _VCS Options
Vendor Version i
W Libraries View Script
" Test Bench Files
W Run Directory
Post PER Netiist

[~ Run

Close

Cancel

Load From...

Save As...

Restore Defaults

Libraries

The following dialog box displays the Libraries task.

:-] Run V(S Post-Synthesis Simulation

I:
X

x|

Choose a Category
W Simulation Type (Post-Synthesis)

Post-Synthesis Libraries

IARTUS_ROOTDIR fedasim_libfnopli.v

Top Level Module (test_bench) BERE .

; ves g;;cn: ule (test_bench) SQUARTUS_ROCTDIR fedasim_ib/220moadel. v

Vendor Version SQUARTUS_ROOTDIR feda/sim_libfaltera_primitives.v

R 5 EQUARTUS_ROOTDIR feda/sim_lib/cydone_atoms. v View Saript

v b : $QUARTUS_ROCTDIR feda/sim_libfaltera_mf.v
W Run Directory
Post PER Metlist

Close

Cancel

III x‘
=
5

Load From...

Save As...

verilog Defaults VHDL Defaults

Restore Defaults
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Test Bench Files

The following dialog box displays the Test Bench Files task.

l_-] Run V(5 Post-Synthesis Simulation

Choose a Category

W Simulation Type (Post-Synthesis)
W Top Level Module (test_bench)
W VCS Options

vendor Version

st Bench Files
W Run Directory
Post P&R. Netlist

Test Bench Files

C:\designs'\cydone_veritestbench_pos.v +ncdir+..Y +v2k

td

21x]

Run

View Script

Close:

Cancel

Load From...

Save As...

Restore Defaults

Run Directory

The following dialog box displays the Run Directory task.

,_-] Run VCS Post-Synthesis Simulation

Choose a Category

W Simulation Type (Post-Synthesis)
W Top Level Module (test_bench)
W VCS Options
vendor Version

W Libraries

V" Test Bench Files

VR
Post P&R Netlist

Post-Synthesis results (run) directory

[C:\destgns\cydonefver\vcsmstsynm

]

X

2=

View Script

Close

Cancel

III ;U
£
=

Load From...

Save As...

Restore Defaults
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Post P&R Netlist
The following dialog box displays the Post P&R Netlist task.

[*]Run VCS Post-Synthesis Simulation 2]l
Choose a Categol
gory Post Place and Route Netlist
W Simulation Type (Post-Synthesis) Run
W Top Level Module (test_bench) I ] E]
W~ VCS Options
Vendor Version
W Libraries View Seript
W Test Bench Files
thost AR Netfist S
Restore Defaults

Changing Library and Test Bench Files

You can add Post-synthesis or Post place-and-route library files and test
bench files before you launch the VCS simulator. For example, specify
options on the following dialog box.
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21|
- | [en]en

Type @ Veriog () VHDL ) Other

Library [work ] - ]

Oations [ x|
Path [ ] E]

Type @ Veriog ) WHDL ) Other

Library [work ] - ]

Options [ ]

You can also edit library files and test bench files before you launch the VCS
simulator. For example: specify options on the following dialog box.

[7]Edit Post-Synthesis Library File 21xl
Path [EQUARTUS_ROOTDIR,.’eda,.’sim_Iib,fnapIi.v ] E]
Type @ Veriog ) VHDL ) Other
Liby . ==
R m ,__!Edit test bench ﬂil
Options
: Path [C:\designs\cydone_ver\besﬂ)endﬂjos.v +incdir +.. Y, +u2k ] E]

Type (@) Veriog ) VHDL ) Other

Library [work ] - ]

Options [ ]
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VCS Script File

When you select the VCS Script button on the Run VCS Simulator dialog box, you
can view the VCS script generated by the synthesis software for this VCS run.
You can also save this VCS script to a file by clicking on Save a Copy.

#!/binfsh -x

# VCS script generated to simulate Synplify Premier with Design Planner project:
# C:\designs\cydone_ver\test.prj

# Generated Tue Oct 20 08:46: 16 2009

#D-2009.12

# Synopsys, Inc.

% mkdirs
if [1 -d work ]; then mkdir wark; fi;
if [ ! -d synplify ]; then mkdir synplify; fi;

SVC5_HOMEbin/vlogan +v2k -fpga -work work C:'designs'\cydone_veritest.vm
$VCS_HOME jbin/vlogan +v2k -fpga -work work C:\designs'\cydone_ver\testbench_pos.v +ncdir+..\ +v2k

SVCS_HOME fbin/fvcs -debug -all work. test_bench
Lfsimv -gui

2=

Refresh | |SaveaCUpy‘.‘
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Analysis Menu

When you synthesize a design, a default timing report is automatically
written to the log file (projectName.srr), located in the results directory. This
report provides a clock summary, I/O timing summary, and detailed critical
path information for the design. However, you can also generate a custom
timing report that provides more information than the default report (specific
paths or more than five paths) or one that provides timing based on
additional analysis constraint files without rerunning synthesis.

Command Description

Timing Analyst Displays the Timing Report Generation dialog box to specify
parameters for a stand-alone customized report. See Timing
Report Generation Parameters, on page 394 for
information on setting these options, and Analyzing Timing
in Schematic Views, on page 356 in the User Guide for
more information.

If you click OK in the dialog box, the specified parameters
are saved to a file. To run the report, click Generate. The
report is created using your specified parameters.

Generate Timing Generates and displays a report using the timing option
parameters specified above. See the following:

* Generating Custom Timing Reports with STA, on
page 363 for specifics on how to run this report.

* Timing Report Generation Parameters, on page 394 for
information on setting parameters for the report. This
includes information on filtering and options for running
backannotation data and power consumption reports.
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Timing Report Generation Parameters

You can use the Analysis->Timing Analyst command to specify parameters for a
stand-alone timing report. See Timing Reports, on page 161 for information

on the file contents.

Timing Report Generation 2 x|

~Fitters

From: [

Through: [

To: [

] Generate Asynchronous Clock Report

Async Clock Report File: [

Limit Number of Critical Start/End Points To: [5

Limit Number of Paths To: [5

] Enable Skck Margin (ns): [

Open Report

Open Schematic

Generate

— Qutput Files

Timing Analyzer Result File: [tutorial.m

] SRM File: [C:'-._s‘,a'npl'rr",a'_pro'-._tutoriaI'-._re‘.-‘_l'-._eight_bﬂ:_uc_ta.srm ] EI
— Constraint Files
| sel | Fie |
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The following table provides brief descriptions of the parameters for running a
stand-alone timing report.

Timing Report Option

From or
To

Through

Generate
Asynchronous Clock
Report

Limit Number of Critical
Start/End Points

Description

Specifies the starting (From) or ending (To) point of the path
for one or more objects. It must be a timing start point
(From) or end (To) point for each object. Use this option in
combination with the others in the Filters section of the
dialog box. See Combining Path Filters for the Timing
Analyzer, on page 399 for examples of using filters.

Tcl equivalent: set_option -reporting_filter "-from {object1} -to
{object2}"

Reports all paths through the specified point or list of
objects. See for more information on using this filter. Use
this option in combination with the others in the Filters
section of the dialog box. See the following for additional
information:

* Timing Analyzer Through Points, on page 397

* Combining Path Filters for the Timing Analyzer, on
page 399

Tcl equivalent: set_option -reporting_filter "-from {object1} -to

{object2} -through {object3}"

Generates a report for paths that cross between clock
groups. Generally paths in different clock groups are
automatically handled as false paths. This option provides
a file that contains information on each of the paths and
can be viewed in a spreadsheet. This file is in the results
directory (projectName_async_clk.rpt.csv). For details on the
report, see Asynchronous Clock Report, on page 169.

Tcl equivalent: set_option -reporting_async_clock 0|1
Specifies the maximum number of start/end paths to
display for critical paths in the design. The default is 5. Use

this option in combination with the others in the Filters
section of the dialog box.

Tcl equivalent: set_option -num_startend_points

numberOfPaths
Limit Number of Paths ~ Specifies the maximum number of paths to report. The
to default is 5. Use this option in combination with the others
in the Filters section of the dialog box.
Tcl equivalent: set_option -reporting_number_paths
numberOfPaths
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
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Timing Report Option

Enable Slack Margin
(ns)

Open Report

Open Schematic

Output Files

Constraint Files

Generate

© 2020 Synopsys, Inc.
396

Description

Limits the report to paths within the specified distance of
the critical path. Use this option in combination with the
others in the Filters section of the dialog box.

Tcl equivalent: set_option -reporting_margin slackValue

When enabled, clicking the Generate button opens the Text
Editor on the generated custom timing report specified in
the timing report file (ta).

When enabled, clicking the Generate button opens a
Technology view showing the netlist specified in the timing
report netlist file (srm).

Tcl equivalent: set_option -reporting_output_srm 0|1

Displays the name of the generated report:

¢ Async Clock Report File contains the spreadsheet data for
the asynchronous clock report. This file is not
automatically opened when report generation is complete.
You can locate this file in the results directory. Default
name is projectName_async_clk.rpt.csv (name cannot be
changed).

Tcl equivalent: set_option -reporting_async_clock 0|1

* Timing Analyst Results File is the standard timing report file,
located in the Implementation Results directory. The file

is also listed in the Project view. Default filename is
projectName.ta.

Tcl equivalent: set_option -reporting_filename filename.ta

* SRM File updates the Technology view so that you can
display the results of the timing updates in the HDL tool.
The file is also listed in the Project view.

Tcl equivalent: set_option -reporting_netlist filename

For more details on any of these reports, see Timing
Reports, on page 161.

Enables analysis design constraint files (adc) to be used for
stand-alone timing analysis only. See Input Files, on
page 144 for information on this file.

Clicking this button generates the specified timing report
file and timing view netlist file (srm) if requested, saves the
current dialog box entries for subsequent use, then closes
the dialog box.

Synplify Pro for Microsemi Edition Command Reference
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Timing Analyzer Through Points

You can specify through points for nets (n:), hierarchical ports (t:), or instanti-
ated cell pins (t). You can specify the through points in two ways:

OR
list

AND
list

Enter the points as a space-separated list. The points are treated as an OR
list and paths are reported if they crosses any of the points in the list. For
example, when you type the following, the tool reports paths that pass
through points b or c:

{n:b n:c}
See Filtering Points: OR List of Through Points, on page 397.

Enter the points in a product of sums (POS) format. The tool treats them as
an AND list, and only reports the path if it passes through all the points in
the list. The POS format for the timing report is the same as for timing
constraints. The POS format is as follows:

{n:b n:c},{n:d n:e}

This constraint translates as follows:

b AND d

CR b AND e
CRc AND d
CRc AND e

See Filtering Points: AND List of Through Points, on page 398.

See Defining From/To/ Through Points for Timing Exceptions, on page 132 in
the User Guide for more information about specifying through points.

Filtering Points: OR List of Through Points

This example reports the five worst paths through port bdpol or net aluout. You
can enter the through points as a space-separated list (enclosing the list in
braces is optional.)
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—Filker:

Fram: [

Through: I pbdpol n:alu_cout

Tos [

Limit Murber of Paths Ta:
[ Enable slack Margin (ns):

Open Repork

Limnit Mumber of Critical Start/End Points To:

—Filters

From: [ ]

Through: I{p:bdpol n:aluout}t I
To: [ ]
Lirnit Murnber of Critical StartfEnd Points To:

Lirnit Murnber of Paths To:
[ Enable Slack Margin {ns): :]

Open Repork Open Schematic

Filtering Points: AND List of Through Points

This example reports the five worst paths passing through port bdpol and net
aluout. Enclose each list in braces {} and separate the lists with a comma.

~Filters

From: [

]

Through: I{p:bdpol},{ rialu_cout}

To [

]

Limit Mumber of Paths To:
[ Enable Slack Margin (ns):

Open Repork

Limnit Mumber of Critical Stark/End Points To:

L]

Open Schematic

© 2020 Synopsys, Inc.
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Combining Path Filters for the Timing Analyzer

This section describes how to use a combination of path filters to specify what
you need and how to specify start and end points for path filtering.

Number and Slack Path Filters

The Limit Number of Paths To option specifies the maximum number of paths to
report and the Enable Slack Margin option limits the report to output only paths
that have a slack value that is within the specified value. When you use these
two options together, the tighter constraint applies, so that the actual
number of paths reported is the minimum of the option with the smallest
value. For example, if you set the number of paths to report to 10 and the
slack margin for 1 ns, if the design has only five paths within 1 ns of critical,
then only five paths are reported (not the 10 worst paths). But if, for example,
the design has 15 paths within a 1 ns of critical, only the first 10 are
reported.

From/To/Through Filters

You can specify the from/to points for a path. You can also specify just a from
point or just a to point. The from and to points are one or more hierarchical
names that specify a port, register, pin on a register, or clock as object (clock
alias). Ports and instances can have the same names, so prefix the name with
p: for top-level port, i: for instance, or t: for hierarchical port or instance pin.
However, the c: prefix for clocks is required for paths to be reported.

The timing analyst searches for the from/to objects in the following order:
clock, port, bit port, cell (instance), net, and pin. Always use the prefix quali-
fier to ensure that all expected paths are reported. Remember that the timing
analyst stops at the first occurrence of an object match. For buses, all
possible paths from the specified start to end points are considered.

You can specify through points for nets, cell pins, or hierarchical ports.

You can simply type in from/to or through points. You can also cut-and-paste or
drag-and-drop valid objects from the RTL or Technology views into the appro-
priate fields on the Timing Report Generation dialog box. Timing analysis requires
that constraints use the Tech View name space. Therefore, it is recommended
that you cut-and-paste or drag-and-drop objects from the Technology view
rather than the RTL view.
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This following examples show how to specify start, end or through point
combinations for path filtering.

Filtering Points: Single Register to Single Register

~Filters
From:  |i:op_a_reg |
Through: | |
Ta: |i:d_out _reg |

Lirit Murmber of Critical Skart/End Points Ta:
Linnit Mumber of Paths To:
[ Enable Slack Margin (ns): :]

Open Repork Open Schematic

Filtering Points: Clock Object to Single Register

—Filker

From: [c:clkl ]

Through: [ ]

To: [ imult_reg ]

Limnit Mumber of Critical Start/End Points To:
Limnit Mumber of Paths To:
[ Enable Slack Margin (ns): :]

Open Repark Open Schematic

Filtering Points: Single Bit of a Bus to Single Register

—Filter:

From: [ piop_req[1] ]

Through: [ ]

To: I irmult_reg I

Lirnit Mumber of Critical Start/End Paoints To:
Lirnit Mumber of Paths To:
[ Enable Slack Margin (ns): :]

Open Repork Open Schematic
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Filtering Points: Single Bit of a Bus to Single Bit of a Bus

~Filker
From:  |piop_regl4] ]
Through: | ]
Ta | pid_out_reqls] J

Lirnit Mumber of Critical Start/End Paints Ta:
Lirnit Mumber of Paths To:
[ Enable Slack Margin (ns): :]

Open Report Open Schematic

Filtering Points: Multiple Bits of a Bus to Multiple Bits of a Bus

~Filters
From:  |piop_a_reql7:0] |
Through: | |
Ta: [p:d_out_regl15:0] |

Lirnit Mumber of Critical Start/End Points To:
Lirnit Murnber of Paths Ta:
[ Enable Slack Margin (ns): :]

Open Report Open Schematic

Filtering Points: With Hierarchy

This example reports the five worst paths for the net foo:

—Filters
From: [ itnac_core.rxu_fifo.reg ]
Through: [ ]
Tor I itnac_core.rxu_channel.reg I

Lirnit Mumber of Critical Start/End Paoints To:
Lirnit Mumber of Paths To:
[ Enable Slack Margin (ns): :]

Open Repork Open Schematic
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Filtering Points: Through Point for a Net

—Filter:

Frarn: [ ]

Through: I ninac_core,foo I

To: [ ]

Lirnit Murnber of Critical Start/End Paints To:

Lirnit Mumber of Paths To:
[ Enable Slack Margin (ns): :]
Open Report Open Schematic

Filtering Points: Through Point for a Hierarchical Port
This example reports the five worst paths for the hierarchical port bdpol:

—Filter:

From: [ ]

Through: [&:drmux. bdpol |
T [ ]
Lirnit Mumber of Critical Start/End Painks To:

Lirnit Mumber of Paths To:
[ Enable Slack Margin {ns): [:]
Open Repart Open Schematic

Examples Using Wildcards

You can use the question mark (?) or asterisk (*) wildcard characters for
object searching and name substitution. These characters work the same
way in the synthesis tool environment as in the Linux environment.
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The ? Wildcard

The ? matches single characters. If a design has buses op_a[7:0], op_b[7:0], and
op_c[7:0], and you want to filter the paths starting at each of these buses,
specify the start points as op_7?[7:0]. See Example: ? Wildcard in the Name, on
page 403 for another example.

The * Wildcard

The * matches a string of characters. In a design with buses op_aZ2[7:0],
op_b2[7:0], and op_c2[7:0], where you want to filter the paths starting at each of
these objects, specify the start points as op_*[*]. The report shows all paths
beginning at each of these buses and for all of the bits of each bus. See
Example: * Wildcard in the Name (With Hierarchy), on page 404 and
Example: * Wildcard in the Bus Index, on page 404 for more examples.

Example: ? Wildcard in the Name
The ? is not supported in bus indices.

—Filter:
From: [ op_?[7:0] ]
Through: [ ]
Ta: |7_out{15:0] |
Lirnit Mumber of Critical Start/End Paoints To:
Limit Mumber of Paths To:
[ Enable Slack Margin (ns): [:]
Open Repart Open Schematic
Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.

January 2020 Synopsys Confidential Information 403



User Interface Commands

Analysis Menu

Example: * Wildcard in the Name (With Hierarchy)

This example reports the five worst paths, starting at block rxu_fifo and ending
at block rxu_channel within module nac_core. Each register in the design has
the characters reg in the name.

—Filter:
From: [ na_core. *rxu_fifo* *reg* ]
Through: [ ]
To: I na_core, *rxu_channel*, *reg| I

Lirnit Mumber of Paths To:

[ Enable slack Margin (ns):

Open Report

Lirnit Mumber of Critical Start/End Points Tao:

L

Open Schematic

Example: * Wildcard in the Bus Index
This example reports the five worst paths, starting at op_b, and ending at

d_out, taking into account all bits on these buses.

—Filter:

From: [ op_b[*]

]

Through: [

]

To: I d_out[*]|

Limit Mumber af Paths To!
[ Enable Slack Margin (ns):

Open Report

Lirnit Mumber of Critical Start/End Points To:

L

Open Schematic

© 2020 Synopsys, Inc.
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HDL Analyst Menu

In the Project View, the HDL Analyst menu contains commands that provide
project analysis in the following views:

* RTL View

* Technology View

This section describes the HDL Analyst menu commands for the RTL and
Technology views. Commands may be disabled (grayed out), depending on
the current context. Generally, the commands enabled in any context reflect
those available in the corresponding popup menus. The descriptions in the
table indicate when commands are context-dependent. For explanations
about the terms used in the table, such as filtered and unfiltered, transparent
and opaque, see Filtered and Unfiltered Schematic Views, on page 84 and
Transparent and Opaque Display of Hierarchical Instances, on page 90. For
procedures on using the HDL Analyst tool, see Analyzing With the Standard
HDL Analyst Tool, on page 332 of the User Guide.

For ease of use, the commands have been divided into sections that corre-
spond to the divisions in the HDL Analyst menu.

* HDL Analyst Menu: RTL and Technology View Submenus, on page 405

* HDL Analyst Menu: Hierarchical and Current Level Submenus, on
page 406

* HDL Analyst Menu: Filtering and Flattening Commands, on page 408
* HDL Analyst Menu: Timing Commands, on page 412

* HDL Analyst Menu: Analysis Commands, on page 412

* HDL Analyst Menu: Selection Commands, on page 416

* HDL Analyst Menu: FSM Commands, on page 416

HDL Analyst Menu: RTL and Technology View Submenus

This table describes the commands that appear on the HDL Analyst->RTL and

HDL Analyst->Technology submenus when the RTL or Technology View is active.
For procedures on using these commands, see Analyzing With the Standard
HDL Analyst Tool, on page 332 of the User Guide.
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HDL Analyst Menu

HDL Analyst Command
RTL->Hierarchical View

RTL->Flattened View

Technology->Hierarchical
iew

Technology->Flattened View

Technology->Flattened to Gates
View

Technology->Hierarchical
Critical Path

Technology->Flattened Critical
Path

Description

Opens a new, hierarchical RTL view. The schematic
is unfiltered.

Opens a new RTL view of your entire design, with a
flattened, unfiltered schematic at the level of generic
logic cells. See Usage Notes for Flattening, on

page 410 for some usage tips.

Opens a new, hierarchical Technology view. The
schematic is unfiltered.

Creates a new Technology view of your entire design,
with a flattened, unfiltered schematic at the level of
technology cells. See Usage Notes for Flattening, on
page 410 for tips about flattening.

Creates a new Technology view of your entire design,
with a flattened, unfiltered schematic at the level of
Boolean logic gates. See Usage Notes for Flattening,
on page 410 for tips about flattening

Creates a new Technology view of your design, with
a hierarchical, filtered schematic showing only the
instances and paths whose slack times are within
the slack margin you specified in the Slack Margin
dialog. This command automatically enables HDL
Analyst->Show Timing Information.

Creates a new Technology view of your design, with
a flattened, filtered schematic showing only the
instances and paths whose slack times are within
the slack margin you specified in the Slack Margin
dialog. This command automatically enables HDL
Analyst->Show Timing Information.

See Usage Notes for Flattening, on page 410 for
tips about flattening.

HDL Analyst Menu: Hierarchical and Current Level Submenus

This table describes the commands on the HDL Analyst->Hierarchical and HDL
Analyst->Current Level submenus. For procedures on using these commands,
see Analyzing With the Standard HDL Analyst Tool, on page 332 of the User

Guide.
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HDL Analyst Command

Hierarchical->Expand

Hierarchical->Expand to
Register/Port

Hierarchical->Expand Paths

Hierarchical->Expand
Inwards

Hierarchical->Goto Net
Driver

Hierarchical->Select Net
Driver

Hierarchical->Select Net
Instances

Current Level->Expand

Synplify Pro for Microsemi Edition Command Reference
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Description

Expands paths from selected pins and/or ports up to
the nearest objects on any hierarchical level, according
to pin/port directions. The result is a filtered
schematic. Operates hierarchically, on lower schematic
levels as well as the current level.

Successive Expand commands expand the paths further,
based on the new current selection.

Expands paths from selected pins and/or ports, in the
port/pin direction, up to the next register, port, or black
box. The result is a filtered schematic. Operates
hierarchically, on lower schematic levels as well as the
current level.

Shows all logic, on any hierarchical level, between two
or more selected instances, pins, or ports. The result is
a filtered schematic. Operates hierarchically, on lower
schematic levels as well as the current level.

Expands within the hierarchy of an instance, from the
lower-level ports that correspond to the selected pins, to
the nearest objects and no further. The result is a
filtered schematic. Operates hierarchically, on lower
schematic levels as well as the current level.

Displays the unfiltered schematic sheet that contains
the net driver for the selected net. Operates
hierarchically, on lower schematic levels as well as the
current level.

Selects the driver for the selected net. The result is a
filtered schematic. Operates hierarchically, on lower
schematic levels as well as the current level.

Selects instances connected to the selected net. The
result is a filtered schematic. Operates hierarchically,
on lower schematic levels as well as the current level.

Expands paths from selected pins and/or ports up to
the nearest objects on the current level, according to
pin/port directions. The result is a filtered schematic.
Limited to all sheets on the current schematic level.
This command is only available if a HDL Analyst view is
open.

Successive Expand commands expand the paths further,
based on the new current selection.
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HDL Analyst Command

Current Level->Expand to
Register/Port

Current Level->Expand
Paths

Current Level->Goto Net
Driver

Current Level->Select Net
Driver

Current Level->Select Net
Instances

Description

Expands paths from selected pins and/or ports,
according to the pin/port direction, up to the next
register, ports, or black box on the current level. The
result is a filtered schematic. Limited to all sheets on
the current schematic level.

Shows all logic on the current level between two or more
selected instances, pins, or ports. The result is a filtered
schematic. Limited to the current schematic level (all
sheets).

Displays the unfiltered schematic sheet that contains
the net driver for the selected net. Limited to all sheets
on the current schematic level.

Selects the driver for the selected net. The result is a
filtered schematic. Limited to all sheets on the current
schematic level.

Selects instances on the current level that are
connected to the selected net. The result is a filtered
schematic. Limited to all sheets on the current
schematic level.

HDL Analyst Menu: Filtering and Flattening Commands

This table describes the filtering and flattening commands on the HDL Analyst
menu. For procedures on filtering and flattening, see Analyzing With the
Standard HDL Analyst Tool, on page 332 of the User Guide.

HDL Analyst Command
Filter Schematic

© 2020 Synopsys, Inc.
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Description

Filters your entire design to show only the selected
objects. The result is a filtered schematic. For more
information about using this command, see Filtering
Schematics, on page 336 of the User Guide.

This command is only available with an open HDL
Analyst view.
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HDL Analyst Command Description

Flatten Current Schematic In an unfiltered schematic, the command flattens the

(Unfiltered Schematic) current schematic, at the current level and all levels
below. In an RTL view, the result is at the generic logic
level. In a Technology view, the result is at the
technology-cell level. See the next table entry for
information about flattening a filtered schematic.

This command does not do the following:

* Flatten your entire design (unless the current level is
the top level)

* Open a new view window

¢ Take into account the number of Dissolve Levels defined
in the Schematic Options dialog box.

See Usage Notes for Flattening, on page 410 for tips.
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HDL Analyst Command Description

Flatten Current Schematic In a filtered schematic, flattening is a two-step process:

(Filtered Schematic) ¢ Only unhidden transparent instances (including nested
ones) are flattened in place, in the context of the entire
design.Opaque and hidden hierarchical instances
remain hierarchical. The effect of this command is that
all hollow boxes with pale yellow borders are removed
from the schematic, leaving only what was displayed
inside them.

* The original filtering is restored.

In an RTL view, the result is at the generic logic level. In a
Technology view, the result is at the technology-cell level.

This command does not do the following:

¢ Flatten everything inside a transparent instance. It only
flattens transparent instances and any nested
transparent instances they contain.

¢ Open a new view window

e Take into account the number of Dissolve Levels defined
in the Schematic Options dialog box.

See Usage Notes for Flattening, on page 410 for usage

tips.
Unflatten Current Undoes any flattening operations and returns you to the
Schematic original schematic, as it was before flattening and any
filtering.

This command is available only if you have explicitly
flattened a hierarchical schematic using HDL
Analyst->Flatten Current Schematic, for example. It is not
available for flattened schematics created directly with
the RTL and Technology submenus of the HDL Analyst menu.

Usage Notes for Flattening

It is usually more memory-efficient to flatten only parts of your design, as
needed. The following are a few tips for flattening designs with different
commands. For detailed procedures, see Flattening Schematic Hierarchy, on
page 343 of the User Guide.
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RTL/Technology->Flattened View Commands

» Use Flatten Current Schematic to flatten only the current hierarchical level and
below.

* Flatten selected hierarchical instances with Dissolve Instances (followed by Flatten
Current Schematic, if the schematic is filtered).

¢ To make hierarchical instances transparent without flattening them, use Dissolve
Instances in a filtered schematic. This shows their details nested inside the
instances.

Flatten Current Schematic Command (Unfiltered View)

¢ Flatten selected hierarchical instances with Dissolve Instances.

* To see the lower-level logic inside a hierarchical instance, push into it instead of
flattening.

* Selectively flatten your design by hiding the instances you do not need, flattening,
and then unhiding the instances.

* Flattening erases the history of displayed sheets for the current view. You can no
longer use View->Back. You can, however, use UnFlatten Schematic to get an
unflattened view of the design.

Flatten Current Schematic Command (Filtered View)

* Flatten selected hierarchical instances with Dissolve Instances, followed by Flatten
Current Schematic.

* Selectively flatten your design by hiding the instances you do not need, flattening,
and then unhiding the instances.

* Flattening erases the history of displayed sheets for the current view. You can no
longer use View->Back. You can do the following:

* Use View->Back for a view of the transparent instance flattened in the context of
the entire design. This is the view generated after step 1 of the two-step flattening
process described above. Use UnFlatten Schematic to get an unflattened view of the
design.
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HDL Analyst Menu: Timing Commands

This table describes the timing commands on the HDL Analyst menu. For
procedures on using the timing commands, see Analyzing With the Standard
HDL Analyst Tool, on page 332 of the User Guide.

HDL Analyst Command Description

Set Slack Margin Displays the Slack Margin dialog box, where you set the
slack margin. HDL Analyst->Show Critical Path displays
only those instances whose slack times are worse than
the limit set here. Available only in a Technology view.

Show Critical Path Filters your entire design to show only the instances
and paths whose slack times exceed the slack margin
set with Set Slack Margin, above. The result is flat if the
entire design was already flat. This command also
enables Show Timing Information (see below). Available only
in a Technology view.

Show Timing Information When enabled, Technology view schematics are
annotated with timing numbers above each instance.
The first number is the cumulative path delay; the
second is the slack time of the worst path through the
instance. Negative slack indicates that timing has not
met requirements. Available only in a Technology view.
For more information, see Viewing Timing Information,
on page 356 on the User Guide.

HDL Analyst Menu: Analysis Commands

This table describes the analysis commands on the HDL Analyst menu. For
procedures on using the analysis commands, see Analyzing With the
Standard HDL Analyst Tool, on page 332 of the User Guide.
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HDL Analyst Command

Isolate Paths

Show Context

Hide Instances

Unhide Instances

Description

Filters the current schematic to display only paths
associated with all the pins of the selected instances.
The paths follow the pin direction (from output to input
pins), up to the next register, black box, port, or
hierarchical instance.

If the selected objects include ports and/or pins on
unselected instances, the result also includes paths
associated with those selected objects.

The range of the operation is all sheets of a filtered
schematic or just the current sheet of an unfiltered
schematic. The result is always a filtered schematic.

In contrast to the Expand operations, which add to what
you see, Isolate Paths can only remove objects from the
display. While Isolate Paths is similar to Expand to
Register/Port, Isolate Paths reduces the display while
Expand to Register/Port augments it.

Shows the original, unfiltered schematic sheet that
contains the selected instance. Available only in a
filtered schematic.

Hides the logic inside the selected hierarchical (non-
primitive) instances. This affects only the active HDL
Analyst view; the instances are not hidden in other HDL
Analyst views.

The logic inside hidden instances is not loaded (saving
dynamic memory), and it is unrecognized by searching,
dissolving, flattening, expansion, and push/pop
operations. (Crossprobing does recognize logic inside
hidden instances, however.) See Usage Notes for Hiding
Instances, on page 415 for tips.

Undoes the effect of Hide Instances: the selected hidden
hierarchical instances become visible (susceptible to
loading, searching, dissolving, flattening, expansion,
and push/pop operations). This affects only the current
HDL Analyst view; the instances are not hidden in other
HDL Analyst views.
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HDL Analyst Command
Show All Hier Pins

Dissolve Instances

Dissolve to Gates

© 2020 Synopsys, Inc.
414

Description

Shows all pins on the selected transparent, non-
primitive instances. Available only in a filtered
schematic. Normally, transparent instance pins that are
connected to logic that has been filtered out are not
displayed. This command lets you display these pins
that connected to logic that has been filtered out. Pins
on primitives are always shown.

Shows the lower-level details of the selected non-hidden
hierarchical instances. The number of levels dissolved
is determined by the Dissolve Levels value in the HDL
Analyst Options dialog box (Standard HDL Analyst
Options Command, on page 434). For usage tips, see
Usage Notes for Dissolving Instances, on page 415.

Dissolves the selected instances by flattening them to
the gate level. This command displays the lower-level
hierarchy of selected instances, but it dissolves
technology primitives as well as hierarchical instances.
Technology primitives are dissolved to generic synthesis
symbols. The command is only available in the
Technology view.

The number of levels dissolved is determined by the
Dissolve Levels value in the HDL Analyst Options dialog box
(Standard HDL Analyst Options Command, on

page 434).

Dissolving an instance one level redraws the current
sheet, replacing the hierarchical dissolved instance with
the logic you would see if you pushed into it using
Push/pop mode. Unselected objects or selected hidden
instances are not dissolved.

The effect of the command varies:

* In an unfiltered schematic, this command flattens the
selected instances. This means the history of
displayed sheets is removed. The resulting schematic
is unfiltered.

¢ In a filtered schematic, this command makes the
selected instances transparent, displaying their
internal, lower-level logic inside hollow boxes. History
is retained. You can use Flatten Schematic to flatten the
transparent instances, if necessary. The resulting
schematic if filtered.
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Usage Notes for Hiding Instances

The following are a few tips for hiding instances. For detailed procedures, see
Flattening Schematic Hierarchy, on page 343 of the User Guide.

* Hiding hierarchical instances soon after startup can often save memory.
After the interior of an instance has been examined (by searching or
displaying), it is too late for this savings.

* You can save memory by creating small, temporary working files:
File->Save As .srs or .srm files does not save the hidden logic (hidden
instances are saved as black boxes). Restarting the synthesis tool and
loading such a saved file can often result in significant memory savings.

* You can selectively flatten instances by temporarily hiding all the others,
flattening, then unhiding.

* You can limit the range of Edit->Find (see Find Command (HDL Analyst),
on page 315) to prevent it looking inside given instances, by temporarily
hiding them.

Usage Notes for Dissolving Instances

Dissolving an instance one level redraws the current sheet, replacing the
hierarchical dissolved instance with the logic you would see if you pushed
into it using Push/pop mode. Unselected objects or selected hidden instances
are not dissolved. For additional information about dissolving instances, see
Flattening Schematic Hierarchy, on page 343 of the User Guide.

The type (filtered or unfiltered) of the resulting schematic is unchanged from
that of the current schematic. However, the effect of the command is different
in filtered and unfiltered schematics:

* In an unfiltered schematic, this command flattens the selected
instances. This means the history of displayed sheets is removed.

* In a filtered schematic, this command makes the selected instances
transparent, displaying their internal, lower-level logic inside hollow
boxes. History is retained. You can use Flatten Schematic to flatten the
transparent instances, if necessary. This command is only available if
an HDL Analyst view is open.
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HDL Analyst Menu: Selection Commands

This table describes the selection commands on the HDL Analyst menu.

HDL Analyst Command Description

Select All Schematic Selects all Instances or Ports, respectively, on all sheets of

->Instances the current schematic. All other objects are unselected.
This does not select objects on other schematics.

->Ports

Select All Sheet Selects all Instances or Ports, respectively, on the current

->Instances schematic sheet. All other objects are unselected.

->Ports

Unselect All Unselects all objects in all HDL Analyst views.

HDL Analyst Menu: FSM Commands

This table describes the FSM commands on the HDL Analyst menu.

HDL Analyst Command Description

View FSM Displays the selected finite state machine in the FSM
Viewer. Available only in an RTL view.

View FSM Info File Displays information about the selected finite state
machine module, including the number of states, the
number of inputs, and a table of the states and
transitions. Available only in an RTL view.
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Options Menu

Use the Options menu to configure the VHDL and Verilog compilers, customize
toolbars, and set options for the Project view, Text Editor, and HDL Analyst
schematics. When using certain technologies, additional menu commands let
you run technology-vendor software from this menu.

The following table describes the Options menu commands.

Command Description
Basic Options Menu Commands for all Views

Configure VHDL Compiler Opens the Implementation Options dialog box where you
can set the top-level entity and the encoding method
for enumerated types. State-machine encoding is
automatically determined by the FSM compiler or FSM
explorer, or you can specify it explicitly using the
syn_encoding attribute. See Implementation Options
Command, on page 345 for details.

Configure Verilog Compiler Opens the Implementation Options dialog box where you
can specify the top-level module and the ‘include search
path. See Implementation Options Command, on
page 345.

Configure Parallel or Compile Lets you specify the maximum number of parallel

Point Process synthesis jobs that can be run and how errors in
compile points are treated. See Configure Parallel or
Compile Point Process Command, on page 418.

Toolbars Lets you customize your toolbars.

Project View Options Sets options for organizing files in the Project view. See
Project View Options Command, on page 422.

Editor Options Sets your Text Editor syntax coloring, font, and tabs.
See Editor Options Command, on page 427.

P&R Environment Options Displays the environmental variable options set for the
place-and-route tool. See Place and Route
Environment Options Command, on page 430.

Project Status Page Location Saves the current project status to a location of your
choice. See Project Status Page Location, on
page 430.
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Command Description

HDL Analyst Options Sets display preferences for HDL Analyst schematics
(RTL and Technology views). See Standard HDL
Analyst Options Command, on page 434.

Standard HDL Analyst Sets display preferences for HDL Analyst schematics
Options (RTL and Technology views). See Standard HDL
Analyst Options Command, on page 434.

Configure External Programs Lets you set browser and Acrobat Reader options on
Linux platforms. See Configure External Programs
Command, on page 441 for details.

Options Menu Commands Specifically for the Project View

Configure Identify Launch If Identify software is not properly installed, you might
run into problems when you try to launch it from the
synthesis tools. Use the Configure Identify Launch dialog
box to help you resolve these issues. For guidelines to
follow, see Handling Problems with Launching
Identify, on page 550 in the User Guide.

Configure Parallel or Compile Point Process Command

Use the Configure Parallel or Compile Point Process command to run parallel jobs
for multiprocessing with compile points. This option allows the synthesis
software to run multiple, independent compile point jobs simultaneously,
providing additional runtime improvements for the compile point synthesis
flow.

This feature is supported on Windows and Linux for certain technologies
only. This command is greyed out for technologies that are not supported.
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Configure Compile Point Process 2| %]

Maxirnurm nurmber of paralel synthesis jobs: [1 I%]

Mote: One license is used for each synthesis job.

[ ] Continue on Errar

View the application note about Multiprocessing 0K Cancel

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 419



User Interface Commands Options Menu

Field/Option Description
Maximum Number of Parallel Sets the maximum number of synthesis jobs that
Synthesis Jobs can run in parallel. It displays the current value

from thei ni file, and allows you to reset it. Use this
option for multiprocessing by running compile point
jobs in parallel.

Set a value based on the number of available
licenses. Note that one license is used for each job.
See License Utilization for Multiprocessing, on
page 421 for details.

When you set this option, it resets the
MaxParallelJobs value in the .i ni file. See Maximum
Parallel Jobs, on page 421 for other ways to specify
this value.

Continue on Error Allows the software to continue on error and
synthesize the rest of the design, even when there
might be problems with a portion of the design.

The Continue on Error mode automatically enables the
MultiProcessing option to run with compile points
using one license; this is the default. For additional
runtime improvements, you can specify multiple
synthesis jobs that run in parallel. See

Chapter 14, Improving Runtime for details.

For more information about Continue on Error mode,
see Using Continue on Error, on page 213 in the
User Guide.

Tcl equivalent: set_option -continue_on_error 0|1
Copy Previous Compile-Point Allows you to copy compile point netlist (.srd) files

Netlists to New Implementation  generated from the previous implementation into a
new implementation that has been created.
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Maximum Parallel Jobs

There are three ways to specify the maximum number of parallel jobs:

i ni File

Tcl Variable

Configure Compile Point
Process Command

Set this variable in the MaxParallelJobs variable in the
product i ni file:

[ JobSetting]
MaxPar al | el Jobs=<n>

This value is used by the Ul as well as in batch mode, and
is effective until you specify a new value. You can change it
with the Options->Configure Parallel or Compile Point Process
command.

Set the following variable in a Tcl file, the project files, or
from the Tcl window:

set_option -nax_paral | el _j obs=<n>
This is a global option that is applied to all project files and
their implementations. This value takes effect immediately.
If you set it in the Tcl file or project file, it remains in effect
until you specify a new value. If you set it from the Tcl
window, the max_parallel_jobs value is only effective for the
session and will be lost when you exit the application.

The Maximum Number of Parallel Synthesis Jobs option displays
the current ini file value and allows you to reset it.

License Utilization for Multiprocessing

When you decide to run parallel synthesis jobs, additional licenses may be
required for the compile point jobs. By default, four parallel jobs use one
license. For example, if you set the Maximum number of parallel synthesis jobs to
12, the synthesis tool consumes one license to run 4 compile point jobs and
can utilize the two additional licenses to run 8 more parallel jobs if they are
available for your computing environment. Licenses are released as jobs
complete, and then consumed by new jobs which need to run.

The actual number of licenses utilized depends on the following:

1. Synthesis software scheme for the compile point requirements used to
determine the maximum number of parallel jobs or licenses a particular
design tries to use.

2. Value set on the Configure Parallel or Compile Point Process dialog box.
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3. Number of licenses actually available. You can use Help->Preferred License
Selection to check the number of available license. If you need to increase
the number of available licenses, you can specify multiple license types.
For more information, see Using Different License Types for
Multiprocessing, on page 526.

Note that factors 1 and 3 above can change during a single synthesis run.
The number of jobs equals the number of licenses; which then equates the
lowest value of these three factors.

Project View Options Command

Select Options->Project View Options to display the Project View Options dialog box,
where you define how projects appear and are organized in the Project view.

Project ¥iew Dptions i

Options

Option

Shows Project File Library

Beep when a job completes

Views Project Files in Type Folders

Vieww Project Files in Custom Folders

Order files alphabetically

Auto-load projects Fram previous session

Auto-save project on Run

Open log File Fallowing Run

Shows all Files in resulks directary

Allow multiple projects to be opened

HRED0R~RERORE
[

Wieww log File in HTML

Praject file name display File name only

[« | ()

Description:

Click on an option for description

| Ok || Zancel |

The following table describes the Project View Options dialog box features.
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Field/Option Description

Show Project File Library When enabled, displays the corresponding VHDL
library next to each source VHDL filename, in the
Project Tree view of the Project view. For example,
with library dune, file pc.vhd is listed as [dune] pc.vhd
if this option is enabled, and as pc.vhd if it is
disabled.

(See also Set VHDL Library Command, on
page 335, for how to change the library of a file.)

Beep when a job completes When enabled, sounds an audible signal whenever
a project finishes running.

View Project Files in Type When enabled, organizes project files into separate

Folders folders by type. See View Project Files in Type
Folders Option, on page 424 and add_file, on
page 27.

View Project Files in Custom When enabled, allows you to view files contained

Folders within the custom folders created for the project.
See View Project Files in Custom Folders Option,
on page 425.

Order files alphabetically When enabled, the software orders the files within

folders alphabetically instead of in project order.
You can also use the Sort Files option in the Project
view.

Autoload projects from previous Enable/Disable automatically loading projects from

session the previous session. Otherwise, projects will not be
loaded automatically. This option is enabled by
default. See Loading Projects With the Run
Command, on page 425.

Auto-save project on Run Enable/Disable automatically saving projects when
the Run button is selected. See Automatically Save
Project on Run, on page 426.

Open Log file following Run Enable/Disable automatically opening and
displaying log file after a synthesis run.

Show all files in results directory When enabled, shows all files in the
Implementation Results view. When disabled, the
results directory shows only files generated by the
synthesis tool itself.
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Field/Option

Allow multiple projects to be
opened

View log file in HTML

Project file name display

Use links in SRR log file to
individual job logs

Description

When enabled, multiple projects are displayed at
the same time. See Allow Multiple Projects to be
Opened Option, on page 425.

Enable/Disable viewing of log file report in HTML
format versus text format. See Log File, on
page 155.

From the drop-down menu, select one the following
ways to display project files:

¢ File name only
¢ Relative file path
 Full file path

Determines if individual job logs use links in the
srr log file. You can select:

» off—appends individual job logs to the srr log file.
* on—always link to individual job logs.

* if_up_to_date—only links to individual job logs if the
module is up-to-date.

View Project Files in Type Folders Option

=X : arnCtrl_prodfram. prj =0 ﬁ C: fDesignsramCtrl_prod ram. pri
:-’ Verllug O &y
al.w - [ data_mnu.y
D data_ru.y - iy
S ERX - [ ins_romm.y
- [ ins_rarn.y - [ ins_decode.y
- [ ins_decode.y ~ [ prgm_cntr.y
- [ pram_chtey =[O reg_fie.w
- [ reg_fle.w ~ [ spcl_regs.v
- spu:l _regs.y ~ [ eight_kit_uc.v
~ [ tirmingrmodels,sdc
~ [ intermal_bb.sdc
[ i& ren_d4
B # rev_d
View project files in type folders enabled View project files in type folders disabled
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View Project Files in Custom Folders Option

Selecting this option enables you to view user-defined custom folders that
contain a predefined subset of project files in various hierarchy groupings or
organizational structures. Custom folders are distinguished by their blue
color. For information on creating custom folders, see Creating Custom
Folders, on page 65 in the User Guide.

Ch- Bl fftutorial] - Crisyrplify. projeutoriaitatorial.or
B [ YHOL

- g const_pka.vhd [work]

& ins_rom.vhd [wark] -=NOTES: 2

Custom “1 verilog
Folders El- ﬁ‘j Constraint
E} ﬁ IREMOryY
----- [ ram.vhd [work]
B ﬁ prep

..... B prepz_2.whd [wark]
rew_1

Allow Multiple Projects to be Opened Option
The following figure shows multiple projects open.

Project 1

E_J EN C:/Designs/ramCtelframm.pri
H . e

g werilog

: L rev_4
c- @ C [Designs,8-bit-vholfproi, pri

Bl [ wHDL

o gk rev_2

Project 2

Loading Projects With the Run Command

When you load a project that includes the project -run command, a dialog box
appears in the Project view with the following message:

Project run command encountered during project |oad. Are you sure
you want to run?

You can reply with either yes or no.
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Automatically Save Project on Run

If you have modified your project on the disk directory since being loaded into
the Project view and you run your design, a message is generated that infers
the Ul is out-of-date.

The following dialog box appears with a message to which you must reply.
oynplity x|

'E Do wou want ko autaomatically save your project befare each run 7

To reset this option use Project Wiew Options and set the Autosave Project checkbox,

Yes Mo | Zancel

You can specify one of the following:

* Yes — The Auto-save project on Run switch on the Project View Options dialog
box is automatically enabled, and then your design is run.

* No — The Auto-save project on Run switch on the Project View Options dialog
box is not enabled, but your design is run.

* Cancel — Closes this message dialog box and does not run your design.
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Editor Options Command

Select Options->Editor Options to display the Editor Options dialog box, where you
select either the internal text editor or an external text editor.

B Editor Options - Project 2| x|
Select Editor

® Synopsys Editor

External Editor ] B

Options

File Type Project Files

Font |C0urier v|
Size |8 -|
Keep Tabs Tab Sze [4 |5

The following table describes the Editor Options dialog box features.

Feature Description

Select Editor Select an internal or external editor.

» Synopsys Editor Sets the Synopsys text editor as the default text editor.
 External Editor Uses the specified external text editor program to view

text files from within the Synopsys FPGA tool. The
executable specified must open its own window for text
editing. See Using an External Text Editor, on page 41
of the User Guide for a procedure.

Note: Files opened with an external editor cannot be

crossprobed.
Options Set text editing preferences.
* File Type You can define text editor preferences for the following

file types: project files, HDL files, log files, constraint
files, and default files.
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Feature Description

* Font Lets you define fonts to use with the text editor.

» Font Size Lets you define font size to use with the text editor.
+ Keep Tabs Lets you define whether to use tab settings with the
« Tab Size text editor.

 Syntax Coloring

Lets you define foreground or background syntax
coloring to use with the text editor. See Color Options,
on page 428.

Color Options

Click in the Foreground or Background field for the corresponding object in the
Syntax Coloring field to display the color palette.

5E|EE|: color

Basu: colars

Zuskom colors

HE NN
HE N ...

@@@@@@@D
1 4 0 b 1] I
ENEEEEEO
EEEEENENE)
EEEEECOOO

A.

Huet [120 |5 Red: [0 |5
Sat: 255 |5 Green: [180 [
val: (160 |[5] Blue: [0 5

| Define Custom Colors =

| o4 || Zancel |

| Add ko Custom Colors |

You can set syntax colors for some common syntax options listed in the

following table.
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Syntax Description

Comment Comment strings contained in all file types.

Error Error messages contained in the log file.

Gates Gates contained in HDL source files.

Info Informational messages contained in the log file.

Keywords Generic keywords contained in the project, HDL
source, constraint, and log files.

Line Comment Line comments contained in the HDL source, C, C++,
and log files.

Note Notes contained in the log file.

SDCKeyword Constraint-specific keywords contained in the .sdc file.

Strength Strength values contained in HDL source files.

String DQ String values within double quotes contained in the
project, HDL source, constraint, C, C++, and log files.

String SQ String values within single quotes contained in the
project, HDL source, constraint, C, C++, and log files.

SVKeyword SystemVerilog keywords contained in the Verilog file.

Types Type values contained in HDL source files.

Warning Warning messages contained in the log file.
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Place and Route Environment Options Command

Select Options->P&R Environment Options to display the environment variable
options set for the place-and-route tool. This option allows you to change the
specified location of the selected place-and-route tool set on your system; the
software locates and runs this updated version of the P&R tool for the current
session of the synthesis tool.

[ ™
©, P&R Environment Vaﬁabm @ﬂ

Options

|Dption |\.|'alue |
ALSDIR (iMicrosemi)

Description:

Click on an option for description

0K | | Cancel

Project Status Page Location

Lets you save the current project status to a location of your choice. You can
then view the project status offline with any browser on a mobile device.
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Select Implementation:
rev_1

Select Status Page Location:

® Use Environment Variable SYMPLIFY_REMOTE_REPORT_LOCATION

Path: [ ]

Save to different Location

Set environment variable SYMPLIFY_REMOTE_REPORT_LOCATION, to
always save the HTML page to a particular location. Otherwise, select a
location to save to, each time. If you set the environment variable, and
then choose to save to a different location, the page is saved to the
different location.

| OK | | Cancel |

The following table describes the Project Status Page Location dialog box options.

Option Description

Select Implementation Select the implementation for the design for
which you want synthesis results. You can
select multiple implementations.

Select Status Page Location Select the location on your computer where

. Use Environment Variable you want to save the project status reports:

SYNPLIFY_REMOTE_REPORT_LOCATION * Use the environment variable to specify a
. Save to Different Location standard location for the project status
reports. Choose this option if you always
want to save the reports to the same
location.
¢ Choose a location for the project status
reports for the current implementation.
You can change this as often as you like.

For more information, see Accessing Results
Remotely, on page 295 in the User Guide.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 431



User Interface Commands

Options Menu

HDL Analyst Options Command

Select Options->Schematic Options to display a dialog box where you define
preferences for the HDL Analyst schematic. For details see Setting Schematic
Preferences, on page 356 in the User Guide.

HDL Analyst Options x

Default View

| Dataflow View

7]

Routing Detail

| standard

-]

Display Instance Limit

Expand Instance Limit

Grow Label Zoom Factor

Allow Automatic Grouping

Show View Mames

Show Instance Names

Show Port Names

Show Pin Names

Show design out of date popup message
E[BETA] Use new hierarchy bmwser§

Changes will appear in the next opened schematic.

Restore Defaults

[¥) Enabled [10000
[J Enabled | 1000
Enabled |2

=
5
=

OK | | Cancel
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The following options are on the HDL Analyst Options panel.

Field/Option

Default View

Routing Detail

Display Instance Limit

Expand Instance Limit

Grow Label Zoom Factor

Allow Automatic Grouping
Show View Names

Show Instance Names
Show Port Names

Show Pin Names

Show design out of date
popup message

[BETA] Use new hierarchy
browser

Restore Defaults

Description

Specify how you want the schematic views to display:

* Clocks View - Displays all sequential elements
connected to clock nets so that clocks in the design
can be debugged.

» Dataflow View - Displays objects from a left to right
datapath flow. This is the default.

Specify how the tool determines the detailed routing
for the design:

* Standard - This is the default.

* Quick - Direct net connections

When enabled, uses the specified limit to display
instances. The default is 10000.

When enabled, uses the specified limit to expand
instances. The default is 1000.

Specify a zoom factor for labels displayed in the
schematic view.

Select a value between 1 and 10, where labels are
shown increasing in size respectively. Changes will
appear in the next opened schematic view. The default
is 2.

When enabled, automatic grouping is performed.
When enabled, module names are displayed.
When enabled, instance names are displayed.
When enabled, port names are displayed.

When enabled, pin names are displayed.

When enabled, shows the design out of date popup
message.

When enabled, the new Hierarchy Browser displays
the RTL schematic at the instance level (Instance
Hierarchy tab) and design level (Design View tab), in
the next schematic displayed.

Click this button to reset all options to their defaults.
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Standard HDL Analyst Options Command

Select Options->HDL Analyst Options to display the HDL Analyst Options dialog box,
where you define preferences for the HDL Analyst schematic views (RTL and
Technology views). Some preferences take effect immediately; others only
take effect in the next view that you open. For details, see Setting Schematic
Preferences, on page 300 in the User Guide.

For information about the options, see the following, which correspond to the
tabs on the dialog box:

* Text Panel, on page 434

* General Panel, on page 435

* Sheet Size Panel, on page 439

* Visual Properties Panel, on page 441

Text Panel

Texk
Show kext Set Defaults

Show port name
Show symbal name
Show pin name
Show bus width

Instance narme

@ show instance name
() show short instance name

() Moinstance name

The following options are in the Text panel.
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Field/Option Description

Show text Enables the selective display of schematic labels.
Which labels are displayed is governed by the other
Show * features and Instance name, described below.

Show port name When enabled, port names are displayed.

Show symbol name When enabled, symbol names are displayed.

Show pin name When enabled, pin names are displayed.

Show bus width When enabled, connectivity bit ranges are displayed

near pins (in square brackets: []), indicating the bits
used for each bus connection.

Instance name Determines how to display instance names:
* Show instance name
* Show short instance name

* No instance name

Set Defaults Set the dialog box to display the default values.

General Panel

General .
General options
Shows higrarchy browser
Showw booltip in schematic
Compact symbals [] shaws cell interior
[ Show sheet connector index
[] compress buses

[ Mo buses in kechnology view

. re
Dissolve levels: [ 1 =

Instances added for expansion: [ZDDD =

The following options are in the General panel.
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Field/Option Description

Show hierarchy browser When enabled, a hierarchy browser is present as the
left pane of RTL and Technology views.

Show tooltip in schematic When enabled, displays tooltips that hover objects as
you move over them in the RTL and Technology
schematic views.

Compact symbols When enabled, symbols are displayed in a slightly
more compact manner, to save space in schematics.
When this is enabled, Show cell interior is disabled.

Show cell interior When enabled, the internal logic of cells that are
technology-specific primitives (such as LUTs) is shown
in Technology views. This is not available if Compact
symbols is enabled.

Show sheet connector index When enabled, sheet connectors show connecting
sheet numbers - see Sheet Connectors, on page 87.

Compress buses When enabled, buses having the same source and
destination instances are displayed as bundles, to
reduce clutter. A single bundle can connect to more
than one pin on a given instance. The display of a
bundle of buses is similar to that of a single bus.

No buses in technology view ~When enabled, buses are not displayed; they are only
indicated as bits in a Technology View. This applies
only to flattened views created by HDL
Analyst->Technology->Flattened View (or Flattened to Gates
View), not to hierarchical views that you have flattened
(using, for example, HDL Analyst->Flatten Current
Schematic).

Display color-coded clock Displays clock nets in the HDL Analyst View with the
nets color green.
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Field/Option

Dissolve levels

Instances added for
expansion

Maximum Routable
Endpoints

Color-coded Clock Nets

Description

The number of levels to dissolve, during HDL
Analyst->Dissolve Instances. See Dissolve Instances, on
page 414

The maximum number of instances to add during any
operation (such as HDL Analyst->Hierarchical->Expand)
that results in a filtered schematic. When this limit is
reached, you are prompted to continue adding more
instances.

Specifies the maximum number of endpoints for nets,
which the synthesis tool routes to their explicit
connection endpoints in the design to improve HDL
Analyst performance.

The default value is set to 2000. You can use this
option to change this value. For more information, see
Results of Maximum Routable Endpoints in the HDL
Analyst View, on page 437.

Clock nets are displayed with the color green in the RTL and Technology

views.

I

FEEEEPEEEE

Results of Maximum Routable Endpoints in the HDL Analyst View

Use the Maximum Routable Endpoints option to specify the maximum number of
endpoints for nets in the design to be explicitly routed to their connection
endpoints. When you adjust the default value of 2000 sufficiently, improve-
ments in performance can be seen in the HDL Analyst tool.
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Options Menu

If the number of connection endpoints routed for the design has been
reduced, you will see dashes (---) for these endpoints in the HDL Analyst (RTL
or Technology) view. Note that you can still select these endpoints and
perform any viable operation for these nets as shown in the RTL view below.

i L
Isolate Paths "X '
Expand
L Expand to Register/Ports
e Expand Paths
"'L""'r Expand Inwards —
Current Level »
Lo Properties... T ———
T e Tirning Analyst
| =
| Copy ——
f Yy SF &% Find...
T -
:E‘u ":;'M,,,,F, E Filter Schematic
P Hide Selected Instances
bk [] Push/Pop Hierarchy
o R 5 SCOPE )
spnicE|| IS — T T
sy
- et
uni e a4 H
==
- o -
| wni futimY
e
FUp e

Foutable Connection Endpaoints

Note: Occasionally, the software does not route nets for some reason.
You will see dashes (---) for these endpoints in the HDL Analyst
(RTL or Technology) view. Note that you can still select these nets
and perform any viable operation for them.

© 2020 Synopsys,
438

Inc.

Synplify Pro for Microsemi Edition Command Reference
Synopsys Confidential Information

January 2020



Options Menu User Interface Commands

Sheet Size Panel

Sheet Size

—5Sheet Size Options
Maximum instances: [SIII ]%]
Maximurn filkered instances: [1IIIIZI ]%]
Maxirurn inskance ports: [1IIIIZIIII ]%]
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The following options are in the Sheet Size panel.

Maximum instances Defines the maximum number of instances to display
on a single sheet of an unfiltered schematic. If a given
hierarchical level has more than this number of
instances, then it will be partitioned into multiple
sheets. See Multiple-sheet Schematics, on page 102.

Maximum filtered instances Defines the maximum number of instances to display
on a filtered schematic sheet, at any visible
hierarchical level. This limit is applied recursively, at
each visible level, when

¢ the sheet itself is a level, and

* each transparent instance is a level (even if inside
another transparent instance).

Whenever a given level has more child instances inside
it than the value of Filtered Instances, it is divided into
multiple sheets.

(Only children are counted, not grandchildren or
below. Instance A is a child of instance B if it is inside
no other instance that is inside B.)

In fact, at each level except the sheet itself, an
additional margin of allowable child instances is added
to the Maximum filtered instances value, increasing its
effective value. This means that you can see more
child instances than Maximum filtered instances itself
implies.

The Maximum filtered instances value must be at least the
Maximum instances value. See Multiple-sheet
Schematics, on page 102.

Maximum Instance Ports Defines the maximum number of instance pins to
display on a schematic sheet.
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Visual Properties Panel

Controls the display of the selected property in open HDL Analyst views. The
properties are displayed as colored boxes on the relevant objects. To display
these properties, the View->Visual Properties command must also be enabled.
For more information about properties, see Viewing Object Properties, on
page 291 in the User Guide.

Wisual Properties

g

Shiows Properky RTL E;E ELT;? ﬂ
1 slow N N
2 [
3 [
4 [
5 [
& [
|Click on a property For & description

The following options are in the Visual Properties panel.

Show

Property
RTL

Tech View

Value Only

Toggles the property name and value is displayed in a
color-coded box on the object.

Sets the properties to display.

Enables or disables the display of visual properties in
the RTL view.

Enables or disables the display of visual properties of
in the Technology view.

Displays only the value of an item and not its property
name.

Configure External Programs Command

This command is for Linux platforms only. It lets you specify the web browser
and PDF reader for accessing Synopsys support (see Web Menu, on page 443
for details) and online documents.
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Configure External Programs

—Web Browser

Application Path:
| mozilbl | [ ]

— Acrobat Reader

Application Path:

= [—

Field/Option Description

Web Browser Specify your web browser as an absolute path. You can use the
Browse button to locate the browser you need. The default is
netscape. If your browser requires additional environment
settings, you must do so outside the synthesis tool.

Acrobat Reader  Specify your PDF reader as an absolute path. You can use the
Browse button to locate the reader you need. The default is
acroread.
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Web Menu

This menu contains commands that access up-to-date information from
Synopsys Support.

Command Description

Synopsys Home Opens the Synopsys home web page for
Synopsys products.

FPGA Implementation Tools Opens the Synopsys FPGA design solution web
page for Synopsys FPGA products. You can find
information about the full line of Synopsys FPGA
Implementation products here.
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Help Menu

There are four help systems accessible from the Help menu:
* Help on the Synopsys FPGA synthesis tool (Help->Help)
* Help on standard Tcl commands (Help->TCL)
* Help on error messages (Help->Error Messages)

* Help on using online help (Help->How to Use Help)

The following table describes the Help menu commands.

Command Description

Help Displays hyperlinked online help for the product.

Additional Products Displays the Synopsys FPGA family of products and a brief
description.

How to Use Help Displays help on how to use Synopsys FPGA online help.

PDF Documents Displays an Open dialog box with hyperlinked PDF

documentation on the product including release notes,
user guide, reference manual, and licensing configuration
and setup. You need Adobe Acrobat Reader® to view the

PDF files.
Error Messages Displays help on the message viewer.
TCL Displays help for Tcl commands.
Mouse Stroke Tutor Displays the Mouse Stroke Tutor dialog box which provides

information on the available mouse strokes — see Using
Mouse Strokes, on page 51 for details.

License Agreement Displays the Synopsys FPGA software license agreement.

Floating License Usage  Specifies the number of floating licenses currently being
used and their users.
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Command Description

Preferred License Displays the floating licenses that are available for your

Selection selection. See Preferred License Selection Command, on
page 445.

Tip of the Day Displays a daily tip on how to use the Synopsys FPGA
synthesis tools better. See Tip of the Day Command, on
page 446.

¥ About this program Displays the About dialog box, showing the synthesis tool
product name, license expiration date, customer
identification number, version number, and copyright.
Clicking the Versions button in the About dialog box displays
the Version Information dialog box, listing the installation
directory and the versions of all the synthesis tool compiler
and mapper programs.

Preferred License Selection Command

Select Help->Preferred License to display the Select Preferred License dialog box,
listing the available licenses for you to choose from. Select a license from the
License Type column and click Save. Close and restart the Synopsys FPGA
synthesis tool. The new session uses the preferred license you selected.

Select Preferred License EHE
o Multiple license types detected, Please select a license type for use in future sessions,
G2y Current hostid: SKEY=5924F4A4, Current license type in use! synplifypro
Mote: Server name is provided For information only and is not used in license selection,
License Type Features Server Avail, | Tokal [3
& synplifypro_trc All FPGAs, rctest 1600@nsparky 45 50
& cyrplifypro_demo Al FPGas 1600@nsparky 21 25 |License Request'
& syrplifypro_cvnapps all FPGAs, cynapps 1600@nsparky 00 200 |:
& synplifypro_ident All FPGAs, ident 1600@nsparky 2399 300
& cyrplifypro_all All FPGAs, m2000, dw, ident 1E00@nsparky 294 300
& syrplifypro_fpga all FPGas 1600@nsparky 287 600
& synplifypro all FPGAs, m2000 1600@nsparky 1379|1500
Al FPGAS, m2000 1600@nspatky 7 @

A license can only be selected For Future sessions {nok current session)
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Tip of the Day Command

Select Help->Tip of the Day to display a dialog box, with a daily tip on how to
best use the Synopsys FPGA synthesis tool. This dialog box also displays
automatically when you first start the tool. To prevent it from redisplaying at
product startup, deselect Show Tips at Startup.

synplify 2] x|
% Did you know... k

Mext Tip

You can drag and drop modules and —
instances from the RTL and Previous Tip
Technology views into the SCOPE

interface to set constraints. —
Elp

Shaow Tips at Start up
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of the User Guide

Properties
[Fsm | Fam
|Option Yalue
Mame F3M
Insk Path pramentr.stacklevel[2:0]
Signal Mame Prefix progmcntr
FSM Properties Encoding sequential
Reset skate ula}
States 3
Transitions 7
— Property Description
Sttatte prcipetr‘tlgs Transition properties
(state selected) (transition selected)
Froperties m
[o1 | o [trans o001 | trans_o0_o1
|Option Walue Option Value
Mame 01 Mame trans_00_01
RTL Encoding skacklevel[1] From Skake o0
Mapped Encading 01 Ta State 01
—Property Description —Property Description
Help | ok | | Cancel | | Apply Help
Command Description
Change The implementation name you specify is the new name for

Implementation Name

the implementation.

Copy Implementation

The currently selected implementation is copied and saved

to the project with the new implementation name you

specify.
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of the User Guide
21|
Place & Route Implementation
[pr_t J

~Flow Settings

Run Place & Route following synthesis

~Place & Route Options File:

Standard Options File

Add Place & Route Options File

Existing Options File... | | Create New Options File... |

in the User Guide

s = L i sloctod it an e e
Property Value |~ |
area 0.000
arrival_time 0.000
hier_rtl_name pramentr
inout_pin_count a
input_pin_count 30
is_hierarchical 1 :
Jarea
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Select a Constraint File

Select the constraint file you wish to use:

i\premier_design4alsys_level_analysis_1.sdc
Ciipremier_designdaitimingmodels, sdc

Tew File || oK | | Cancel
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Silicon to Software

CHAPTER 6

GUI Popup Menu Commands

In addition to the GUI menu commands described in Chapter 5, User Inter-
face Commands, the FPGA synthesis tools also have context-sensitive
commands that are accessed from popup or right-click menus in different
parts of the interface. Most of these commands have an equivalent menu
command. This chapter only describes the unique commands that are not
documented in the previous chapter.

See the following sections for details:
* Popup Menus, on page 452
* Project View Popup Menus, on page 458
* RTL and Technology Views Popup Menus, on page 475
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Popup Menus

Popup menus, available by clicking the right mouse button, offer quick ways
to access commonly used menu commands that are specific to the view
where you click. Commands shown greyed out (dimmed) are currently
inaccessible. Popup menu commands generally duplicate commands avail-
able from the regular menus, but sometimes have commands that are only
available from the popup menu. The following table lists the popup menus:

Popup Menu Description

Project view See Project View Popup Menus, on page 458 for details

SCOPE window Contains commonly used commands from the Edit menu.

Watch Window See Watch Window Popup MenuThe Watch window popup
menu contains the following commands:, on page 452 for
details.

Tcl window Contains commands from the Edit menu. For details, see Edit

Menu Commands for the Text Editor, on page 310.

Text Editor window See Text Editor Popup Menu, on page 453 for more
information.

RTL and Technology = See RTL and Technology Views Popup Menus, on page 475.
views

FSM viewer See FSM Viewer Popup Menu, on page 455.

Watch Window Popup MenuThe Watch window popup menu

contains the following commands:

Command Description

Configure Watch Displays the Log Watch Configuration dialog box, where you
choose the implementations to watch.

Refresh Refreshes (updates) the window display.
Clear Parameters Empties the Watch window.

For more information on the Watch window and the Configure Watch dialog
box, see Watch Window, on page 34.
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Tcl Window Popup Menu

The Tcl window popup menu contains the Copy, Paste, and Find commands
from the Edit menu, as well as the Clear command, which empties the Tcl
window. For information on the Edit menu commands available in the Tcl
window, see Edit Menu Commands for the Text Editor, on page 310.

Text Editor Popup Menu

The popup menu in the Text Editor window contains the following commonly
used text-editing commands from the Edit menu: Undo, Redo, Cut, Copy, Paste,
and Toggle Bookmark. In addition, HDL Analyst specific commands appear
when both an HDL Analyst view and it’s corresponding HDL source file is
open. For details of these commands, see Edit Menu Commands for the Text
Editor, on page 310 and HDL Analyst Menu, on page 405.

The following table lists the commands that are unique to the popup menu:

Command Description

Filter Analyst  Filters your design to show only the currently selected objects in the
HDL text file. This is the same as HDL Analyst->Filter Schematic.

Select in Crossprobes from the Text Editor and selects the objects in the HDL
Analyst Analyst view. To use this command, the Enhanced Text Crossprobing
(option must be engaged.

Log File Popup Menu

The popup menu in the log file contains commands that control operations in
the log file. The popup menu differs when the log file is opened in the HTML
mode or in the ASCII text mode.

Log File Filter Dialog Box

The Log File Filter dialog box is available by selecting Log File Message Filter from
the log file popup menu when the log file is opened in the HDML mode. The
dialog box allows messages in the current session to be promoted or demoted
in severity or suppressed from the log files for subsequent sessions. For
additional information on using this dialog box, see Log File Message
Controls, on page 207 of the User Guide.
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The following table describes the dialog box functions.

Function Description

Log File Displays the message ID and text and the default message type
Messages of messages generated during the current session.

window

Suppress Suppresses the selected note, warning, or advisory message. The

Message button

selected message is removed from the upper Log File Messages
window and displayed in the lower window with the Override
column indicating suppress status. Note that error messages
cannot be suppressed.

Make Error button

Promotes the status of the selected warning (or note) to an error.
The selected message is removed from the upper Log File
Messages window and displayed in the lower window with the
Override column indicating error status.

Make Warning
button

Promotes the status of the selected note to a warning. The
selected message is removed from the upper Log File Messages
window and displayed in the lower window with the Override
column indicating warning status.

© 2020 Synopsys, Inc.
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Function Description

Make Note button Demotes the status of the selected warning to a note. The
selected message is removed from the upper Log File Messages
window and displayed in the lower window with the Override
column indicating note status.

Remove Override Removes the override status on the selected message in the lower
button window and returns the message to the upper Log File Messages
window.

Read Message Select the message filter file (project.pfl) to be read for the project.
File

lower window Lists the status of all messages that have been promoted,
demoted, or suppressed.

OK button Updates the status of any changed messages in the .pfl file. Note
that you must recompile/resynthesize the design before any
message status changes become effective.

FSM Viewer Popup Menu

The popup menu in the FSM Viewer contains commands that determine what
is shown in the FSM Viewer. The following table lists the popup commands in
the FSM Viewer.

Command Description

Properties Displays the Object Properties dialog box and view properties of
a selected state or transition. Information about a selected
transition includes the conditions enabling the transition and
the identities of its origin and destination states. Information
about a selected state includes its name, RTL encoding, and
mapped encoding.

Filter See View Menu: FSM Viewer Commands, on page 325.
Unfilter See View Menu: FSM Viewer Commands, on page 325.

FSM Properties Displays the Object Properties dialog box indicating the FSM
identity and location, encoding style, reset state, and the
number of states and transitions.
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Field/Option
£33 2

Name

Inst Path

Signal Name Prefix

Encoding

Reset State
States
Transitions

RTL Encoding

Mapped Encoding
From

To

Conditions (min-terms)

Synplify Pro for Microsemi Edition Command Reference
January 2020

Description
Icons indicating the object type: FSM, state, or transition.

The name of the selected state or transition, or FSM if
nothing is selected.

The full name and position of the state machine in the
hierarchy.

The position of the state machine in the hierarchy.

The style of encoding used for the state machine. This can be
onehot, sequential, gray, or safe. See syn_encoding, on
page 35, for information on changing the encoding type.

The initial state of the FSM: the active state after resetting.
The number of states in the state machine.
The number of transitions in the state machine.

The name (address) of the selected state, as referred to in the
RTL (HDL) file.

The encoding of the selected state.
The origin state of the selected transition.
The destination state of the selected transition.

The conditions enabling the selected transition, as defined in
the RTL (HDL) file.
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Project View Popup Menus

The popup menu commands available in the Project view are context-sensi-
tive, depending on what is currently selected and where in the view you click
to open the popup menu. Most commands duplicate commands from the File,
Project, Run, and Options menus.

Project Management View Popup Commands

The following table describes the Project Management view commands that
are not duplicated on other menus in the tool:

Command

Description

Project Management View, No Selections

Open Project

New Project
Refresh

Project View Options

Project Selected
Open as Text

Add File

Synthesize
Compile Only

Write Output Netlist
Only

Arrange VHDL Files

© 2020 Synopsys, Inc.
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Displays the Open Project Dialog. See Open Project
Command, on page 309.

Creates a new empty project in the Project Window.
Refreshes the display.

Displays the Project View Options dialog. See Project View
Options Command, on page 422.

Opens the selected file in the Text Editor.

Displays the Add Files to Project dialog. See Add Source File
Command, on page 332.

Compiles and maps the selected design.

Compiles the selected design.

Writes the mapped output netlist to structural Verilog (.vm)
or VHDL (.vhm) format.

Same as enabling:

* Write Mapped Verilog Netlist
* Write Mapped VDHL Netlist

on the Implementation Results tab of the Implementation
Options dialog box.

Reorders the VHDL source files.
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Command Description
Save Project Displays the Save Project As dialog box.
Close Project Closes your project.

Project Folder or File Selected

Add Folder Creates a folder with the new name you specified and adds it
to the Project view. See Add Folder Command, on page 463.

Rename Folder Renames an existing folder with the new name you specified
in the Project view. See Rename Folder Command, on
page 463.

Delete Folder Deletes the specified folder and all its contents as necessary.

See Delete Folder Command, on page 463.

Remove from Folder =~ Removes the selected file from its corresponding folder.

Place in Folder Places the selected file into the folder you specify.
Launch Tools->Run Launches the vendor application or Tcl procedure tool from
Vendor Tool the Project view for the selected file of folder. See Vendor

Tool Invocation Popup Menu Command, on page 464.

Constraint File Selected

File Options Displays the File Options dialog box. See File Options Popup
Menu Command, on page 465.

Open Opens the SCOPE window.

Open as Text Opens the selected file in the Text Editor.

Copy File Displays the Copy File dialog box, where you copy the

selected file and add it to the current project. You specify a
new name for the file. See Copy File Popup Menu
Command, on page 468.

Change File Opens the Source File dialog box where you choose a new file
to replace the selected file. See Change File Command, on
page 335.

Remove File From Removes the file from the project.

Project

HDL File Selected

File Options Displays the File Options dialog box. See File Options Popup
Menu Command, on page 465.
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Project View Popup Menus

Command
Open
Syntax Check

Synthesis Check

Copy File

Change File

Remove File From

Project

Description
Opens the file in the Text Editor.

Runs a syntax check on your design code. Reports errors,
warnings, or notes in the Tcl Window.

Runs a synthesis check on your design code. This includes a
syntax check and a check to see if the synthesis tool could
map the design to the hardware. No optimizations are
performed. Reports errors, warnings, or notes in the Tcl
Window.

Displays the Copy File dialog box, where you copy the
selected file and add it to the current project. You specify a
new name for the file. See Copy File Popup Menu
Command, on page 468.

Opens the Source File dialog box where you choose a new file
to replace the selected file. See Change File Command, on
page 335.

Removes the file from the project.

Implementation Selected

Implementation
Options

Change

Implementation Name

Copy Implementation

Remove
Implementation

RTL View

Tech View

Add P&R
Implementation

© 2020 Synopsys, Inc.

Displays the Implementation Options dialog box. See
Implementation Options Command, on page 345.

Displays the Implementation Name dialog box, where you
rename the selected implementation. See Change
Implementation Popup Menu Commands, on page 468.

Copies the selected implementation and adds it to the
current project with the name you specify in the dialog box.
See Change Implementation Popup Menu Commands, on
page 468.

Removes the selected implementation from the project.

Creates an RTL View based on the properties of the selected
implementation.

Creates a Technology View based on the properties of the
selected implementation.

Displays the Add New Place & Route Task dialog box where you
set options to run place & route after synthesis. See Add
P&R Implementation Popup Menu Command, on page 470
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Command Description
Run Starts a synthesis run on your design.
Identify Implementation Selected

Identify Instrumentor Displays the Identify Instrumentor tool, so that you can
instrument signals based on the RTL and SRS netlist (after
compile). See Working with the Identify Tools, on page 545.

Launch Identify Launches the Identify Debugger tool to debug the
Debugger instrumented design. See Working with the Identify Tools,
on page 545.

Place & Route Implementation Selected

Add Place & Route Displays the Add New Place & Route Task dialog box, so you

Job can set options and run placement and routing. See Add
P&R Implementation Popup Menu Command, on
page 470.
Remove Place & Deletes the place-and-route implementation from the
Route Job project.
Run Place & Route Runs the place-and-route job for the design.
Job

Project Management Commands

The following table lists the popup commands in the Project Management
views that are not available on the tool command menus. The Project
Management view consists of two tabs, and the table lists the popup
commands available in both tabs.

For the Design Hierarchy tab, the tools support all the project management
commands listed in Project Management View Popup Commands, on
page 458, as well as the unique commands listed here.
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Command Description

Project Management View -> Project FilesTab Popup Commands

All Synplify project Refer to the table in Project Management View Popup

management Commands, on page 458 for descriptions of these
commands commands.
Project Options With the project selected, displays project properties such as

name and location. See Project Options Popup Menu
Command, on page 469.

Show Compile Points  Displays the compile points of the selected implementation
and lets you edit them. See Show Compile Points Popup
Menu Command, on page 469.

P & R Options With a place-and-route implementation selected, displays
the Options for Place & Route on Implementation dialog box, so
you can change options and rerun placement and routing.
See Options for Place & Route Jobs Popup Menu
Command, on page 473 for a description of the features.

Set as Black Box When enabled, specifies that the design block be
implemented as a black box during synthesis. Only available
when the subproject is selected.

Project Management View -> Design Hierarchy Tab Commands

Set as Black Box Specifies that the design block be implemented as a black
box during synthesis.

Design Block source Takes you to the design block or instance block definition in
the HDL source file.

Refresh Hierarchy Refreshes the Design Hierarchy view after design blocks or
instance blocks have changed.

Properties Displays the design block or instance block properties. For
details.

Project Management View Popup Folder Commands

The Project view popup menu includes commands for manipulating folders.
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Add Folder Command

Use this option to add a folder to the Project view.

g Create Mew Folder ﬂﬂ

Folder Name

| Ok | | Zancel

Rename Folder Command

Use this option to rename an existing folder in the Project view.

" Rename folder new ﬂﬂ

Folder Name | new|

Delete Folder Command

Use this option to delete a folder from the Project view.
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| _symplifyPro______________ 2|

Do vou want ko delete the Folder "nes"?
Select Yes bo delete the Folder and remove all contained files From the project
Select Mo to just delete the Folder

& | Yes | | R ] | | Zancel

This dialog box includes the following options:

Feature Description

Yes Select Yes to delete the folder and all files contained in
the folder from the Project view.

No Select No to delete just the folder from the Project view.

Cancel Select Cancel, to discontinue the operation.

Vendor Tool Invocation Popup Menu Command

Use the Vendor Tool Invocation command to invoke third-party tools, such as the
Embedded Development Kit (EDK) from within the Synopsys FPGA products.
This allows you to modify source files or libraries added to your synthesis
projects from within the third-party tool directly. Use the following dialog box
to run the vendor tools.

For more information, see Invoking Third-Party Vendor Tools, on page 519 in
the User Guide.

The Vendor Tool Invocation dialog box includes the following options:
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Feature Description

Application Tag Name Specifies an application or Tcl procedure name. Type
in the name or select a preconfigured application from
the list.

Additional Options Defines any additional arguments for the Tcl

procedure or third-party application. You can select
arguments from the drop-down list or type them.
Note: For internal Synopsys tools, you must include
the $Syncode parameter.

Command Preview Sets up the direct invocation of a third-party tool from
within the FPGA synthesis tool, using the path defined
for the executable in Application Name with Path or to
execute the Tcl procedure from within the FPGA
synthesis tool, using the path defined for the
procedure in Tcl Procedure Name.

Run The synthesis tool launches the third-party tool or
runs the Tcl procedure with the arguments you
specified.

File Options Popup Menu Command

To display the File Options dialog box, right-click a project file and select File
Options from the popup menu. Specify the path as relative or absolute when
listing the file in the project (prj) file and if the file is to be passed to the
place-and-route tool or used only for simulation.
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Field/Option Description
File Path Path to the selected file.

File Type The folder type for the selected file. You can select the file folder
type from a large list of file types.

Changing the folder file type does not change the file contents or
its extension; it simply places the file in the specified Project view
folder. For example, if you change the file type of a VHDL file to
Verilog, the file retains its Verilog extension, but is moved from the
VHDL folder to the Verilog folder.

Library Names  Name of the library which must be compatible with the HDL
simulator. For VHDL files, the dialog box is the same as that
accessed by Project->Set VHDL Library - see Set VHDL Library
Command, on page 335.

Last modified Date the file was last modified.

Save file The format for the path type: choose either Relative to Project (the
default) or with an Absolute Path.

Verilog Standard  Select the Verilog file type from the menu: Use Project Default,
(Verilog only) Verilog 95, Verilog 2001, or SystemVerilog.

Use Project Default sets the type of the selected file to the default for
the project (new projects default to SystemVerilog).

Use for Place Determines if files are automatically passed to the backend

and Route place-and-route tool. The files are copied to the place-and-route
implementation directory and then invoked when the
place-and-route tool is run.

Use for Determines if files are only to be used for simulation. For example,
Simulation Only files such as test benches containing HDL constructs used only for
simulation can be specified using this option.
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The following is the Verilog dialog box:

&¥ File Options Zlx
File Path: |C:\designs‘u’denﬁfy_bus_demo\abc.v
Modified: [07:40:48  06-May-2011 ]
Library Names: [wnrk ]
Save File
File Type: Iverilog | 'I

® Relative to Project
Verilog Standard: IUse Project Default | vI [} Absolute Path

[ Use for Place and Route

[ Use for Simulation only

oK | | Cancel
The following is the VHDL dialog box:

File Path: |C:\designs\idenﬁfy_bus_demo‘ﬁrb.vhd

Modified: [16:43:35 29-apr-2011 |

Library Mames: ’work ]
Save File

File Type: Ivhdl |v| '@ Relative to Project
() Absolute Path

[ use for Place and Route

[ use for Simulation only

Ok | | Cancel
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Copy File Popup Menu Command

With a file selected, select the Copy File popup menu command to copy the
selected file and add it to the current project. This displays the Copy File dialog
box where you specify the name of the new file.

@ Copy File

Qriginal Marme

I Z:/Designs)a-bit-whdlfio.vhd I

Mew Narne

[C:,I'Designsll'S—bit—vhdlll'io1 whd ]

ok ” Zancel |

Change Implementation Popup Menu Commands

With an implementation selected, right-click and select the Change Implementa-
tion Name or Copy Implementation popup menu commands to display a dialog
box where you specify the new name.

Command Description

Change The implementation name you specify is the new name for
Implementation Name  the implementation.

Copy Implementation The currently selected implementation is copied and saved
to the project with the new implementation name you
specify.

@ Implementation Mame | x|

Implementation Mame

(04 ” Cancel |
y
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Show Compile Points Popup Menu Command

With an implementation selected, select the Show Compile Points popup menu
command to display the Compile Points dialog box and view or edit the compile
points of the selected implementation.

Compile points are only available for certain technologies. For more informa-
tion on compile points and the compile-point synthesis flow, see Compile
Point Types, on page 439 and Synthesizing Compile Points, on page 452 of the
User Guide.

o synplify kB3
Enable | Module I Type | Corrnent | File
ALU soft Automatically Inserted  CifDesigns/ramChrl_prod/data_control.sdc
INS_Decode  locked Ci/DesignsramCtr]_prod/data_control,sdc
mulk locked Ct/DesignsramCtrl_prod/data_control.sdc
comb_logic  locked _control.sdc

C:/Desi
i didata control,sdc

I Close | | Edit: Compile Point |

The columns Enable, Module, Type, and Comment in the dialog box correspond

to the columns Enabled, Module, Type, and Comment in the SCOPE spreadsheet
for the compile point. The File column lists the top-level constraint file where
the compile point is defined.

To open and edit the SCOPE spreadsheet for a compile point, either
double-click the row of the compile point or select it and click the Edit Compile
Point button.

Project Options Popup Menu Command

With a project selected, select the Project Options popup menu command to
display the Project Properties dialog box and change the implementation of a
project.

In the dialog box, select an implementation in the Implementations list, then
click OK or Apply to make it the active implementation of the project.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 469



GUI Popup Menu Commands Project View Popup Menus

Project Properties 2]

Project Mame

I proj_1 I

Project Location

[ Ci/Designsfaaa-QT proj_1.prj ]

Implementations

rev_t
rev_6_identify

Add P&R Implementation Popup Menu Command

Displays the Add New Place & Route Task dialog box. For information about
using this command for place-and-route encapsulation, see Running P&R
Automatically after Synthesis, on page 542 in the User Guide.
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B Al M Mace & Route Task

2=

Place b Foute Implemeriabon

lor
[or_2

v Sethngs

] Fun Pace & Route foliowng synthess

x|

MR PY L Auld How Place & Route Task

T!’l Ctaadr,  Pece BRoute Implemertadon:

|pr_1
Flow Soinncg

[l i Flace Ut folloieng spthess
(] Us= plscement consir snte from physcs! synthess

Placs & Reiea ot hddhpﬁqwm Im
g Piape & Route mplamentmaon:
pr1 |
Fate B Route Sourca;
Logkal Synthess =] |C\smolfy_premier_tutoriahnutoriahobysical_smithesisheight_bt_uc.sdf | |
Add Place & Ao
b Floa Settngs
| || Grmart Guide
|+ Aun Place B Route after Synthess
Agd Place & Routes
|+ Run Timing & Plcemsnt Backannetation + Generate Congestion Aralss Report
L &
Place & Routs Options Fle:
[I¥! Standard Ontions Ak
“—
Add Pca & Routs Cptons Fia
| Exgtg poons Fie.., | Craate Hew Options ... |
I_E’:I( l Cancal
Command Description
Place & Route Enter a name for the place & route implementation. Do
Implementation Name not use spaces for the implementation name.
Flow Settings
Run Place & Route Enable/disable the running of the place & route tool from
following synthesis the synthesis tool immediately following synthesis.
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Command Description
Add Place & Route This option opens the Select Place & Route option file dialog
Options File box where you browse for an existing place & route

options file. See Running P&R Automatically after
Synthesis, on page 542 for information about using this
feature.

Existing Options File

Select Place & Route File 2lx

Look in: I&)synplify)remiar_mute j & e ER-

D vhd
m run_ise2, td

File name: I j Open
Files of type: I)thx P&R Tcl Option File (“tcl) j Cancel

Add Place & Route This option opens the Create Place & Route Options File
Options File dialog box where you specify a new place & route options
Create New Options File file. See Running P&R Automatically after Synthesis, on

page 542 for information about creating a new options
file.

T Create Place & Route Options File ? X

Place & Route Opticns File Name:

| C:\Synplify_Premier_labs\Synthesis_Lab\altera_partcl
Description

The specified Place & Route options file will be created and added to your project.
Changes to the options file need to be made from the Project View.

Using "* as the starting template.
Select from the "P&R Options File List" to choose a different template.
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Once the par implementation is created, then you can right-click and perform
any of the following options:

* P&R Options—See Options for Place & Route Jobs Popup Menu
Command, on page 473.

* Add Place & Route Job—See Add P&R Implementation Popup Menu
Command, on page 470.

* Run Place & Route Job—Runs the place-and-route job.

Options for Place & Route Jobs Popup Menu Command

You can select a place-and-route job for a particular implementation, easily
change options and then rerun the job. These options are the same found on
the Options for Place & Route on Implementation dialog box. For a description of
these options, see Add P&R Implementation Popup Menu Command, on
page 470.
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B Optians for Place & Route on Tnsplementation: butoral: ree 1 =

Plsce & Routs Implemaristion

[or_1 ]
o Setings

] Aun Flace & Aoubs foloving synithesss
B Opticns for P toube an Innplemen tatien: tulerdal = rev_1 1|

e e L
[l Starcand On [orz ]

Flzay Sottingg

] A Flsos & Routs follmwng cpnthess
] Use placement consirants fron physcal synthess

T Optians for Place B Rovte on Implemantation: exgh_ it usson - physica_syrknesis T | i
Piape & Roule implenerizion:
[pr_1 |

Pl 2 Aol

Ptace B Roube Source:
| Logical Synthesie =] | Chsyrphfy_premier_tutoraltutorhphysical_syrithesieight_bik_uc.edf |

Add Place & Aouts
= Flow Settngs
! || Smart Guide
| Aun Plaoe B Route after Synthass
[+ Run Timing & Placement Backannotation + Generabe Congestion Anakyss Report

add Flace &

- || =4

Pace & Routs Opbons Rle:
| Standard Qptons Fk

T —
Add Place & Route Ootions Fie
i Exicting Optionc Fia.... I {razto flew Optbons Ala.._ |
— |
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RTL and Technology Views Popup Menus

Some commands are only available from the popup menus in the RTL and
Technology views, but most of the commands are duplicates of commands
from the HDL Analyst, Edit, and View menus. The popup menus in the RTL and
Technology views are nearly identical. See the following:

* Hierarchy Browser Popup Menu Commands, on page 475

* RTL View and Technology View Popup Menu Commands, on page 475

Hierarchy Browser Popup Menu Commands

The following commands become available when you right-click in the
Hierarchy Browser of an RTL or Technology view. The Filter, Hide Instances, and
Unhide Instances commands are the same as the corresponding commands in
the HDL Analyst menu. The following commands are unique to this popup

menu.

Command Description

Collapse All Collapses all trees in the Hierarchy Browser.

Filter Highlights and filters objects such as ports, instances, and
primitives in the HDL analyst window.

Reload Refreshes the Hierarchy Browser. Use this if the Hierarchy
Browser and schematic view do not match.

Hide/Unhide Hides or unhides selected instances in the HDL analyst window.

Instances For more information on hidden instances, see Hidden

Hierarchical Instances, on page 92.

RTL View and Technology View Popup Menu Commands

The commands on the popup menu are context-sensitive, and vary
depending on the object selected, the kind of view, and where you click. In
general, if you have a selected object and you right-click in the background,
the menu includes global commands as well as selection-specific commands
for the objects.

Most of the commands duplicate commands available on the HDL Analyst
menu (see HDL Analyst Menu, on page 405). The following table lists the
unique commands.

Synplify Pro for Microsemi Edition Command Reference © 2020 Synopsys, Inc.
January 2020 Synopsys Confidential Information 475



GUI Popup Menu Commands

RTL and Technology Views Popup Menus

Command

Show Critical Path
Timing Analyst

Find

Filter Schematic

Push/Pop Hierarchy

Select All Schematic

Select All Sheet

Unselect All

Flatten Schematic

Unflatten Current Schematic
HDL Analyst Options

SCOPE->Edit Attributes
(object name)

© 2020 Synopsys, Inc.
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Common Commands
See ...

HDL Analyst Menu: Timing Commands, on
page 412.

HDL Analyst Menu: Timing Commands, on
page 412.

Find Command (HDL Analyst), on page 315.

HDL Analyst Menu: Filtering and Flattening
Commands, on page 408.

HDL Analyst Menu: RTL and Technology
View Submenus, on page 405.

HDL Analyst Menu: Selection Commands, on
page 416.

HDL Analyst Menu: Selection Commands, on
page 416.

HDL Analyst Menu: Selection Commands, on
page 416.

HDL Analyst Menu: Filtering and Flattening
Commands, on page 408.

HDL Analyst Menu: Filtering and Flattening
Commands, on page 408.

HDL Analyst Options Command, on page 432.

Opens a SCOPE window where you can enter
attributes for the selected object. It displays the
Select Constraint File dialog box (Edit Attributes
Popup Menu Command, on page 479), where you
select the constraint file to edit. If no constraint file
exists, you are prompted to create one.
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SCOPE->Edit Compile Point
Constraints (module
moduleName)

SCOPE->Edit Module
Constraints (module
moduleName)

Command

Isolate Paths

Expand Paths

Current Level Expand Paths
Show Context

Hide Instance

Unhide Instance

Show All Hier Pins

Dissolve Instance

Dissolve to Gates

Command

Expand to Register/Port
Expand Inwards
Current Level->Expand

Current Level->Expand to
Register/Port

Current Level->Expand Paths

Synplify Pro for Microsemi Edition Command Reference
Synopsys Confidential Information

For technologies that support compile points, it
opens a SCOPE window where you can enter
constraints for the selected compile point. It
displays the Select Compile Point Definition File dialog
box and lets you create or edit a compile-point
constraint file for the selected region or instance.
See Edit Attributes Popup Menu Command, on
page 479.

Opens a SCOPE window so you can define module
constraints for the selected module). If you do not

have a constraint file, it prompts you to create one.

The file created is a separate, module-level
constraint file.

Instance Selected
See ...
Isolate Paths, on page 413.
Hierarchical->Expand Paths, on page 407.
Current Level->Expand Paths, on page 408.
Show Context, on page 413.
Hide Instances, on page 413.
Unhide Instances, on page 413.
Show All Hier Pins, on page 414.
Dissolve Instances, on page 414.

Dissolve to Gates, on page 414.

Port Selected
See ...
Hierarchical->Expand to Register/Port, on page 407.
Hierarchical->Expand Inwards, on page 407.
Current Level->Expand, on page 407.
Current Level->Expand to Register/Port, on page 408.

Current Level->Expand Paths, on page 408.
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Properties Properties Popup Menu Command, on page 479.

Net Selected

Command See ...

Goto Net Driver Hierarchical->Goto Net Driver, on page 407.
Select Net Driver Hierarchical->Select Net Driver, on page 407.
Select Net Instances Hierarchical->Select Net Instances, on page 407.

Current Level->Goto Net Driver Current Level->Goto Net Driver, on page 408.

Current Level->Select Net Current Level->Select Net Driver, on page 408.

Driver

Current Level->Select Net Current Level->Select Net Instances, on page 408.
Instances

Set Net Color Sets the color of the selected net from a color pallet.

For details, see Set Net Color Popup Menu
Command, on page 478.

Set Net Color Popup Menu Command

The set net color command sets the color of the selected net in the HDL Analyst
for the current session. To use the command, select the desired net or nets in
the RTL view and select set net color from the popup menu to display the dialog

box.
& Set Net Color 2| x|
Set net color in current schematic view
Net/ Group Name | Group Number Color
sysclk 1 - I
clk 1 - I
0_sys_rst 2 | I
| 0K | | Cancel
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Double-click the corresponding color in the Color column to display the color
pallet and then double click the desired color and click OK. Nets can be

grouped and assigned to the same color by selecting the same group number
in the Group Number column.

Properties Popup Menu Command

The software displays property information about the selected object when
you right-click on a net, instance, pin, or port in an HDL Analyst view. See
Visual Properties Panel, on page 441 or Viewing Object Properties, on

page 291 in the User Guide for more information about viewing object proper-
ties.

2 Vizual Propeities

[ === (idebie, i he seectsdovectisaport
Propesly | Ve 1=

L] }(.DOU

arrhal_ima C.000

Fer rkl néme .:run-:rtr

irout pm zount C

irpul_pr_zoLnt .Il

is_hizrarchica .1 l%

|aea

Edit Attributes Popup Menu Command

You use the Select a Constraint File dialog box to choose or create a constraint
file. You can open the constraint file and edit it. For technologies that support

the compile points, it lets you create or edit a compile-point constraint file for
the selected region or instance.
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© 2020 Synopsys, Inc.
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Select a Constraint File

Select the constraink file you wish to use:

Ci\premier_design4alsys_level_analysis_1.sdc
Ciipremier_designaaltimingmodels, sdc

Mew File ” Ok | | Cancel

i) Mo progect lnaded. Do you want ko open a prasct?
Synplify Pro &

e
Sawe charges bo project fucoeial 7

2=

Cancel
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Symbols
_ ALLOWNESTEDBLOCKCOMMENTSTA
RT__ directive 368

_SEARCHFILENAMEONLY_
directive 367

! character, find command 164

? wildcard
Timing Analyzer 403

.srr file
See log file

.srs file
See srs file

Numerics
64-bit mapping 348

A

aborting a synthesis run 379
About this program command 445

add files
-_include tcl argument 22

Add Implementation command 332
Add P&R Implementation command 470

Add Place & Route Options File
command 472

Add Place and Route Job command 470
Add Source File command 331
add_file Tcl command 21

add_folder Tcl command 25
add_to_collection command 202
Additional Products command 444

annotated properties for analyst
object properties for filtering 160

append_to_collection command 204
archive utility
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_SEARCHFILENAMEONLY_
directive 367

copy tcl command 83

unarchive tcl command 83

Arrange VHDL files command 375

asynchronous clock report
generation option 395

Attributes panel, SCOPE 232

auto constraints
Maximize option (Constraints tab) 350

B

Back command 325

batch mode 144

Build Project command 304
bus bundling 436

bus_dimension_separator_style
command 297

bus_naming style command 297

buses
compressed display 436
enabling bit range display 435
hiding in flattened Technology
views 436

By any transition command 326
By input transitions command 325
By output transitions command 325

Cc

c_diff command (collections) 224
c_intersect command (collections) 224
c_print command (collections) 224
c_sub command (collections) 224
c_symdiff command (collections) 224
c_symdiff command, examples 173
c_union command (collections) 224
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camera mouse pointer 304

case sensitivity, Tcl find command 155

cell interior display,
enabling/disabling 436

Change File command 331

Change Implementation Name
command 460

check_fdc_query command 29

check_fdc_query Tcl command 29

Clear Parameters command 452

clock alias 399

clock as object 399

clock groups, SCOPE 217

clock paths, ignoring 245

Clocks panel, SCOPE 216

Close command 304

Close Project command 305

Collapse All command 475

Collection Commands

get_prop 176

collection commands

c_diff 170
c_intersect 171
c_list 172

c_print 172
c_symdiff 173
c_union 174
SCOPE 224

collections
Synopsys standard commands 202

Collections panel, SCOPE 223

commands
accessing 304
Add Place & Route Job 470
Hierarchy Browser 475
menu
See individual command entries
set_modules (Tcl) 176
Tcl
See Tcl commands
Tcl collection 169
Tcl command equivalents 12
Tcl expand 166
Tcl find 152

Comment Code command 310
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Compile Only command 374

compile point constraints
editing 477
Compile Points panel, SCOPE 234

compiler directive
_SEARCHFILENAMEONLY_ 367

compiler directives
__ ALLOWNESTEDBLOCKCOMMENTS

TART__ 368
__SYN_COMPATIBLE_INCLUDEPATH_
369

IGNORE_VERILOG_BLACKBOX_GUTS
365

UI option 359
Verilog 363

Configure External Programs
command 441

Configure Mapper Parallel Job
command 417

Configure Verilog Compiler
command 417

Configure VHDL Compiler
command 417

Configure Watch command 452

connectivity, enabling bit range
display 435
constraint checker

check fdc_query command 29

constraint file
define_compile_point 299
define_current_design 300
syn_connect 141
syn_create_err_net 142

constraint files
editing compile point files 477
SCOPE spreadsheet 214

constraint_file Tcl command 34

constraints
automatic. See auto constraints
check constraints 375
FPGA timing 259

Constraints panel
Implementation Options dialog box 349

context-sensitive popup menus
See popup menus

Copy command 310
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Copy File command 459
Copy Implementation command 460
copy_collection command 205
copying image

Create Image command 304
Create Image command 304

Create Place & Route Options file dialog
box 472

create_clock timing constraint 260

create_generated_clock timing
constraint 262

critical paths
creating new schematics 406
custom timing reports 394
finding 412
Timing Report panel, Implementation
Options dialog box 353

custom folders
project_folder Tcl command 94

Customize command 417

customizing
project files 422

Cut command 310

D

define_compile_point
Tcl 299

define_current_design
Tcl 300

defining I/O standards 233

delay paths
POS 251

Delay Paths panel, SCOPE 229
Delete all bookmarks command 310

design parameters (Verilog)
extracting 363

Device panel
Conservative Register
Optimization 123
Implementation Options dialog box 346

dialog boxes
Implementation Options 345

directive
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IGNORE_VERILOG_BLACKBOX_GUTS
365

directives

_SEARCHFILENAMEONLY_ 367

beta features 366

ignore syntax check 365

specifying for the compiler (Verilog) 363
disabling sequential optimizations 122
display settings

Project view 422
Dissolve Instances command 414
Dissolve to Gates command 414
dissolving instances 414

duplicate modules (Verilog)
Tcl option 116, 118

E

Edit Attributes command 476

Edit Compile Point Constraints
command 477
Edit menu 309
Advanced submenu 310

Edit Module Constraints command 477
Editor Options command 417
Enable Slack Margin 399
encoding
enumeration, default (VHDL) 355
state machine
displaying 457
encryptIP script
command-line arguments 51
syntax 51
encryptP1735 script 54
command-line arguments 54
public keys repository file 55
syntax 54
use models 57
enumeration encoding, default
(VHDL) 355
environment variables
accessing, get_env Tcl command 64

examples
Tcl find command syntax 156

Exit command 305
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Expand command
current level 407
hierarchical 407

Expand Inwards command 407

Expand Paths command
current level 408
hierarchical 407

Expand to Register/Port command
current level 408
hierarchical 407
expanding
paths between schematic objects 407
export project Tcl command 64

Extract Parameters 363

F

false paths
architectural 245
clocks as from/to points 254
code-introduced 245
defined 245
POS 251

FDC
create_clock constraint 260
create_generated_clock 262
reset_path 266
set_clock_groups 268
set_clock_latency 274
set_clock_uncertainty 276
set_false_path 278
set_input_delay 281
set_max_delay 284
set_multicycle_path 287
set_output_delay 291
set_reg input_delay 294
set_reg output_delay 295
standard collection commands 202

File menu
Recent Projects submenu 305

File Options command 465

files
.ta See also timing report file 396
adding to project 21,332
constraint 34
copying 459, 460
include 22
log. See log file
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opening recent project 305
organization into folders 423
project 92
removing from project 331
replacing in project 335
srs See srs file
stand-alone timing report (.ta) 393
temporary 415
timing report. See also timing report
file 396

Filter Schematic command 408

popup menu 453

filtering
critical paths 412
FSM states and transitions 325
paths from pins or ports 413
selected objects 408
timing reports 395
Find again command 310
Find command
HDL Analyst 315
Text Editor 310

find command
batch mode 78
filter properties 160

finding
critical paths 412

Flatten Current Schematic command
filtered schematic 410
unfiltered schematic 409

Flattened Critical Path command 406
flattened schematic, creating 406
Flattened to Gates View command 406
Flattened View command 406

flattening
instances 414
schematics 409

Floating License Usage command 444

folders
adding to project 25

folders for project files 423
foreach_in_collection command 206
Forward command 325

FPGA Implementation Tools
command 443
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FPGA timing constraints 259

from points

clocks 253

multiple 248

object search order (Timing

Analyzer) 399

objects 247

timing analyzer 399
FSM Explorer command 375
FSM Table command 326
FSM Viewer

popup menu 455

popup menu commands 455

FSMs
optimizing with FSM Compiler 125

Full View command 324

G

Generated Clocks panel, SCOPE 220
get_env Tcl command 64
get_object_ name command 208
get_option Tcl command 64
get_prop

design get_prop 45
get_prop TCL command 176
Goto command 310

Goto Net Driver command
current level 408
hierarchical 407

H

HDL Analyst
Find command 315
Visual Properties 325

HDL Analyst menu 405
Current Level submenu 407
Hierarchical submenu 407
RTL submenu 406
Select All Schematic submenu 416
Select All Sheet submenu 416
Technology submenu 406

HDL Analyst Options command 418

HDL Analyst tool
displaying timing information 412

© 2020 Synopsys, Inc.

HDL parameter overrides 66

hdl define Tcl command 65

hdl param Tcl command 66

Help command 444

Help menu 444

Hide Instances command 413

hiding instances 413

Hierarchical Critical Path command 406
Hierarchical View command 406

hierarchy
flattening 409

Hierarchy Browser
commands 475
popup menu 475
refreshing 475

hierarchy browser
enabling/disabling display 436

hierarchy separator 296

How to Use Help command 444

I/O constraints
multiple on same port 227

I/O Standards panel, SCOPE 233
impl Tcl command 70

implementation options
Options Panel 347

Implementation Options
command 331, 345
Implementation Options dialog
box 336, 345
Constraints panel 349
Device panel 346
Options panel 347
Place and Route panel 372
Timing Report panel 353
Verilog panel 358
VHDL panel 354

implementation options, device
partdata tcl command 80

Implementation Results panel

Options for implementation dialog
box 351

implementations
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creating 332

naming 460
include command

verilog library directories 360
include files 22
index_collection command 208
Inputs/Outputs panel, SCOPE 225
instances

dissolving 414

expanding paths between 407

expansion maximum limit 437

expansion maximum limit (per filtered
sheet) 440

expansion maximum limit (per
unfiltered sheet) 440

finding by name 310

hiding and unhiding 413

isolating paths through 413

making transparent 414

name display 435

selecting all in schematic 416

Instances command
schematic selection 416
sheet selection 416

IP
license queuing syntax 145

IP cores (SYNCore)
building ram models 382

Isolate Paths command 413

J

Job Status command 376, 379
job tcl command 72

L

labels, displaying 435

Launch Identify Instrumentor
command 376, 379, 381

levels
See hierarchy

license
floating 444
saving 445
specifying in batch mode 144

License Agreement command 444
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license queuing 146
Limit Number of Paths 399
Linux, 64-bit mapping 348
Log File

HTML 328

text 328
log file

displaying 324

Tcl commands for filtering 147
Log File command

View menu 328
Log Watch window

popup menu 452

Log Watch Window command 324

log filter Tcl command
syntax 73

log report Tcl command 75
Lowercase command 311

maximum parallel jobs 421
memory compiler 382
memory, saving 415
menubar 14

menus
context-sensitive
See popup menus
Edit 309
HDL Analyst 405
Help 444
Options 417
popup
See popup menus
Project 331
Run 374
View 323

Messages
Tcl Window command 323

Mouse Stroke Tutor command 444
multicycle paths
clocks as from/to points 253
examples 243
POS 251
using different start/end clocks 242
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multiple drivers
resolving 130

Multiple File Compilation Unit
Verilog panel 359

multiple projects
displaying project files 424

MultiProcessing
Continue on Error mode 420

multiprocessing
maximum parallel jobs 421

N

naming rules 295
net drivers

displaying and selecting 407
netlist formats

Implementation Options dialog box,
Implementation Results

panel 352
nets
expanding hierarchically from pins and
ports 407

finding by name 310
selecting instances on 407

New command 304

New Implementation command 336
New Project command 304

New Workspace command 305
Next Bookmark command 310
Next Error command 376

Next Sheet command 325

Normal View command 324

(0

object prefixes
Tcl find command 154

object properties
annotated properties for analyst 160

object search order (Timing
Analyzer) 399

object types
Tcl find command 154

objects
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displaying compactly 436
expanding paths between 407
filtering 408
unselecting

all in schematic 416

Online Documents command 444

Open command
File menu 304

Open Project command 304
open_design command 78
open_file command 79
opening

project 304

operators
Tcl collection 169

option settings
reporting 64

options
setting 112

Options for implementation dialog box
Implementation Results panel 351

Options menu 417

Options panel
Implementation Options dialog box 347

output files
log. See log file
srs
See srs file

overriding FSM Compiler 122

P

Pan command 324

parameters
overriding HDL 66

partdata tcl command 80
Paste command 310

path delays
clocks as from/to points 254

path filtering 399

paths
expanding hierarchically from pins and
ports 407
pins
displaying names 435
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displaying on transparent Previous Sheet command 325
instances 414

expanding hierarchically from 407

expanding paths between 407

isolating paths from 413

primitives
internal logic, displaying 436
Print command 304

maximum on schematic sheet 440 Print Setup command 304
Place & Route printing
creating a new options file for view 304
Xilinx 472 printing image
place & route . Create Image command 304
run from the synthesis tool 471 Product of Sums

Place & Route options file See POS
adding for Xilinx 472

Place and Route panel
Implementation Options dialog box 372

program_terminate command 81
program_version command 82

project files

place and route tcl commands organization into folders 423

job 72

pointers, mouse
zoom 324

Project menu 331
commands 331

popup menus Project Options command 462

FSM Viewer 455 project Tcl command 83

Hierarchy Browser 475 Project view

Log Watch window 452 display settings 422

Project view 458 popup menu 458

RTL view 475 setting up 422

Tcl window 452, 453 Project View Options command 417

i 47
Technology view S project_data Tcl command 91

pO(;”itsSplaying names 435 project_file Tcl command 92
expanding hierarchically from 407 project_folder
expanding paths between 407 Tcl command 94
ﬁnding by name 310 projects
1solat1.ng paths from 413 adding files 332
selecting all in schematic 416 closing 305
Ports command creating (Build Project) 304
schematic 416 creating (New) 304
sheet 416 displaying multiple 424
POS opening 304
interface 250 properties
preferences ﬁnq command 160
project 91

project file display 422
Push Tristates
Verilog panel 359

Push/Pop Hierarchy command 325

Preferred License Selection
command 445

prefixes
Timing Analyzer points 399

Previous bookmark command 310
Previous Error/Warning command 376
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Q

quitting a synthesis run 379

R

recent projects, opening 305
recording command 102
Redo command 309

Refresh command 452
Registers panel, SCOPE 228

regular expressions
Tcl find command 155

Reload command 475

Remove Files From Project
command 331

Remove Implementation command 460
remove_from_collection command 210

Replace command
Text Editor 310

replacing

text 321
report_clocks command 103
report_messages command 105

reports
timing report (.ta file) 393

reset_path timing constraint 266
Resolve Multiple Drivers option 130

resolving conflicting timing
constraints 255

resource sharing
Resource Sharing option 349

Resynthesize All command 374

RTL view
displaying 79
opening hierarchical view 406
popup menu 475
popup menu commands 475
printing 304
Run All Implementations command 376
Run menu 374
Run Tcl Script command 376,377

running place & route 471
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S

sar file
Archive Project command 337

Save All command 304
Save As command 304
Save command 304

schematic objects
displaying compactly 436
expanding paths between 407
filtering 408
unselecting all 416

schematics
displaying labels 435
flattening 409
navigating sheets 324
opening hierarchical RTL 406
sheet connectors 436
unselecting objects 416

SCOPE
Attributes panel 232
clock groups 217
Clocks panel 216
Collections panel 223
Compile Points panel 234
Delay Paths panel 229
Generated Clocks panel 220
I/O Standards panel 233
Inputs/Outputs panel 225
Registers panel 228
TCL View 237

SCOPE spreadsheet
popup menu commands 452
starting 214

SCOPE timing constraints summary 215

sdc
standard sdc collection commands 202

sdc2fdc utility 110

Select All command 310

Select All States command 326
Select in Analyst command 453

Select Net Driver command
current level 408
hierarchical 407

Select Net Instances command
current level 408
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hierarchical 407

Select Place & Route option file dialog
box 472

Selected command 325

sequential elements
naming 296

sequential optimizations
disabling 122

Set Library command 331
set modules command (collections) 224

set modules_copy command
(collections) 224

Set Slack Margin command 412
Set VHDL Library command 331
set_clock_groups timing constraint 268
set_clock_latency timing constraint 274

set_clock_uncertainty timing
constraint 276

set_false_path timing constraint 278
set_hierarchy separator command 296
set_input_delay timing constraint 281
set_max_delay timing constraint 284

set_multicycle_path timing
constraint 287

set_option
Resolve Multiple Drivers 130

set_option Tcl command 112
set_output_delay timing constraint 291

set_reg input_delay timing
constraint 294

set_reg output_delay timing
constraint 295

set_rtl_ff names command 296
settings

reporting option 64
sheet connectors 436
Show All Hier Pins command 414
Show Compile Points command 462
Show Context command 413
Show Critical Path command 412
Show Timing Information command 412
sizeof_collection command 211
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slack

margin

setting 412

slack margin 399
srm file

hidden logic not saved 415
srr file

See log file
srs file

hidden logic not saved

start/end points
Timing Report panel, Implementation
Options dialog box 353

state machines

See also FSM Compiler, FSM viewer,

FSMs.
displaying in FSM viewer 416
encoding
displaying 457

filtering states and transitions 325
Status Bar command 323
status_report Tcl command 136
stopping a synthesis run 379

symbols
enabling name display 435
finding by name 310

syn_connect 141
syn_create_err_net 142

syn_reference_clock attribute
effect on multiple I/O constraints 228

syn_tristatetomux attribute
effect of tristate pushing 362

SYNCore wizard 382

Synopsys FPGA implementation tools
product information 443

Synopsys FPGA products 443
Synopsys Home Page command 443
synplify command-line command 144

synplify premier command-line
command 144

synplify premier dp command-line
command 144

synplify_pro command-line
command 144

syntax
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bus dimension separator 297
bus naming 297

Syntax Check command 375

synthesis
stopping 379
Synthesis Check command 375

synthesis jobs
monitoring 379

synthesis_off directive, handling 355
synthesis_on directive, handling 355
Synthesize command 374
SystemVerilog 359

T

Tcl
c_diff collection command 170
c_intersect collection command 171
c_list collection command 172
c_print collection command 172
c_symdiff collection command 173
c_union collection command 174
collection commands 169
set_modules collection command 176
-verilog argument 21
-vhdl argument 21

Tcl (Tool Command Language) 12

tcl argument
-_include 22

Tcl collection commands 169
c_diff 170
c_intersect 171
c_list 172
c_print 172
c_symdiff 173
c_union 174
set_modules 176

Tcl collection operators 169

Tcl commands
add_file 21
add_folder 25
collections 224
constraint_file 34
get_env 64
get_option 64
hdl_param 66
impl 70
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log file commands 147
project 83
project_data 91
project_file 92
project_folder 94
set_option 112

Tcl conventions 12
Tcl expand command 166

Tcl find command 152
case sensitivity 155
examples 156
object prefixes 154
object types 154
regular expression syntax 155
special characters 155
wildcards 155

TCL Help command 444

Tcl Script
Tcl Window command 323

Tcl scripts
running 376, 377

Tcl shell command
sdc2fdc 110

TCL View, SCOPE 237

Tcl window
popup menu 452,453

Tcl Window command 323

Technical Resource Center
specifying PDF reader (UNIX) 441
specifying web browser (UNIX) 441

Technology view
creating 406
popup menu 475
popup menu commands 475
printing 304

technology view
displaying 79

text
copying, cutting and pasting 309
replacing 321

Text Editor
popup menu commands 453
printing 304

through constraints
point-to-point delays 230

through points
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clocks 254

lists, multiple 250

lists, single 249

multiple 250

product of sums UI 250

single 249

specifying for timing exceptions 249

specifying for timing report 397
timing analyst

generating report 393
timing analyzer

wildcards 402
timing constraints

checking 375

conflict resolution 255

constraint priority 255

create_clock 260

create_generated_clock 262

FPGA 259

reset_path 266

set_clock_groups 268

set_clock_latency 274

set_clock_uncertainty 276

set_false_path 278

set_input_delay 281

set_max_delay 284

set_multicycle_path 287

set_output_delay 291

set_reg input_delay 294

set_reg output_delay 295
timing exceptions

False Paths panel 245

multicycle paths 242

priority 255

specifying paths/points 245
timing information, displaying (HDL

Analyst tool) 412

timing report

asynchronous clock report 395

defining through points 397

file (.ta) 393

specifying slack margin 399

using path filtering 399

timing report file
generating custom 394
stand-alone 396

Timing Report panel

Implementation Options dialog box 353

Number of Critical Paths 353
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Start/End Points 353
timing reports
file. See timing report file
filtering 395
parameters 393
stand-alone 393
stand-alone (.ta file) 393
Tip of the Day command 445

to points 399
clocks 253
multiple 248
objects 247
Timing Analyzer 399

Toggle bookmark command 310
Toolbars command 323
tooltips
displaying 327
transparent instances
displaying pins 414
tristates
pushing tristates, description 361

pushing tristates, example 361
pushing tristates, pros and cons 361

U

Uncomment Code 310
Undo command 309
Unfilter command 326

unfiltering 413
FSM diagram 326
schematic 413

Unflatten Current Schematic
command 410

Unhide Instances command 413
unhiding hidden instance 413

UNIX
configure external programs 418

Unselect All command 416
View menu (FSM Viewer) 326

Uppercase command 311
utilities
sdc2fdc 110
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Vv

variables
accessing, get_env Tcl command 64
reporting 64

VCS Simulator command 376

Vendor Constraints
Implementation Results panel,
Implementation Options dialog
box 352
writing 352
Verilog
‘ifdef and ‘ defi ne statements 363
allow duplicate modules (Tcl
option) 116, 118
beta features 366
compiler, configuring 417
extract design parameters 363
library directories 360
specifying compiler directives 363
Verilog 2001
Verilog panel 359

-verilog argument
Tcl 21

Verilog include files
using _ SEARCHFILENAMEONLY _
directive 367

Verilog panel 359
Implementation Options dialog box 358
Multiple File Compilation Unit 359
options 359
Push Tristates 359
SystemVerilog 359
version information 445
VHDL
compiler, configuring 417
enumeration encoding, default 355
ignoring code with synthesis off/on 355
-vhdl argument
Tcl 21
VHDL libraries
setting up 335
VHDL panel
Implementation Options dialog box 354
View FSM command 416
View FSM Info File command 416

View Log File command 324
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View menu 323
Filter submenu 325
Log File command 328
RTL and Technology view
commands 324

View Result File command 324
View Sheets command 325
Visual Properties command 325

w

web browser, specifying for UNIX 441

wildcards
Tcl find command 155
text Find 312
text replacement 321
timing analyzer 402

Windows, 64-bit mapping 348

workspaces
creating (New) 305

Write Output Netlist Only command 375

y4

zoom mouse pointer 324
Zoom Out command 324
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